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ExtrasRechtschreibung
Überprüft die
Rechtschreibung im
aktuellen Dokument.

WordBasic.ToolsSpelling ToolsSpelling
Checks the
spelling in the
active document

Kontext
(Rechtschreibung) Rechtschreibung... Context

(Spelling) 2 191

DateiSpeichern Speichert die aktuelle Datei
oder Dokumentvorlage. ActiveDocument.Save FileSave

Saves the active
document or
template

Datei
Standard
Word für Windows 2.0
E-Mail senden
Outlook-E-Mail senden

Speichern
Strg+S oder Umschalt+F12
oder Alt+Umschalt+F2

File, Standard
Word for
Windows 2.0
Send Mail
Outlook Send
Mail

Ctrl+S 3 83

DateiDrucken Druckt das aktive
Dokument. Dialogs(wdDialogFilePrint).Show FilePrint Prints the active

document Datei Drucken... File Ctrl+P 4 88

AnsichtZoomGanzeSeite
Ändert die Größe der
Bearbeitungansicht auf eine
ganze Seite in der
Layoutansicht.

ActiveWindow.ActivePane.View.Zoom.PageFit =
wdPageFitFullPage ViewZoomWholePage

Scales the editing
view to see the
whole page in
page layout view

Seitenansicht
Word für Windows 2.0 Eine Seite

Print Preview
Word for
Windows 2.0

5 303

AnsichtZoomSeitenbreite
Ändert die Größe der
Bearbeitungansicht auf die
Seitenbreite.

ActiveWindow.ActivePane.View.Zoom.PageFit = wdPageFitBestFit ViewZoomPageWidth
Scales the editing
view to see the
width of the page

Word für Windows 2.0 An Fenster anpassen Word for
Windows 2.0 6 304

AnsichtZoom100
Ändert die Größe der
Bearbeitungsansicht auf
100% in der Normalansicht.

ActiveWindow.ActivePane.View.Zoom.Percentage = 100 ViewZoom100
Scales the editing
view to 100% in
normal view

Word für Windows 2.0 Zoom 100% Word for
Windows 2.0 7 305

TabelleEinfügenTabelleEG Fügt eine Tabelle ein WordBasic.TableInsertTableEG TableInsertTableEG Inserts a table E-Mail senden
Outlook-E-Mail senden Fügt eine Tabelle ein

Send Mail
Outlook Send
Mail

8 1079

FormatSpalten Ändert das Spaltenformat in
markierten Abschnitten. Dialogs(wdDialogFormatColumns).Show FormatColumns

Changes the
column format of
the selected
sections

Format
Standard
Word für Windows 2.0
Erweiterte Formatierung

Spalten...

Standard
Word for
Windows 2.0
Extended
Formatting

Alt O, C 9 177

FormatNummerStandard

Erstellt eine nummerierte
Liste basierend auf den
aktuellen
Standardeinstellungen
Erstellt eine Nummerierung
mit den aktuellen
Einstellungen

WordBasic.FormatNumberDefault FormatNumberDefault
Creates a
numbered list
based on the
current defaults

Format Nummerierung Formatting 11 950

FormatAufzählungStandard

Erstellt eine Aufzählung
basierend auf den aktuellen
Standardeinstellungen
Erstellt eine Aufzählung mit
den aktuellen Einstellungen.

Selection.Range.ListFormat.ApplyBulletDefault FormatBulletDefault
Creates a bulleted
list based on the
current defaults

Format Aufzählungszeichen Formatting 12 399

HochFormatUmschalten
Schaltet zwischen
Hochformat- und
Querformatmodus um.

WordBasic.TogglePortrait TogglePortrait
Toggles between
portrait and
landscape mode

Hochformat/Querformat 13 306

RückEinzugAbsatz
Verschiebt den linken
Einzug zum vorherigen
Tabstopp.

Selection.Paragraphs.Outdent UnIndent
Moves the left
indent to the
previous tab stop

Word für Windows 2.0
Einzug verkleinern
Strg+Umschalt+M (oder in
Lineal ziehen)

Word for
Windows 2.0

Ctrl+Shift+M (or
drag the ruler) 14 39

Einzug
Verschiebt den linken
Einzug zum nächsten
Tabstopp.

Selection.Paragraphs.Indent Indent
Moves the left
indent to the next
tab stop

Word für Windows 2.0 Einzug vergrößern
Strg+M

Word for
Windows 2.0

Ctrl+M (or drag
the ruler) 15 38

EinfügenZeichnung Fügt ein Microsoft Draw-
Objekt ein. WordBasic.InsertDrawing InsertDrawing Inserts a Microsoft

Draw object Zeichnung einfügen 16 284

EinfügenDiagramm Fügt ein Microsoft Graph-
Objekt ein. WordBasic.InsertChart InsertChart Inserts a Microsoft

Graph object
Einfügen > Grafik
Word für Windows 2.0 Diagramm Word for

Windows 2.0 17 285

DateiNeu Erstellt ein neues Dokument
oder eine Dokumentvorlage. Dialogs(wdDialogFileNew).Show FileNew

Creates a new
document or
template

Datei Neu... File (but not
Standard) NOT Ctrl+N!! 18 79

BearbeitenKopieren
Kopiert die Markierung und
überträgt sie in die
Zwischenablage.

Selection.Copy EditCopy
Copies the
selection and puts
it on the Clipboard

Bearbeiten
Kontext
Standard
Word für Windows 2.0
Nachricht lesen
E-Mail senden
Zwischenablage
Outlook-E-Mail lesen
Outlook-E-Mail senden
Skriptanchormenü

Kopieren
Strg+C oder Strg+Einfügen

Edit & Context
Standard
Word for
Windows 2.0
Read Mail
Send Mail
Clipboard
Outlook Read
Mail
Outlook Send
Mail
Script Anchor
Popup

Ctrl+C 19 109
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BearbeitenAusschneiden
Schneidet die Markierung
aus und überträgt sie in die
Zwischenablage.

Selection.Cut EditCut
Cuts the selection
and puts it on the
Clipboard

Bearbeiten
Kontext
Standard
Word für Windows 2.0
E-Mail senden
Outlook-E-Mail senden
Skriptanchormenü
Untermenü Schrift

Ausschneiden
Strg+X
Umschalt+Entf

Edit & Context
Standard
Word for
Windows 2.0
Send Mail
Outlook Send
Mail
Script Anchor
Popup
Font Popup

Ctrl+X 21 108

BearbeitenEinfügen
Fügt den Inhalt der
Zwischenablage vor der
Einfügemarke ein

Selection.Paste EditPaste
Inserts the
Clipboard contents
at the insertion
point

Bearbeiten
Kontext
Standard
Word für Windows 2.0
E-Mail senden
Outlook-E-Mail senden
Skriptanchormenü

Einfügen
Strg+V oder
Umschalt+Einfügen

Edit & Context
Standard
Word for
Windows 2.0
Send Mail
Outlook Send
Mail
Script Anchor
Popup

Ctrl+V 22 110

DateiÖffnen
Öffnet ein bereits
vorhandenes Dokument
oder eine Dokumentvorlage.

Dialogs(wdDialogFileOpen).Show FileOpen
Opens an existing
document or
template

Datei
Standard
Word für Windows 2.0

Öffnen...
Strg+O oder Strg+F12 oder
Alt+Strg+F2

File & Standard
Word for
Windows 2.0

Ctrl+O 23 80

ExtrasBriefumschlagErstellen Erstellt oder druckt einen
Briefumschlag. Dialogs(wdDialogToolsCreateEnvelope).Show ToolsCreateEnvelope Creates or prints

an envelope Word für Windows 2.0 Umschlag Word for
Windows 2.0 24 173

EinfügenFormel Fügt ein Microsoft Formel-
Objekt ein. WordBasic.InsertEquation InsertEquation Inserts a Microsoft

Equation object Formel-Editor 26 683

FreihandSchreibmodusUmschalten
Schaltet den PEN-
Überarbeitungsmodus ein
und aus.

WordBasic.ToggleScribbleMode ToggleScribbleMode
Inserts a pen
comment at the
location of the
insertion point

Penkommentar 30 308

BearbeitenWiederholen Wiederholt den letzten
Befehl. WordBasic.EditRepeat EditRepeat Repeats the last

action Wiederholen: ((+ Aktion)) 37 68

BearbeitenLöschen
Löscht die Markierung ohne
Übertragung in die
Zwischenablage.

Selection.Delete Unit:=wdCharacter, Count:=1 EditClear

Performs a
forward delete or
removes the
selection without
putting it on the
Clipboard

Bearbeiten Markierung löschen
Entf Edit Del 47 30

Zeilenabstand1 Setzt den Zeilenabstand auf
"Einfach" Selection.ParagraphFormat.Space1 SpacePara1

Sets the line
spacing to single
space

Erweiterte Formatierung Einfacher Zeilenabstand
Strg+1

Extended
Formatting Ctrl+1 54 62

ZeilenabstandEinsKommaFünf Setzt den Zeilenabstand auf
1,5 Zeilen. Selection.ParagraphFormat.Space15 SpacePara15

Sets the line
spacing to one-
and-one-half
space

Erweiterte Formatierung 1,5facher Zeilenabstand
Strg+5

Extended
Formatting Ctrl+5 55 63

Zeilenabstand2 Setzt den Zeilenabstand auf
"Doppelt" Selection.ParagraphFormat.Space2 SpacePara2

Sets the line
spacing to double
space

Erweiterte Formatierung Doppelter Zeilenabstand
Strg+2

Extended
Formatting Ctrl+2 56 64

Hochgestellt
Formatiert den markierten
Textteil hochgestellt
[ein/aus].

Selection.Font.Superscript = wdToggle Superscript
Makes the
selection
superscript
(toggle)

Hochgestellt
Strg++ Ctrl++ 57 54

Tiefgestellt Formatiert den markierten
Textteil tiefgestellt [ein/aus]. Selection.Font.Subscript = wdToggle Subscript

Makes the
selection subscript
(toggle)

Tiefgestellt
Strg+# Ctrl+= 58 55

DoppeltUnterstreichen
Formatiert einen markierten
Textteil doppelt
unterstrichen [ein/aus].

If Selection.Font.Underline = wdUnderlineDouble Then
Selection.Font.Underline = wdUnderlineNone

Else
Selection.Font.Underline = wdUnderlineDouble

End If

DoubleUnderline
Double underlines
the selection
(toggle)

Doppelt unterstrichen
Strg+Umschalt+D Ctrl+Shift+D 60 52

WortUnterstreichen
Formatiert nur die Wörter
(nicht die Leerzeichen) in
einem markierten Textteil
unterstrichen [ein/aus].

If Selection.Font.Underline = wdUnderlineWords Then
Selection.Font.Underline = wdUnderlineNone

Else
Selection.Font.Underline = wdUnderlineWords

End If

WordUnderline
Underlines the
words but not the
spaces in the
selection (toggle)

Wort unterstrichen
Strg+Umschalt+W Ctrl+Shift+W 61 53

SchriftVergrößern Vergrößert den Schriftgrad
des markierten Textteils. Selection.Font.Grow GrowFont

Increases the font
size of the
selection

Schriftart vergrößern
Strg+> Ctrl+> 62 11

SchriftVerkleinern Verkleinert den Schriftgrad
des markierten Textteils. Selection.Font.Shrink ShrinkFont

Decreases the font
size of the
selection

Schriftart verkleinern
Strg+< Ctrl+< 63 12
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EinblendenEbene1 Zeigt nur die Überschriften
der ersten Ebene an. ActiveWindow.View.ShowHeading 1 ShowHeading1 Displays the level

1 headings only
Gliederung
Kontext
Dokumentstruktur

Überschrift 1 einblenden
Alt+Umschalt+1

Outlining
Context
Document Map

71 251

EinblendenEbene2
Zeigt die Überschriften der
ersten und zweiten Ebene
an.

ActiveWindow.View.ShowHeading 2 ShowHeading2 Displays the level
1 and 2 headings

Gliederung
Kontext
Dokumentstruktur

Überschrift 2 einblenden
Alt+Umschalt+2

Outlining
Context
Document Map

72 252

EinblendenEbene3 Zeigt die Überschriften der
ersten bis dritten Ebene an. ActiveWindow.View.ShowHeading 3 ShowHeading3

Displays the level
1 through 3
headings

Gliederung
Kontext
Dokumentstruktur

Überschrift 3 einblenden
Alt+Umschalt+3

Outlining
Context
Document Map

73 253

EinblendenEbene4 Zeigt die Überschriften der
ersten bis vierten Ebene an. ActiveWindow.View.ShowHeading 4 ShowHeading4

Displays the level
1 through 4
headings

Gliederung
Kontext
Dokumentstruktur

Überschrift 4 einblenden
Alt+Umschalt+4

Outlining
Context
Document Map

74 254

EinblendenEbene5 Zeigt die Überschriften der
ersten bis fünften Ebene an. ActiveWindow.View.ShowHeading 5 ShowHeading5

Displays the level
1 through 5
headings

Gliederung
Kontext
Dokumentstruktur

Überschrift 5 einblenden
Alt+Umschalt+5

Outlining
Context
Document Map

75 255

EinblendenEbene6
Zeigt die Überschriften der
ersten bis sechsten Ebene
an.

ActiveWindow.View.ShowHeading 6 ShowHeading6
Displays the level
1 through 6
headings

Gliederung
Kontext
Dokumentstruktur

Überschrift 6 einblenden
Alt+Umschalt+6

Outlining
Context
Document Map

76 256

EinblendenEbene7
Zeigt die Überschriften der
ersten bis siebten Ebene
an.

ActiveWindow.View.ShowHeading 7 ShowHeading7
Displays the level
1 through 7
headings

Gliederung
Kontext
Dokumentstruktur

Überschrift 7 einblenden
Alt+Umschalt+7

Outlining
Context
Document Map

77 257

EinblendenEbene8 Zeigt die Überschriften der
ersten bis achten Ebene an. ActiveWindow.View.ShowHeading 8 ShowHeading8

Displays the level
1 through 8
headings

Gliederung
Kontext
Dokumentstruktur

Überschrift 8 einblenden
Alt+Umschalt+8

Outlining
Context
Document Map

78 258

EinblendenEbene9
Zeigt die Überschriften der
ersten bis neunten Ebene
an.

ActiveWindow.View.ShowHeading 9 ShowHeading9
Displays the level
1 through 9
headings

Gliederung
Kontext
Dokumentstruktur

Überschrift 9 einblenden
Alt+Umschalt+9

Outlining
Context
Document Map

79 259

DateiSchließen Schließt alle Fenster des
aktiven Dokuments WordBasic.FileClose FileClose

Closes all of the
windows of the
active document

Datei Schließen File 106 283

TabelleAutoFormat
Weist einer Tabelle
verschiedene
Formatierungen zu.

Dialogs(wdDialogTableAutoFormat).Show TableAutoFormat
Applies a set of
formatting to a
table

Tabelle
Tabellen und Rahmen Tabelle AutoFormat...

Table
Tables and
Borders

Alt A, F 107 563

FormatKopieren
Kopiert die Formatierung
einer Markierung an eine
bestimmte Textstelle.

Selection.CopyFormat CopyFormat
Copies the
formatting of the
selection to a
specified location

Standard
E-Mail senden
Outlook-E-Mail senden

Format übertragen
Strg+Umschalt+C

Standard
Send Mail
Outlook Send
Mail

Ctrl+Shift+C 108 73

DateiSeitenansicht
Zeigt ganze Seiten
entsprechend der
Druckausgabe an.

ActiveDocument.PrintPreview FilePrintPreview
Displays full pages
as they will be
printed

Datei
Standard

Seitenansicht
Strg+F2 oder Alt+Strg+I

File
Standard Ctrl+F2 109 89

FormatEinfügen
Weist der Markierung die
zuvor kopierte Formatierung
zu.

Selection.PasteFormat PasteFormat
Applies the
previously copied
formatting to
selection

Formatvorlage übernehmen
Strg+Umschalt+V Ctrl+Shift+V 111 486

Fett Formatiert den markierten
Textteil fett (ein/aus). Selection.Font.Bold = wdToggle Bold

Makes the
selection bold
(toggle)

Format Fett
Strg+Umschalt+F Formatting Ctrl+B 113 45

Kursiv Formatiert einen markierten
Textteil kursiv (ein/aus). Selection.Font.Italic = wdToggle Italic

Makes the
selection italic
(toggle)

Format Kursiv
Strg+Umschalt+K Formatting Ctrl+I 114 46

Unterstrichen
Formatiert einen markierten
Textteil durchgehend
unterstrichen [ein/aus].

If Selection.Font.Underline = wdUnderlineNone Then
Selection.Font.Underline = wdUnderlineSingle

Else
Selection.Font.Underline = wdUnderlineNone

End If

Underline
Formats the
selection with a
continuous
underline (toggle)

Format Unterstrichen
Strg+Umschalt+U Formatting Ctrl+U 115 51

AlleAnzeigen

Blendet alle
nichtdruckbaren Zeichen ein
oder aus
Zeigt alle nichtdruckbaren
Zeichen an (ein/aus).

ActiveWindow.ActivePane.View.ShowAll = Not
ActiveWindow.ActivePane.View. _
ShowAll

ShowAll
Shows/hides all
nonprinting
characters

Standard
E-Mail-Symbolleisten

Alle anzeigen

einblenden/ausblenden
Strg+Umschalt++
Strg+Umschalt+8

Standard
Mail toolbars Ctrl+ 119 276

AbsatzLinks Richtet einen markierten
Absatz links aus. Selection.ParagraphFormat.Alignment = wdAlignParagraphLeft LeftPara

Aligns the
paragraph at the
left indent

Format Linksbündig
Strg+L Formatting Ctrl+L 120 58

AbsatzRechts Richtet einen markierten
Absatz rechts aus. Selection.ParagraphFormat.Alignment = wdAlignParagraphRight RightPara

Aligns the
paragraph at the
right indent

Format Rechtsbündig
Strg+R Formatting Ctrl+R 121 60
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AbsatzZentriert Richtet einen markierten
Absatz zentriert aus. Selection.ParagraphFormat.Alignment = wdAlignParagraphCenter CenterPara

Centers the
paragraph
between the
indents

Format Zentriert
Strg+E Formatting Ctrl+E 122 59

AbsatzBlock Richtet einen markierten
Absatz als Block aus. Selection.ParagraphFormat.Alignment = wdAlignParagraphJustify JustifyPara

Aligns the
paragraph at both
the left and the
right indent

Format Blocksatz
Strg+B Formatting Ctrl+J 123 61

HilfeSymbol
Bietet Hilfe zu Befehlen,
Bildschirmbereichen oder
überprüft Formatierungen.

Application.HelpTool HelpTool

Lets you get help
on a command or
screen region or
examine text
properties

?
Seitenansicht

Direkthilfe
Umschalt+F1 (Modus verlassen
mit Esc)

Print Preview Shift+F1 124 2

EinfügenFeldDatum Fügt ein Feld für das Datum
ein. Selection.Fields.Add Range:=Selection.Range, Type:=wdFieldDate InsertDateField Inserts a date field Kopf- und Fußzeile Datum

Alt+Umschalt+D
Header and
Footer Alt+Shift+D 125 240

EinfügenFeldZeit Fügt ein Feld für die Uhrzeit
ein. Selection.Fields.Add Range:=Selection.Range, Type:=wdFieldTime InsertTimeField Inserts a time field Kopf- und Fußzeile Zeit

Alt+Umschalt+T
Header and
Footer Alt+Shift+T 126 241

EinfügenSeitenzahlen
Fügt am oberen oder
unteren Rand Seitenzahlen
ein.

Dialogs(wdDialogInsertPageNumbers).Show InsertPageNumbers
Adds page
numbers to the top
or the bottom of
the pages

Einfügen Seitenzahlen... 127 294

BearbeitenRückgängig Macht den letzten Befehl
rückgängig. WordBasic.EditUndo EditUndo Reverses the last

action

Bearbeiten
Standard
Word für Windows 2.0
E-Mail senden
Outlook-E-Mail senden

Rückgängig: ((+ Aktion))
Strg+Z oder Alt+RÜCK

Edit & Standard
Word for
Windows 2.0
Send Mail
Outlook Send
Mail

Ctrl+Z 128 107

BearbeitenWiederherstellen
Stellt den Zustand vor der
Wahl des Befehls
"Rückgängig" wieder her.

WordBasic.EditRedo EditRedo
Redoes the last
action that was
undone

Standard
E-Mail senden
Outlook-E-Mail senden

Wiederherstellen: ((+ Aktion))
Alt+Umschalt+RÜCK

Standard
Send Mail
Outlook Send
Mail

Alt+Shift+Backsp
c 129 329

ZeichnungEinfügenLinie

Fügt ein
Zeichnungselement "Linie"
ein.
Zeichnet eine gerade Linie
an der Stelle, an der Sie
klicken und ziehen im
aktiven Fenster.

WordBasic.DrawLine
ActiveDocument.Shapes.AddLine(BeginX, BeginY, EndX, EndY,
[Anchor]).Select

DrawLine
Zeichnen
Zeichnen > AutoFormen
> Linien

Linie
Drawing
Drawing >
AutoShapes >
Lines

130 376

ZeichnungRechteck
Fügt ein
Zeichnungselement
"Rechteck" ein.

WordBasic.DrawRectangle
ActiveDocument.Shapes.AddShape(msoShapeRectangle, Left,
Top, Width, Height, [Anchor]).Select

DrawRectangle Inserts a rectangle
drawing object Zeichnen Rechteck 131 377

GliederungHöherstufen
Bringt den markierten
Absatz auf die
nächsthöhere Ebene.

Selection.Paragraphs.OutlinePromoteSelection.Paragraphs.Outline
Promote OutlinePromote

Promotes the
selected
paragraphs one
heading level

Gliederung
Höher stufen
Alt+Umschalt+Links
(funktioniert auch mit Listen-FV,
die zu einer Gliederung
gehören)

Outlining toolbar Alt+Shift+left
arrow 132 244

GliederungTieferstufen
Bringt den markierten
Absatz auf die
nächstniedrigere Ebene.

Selection.Paragraphs.OutlineDemote OutlineDemote
Demotes the
selected
paragraphs one
heading level

Gliederung
Tiefer stufen
Alt+Umschalt+Rechts
(funktioniert auch mit Listen-FV,
die zu einer Gliederung
gehören)

Outlining toolbar Alt+Shift+rt arrow 133 245

GliederungAbsatzNachOben
Verschiebt den markierten
Absatz über den vorherigen
Eintrag in der Gliederung.

Selection.Range.Relocate wdRelocateUp OutlineMoveUp
Moves the
selection above
the previous item
in the outline

Gliederung
Nach oben
Alt+Umschalt+Aufwärts ... auch
gut geeignet um (mehrere)
Tabellenzeilen zu verschieben

Outlining toolbar Alt+Shift+up
arrow 134 246

GliederungAbsatzNachUnten
Verschiebt den markierten
Absatz unter den folgenden
Eintrag in der Gliederung.

Selection.Range.Relocate wdRelocateDown OutlineMoveDown
Moves the
selection below
the next item in
the outline

Gliederung
Nach unten
Alt+Umschalt+Abwärts ... auch
gut geeignet um (mehrere)
Tabellenzeilen zu verschieben

Outlining toolbar Alt+Shift+down
arrow 135 247

TieferstufenZuTextKörper

Weist die
Standardformatvorlage zu
und wandelt die markierten
Überschriften in Textkörper
um.

Selection.Paragraphs.OutlineDemoteToBody DemoteToBodyText

Applies the
Normal style and
converts the
selected headings
to body text

Gliederung
Tieferstufen zu Textkörper
Strg+Umschalt+N (= FV
Standard zuweisen)

Outlining 136 366

GliederungErweitern
Zeigt die nächstniedrigere
Text-Ebene einer
Markierung an.

ActiveWindow.ActivePane.View.ExpandOutline
Range:=Selection.Range OutlineExpand

Displays the next
level of subtext of
the selection

Gliederung
Kontext
Dokumentstruktur

Gliederung erweitern
Alt+Umschalt+0

Outlining
Context
Document Map

Alt++ 137 249

GliederungReduzieren

Blendet die unterste Text-
Ebene einer Markierung
aus.
Verbirgt die unterste Text-
Ebene einer Markierung.

ActiveWindow.ActivePane.View.CollapseOutline
Range:=Selection.Range OutlineCollapse

Hides the lowest
subtext of the
selection

Gliederung
Kontext
Dokumentstruktur

Gliederung reduzieren
Alt+_ Outlining toolbar Alt+_ 138 250



Deutsch Beschreibung Makro-Beispiel English Description Type Symbolleiste Befehl/Kürzel Toolbar Shortcut Comm Dial

ZeichnenTextfeld
Fügt ein leeres Textfeld ein,
oder umgibt das markierte
Element mit einem Textfeld

Selection.CreateTextbox DrawTextBox

Inserts an empty
textbox or
encloses the
selected item in a
textbox

Einfügen
Zeichnen Textfeld Drawing 139 947

DateiManager
Sucht nach Dokumenten in
beliebigen Verzeichnissen,
Laufwerken oder Ordnern

Dialogs(wdDialogFileFind).Show FileFind
Locates the
documents in any
directory, drive, or
folder

Datei suchen... 140 99

BearbeitenSuchen Sucht Text und
Formatierung. Dialogs(wdDialogEditFind).Show EditFind

Finds the specified
text or the
specified
formatting

Bearbeiten Suchen...
Strg+F Edit Ctrl+F 141 112

EinfügenExcelTabelle Fügt ein Microsoft Excel
Arbeitsblatt-Objekt ein. WordBasic.InsertExcelTable InsertExcelTable

Inserts a Microsoft
Excel worksheet
object

Standard Excel-Tabelle einfügen Standard 142 567

FormatAutoFormat
Führt eine automatische
Formatierung des
Dokuments durch.

Selection.Range.AutoFormat FormatAutoFormat
Automatically
formats a
document

Format
Nachricht lesen
E-Mail senden
Outlook-E-Mail lesen

AutoFormat...
Strg+J

Formatting
Read Mail
Send Mail
Outlook Read
Mail

Alt+Ctrl+K 144 385

RahmenlinieInnen
Ändert den Innenrahmen
der markierten Absätze,
Tabellenzellen und
Grafiken.

With Selection.Borders
.InsideLineStyle = Options.DefaultBorderLineStyle
.InsideLineWidth = Options.DefaultBorderLineWidth
.InsideColor = Options.DefaultBorderColor

End With

BorderInside

Changes the
inside borders of
the selected
paragraphs, table
cells, and pictures

Format > Rahmen
Tabellen und Rahmen >
Rahmen
Rahmen

Rahmenlinien innen
Formatting
Tables and
Borders
Borders

149 4066

Kasten
Ändert den Außenrahmen
der markierten Absätze,
Tabellenzellen und
Grafiken.

With Selection.Borders
.OutsideLineStyle = Options.DefaultBorderLineStyle
.OutsideLineWidth = Options.DefaultBorderLineWidth
.OutsideColor = Options.DefaultBorderColor

End With

BorderOutside

Changes the
outside borders of
the selected
paragraphs, table
cells, and pictures

Format > Rahmen
Tabellen und Rahmen >
Rahmen
Rahmen

Rahmenlinien außen
Formatting
Tables and
Borders
Borders

150 449

OhneRahmenlinien
Entfernt Rahmen um
markierte Absätze,
Tabellenzellen und
Grafiken.

WordBasic.BorderNone BorderNone
Removes borders
from the selected
paragraphs, table
cells, and pictures

Format > Rahmen
Tabellen und Rahmen >
Rahmen
Rahmen

Kein Rahmen
Formatting
Tables and
Borders
Borders

151 450

ZeichnungEllipse
Fügt ein
Zeichnungselement
"Ellipse" ein.

WordBasic.DrawEllipse
ActiveDocument.Shapes.AddShape(msoShapeOval, Left, Top,
Width, Height, [Anchor]).Select

DrawEllipse Inserts an ellipse
drawing object Zeichnen Ellipse 152 454

ZeichnungBogen
Fügt ein
Zeichnungselement
"Bogen" ein.

WordBasic.DrawArc
ActiveDocument.Shapes.AddShape(msoShapeArc, Left, Top,
Width, Height, [Anchor]).Select

DrawArc Bogen 153 455

SeriendruckErsterDatensatz
Zeigt den ersten Datensatz
in der aktuellen
Seriendruck-Datenquelle
an.

ActiveDocument.MailMerge.DataSource.ActiveRecord =
wdFirstRecord MailMergeFirstRecord

Displays the first
record in the
active mail merge
data source

Seriendruck Erster Mail Merge 154 480

SeriendruckVorherigerDatensatz
Zeigt den vorherigen
Datensatz in der aktuellen
Seriendruck-Datenquelle
an.

ActiveDocument.MailMerge.DataSource.ActiveRecord =
wdPreviousRecord MailMergePrevRecord

Displays the
previous record in
the active mail
merge data source

Seriendruck Vorheriger Mail Merge 155 479

SeriendruckNächsterDatensatz
Zeigt den nächsten
Datensatz in der aktuellen
Seriendruck-Datenquelle
an.

ActiveDocument.MailMerge.DataSource.ActiveRecord =
wdNextRecord MailMergeNextRecord

Displays the next
record in the
active mail merge
data source

Seriendruck Nächster Mail Merge 156 478

SeriendruckLetzterDatensatz
Zeigt den letzten Datensatz
in der aktuellen
Seriendruck-Datenquelle
an.

ActiveDocument.MailMerge.DataSource.ActiveRecord =
wdLastRecord MailMergeLastRecord

Displays the last
record in the
active mail merge
data source

Seriendruck Letzter Mail Merge 157 481

SeriendruckInDokument
Sammelt die Ergebnisse
eines Seriendrucks in einem
Dokument.

With ActiveDocument.MailMerge
.Destination = wdSendToNewDocument
.Execute

End With
MailMergeToDoc

Collects the
results of the mail
merge in a
document

Seriendruck Seriendruck in Dokument
Alt+Umschalt+N Mail Merge Alt+Shift+N 159 678

SeriendruckAnDrucker
Sendet die Ergebnisse des
Seriendrucks an den
Drucker.

With ActiveDocument.MailMerge
.Destination = wdSendToPrinter
.Execute

End With
MailMergeToPrinter

Sends the results
of the mail merge
to the printer

Seriendruck Seriendruck an Drucker
Alt+Umschalt+M Mail Merge Alt Shift+M 160 679

SeriendruckPrüfen Prüft den Seriendruck auf
Fehler. Dialogs(wdDialogMailMergeCheck).Show MailMergeCheck Checks for errors

in a mail merge Seriendruck
Fehlerprüfung beim
Zusammenführen
Alt+Umschalt+K

Mail Merge Alt+Shift+K 161 677

SeriendruckDatenquelleBearbeiten Öffnet eine Seriendruck-
Datenquelle. ActiveDocument.MailMerge.EditDataSource MailMergeEditDataSource Opens a mail

merge data source Seriendruck Datenformular
Alt+Umschalt+E Mail Merge Alt+Shift+E 162 104

SeriendruckAnsichtDaten
Schaltet zwischen
Seriendruckfeld-Resultat
und Seriendruckfeld hin und
her.

ActiveDocument.MailMerge.ViewMailMergeFieldCodes = wdToggle MailMergeViewData
Toggles between
viewing merge
fields and actual
data

Seriendruck Felder/Werte anzeigen Mail Merge 163 431
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ZeichnungsGruppe

Fasst die markierten
Zeichnungselemente zu
einer Gruppe zusammen.
Fasst zwei oder mehr
markierte Objekte zu einem
einzigen Objekt zusammen,
um diese als Gruppe zu
verschieben oder zu
ändern.

WordBasic.DrawGroup DrawGroup
Groups the
selected drawing
objects

Zeichnen > Zeichnen
ActiveX-Steuerelemente
Zeichnen.Formen
Zeichnen.Kurve
Unverankerte Grafik
OLE-Objekt
WordArt-Kontextmenü

Gruppierung Drawing > Draw Alt R, G 164 465

ZeichnungGruppierungAufheben

Hebt die Gruppierung von
Zeichnungselementen auf.
Hebt die Gruppierung eines
gruppierten Objekts auf und
erstellt einzelne Objekte,
damit jedes Einzelne
verschoben oder geändert
werden kann.

WordBasic.DrawUngroup DrawUngroup
Ungroups the
selected group of
drawing objects

Zeichnen > Zeichnen
ActiveX-Steuerelemente
Zeichnen.Formen
Zeichnen.Kurve
Unverankerte Grafik
OLE-Objekt
WordArt-Kontextmenü

Gruppierung aufheben Drawing > Draw Alt R, U 165 485

ZeichnungInVordergrund

Stellt die markierten
Zeichnungselemente in
dieser Zeichnungsebene
ganz nach vorne.
Verschiebt das markierte
Objekt vor andere
überschneidende Objekte.

WordBasic.DrawBringToFront DrawBringToFront
Brings the
selected drawing
objects to the front

Zeichnen > Zeichnen >
Reihenfolge
Kontext > Reihenfolge

In den Vordergrund
Drawing > Draw
> Order
Context

166 466

ZeichnungInHintergrund

Stellt die markierten
Zeichnungselemente in
dieser Zeichnungsebene
ganz nach hinten.
Verschiebt das markierte
Objekt hin andere
überschneidende Objekte.

WordBasic.DrawSendToBack DrawSendToBack
Sends the
selected drawing
objects to the back

Zeichnen > Zeichnen >
Reihenfolge
Kontext > Reihenfolge

In den Hintergrund
Drawing > Draw
> Order
Context > Order

167 467

ZeichnungVorText

Stellt die markierten
Zeichnungselemente um
eine Zeichnungsebene
nach vorne.
Verschiebt das markierte
Zeichnungsobjekt vor den
Text.

WordBasic.DrawBringInFrontOfText DrawBringInFrontOfText
Brings the
selected drawing
objects forward
one layer

Zeichnen > Zeichnen >
Reihenfolge
Kontext > Reihenfolge

Vor den Text bringen Drawing > Draw
Context > Order 168 469

ZeichnungHinterText

Stellt die markierten
Zeichnungselemente um
eine Zeichnungsebene
nach hinten.
Verschiebt das markierte
Zeichnungsobjekt hinter den
Text.

WordBasic.DrawSendBehindText DrawSendBehindText
Sends the
selected drawing
objects back one
layer

Zeichnen > Zeichnen >
Reihenfolge
Kontext > Reihenfolge

Hinter den Text bringen
Drawing > Draw
> Order
Context > Order

169 468

ZeichnungNachVorne

Stellt die markierten
Zeichnungselemente in
dieser Zeichnungsebene
weiter nach vorne.
Verschiebt das markierte
Objekt oder die markierte
Gruppe eine Schicht höher
zur Spitze des
Objektstapels.

WordBasic.DrawBringForward DrawBringForward
Brings the
selected drawing
objects forward

Zeichnen > Zeichnen >
Reihenfolge
Kontext > Reihenfolge

Eine Ebene nach vorne Drawing > Draw
Context > Order 170 500

ZeichnungNachHinten

Stellt die markierten
Zeichnungselemente in
dieser Zeichnungsebene
weiter nach hinten.
Verschiebt das markierte
Objekt oder die markierte
Gruppe um eine Stufe nach
untem im Objektstapel.

WordBasic.DrawSendBackward DrawSendBackward
Sends the
selected drawing
objects backward

Zeichnen > Zeichnen >
Reihenfolge
Kontext > Reihenfolge

Eine Ebene nach hinten Drawing > Draw
> Order 171 501

Lupe Ändert die
Vergrößerungswerte.

ActiveWindow.ActivePane.View.Magnifier = Not
ActiveWindow.ActivePane.View. _

Magnifier
Magnifier Toggle zoom-in

zoom-out mode Seitenansicht Lupe Print Preview 172 515

ExtrasGrößeAnpassen
Versucht das Dokument mit
einer Seite weniger
darzustellen.

ActiveDocument.FitToPages ToolsShrinkToFit
Attempts to make
the document fit
on one less page

Seitenansicht Um eine Seite verkleinern Print Preview
toolbar 173 504

Mehrere Seiten anzeigen Seitenansicht Mehrere Seiten Print Preview 177

GanzerBildschirmUmschalten
Blendet die Menü-,
Bearbeitungs- und
Statusleisten ein und aus.

ActiveWindow.View.FullScreen = Not
ActiveWindow.View.FullScreen ToggleFull Toggles full screen

mode on/off
Ansicht
Ganzer Bildschirm

Ganzer Bildschirm/Ganzer
Bildschirm schließen

View
Full Screen 178 582

AnsichtLineal Schaltet das Lineal ein oder
aus.

ActiveWindow.ActivePane.DisplayRulers = Not
ActiveWindow.ActivePane. _
DisplayRulers

ViewRuler Shows or hides
the ruler

Ansicht
Seitenansicht Lineal Print Preview 179 153
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ZeichnungAbgerundetesRechteck
Fügt ein
Zeichnungselement
"abgerundetes Rechteck"
ein.

WordBasic.DrawRoundRectangle DrawRoundRectangle
Inserts a rounded
rectangle drawing
object

Abgerundetes Rechteck 180 537

EinfügenKlang Fügt ein Klang-Objekt in
das Dokument ein. WordBasic.InsertSound InsertSound

Inserts a sound
object into the
document

Gesprochener Kommentar
Audioobjekt einfügen 181 519

MarkierungZeichnungsElement

Zeichnungselemente
markieren
Wird benutzt, um
Zeichnungselemente zu
markieren -- Ziehen Sie mit
der Maus ein Rechteck um
die Elemente.
Ändert den Zeiger zum
Auswahlpfeil, um Objekt im
aktiven Fenster
auszuwählen.

WordBasic.SelectDrawingObjects SelectDrawingObjects

Use to select
drawing objects --
drag to create a
rectangle
enclosing the
objects

Zeichnen Objekte markieren Drawing 182 545

SeriendruckDatensatzSuchen
Sucht nach einem
bestimmten Datensatz in
einer Seriendruck-
Datenquelle.

Dialogs(wdDialogMailMergeFindRecord).Show MailMergeFindRecord
Finds a specified
record in a mail
merge data source

Seriendruck
Datenbank In Feld suchen Mail Merge

Database 183 569

ExtrasMakroAufzeichnenAnfang Schaltet den Makrorekorder
ein oder aus ToolsRecordMacroStart Turns macro

recording on or off Visual Basic Aufzeichnen... Visual Basic 184 666

MakroAufzeichnungUnterbrechen Hält die Makroaufzeichnung
an (ein/aus). WordBasic.PauseRecorder PauseRecorder Pauses the macro

recorder (toggle) Aufzeichnung anhalten 185 216

ExtrasMakro
Erstellt, löscht und
überarbeitet ein Makro oder
führt es aus.

Dialogs(wdDialogToolsMacro).Show ToolsMacro
Runs, creates,
deletes, or revises
a macro

Extras > Makro
Visual Basic

Makros...
Alt+F8

Tools > Macro
Visual Basic Alt+F8 186 215

MakroProtokoll Protokoll TraceMacro
This command is
not available on
this platform.

Protokoll 187 267

MakroSchrittweisePrüfen SchrittweisePrüfen StepIn
This command is
not available on
this platform.

Einzelschritt 188 265

MakroWeiter Fortsetzen ContinueMacro
This command is
not available on
this platform.

Anhalten 189 266

WW2_ExtrasMakro
Ermöglicht das Ausführen,
Erstellen, Löschen oder
Bearbeiten eines Makros

WordBasic.WW2_ToolsMacro WW2_ToolsMacro
Runs, creates,
deletes, or revises
a macro

190 674

DialogEditor Öffnet den Makrodialog-
Editor. WordBasic.DialogEditor DialogEditor Opens the macro

dialog editor Dialog-Editor 191 552

MakroREM REM hinzufügen/entfernen MacroREM
This command is
not available on
this platform.

Kommentarblock 192 553

NächstenBefehlAufzeichnen Zeichnet den nächsten
ausgeführten Befehl auf. RecordNextCommand

Records the next
command
executed

Nachfolgend aufzeichnen 193 226

MakroSubPrüfen Subs prüfen StepOver
This command is
not available on
this platform.

Prozedurschritt 194 264

ZeichnungHorizontalKippen

Kippt die markierten
Zeichnungselemente von
links nach rechts.
Kippt das markierte
Zeichnungsobjekt horizontal
um 180 Grad.

WordBasic.DrawFlipHorizontal DrawFlipHorizontal
Flips the selected
drawing objects
from left to right

Zeichnen > Zeichnen >
Drehen oder kippen Horizontal kippen Drawing > Draw

> Rotate or Flip 196 559

ZeichnungVertikalKippen

Kippt die markierten
Zeichnungselemente von
oben nach unten.
Kippt das markierte
Zeichnungsobjekt oder die
markierte Gruppe vertikal
um 180 Grad, sozusagen
von oben nach unten.

WordBasic.DrawFlipVertical DrawFlipVertical
Flips the selected
drawing objects
from top to bottom

Zeichnen > Zeichnen >
Drehen oder kippen Vertikal kippen Drawing > Draw

> Rotate or Flip 197 560

ZeichnungDrehenRechts

Dreht die markierten
Zeichnungselemente um 90
Grad nach rechts.
Dreht das markierte Objekt
um 90 Grad nach rechts.

WordBasic.DrawRotateRight DrawRotateRight

Rotates the
selected drawing
objects 90
degrees to the
right

Zeichnen > Zeichnen >
Drehen oder kippen Rechtsdrehung Drawing > Draw

> Rotate or Flip 198 561

ZeichnungDrehenLinks

Dreht die markierten
Zeichnungselemente um 90
Grad nach links.
Dreht das markierte Objekt
um 90 Grad nach links.

WordBasic.DrawRotateLeft DrawRotateLeft
Rotates the
selected drawing
objects 90
degrees to the left

Zeichnen > Zeichnen >
Drehen oder kippen Linksdrehung Drawing > Draw

> Rotate or Flip 199 562
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ZeichnenFreihandformEinfügen
Zeichnet ein Objekt mit
sowohl gekrümmten und
geraden Abschnitten.

??? ??? Zeichnen > AutoFormen
> Linien Freihandform

Drawing >
AutoShapes >
Lines

200

Format
Format Rahmen Format

Formatting 203

AnsichtZeichnungsSymbolleiste
Zeigt die
Zeichnungssymbolleiste an
[ein/aus].

WordBasic.ViewDrawingToolbar ViewDrawingToolbar
Shows or hides
the Drawing
toolbar

Standard
Word für Windows 2.0

Zeichnen
(oder in irgendeine
Symbolleiste rechts-klicken und
"Zeichnen" auswählen)

Standard
(but you can
right-click on any
toolbar to select
which toolbars
should be visible)

204 605

BearbeitenAutoText
Fügt einen AutoText-Eintrag
ein oder definiert einen
Eintrag neu.

Dialogs(wdDialogEditAutoText).Show EditAutoText Inserts or defines
AutoText entries

Einfügen > AutoText
AutoText AutoText... AutoText 205 985

ZeichnungUmformen

Zeigt Ziehpunkte zur
Größenänderung markierter
Freihand-Vieleck-
Zeichnungselemente an.
Umformen durch Ziehen der
Punkte.
Zeigt die Scheitelpunkte an,
damit Sie die Form der
markierten Freihandform
oder Kurve ändern können.

WordBasic.DrawReshape DrawReshape

Displays resizing
handles on
selected freeform
drawing objects.
Drag a handle to
reshape the object

Zeichnen
Krümmen Zeichnen > Punkte bearbeiten Drawing

Curve
To add:
3480
Added:
206

608

FormatFüllFarbe

Übernimmt die zuletzt
verwendete Füllfarbe in die
AutoForm
Entfernt die Füllung des
markierten Objektes oder
fügt die Standardfülllung
dem markierten Objekt
hinzu.

WordBasic.FormatFillColor FormatFillColor

Applies the most
recently used fill
color to the
selected
AutoShape

Füllfarbe 207 5724

Entfernt die Linie des
markierten Objektes oder
fügt die Standardlinie dem
markierten Objekt hinzu.

Linienfarbe 208

FormatLegende

Formatiert die markierten
Legende-
Zeichnungselemente oder
setzt sie zur Vorgabe
zurück.

Dialogs(wdDialogFormatCallout).Show FormatCallout
Formats the
selected callouts
or sets callout
defaults

Optionen für Legende 209 610

ExtrasDatensatzHinzufügen Fügt einen Datensatz zu
einer Datenbank hinzu. ActiveDocument.Tables(1).Rows.Add ToolsAddRecordDefault Adds a record to a

database Datenbank Datensatz hinzufügen Database 213 629

ExtrasDatensatzLöschen Löscht einen Datensatz aus
einer Datenbank. Selection.Rows(1).Delete ToolsRemoveRecordDefault Removes a record

from a database Datenbank Datensatz löschen Database 214 630

FelderAktualisieren
Aktualisiert die markierten
Felder und zeigt die
Ergebnisse an.

Selection.Fields.Update UpdateFields
Updates and
displays the
results of the
selected fields

Kontext
Datenbank

Felder aktualisieren
F9 oder Alt+Umschalt+U

Context
Database F9 215 32

EinfügenDatenbank
Fügt Informationen aus
einer externen Datenquelle
in das aktive Dokument ein.

Dialogs(wdDialogInsertDatabase).Show InsertDatabase

Inserts information
from an external
data source into
the active
document

Datenbank Datenbank... Database 216 341

ZeichnungAmRasterAusrichten
Erzeugt ein Gitternetz zum
Ausrichten von
Zeichnungselementen.

Dialogs(wdDialogDrawSnapToGrid).Show DrawSnapToGrid
Sets up a grid for
aligning drawing
objects

Zeichnen > Zeichnen Gitternetz... Drawing > Draw Alt R, I 217 633

ZeichnungEinfügenWordGrafik

Öffnet ein neues Fenster,
um ein Grafik-Objekt zu
erstellen, oder fügt
markierte
Zeichnungselemente in eine
Grafik ein.

WordBasic.DrawInsertWordPicture DrawInsertWordPicture

Opens a separate
window for
creating a picture
object or inserts
the selected
drawing objects
into a picture

Word-Grafik 218 648

TextFormularFeld Fügt ein Text-Formularfeld
ein.

Selection.FormFields.Add Range:=Selection.Range, _
Type:= wdFieldFormTextInput TextFormField Inserts a text form

field Formular Bearbeitungsfeld Forms 219 349

KontrollkästchenFormularFeld Fügt ein Kontrollkästchen-
Formularfeld ein.

Selection.FormFields.Add Range:=Selection.Range,
Type:=wdFieldFormCheckBox CheckBoxFormField Inserts a check

box form field Formular Kontrollkästchen Forms 220 350

DropDownFormularFeld Fügt ein Dropdown-
Formularfeld ein.

Selection.FormFields.Add Range:=Selection.Range,
Type:=wdFieldFormDropDown DropDownFormField Inserts a drop-

down form field Formular Kombinationsfeld Forms 221 351

EinblendenEigenschaftenKatalog Zeigt den
Eigenschaftenbrowser an ActiveDocument.ViewPropertyBrowser ShowPropertyBrowser Shows the

Property Browser
Kontext
Webtools
Steuerelement-Toolbox

Eigenschaften
Context
Web Tools
Control Toolbox

222 7088
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FormularfelderSchattieren
Ändert die
Schattierungsoptionen für
das aktuelle Formular.

ActiveDocument.FormFields.Shaded = Not
ActiveDocument.FormFields.Shaded FormShading

Changes shading
options for the
current form

Formular Feldschattierung anzeigen Forms 223 636

AnsichtNormal
Wechselt von der
Bearbeitungsansicht zur
Normalansicht.

If ActiveWindow.View.SplitSpecial = wdPaneNone Then
ActiveWindow.ActivePane.View.Type = wdNormalView

Else
ActiveWindow.View.Type = wdNormalView

End If

ViewNormal
Changes the
editing view to
normal view

Ansicht Normal
Alt+Strg+N View Alt V, N (or

Alt+Ctrl+N) 224 145

FormularSchutz

Schaltet den
Dokumentschutz für das
aktive Dokument ein und
aus
Ändert den Schutzumfang
für das aktive Dokument.

ProtectForm
Toggles protection
for the active
document

Formular Formular schützen Forms 225 354;
520

TabelleAutoSumme

Fügt ein Ausdruck-Feld ein,
das automatisch die
Summe einer Tabellenzeile
oder Tabellenspalte
automatisch berechnet.

Selection.Cells(1).AutoSum TableAutoSum

Inserts an
expression field
that automatically
sums a table row
or column

Tabellen und Rahmen AutoSumme Tables and
Borders 226 641

VariablenAnzeigen Variablen anzeigen WordBasic.ShowVars ShowVars Schnellansicht 229 263

AnsichtZentraldokumentUmschalten
Schaltet zwischen der
Gliederungs- und der
Zentraldokument-Ansicht
hin und her.

If ActiveWindow.View = wdMasterView Then
ActiveWindow.View = wdOutlineView

Else
ActiveWindow.View = wdMasterView

End If

ViewToggleMasterDocument
Switches between
outline and master
document views

Gliederung Zentraldokumentansicht
Masterldokumentansicht Outlining 230 632

FilialDokErstellen
Wandelt die markierten
Gliederungselemente in
Filialdokumente um.

ActiveDocument.Subdocuments.AddFromRange
Range:=Selection.Range CreateSubdocument

Transforms the
selected outline
items into
subdocuments

Gliederung Filialdokument erstellen
Unterdokument erstellen Outlining 231 491

FilialDokEntfernen

Verbindet die markierten
Filialdokumente und fasst
sie in deren
Zentraldokument
zusammen.

Selection.Range.Subdocuments.Delete RemoveSubdocument

Merges the
contents of the
selected
subdocuments into
the master
document that
contains them

Gliederung Filialdokument löschen
Unterdokument löschen Outlining toolbar 232 639

FilialDokEinfügen
Öffnet eine Datei und fügt
sie als Filialdokument in ein
Zentraldokument ein.

Dialogs(wdDialogInsertSubdocument).Show InsertSubdocument
Opens a file and
inserts it as a
subdocument in a
master document

Gliederung Filialdokument importieren
Unterdokument importieren Outlining 233 583

FilialDokTeilen
Verschiebt den markierten
Teil eines Filialdokuments in
ein anderes Filialdokument
auf der gleichen Ebene.

Selection.Range.Subdocuments(1).Split Range:=Selection.Range SplitSubdocument

Splits the selected
part of a
subdocument into
another
subdocument at
the same level

Gliederung Filialdokument teilen
Unterdokument teilen Outlining toolbar 234 585

FilialDokVerbinden Verbindet zwei
Filialdokumente zu einem. Selection.Range.Subdocuments.Merge MergeSubdocument

Merges two
adjacent
subdocuments into
one subdocument

Gliederung Filialdokument verbinden
Unterdokument verbinden Outlining toolbar 235 584

DokumentSperren Bestimmt den Umfang des
Dokumentschutzes.

Selection.Range.Subdocuments(1).Locked = Not
Selection.Range.Subdocuments( _
1).Locked

LockDocument
Toggles the file
lock state of a
document

Gliederung Filialdokument schützen
Unterdokument schützen Outlining 236 600

GeheZuKopfFußzeile Wechselt zwischen Kopf-
und Fußzeile.

If Selection.HeaderFooter.IsHeader = True Then
ActiveWindow.ActivePane.View.SeekView =

wdSeekCurrentPageFooter
Else
ActiveWindow.ActivePane.View.SeekView =

wdSeekCurrentPageHeader
End If

GoToHeaderFooter Jump between
header and footer Kopf- und Fußzeile Kopf-/Fußzeile anzeigen Header and

Footer 237 590

EinblendenVorherigeKopfFußzeile
Zeigt die Kopf-/Fußzeile des
vorherigen Abschnitts in der
Layout-Ansicht an.

ActiveWindow.ActivePane.View.PreviousHeaderFooter ShowPrevHeaderFooter
Shows previous
section's
header/footer in
page layout view

Kopf- und Fußzeile Vorherige Kopfzeile Header/footer
toolbar 238 588

EinblendenNächsteKopfFußzeile
Zeigt die Kopf-/Fußzeile des
folgenden Abschnitts in der
Layout-Ansicht an.

ActiveWindow.ActivePane.View.NextHeaderFooter ShowNextHeaderFooter
Shows next
section's
header/footer in
page layout view

Kopf- und Fußzeile Nächste Kopfzeile Header/footer
toolbar 239 589

ZeichnungAusrichten

Zeichnungselemente
ausrichten
Richtet die markierten
Zeichnungselemente
aneinander oder an der
Seite aus.

Dialogs(wdDialogDrawAlign).Show DrawAlign
Aligns the selected
drawing objects
with one another
or the page

Objekte ausrichten Drawing > Draw 242 634



Deutsch Beschreibung Makro-Beispiel English Description Type Symbolleiste Befehl/Kürzel Toolbar Shortcut Comm Dial

Fügt eine Linie mit einer
Pfeilspitze an der Stelle ein,
auf der Sie im aktiven
Fenster klicken.

ActiveDocument.Shapes.AddLine(BeginX, BeginY, EndX, EndY,
Anchor).Select
Selection.ShapeRange.Line.EndArrowheadStyle =
MsoArrowheadStyle
Selection.ShapeRange.Line.EndArrowheadLength =
MsoArrowheadLength
Selection.ShapeRange.Line.EndArrowheadWidth =
MsoArrowheadWidth

DrawInsertArrow
Zeichnen
Zeichnen > AutoFormen
> Linien

Pfeil
Drawing
Drawing >
AutoShapes >
Lines

243

SeriendruckHauptdokumentBearbeiten
Schaltet zu einem
Seriendruck-
Hauptdokument um.

ActiveDocument.MailMerge.EditMainDocument MailMergeEditMainDocument
Switches to a mail
merge main
document

Datenbank Hauptdokument Database 244 219

Seriendruck

Verbindet Dateien, um
Serienbriefe,
Adressetiketten,
Briefumschläge und
Kataloge zu erstellen

Dialogs(wdDialogMailMerge).Show MailMerge

Combines files to
produce form
letters, mailing
labels, envelopes,
and catalogs

Seriendruck Seriendruck... Mail Merge 245 676

SeriendruckManager Bereitet ein Hauptdokument
für den Seriendruck vor. Dialogs(wdDialogMailMergeHelper).Show MailMergeHelper

Prepares a main
document for a
mail merge

Extras
Seriendruck Seriendruck... Tools & Mail

Merge 246 680

DateiSeiteEinrichten Ändert die Einrichtung der
Seite für diesen Abschnitt. Dialogs(wdDialogFileDocumentLayout).Show FilePageSetup

Changes the page
setup of the
selected sections

Datei
Kopf- und Fußzeile Seite einrichten... Header and

Footer Alt F, U 247 178

TextkörperUmschalten
Ändert die Anzeige der
Haupttext-Ebene in der
Layout-Ansicht

ActiveWindow.ActivePane.View.ShowMainTextLayer = Not
ActiveWindow. _
ActivePane.View.ShowMainTextLayer

ToggleMainTextLayer
Toggles showing
the main text layer
in page layout
view

Kopf- und Fußzeile Textkörper ausblenden Header and
Footer 248 587

KopfFußzeilenVerknüpfungUmschalten
Verknüpft diese Kopf-
/Fußzeile mit dem
vorherigen Abschnitt oder
hebt die Verknüpfung auf.

Selection.HeaderFooter.LinkToPrevious = Not
Selection.HeaderFooter. _
LinkToPrevious

ToggleHeaderFooterLink
Links or unlinks
this header/footer
to or from the
previous section

Kopf- und Fußzeile Mit vorheriger verknüpfen Header/footer
toolbar 250 652

GliederungErstzeileEinblenden
Zeigt nur die erste oder alle
Zeilen des Textkörpers in
der Gliederung an.

ActiveWindow.ActivePane.View.ShowFirstLineOnly = Not
ActiveWindow. _
ActivePane.View.ShowFirstLineOnly

OutlineShowFirstLine

Toggles between
showing the first
line of each
paragraph only or
showing all of the
body text in the
outline

Gliederung Nur erste Zeile-Ansicht
Alt+Umschalt+L Outlining toolbar Alt+Shift+L 251 261

GliederungFormatAnzeigen
Ändert die Anzeige von
Zeichenformatierungen in
der Gliederungsansicht.

ActiveWindow.ActivePane.View.ShowFormat = Not
ActiveWindow.ActivePane.View _
.ShowFormat

OutlineShowFormat

Toggles the
display of
character
formatting in
outline view

Gliederung Formatierung anzeigen Outlining toolbar 252 262

FormatZeichen Ändert die Darstellung der
markierten Zeichen. Dialogs(wdDialogFormatFont).Show FormatFont

Changes the
appearance of the
selected
characters

Format
Kontext

Zeichen...
Strg+D Context Ctrl+D 253 174

FormatFormatvorlage Erstellt, ändert oder weist
Formatvorlagen zu. Dialogs(wdDialogFormatStyle).Show FormatStyle Applies, creates,

or modifies styles
Format
Kontext Formatvorlage... Formatting

Context Alt O, S 254 180

DateiVerteiler
Erstellt oder bearbeitet den
E-mail-Verteiler für das
aktive Dokument.

Dialogs(wdDialogFileRoutingSlip).Show FileRoutingSlip
Adds or changes
the electronic mail
routing slip of the
active document

Datei Senden an >
Verteilerempfänger... File + Send to 259 624

FußnoteJetztEinfügen Fügt vor der Einfügemarke
ein Fußnotenzeichen ein ActiveDocument.Footnotes.Add(Range As Range, Reference, text) InsertFootnoteNow

Inserts a footnote
reference at the
insertion point

Fußnote einfügen
Fußnote...
Alt+Strg+F

Alt+Ctrl+F 260 368

MicrosoftMail
Startet Microsoft Mail oder
schaltet zu dieser
Anwendung um.

WordBasic.MicrosoftMail MicrosoftMail Starts or switches
to Microsoft Mail Microsoft Microsoft Mail Microsoft toolbar 262 656

MicrosoftExcel
Startet Microsoft Excel oder
schaltet zu dieser
Anwendung um.

WordBasic.MicrosoftExcel MicrosoftExcel Starts or switches
to Microsoft Excel Microsoft Microsoft Excel Microsoft toolbar 263 657

MicrosoftAccess
Startet Microsoft Access
oder schaltet zu dieser
Anwendung um.

WordBasic.MicrosoftAccess MicrosoftAccess
Starts or switches
to Microsoft
Access

Microsoft Microsoft Access Microsoft toolbar 264 658

MicrosoftSchedule
Startet Microsoft Schedule+
oder schaltet zu dieser
Anwendung um.

WordBasic.MicrosoftSchedule MicrosoftSchedule
Starts or switches
to Microsoft
Schedule+

Microsoft Microsoft Schedule+ Microsoft toolbar 265 659

MicrosoftFoxPro
Startet Microsoft FoxPro
oder schaltet zu dieser
Anwendung um.

WordBasic.MicrosoftFoxPro MicrosoftFoxPro
Starts or switches
to Microsoft
FoxPro

Microsoft Microsoft Visual FoxPro Microsoft toolbar 266 660

MicrosoftPowerPoint
Startet Microsoft
PowerPoint oder schaltet zu
dieser Anwendung um.

WordBasic.MicrosoftPowerPoint MicrosoftPowerPoint
Starts or switches
to Microsoft
PowerPoint

Microsoft Microsoft PowerPoint Microsoft toolbar 267 661
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MicrosoftPublisher
Startet Microsoft Publisher
oder schaltet zu dieser
Anwendung um.

WordBasic.MicrosoftPublisher MicrosoftPublisher
Starts or switches
to Microsoft
Publisher

Microsoft Microsoft Publisher Microsoft toolbar 268 662

MicrosoftProject
Startet Microsoft Project
oder schaltet zu dieser
Anwendung um.

WordBasic.MicrosoftProject MicrosoftProject
Starts or switches
to Microsoft
Project

Microsoft Microsoft Project Microsoft toolbar 269 663

AnsichtLayout
Zeigt die Seite
entsprechend dem späteren
Ausdruck an und lässt eine
Bearbeitung zu

If ActiveWindow.View.SplitSpecial = wdPaneNone Then
ActiveWindow.ActivePane.View.Type = wdPrintView

Else
ActiveWindow.View.Type = wdPrintView

End If

ViewPage
Displays the page
as it will be printed
and allows editing

Ansicht Seitenlayout
Alt+Strg+L View Alt V, P (or

Alt+Ctrl+P) 287 147

AnsichtFeldfunktionen
Zeigt die Feldfunktionen
oder Ergebnisse aller Felder
an (ein/aus).

ActiveWindow.View.ShowFieldCodes = Not
ActiveWindow.View.ShowFieldCodes ViewFieldCodes

Shows the field
codes or results
for all fields
(toggle)

Feldfunktionen anzeigen
Alt+F9 Alt+F9 288 150

FormatInitial
Formatiert das erste
Zeichen des aktuellen
Absatzes als Initial.

Dialogs(wdDialogFormatDropCap).Show FormatDropCap

Formats the first
character of
current paragraph
as a dropped
capital

Format
Kontext Initial... Formatting

Context Alt O, D 289 488

Durchgestrichen
Formatiert einen markierten
Textteil durchgestrichen
[ein/aus].

Selection.Font.Strikethrough = wdToggle Strikethrough
Makes the
selection
strikethrough
(toggle)

Durchgestrichen 290 49

Kapitälchen
Formatiert einen markierten
Textteil in Kapitälchen
[ein/aus].

Selection.Font.SmallCaps = wdToggle SmallCaps
Makes the
selection small
capitals (toggle)

Kapitälchen
Strg+Umschalt+Q Ctrl+Shift+K 291 47

TabelleZellenLöschen Löscht die markierten Zellen
aus der Tabelle. Dialogs(wdDialogTableDeleteCells).Show TableDeleteCells Tabelle > Löschen Zellen...

Zellen löschen 292 133

TabelleZeileLöschen Löscht die markierten Zeilen
aus der Tabelle. Selection.Rows.Delete TableDeleteRow

Deletes the
selected rows from
the table

Tabelle > Löschen Zeilen
Zeilen löschen

Table
(Word2000) 293 134

TabelleSpalteLöschen Löscht die markierten
Spalten aus der Tabelle. Selection.Columns.Delete TableDeleteColumn

Deletes the
selected columns
from the table

Tabelle > Löschen Spalten
Spalten löschen

Table
(Word2000) 294 135

TabelleZellenEinfügen Fügt eine oder mehrere
Zellen in die Tabelle ein. Dialogs(wdDialogTableInsertCells).Show TableInsertCells

Tabelle > Zellen
einfügen
Tabellen und Rahmen

Zellen...
Zellen einfügen... 295 130

TabelleZeileEinfügen Fügt eine oder mehrere
Zeilen in die Tabelle ein. Dialogs(wdDialogTableInsertRow).Show TableInsertRow

Inserts one or
more rows into the
table

Zeilen einfügen 296 131

FensterAlleAnordnen Ordnet alle Fenster
nebeneinander an Windows.Arrange WindowArrangeAll

Arranges windows
as non-
overlapping tiles

Fenster
Alle anordnen
(mehr Auswahl: Rechtsklick auf
Windows-Startleiste!)

Window Alt W, A 298 218

ZeichnungWordGrafikVorgabe
Bestimmt die Seitenränder
des Dokuments so, dass
alle Zeichnungselemente
auf der Seite Platz finden.

WordBasic.DrawResetWordPicture DrawResetWordPicture
Sets document
margins to enclose
all drawing objects
on the page

Grafik bearbeiten Seitenränder anpassen Edit Picture 299 696

AnsichtGitternetzlinien Blendet die Gittenetzlinien
ein oder aus Options.DisplayGridLines = Not Options.DisplayGridLines ViewGridlines Shows or hides

the gridlines Gitternetzlinien 300 741

FilialDokÖffnen Öffnet ein Filialdokument in
einem neuen Fenster. Selection.Range.Subdocuments(1).Open OpenSubdocument

Opens a
subdocument in a
new window

Filialdokument öffnen
Unterdokument öffnen

Double-clicking
the little icon to
the left of the first
heading in a
subdocument,
when in Master
Document view

301 599

DokumentfensterTeilen
Teilt das aktuelle
Dokumentfenster horizontal
und ordnet die Fenster an.

WordBasic.DocSplit DocSplit

Splits the active
window
horizontally and
then adjusts the
split

Fenster
Teilen
Alt+Strg+S oder in Teilungsfeld
(oberhalb der vertikalen
Bildlaufleiste) klicken und
ziehen

Window Alt+Ctrl+S 302 229

FensterNeuesFenster Öffnet ein weiteres Fenster
für das aktive Dokument. NewWindow WindowNewWindow

Opens another
window for the
active document

Fenster Neues Fenster Window 303 217

ExtrasVersionsvergleich
Vergleicht das aktuelle
Dokument mit einer
vorherigen Version.

Dialogs(wdDialogToolsCompareDocuments).Show ToolsCompareVersions
Compares the
active document
with an earlier
version

Extras > Änderungen
verfolgen

Dokumente vergleichen...
Änderungen markiert... Tools 304 198

ExtrasÜberarbeitenPrüfen Überarbeitet Änderungen im
aktiven Dokument. Dialogs(wdDialogToolsAcceptRejectChanges).Show ToolsReviewRevisions

Reviews changes
to the active
document

Extras > Änderungen
verfolgen
Kontext

Änderungen akzeptieren oder
ablehnen...
Änderungen annehmen oder
ablehnen...

Tools
Context 305 506
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Großbuchstaben
Formatiert einen markierten
Textteil in Großbuchstaben
[ein/aus].

Selection.Font.AllCaps = wdToggle AllCaps
Makes the
selection all
capitals (toggle)

Großbuchstaben
Strg+Umschalt+G Ctrl+Shift+A 306 48

ZeichnungAuflösenGrafik
Löst die markierte
Metadatei-Grafik in
Zeichnungselemente auf

WordBasic.DrawDisassemblePicture DrawDisassemblePicture
Disassembles the
selected metafile
picture into
drawing objects

Grafik auflösen 307 575

EinfügenSonderzeichen Fügt ein Sonderzeichen ein. Dialogs(wdDialogInsertSymbol).Show InsertSymbol Inserts a special
character Einfügen Symbol... Insert 308 162

FormatGroßKleinschreibung
Ändert die Groß-
/Kleinschreibung im
markierten Textteil.

Dialogs(wdDialogFormatChangeCase).Show FormatChangeCase
Changes the case
of the letters in the
selection

Groß-/Kleinschreibung... Formatting Alt O, E 309 322

SchriftVerkleinernEinPunkt
Verkleinert den Schriftgrad
des markierten Textteils um
einen Punkt.

Selection.Font.Size = Selection.Font.Size - 1 ShrinkFontOnePoint
Decreases the font
size of the
selection by one
point

Schriftart verkleinern um 1 Pt
Strg+8 Ctrl+[ 310 514

SchriftVergrößernEinPunkt
Vergrößert den Schriftgrad
des markierten Textteils um
einen Punkt.

Selection.Font.Size = Selection.Font.Size + 1 GrowFontOnePoint
Increases the font
size of the
selection by one
point

Schriftart vergrößern um 1 Pt
Strg+9 Ctrl+] 311 513

ExtrasSeitenumbruch Prüft und ändert die
Seitenwechsel. ActiveDocument.Repaginate ToolsRepaginate Recalculates the

page breaks Seiten neu nummerieren 312 201

BearbeitenErsetzen Sucht und ersetzt Text und
Formatierung. Dialogs(wdDialogEditReplace).Show EditReplace

Finds the specified
text or the
specified
formatting and
replaces it

Bearbeiten Ersetzen...
Strg+H Edit Ctrl+H 313 117

BeginnZeile
Bewegt die Einfügemarke
zum Anfang der aktuellen
Zeile.

Selection.HomeKey Unit:=wdLine StartOfLine
Moves the
insertion point to
the beginning of
the current line

Zeilenanfang
Pos1 Home 314 4012

EndeZeile
Bewegt die Einfügemarke
ans Ende der aktuellen
Zeile

Selection.EndKey Unit:=wdLine EndOfLine
Moves the
insertion point to
the end of the
current line

Ende der Zeile
End End 315 4013

BildAuf
Bewegt die Einfügemarke
und die Dokumentanzeige
um eine Bildschirmseite
nach oben.

Selection.MoveUp Unit:=wdScreen, Count:=1 PageUp

Moves the
insertion point and
document display
to the previous
screen of text

Seite nach oben
Bild-AUF-Taste PgUp 316 4010

BildAb
Bewegt die Einfügemarke
und die Dokumentanzeige
um eine Bildschirmseite
nach unten.

Selection.MoveDown Unit:=wdScreen, Count:=1 PageDown

Moves the
insertion point and
document display
to the next screen
of text

Seite nach unten
Bild-AB-Taste PgDn 317 4011

ZeichnenVertikalesTextfeld
Fügt ein leeres vertikales
Textfeld ein oder positioniert
das markierte Element in
ein vertikales Textfeld

WordBasic.DrawVerticalTextBox DrawVerticalTextBox

Inserts an empty
vertical text box or
encloses the
selected item in a
vertical textbox

Vertikales Textfeld 318 996

FormatMultilevelStandard
Erstellt eine nummerierte
Liste basierend auf den
aktuellen
Standardeinstellungen

WordBasic.FormatMultilevelDefault FormatMultilevelDefault
Creates a
numbered list
based on the
current defaults

318 951

BeginnDokument
Bewegt die Einfügemarke
an den Anfang der ersten
Zeile des Dokuments.

Selection.HomeKey Unit:=wdStory StartOfDocument

Moves the
insertion point to
the beginning of
the first line of the
document

Dokumentanfang
Strg+Pos1 Ctrl+Home 319 4016

EndeDokument
Bewegt die Einfügemarke
an das Ende der letzten
Zeile im Dokument.

Selection.EndKey Unit:=wdStory EndOfDocument

Moves the
insertion point to
the end of the last
line of the
document

Ende des Dokuments
Strg+End Ctrl+End 320 4017

DateiAOCENächsterBrief Nächster Brief WordBasic.FileAOCENextLetter FileAOCENextLetter Nächster Brief 321 319
DateiAOCEAdreßfeldHinzufügen Adressfeld hinzufügen WordBasic.FileAOCEAddMailer FileAOCEAddMailer Adressfeld hinzufügen 322 311
DateiAOCEAdreßfeldLöschen Adressfeld löschen WordBasic.FileAOCEDeleteMailer FileAOCEDeleteMailer Adressfeld löschen 323 312
DateiAOCEAdreßfeldEinblenden Adressfeld erweitern WordBasic.FileAOCEExpandMailer FileAOCEExpandMailer Adressfeld erweitern 324 313
DateiAOCENachrichtSenden E-Mail-Nachricht senden WordBasic.FileAOCESendMail FileAOCESendMail E-Mail-Nachricht senden 325 315
DateiAOCENachrichtBeantworten Antworten WordBasic.FileAOCEReplyMail FileAOCEReplyMail Antworten 326 316
DateiAOCEAllenAntwortenNachricht Allen antworten WordBasic.FileAOCEReplyAllMail FileAOCEReplyAllMail Allen antworten 327 317
DateiAOCENachrichtWeiterleiten Weiterleiten WordBasic.FileAOCEForwardMail FileAOCEForwardMail Weiterleiten 328 318
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ExtrasGrammatik Prüft die Grammatik im
aktuellen Dokument. WordBasic.ToolsGrammar ToolsGrammar

Checks the
grammar in the
active document

Kontext Grammatik... Context 329 193

DateiSchließenOderAllesSchließen
Führt Befehl "Datei
Schließen" aus, oder bei
gedrückter Umschalttaste
"Datei Alles schließen".

FileCloseOrCloseAll
Performs
FileClose or, if the
shift key is down,
FileCloseAll

Schließen File 331 523

TabelleInOderAusText Wandelt eine Tabelle in
Text um und umgekehrt.

Selection.Rows.ConvertToText ...
Selection.ConvertToTable ...
(Dialog je nach Kontext)

TableToOrFromText Converts a table to
text Word97 Tabelle in Text umwandeln...

Text in Tabelle umwandeln... Table (Word97) 332 327

TabelleEinfügenGesamt Fügt eine Tabelle ein TableInsertGeneral Inserts a table Standard
Formular Tabelle einfügen... Standard , Forms

Table (Word97) 333 324

TabelleLöschenGesamt Löscht die markierten Zellen
aus der Tabelle. TableDeleteGeneral

Deletes the
selected cells from
the table

Kontext Zellen löschen... Context
Table (Word97) 334 325

BearbeitenWiederherstellenOderWiederholen Wiederholt den letzten
Befehl. EditRedoOrRepeat Repeats the last

action Bearbeiten Wiederholen:
F4 oder Strg+Y oder Alt+Return Edit F4 335 330

ExtrasDokSchützenEinAus
Bestimmt den
Dokumentschutz für das
aktive Dokument.

Dialogs(wdDialogToolsProtectDocument).Show ToolsProtectUnprotectDocument
Sets protection for
the active
document (older
versions only?)

Extras Dokument schützen... Tools 336 (503)

FormatPosRahmen Ändert die Optionen für
Frameformatierung Dialogs(wdDialogFormatFrame).Show FormatFrame

Changes the
options for frame
formatting

Kontext
(Positionsrahmen) Positionsrahmen formatieren... Rt-click on a

frame 337 190

Fasst eine Gruppe von
Objekten zusammen, die
zuvor mit dem 'Gruppierung
aufheben'-Befehl geteilt
wurden.

Zeichnen > Zeichnen
ActiveX-Steuerelemente
Zeichnen.Formen
Zeichnen.Kurve
Unverankerte Grafik
OLE-Objekt
WordArt-Kontextmenü

Gruppierung wiederherstellen 338

3D ButtonPopup Zeichnen 3D
3D-Art Drawing 339

Hervorheben Hebt den markierten Text
farbig hervor WordBasic.Highlight Highlight

Applies color
highlighting to the
selection

Format
Überarbeiten
Erweiterte Formatierung
Nachricht lesen

Hervorheben

Formatting
Reviewing
Extended
Formatting
Read Mail

340 742

InfoAnzeigen
Zeigt weitere Informationen
zum vorgeschlagenen Tipp
an

Application.ShowMe ShowMe
Gives an in-depth
explanation of the
suggested tip

Info anzeigen
Tipp-Assistent 5 345 4068

AutomatischÄndern Führt den vorgeschlagenen
AutoFormat-Vorgang durch Application.AutomaticChange AutomaticChange

Performs the
suggested
AutoFormat action

Ändern
Tipp-Assistent 6 346 4070

EinfügenAdresse
Fügt eine Adresse aus
Ihrem persönlichen
Adressbuch ein

WordBasic.InsertAddress InsertAddress
Inserts an address
from your
Personal Address
Book

353 758

MailAntworten Antworten auf eine
Nachricht MailMessageReply Replies to a mail

message
Nachricht lesen
Outlook-E-Mail lesen Antworten

Read Mail
Outlook Read
Mail

354 768

MailAllenAntworten Allen antworten auf eine
Nachricht MailMessageReplyAll Replies All to a

mail message
Nachricht lesen
Outlook-E-Mail lesen Allen antworten

Read Mail
Outlook Read
Mail

355 769

MailNachrichtWeiterleiten Weiterleiten einer Nachricht MailMessageForward Forwards a mail
message

Nachricht lesen
Outlook-E-Mail lesen Weiterleiten

Read Mail
Outlook Read
Mail

356 776

MailNachrichtVerschieben Verschieben einer Nachricht MailMessageMove Moves a mail
message

Nachricht lesen
Outlook-E-Mail lesen Nachricht verschieben

Read Mail
Outlook Read
Mail

357 770

MailNachrichtLöschen Löschen einer Nachricht MailMessageDelete Deletes a mail
message

Nachricht lesen
Outlook-E-Mail lesen Nachricht löschen

Read Mail
Outlook Read
Mail

358 771

MailVorherigeNachricht Geht zur vorherigen
Nachricht MailMessagePrevious

Goes to the
previous mail
message

Nachricht lesen
Outlook-E-Mail lesen

Vorheriges Element
Element

Read Mail
Outlook Read
Mail

359 772
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MailNächsteNachricht Geht zur nächsten
Nachricht MailMessageNext Goes to the next

mail message
Nachricht lesen
Outlook-E-Mail lesen

Nächstes Element
Element

Read Mail
Outlook Read
Mail

360 773

MailNamenÜberprüfen
Überprüft die
Empfängernamen einer
Nachricht

MailCheckNames
Checks the
recipient names of
a mail message

E-Mail senden Namen überprüfen Send Mail 361 774

MailNamenAuswählen Wählt die Empfänger einer
Nachricht aus MailSelectNames

Selects the
recipients of a mail
message

E-Mail senden
Outlook-E-Mail senden

Adressbuch
Namen auswählen...

Send Mail
Outlook Send
Mail

362 775

ZeichenSkalieren Fügt der Markierung
Skalieroptionen hinzu WordBasic.CharScale CharScale Applies scaling to

the selection Zeichenskalierung 386 797

Schatten ButtonPopup Zeichnen Schatten
Schattenart Drawing 394

ZeichenFarbe Ändert die Farbe des
markierten Textes WordBasic.FontColor FontColor Changes the color

of the selected text
Format > Zeichen
Format
Zeichnen

Schriftfarbe
Format > Font
Formatting
Drawing

401 882

Verteilt die markierten
Objekte horizontal, relativ
zueinander.

DrawDistributeHorizontally Zeichnen > Ausrichten
oder Verteilen Horizontal verteilen Drawing > Align

or Distribute 408

ZeichnenEinfügenFreihand
Zeichnet freihändig an der
Stelle im aktiven Fenster,
an der Sie ziehen.

DrawInsertScribble ??? Zeichnen > Linien
AutoFormen > Linien

Freihand
Skizze Drawing 409

Ändert den Zeiger zu einem
Kreuz, damit Sie ein
Markierungsrechteck um
mehrere Objekte ziehen
können, um diese zu
markieren.

Grafiken markieren 410

Zeichnet Vieleckformen.
(veraltet?) Vieleck 411
Zeichent gefüllte
Vieleckformen. (veraltet?) Ausgefülltes Vieleck 415
Zeichent gefüllte
Vieleckformen. (veraltet?) Ausgefüllte Freihandform 416
Verteilt die markierten
Objekte vertikal, relativ
zueinander.

DrawDistributeVertically Zeichnen > Ausrichten
oder Verteilen Vertikal verteilen Drawing > Align

or Distribute 465

Wählt alle Grafiken im
aktiven Fenster aus DrawSelectAll Alle Zeichnungsobjekte

markieren 466

ZeichnenCagAusführenBilder Führt Microsoft Clip Gallery
aus und sucht nach Bildern

InsertDrawRunCag? DrawRunCag? ? Anpassen
(should display
the Clipart task
pane; doesn’t
work?)

481

WW7_EinfügenSeitenWechsel Fügt vor der Einfügemarke
einen Seitenwechsel ein. Selection.InsertBreak Type:=wdPageBreak WW7_InsertPageBreak Seitenwechsel

Strg+Return 509 277

DateiDruckereinrichtung Ändert die Drucker- und
Druckoptionen. Dialogs(wdDialogFilePrintSetup).Show FilePrintSetup

Changes the
printer and the
printing options

Druckereinrichtung... 511 97

ExtrasOptionen
Passt eine Vielzahl von
Word für Windows-
Einstellungen an

Dialogs(wdDialogToolsOptions).Show ToolsOptions
Changes various
categories of Word
for Windows
options

Extras Optionen... Tools 522 974

TabelleZeilenHöhe Ändert die Zeilenhöhe in
einer Tabelle WordBasic.TableRowHeight TableRowHeight

Changes the
height of the rows
in a table

Zeilenhöhe... 541 142

TabelleSpaltenBreite Ändert die Spaltenbreite in
einer Tabelle. WordBasic.TableColumnWidth TableColumnWidth

Changes the width
of the columns in a
table

Spaltenbreite... 542 143

EinfügenObjekt
Fügt eine Formel, ein
Diagramm, eine Zeichnung
oder ein anderes Objekt ein.

Dialogs(wdDialogInsertObject).Show InsertObject
Inserts an
equation, chart,
drawing, or some
other object

Einfügen Objekt... Insert 546 172

AnsichtSteuerelementToolbox
Blendet die Toolbox mit
Steuerelementen ein oder
aus

WordBasic.ViewControlToolbox ViewControlToolbox
Shows or hides
the Control
Toolbox

Visual Basic Steuerelement-Toolbox Visual Basic 548 7087

HilfeSuchen
Sucht nach einem
Hilfethema durch Eingabe
oder Auswahl eines
Stichwortes.

Help wdHelpSearch HelpSearch Hilfe-Suchen
Suchen... 564 510

Abbrechen Bricht eine Aktion ab. Selection.EscapeKey Cancel Terminates an
action

Abbrechen
ESC Esc 569 72
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SuchenWiederholen Wiederholt "Gehe zu" oder
"Suchen". Selection.Find.Execute RepeatFind

Repeats Go To or
Find to find the
next occurrence

Weitersuchen
Umschalt+F4 oder Alt+Strg+Y Sfift+F4 570 24

ZeichnenKopie
Erstellt Kopien der
markierten
Zeichnungsobjekte

WordBasic.DrawDuplicate DrawDuplicate
Duplicates the
selected drawing
objects

Duplizieren 571 955

EinfügenOCX
Fügt das markierte OCX-
Steuerelement ein oder
registriert ein neues OCX-
Steuerelement

InsertOCX

Inserts the
selected OCX
control or
Registers a new
OCX control

Steuerelement-Toolbox Weitere Steuerelemente... Control Toolbox 642 913

Richtet die linken Kanten
der markierten Objekte
vertikal aus.

DrawAlignLeft Zeichnen > Ausrichten
oder Verteilen Linksbündig Drawing > Align

or Distribute 664

Richtet die rechten Kanten
der markierten Objekte
vertikal aus.

DrawAlignRight Zeichnen > Ausrichten
oder Verteilen Rechtsbündig Drawing > Align

or Distribute 665

Richtet die oberen Kanten
der markierten Objekte
horizontal aus.

DrawAlignTop Zeichnen > Ausrichten
oder Verteilen Oben ausrichten Drawing > Align

or Distribute 666

Richtet die unteren Kanten
der markierten Objekte aus. DrawAlignBottom Zeichnen > Ausrichten

oder Verteilen Unten ausrichten Drawing > Align
or Distribute 667

Richtet die Mitte der
markierten Objekte
horizontal aus.

DrawAlignCenterHorizontal Zeichnen > Ausrichten
oder Verteilen Horizontal zentrieren Drawing > Align

or Distribute 668

Zentriert die markierten
Objekte vertikal. DrawAlignCenterVertical Zeichnen > Ausrichten

oder Verteilen Vertikal zentrieren Drawing > Align
or Distribute 669

ZeichnenCagAusführen Führt Microsoft Clip Gallery
aus InsertClipArt

Inserts a Microsoft
Clip Art Gallery
object

Einfügen > Grafik
Zeichnen ClipArt... Word 97 Insert

Drawing 682

Freies drehen eines
markierten Objekts. DrawToggleRotateMode

Zeichnen
Zeichnen > Zeichnen >
Drehen oder kippen
WordArt

Freies Drehen
Drawing
Drawing > Draw
> Rotate or Flip

688

Linienart ButtonPopup Zeichnen
Grafik Linienart Drawing

Picture 692

Strichart ButtonPopup Zeichnen Strichart Drawing 693
Pfeilart ButtonPopup Zeichnen Pfeilart Drawing 694

VergrößernAbsatzAbstand
Erhöhen des
Abschnittabstandes um 6
Punkte

Selection.Paragraphs.IncreaseSpacing IncreaseParagraphSpacing
Increases
paragraph spacing
by 6 points

Absatzabstand vergrößern 698 1342

VerkleinernAbsatzAbstand
Verringern des
Abschnittabstandes um 6
Punkte

DecreaseParagraphSpacing
Decreases
paragraph spacing
by 6 points

Absatzabstand verkleinern 699 1343

ZeichnenEinfügenOrgDiagramm Fügt ein neues
Organigramm ein ??? ??? Organigramm 702

DoppeltDurchgestrichen
Weist der Markierung
"doppelt durchgestrichen"
zu (ein/aus)

Selection.Font.DoubleStrikethrough = wdToggle DoubleStrikethrough
Makes the
selection double
strikethrough
(toggle)

Erweiterte Formatierung Doppelt durchgestrichen Extended
Formatting 714 798

Schneidet zu oder stellt
Teile einer Grafik wieder
her.

Kontext Grafik Zuschneiden Context Picture 732

AnsichtGliederung Zeigt das Dokument in der
Gliederungsansicht an. ActiveWindow.ActivePane.View.Type = wdOutlineView ViewOutline Displays a

document's outline Ansicht Gliederung
Alt+Strg+G View Alt V, O (or

Alt+Ctrl+O) 737 146

EinfügenSeitenAnzahl Fügt ein Seitennummernfeld
ein

Selection.Fields.Add Range:=Selection.Range,
Type:=wdFieldNumPages InsertNumberOfPages Inserts a number

of pages field Kopf- und Fußzeile Anzahl Seiten Header and
Footer 743 835
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(control on 5734 ZeilenAbstand)
(control on 30077
SeriendruckListeBedingungsfelder)
(control on ?)

Zeilenabstand übernehmen
für die Auswahl
Markiersprechblasen ein-
oder ausblenden
Fügt ein Frage-Feld an der
Einfügemarke ein.
Fügt ein Eingeben-Feld an
der Einfügemarke ein.
Fügt ein Bedingungsfeld an
der Einfügemarke ein.
Fügt ein Datensatz-Feld an
der Einfügemarke ein.
Fügt ein SEQ-Feld an der
Einfügemarke ein.
Fügt ein Nächster-Feld an
der Einfügemarke ein.
Fügt ein NWenn-Feld an
der Einfügemarke ein.
Fügt ein Bestimmen-Feld an
der Einfügemarke ein.
Fügt ein Überspringen-Feld
an der Einfügemarke ein.

LineSpacing
Applies line
spacing to the
selection

1.0
1.5
2.0
2.5
3.0
Weitere…
Ihr Benutzername
> Frage...
> Eingeben...
> Wenn... Dann... Sonst...
> Datensatz verbinden
> Sequenz verbinden
> Nächster Datensatz
> Nächster Datensatz Wenn...
> Textmarke bestimmen...
> Datensatz überspringen...

746 1263

DateiAllesSchließen Schließt sämtliche Fenster
in allen Dokumenten Documents.Close FileCloseAll

Closes all of the
windows of all
documents

Datei (mit gedrückter
Umschalt-Taste)

Alles schließen
Alt, Umschalt+D, C

File with Shift key
held down 747 524

DateiSpeichernUnter
Speichert eine Kopie des
Dokuments in eine andere
Datei.

Dialogs(wdDialogFileSaveAs).Show FileSaveAs
Saves a copy of
the document in a
separate file

Datei Speichern unter...
F12 File Alt F, A (or F12) 748 84

DateiAllesSpeichern

Speichert alle offenen
Dateien, Makros und
AutoText-Einträge und
fordert einzeln zum
Speichern auf.

Documents.Save FileSaveAll

Saves all open
files, macros, and
AutoText entries,
prompting for each
one separately

Datei, Standard (mit
gedrückter Umschalt-
Taste)

Alle speichern
Alt, Umschalt+D, A

File & Standard
with Shift key
down

749 85

DateiEigenschaften
Zeigt die
Dokumenteigenschaften
des aktiven Dokuments an.

WordBasic.FileProperties FileProperties
Shows the
properties of the
active document

Datei Eigenschaften File Alt F, I 750 750

DateiDokVorlagen
Ändert die aktive
Dokumentvorlage und die
aktiven
Dokumentvorlagenoptionen.

Dialogs(wdDialogToolsTemplates).Show FileTemplates
Changes the
active template
and the template
options

Extras Vorlagen und Add-Ins... Tools

Display “XML
Schema” tab of
the “Templates
and AddIns”
dialog (also if you
click on
“Templates and
Add-Ins…” on the
“XML Structure”
task pane).
WordBasic.FileTe
mplates doesn’t
work?

751 87

DateiBeenden
Beendet Microsoft Word
und fordert zur
Dokumentspeicherung auf

WordBasic.FileExit FileExit
Quits Microsoft
Word and prompts
to save the
documents

Datei Beenden File Alt+F4 (Word 97) 752 98

BearbeitenKopierenAlsGrafik
Kopiert die Markierung und
kopiert sie als Grafik in die
Zwischenablage .

Selection.CopyAsPicture EditCopyAsPicture
Copies the
selection and puts
it on the Clipboard
as a picture

Als Grafik kopieren 754 751

BearbeitenInhalteEinfügen

Fügt den Inhalt der
Zwischenablage als
verknüpftes Objekt,
eingebettetes Objekt oder
als ein anderes Format ein.

Dialogs(wdDialogEditPasteSpecial).Show EditPasteSpecial

Inserts the
Clipboard contents
as a linked object,
embedded object,
or other format

Bearbeiten Inhalte einfügen... Edit Alt E, S 755 111

BearbeitenAllesMarkieren Markiert das gesamte
Dokument. Selection.WholeStory EditSelectAll Selects the entire

document Bearbeiten
Alles markieren
Strg+A
Strg+Num5

Edit Ctrl+A 756 237

BearbeitenGeheZu
Springt zu einer bestimmten
Position im aktiven
Dokument

Dialogs(wdDialogEditGoTo).Show EditGoTo
Jumps to a
specified place in
the active
document

Bearbeiten Gehe zu...
F5 oder Strg+G Edit F5, Ctrl+G 757 896

BearbeitenTextmarke Weist der Markierung einen
Namen zu. Dialogs(wdDialogInsertBookmark).Show EditBookmark Assigns a name to

the selection Einfügen Textmarke...
Strg+Umschalt+F5 Insert Ctrl+Shift+F5 (Or:

Alt I, K) 758 168

BearbeitenVerknüpfungen
Ermöglicht die Ansicht,
Akualisierung, das Öffnen
oder Aufheben von
Verknüpfungen.

Dialogs(wdDialogEditLinks).Show EditLinks
Allows links to be
viewed, updated,
opened, or
removed

Bearbeiten Verknüpfungen... Edit Alt E, K 759 124
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AnsichtOnline Für Onlinelesen optimierte
Dokumentanzeige WordBasic.ViewOnline ViewOnline

Displays the
document
optimized for
reading online

Onlinelayout Word 97 View 760 820

AnsichtKopfzeile Zeigt Kopfzeilen in der
Layout-Ansicht an.

If ActiveWindow.View.SplitSpecial wdPaneNone Then
ActiveWindow.Panes(2).Close

End If
If ActiveWindow.ActivePane.View.Type = wdNormalView Or
ActiveWindow. _
ActivePane.View.Type = wdOutlineView Then
ActiveWindow.ActivePane.View.Type = wdPrintView

End If
ActiveWindow.ActivePane.View.SeekView =
wdSeekCurrentPageHeader

ViewHeader Displays header in
page layout view Ansicht Kopf- und Fußzeile View Alt V, H 762 484

AnsichtFußnoten
Öffnet ein Fenster zur
Ansicht und Bearbeitung
von Fuß- oder Endnoten
[ein/aus].

WordBasic.ViewFootnotes ViewFootnotes
Opens a pane for
viewing and
editing the notes
(toggle)

Ansicht Fußnoten View Alt V, F 764 502

EinfügenManuellerWechsel
Beendet eine Seite, Spalte
oder einen Abschnitt vor der
Einfügemarke.

Dialogs(wdDialogInsertBreak).Show InsertBreak
Ends a page,
column, or section
at the insertion
point

Einfügen Manueller Wechsel...
Manueller Umbruch... Insert Alt I, B 766 159

Fügt ein leeres Textfeld ein,
oder umgibt das markierte
Element mit einem Textfeld

Inserts an empty
textbox or
encloses the
selected item in a
textbox

Textfeld 767

EinfügenDatumZeit
Fügt das aktuelle Datum
und/oder die aktuelle
Uhrzeit in das aktuelle
Dokument ein.

Dialogs(wdDialogInsertDateTime).Show InsertDateTime
Inserts the current
date and/or time
into the active
document

Einfügen Datum und Uhrzeit... Insert 768 165

EinfügenZahl Fügt eine Zahl in das aktive
Dokument ein Dialogs(wdDialogInsertNumber).Show InsertNumber

Inserts a number
in the active
document

Einfügen Zahl... 769 812

EinfügenFeld Fügt ein Feld in das aktive
Dokument ein. Dialogs(wdDialogInsertField).Show InsertField

Inserts a field in
the active
document

Einfügen Feld... Insert Alt I, F 772 166

EinfügenFormularFeld Fügt ein neues Formularfeld
ein. Dialogs(wdDialogInsertFormField).Show InsertFormField Inserts a new form

field Formularfeld... 773 483

EinfügenBeschriftung
Fügt eine Beschriftung
unterhalb oder oberhalb des
markierten Objekts ein.

Dialogs(wdDialogInsertCaption).Show InsertCaption
Inserts a caption
above or below a
selected object

Einfügen
Kontext Beschriftung... Insert

Context Alt I, C 774 357

EinfügenQuerverweis Fügt einen Querverweis ein. Dialogs(wdDialogInsertCrossReference).Show InsertCrossReference Inserts a cross-
reference Einfügen Querverweis... Insert 775 367

EinfügenIndexUndVerzeichnisse
Erstellt einen Index, ein
Inhalts- oder
Abbildungsverzeichnis.

Dialogs(wdDialogInsertIndexAndTables).Show InsertIndexAndTables

Inserts an index or
a table of
contents, figures,
or authorities into
the document

Einfügen Index und Verzeichnisse... Insert Alt I, D 776 473

EinfügenDatei
Fügt den Inhalt einer
anderen Datei in das aktive
Dokument ein.

Dialogs(wdDialogInsertFile).Show InsertFile
Inserts the text of
another file into
the active
document

Einfügen
E-Mail senden
Outlook-E-Mail senden

Datei...
Insert
Send Mail
Outlook Send
Mail

Alt I, L 777 164

FormatAbsatz
Ändert die Darstellung und
Zeilennummerierung der
markierten Absätze.

Dialogs(wdDialogFormatParagraph).Show FormatParagraph

Changes the
appearance and
line numbering of
the selected
paragraphs

Format
Kontext Absatz... Formatting

Context Alt O, P 779 175

FormatTabulator Setzt und löscht Tabstopps
in den markierten Absätzen. Dialogs(wdDialogFormatTabs).Show FormatTabs

Sets and clears
the tab stops for
the selected
paragraphs

Format Tabstopp... Formatting Alt O, T 780 179

WW2_FormatRahmenUndSchattierung

Verändert Rahmen und
Schattierung der markierten
Absätze, Tabellenzellen und
Grafiken.
Ändert Rahmen und
Schattierung von markierten
Absätzen, Tabellenzellen
und Grafiken.

WordBasic.WW2_FormatBordersAndShading WW2_FormatBordersAndShading
Format Rahmen und
Schattierung
Rahmen und Schattierung...

781 697

FormatTextfluss
Textrichtung ändern
Ändert die Textflussrichtung
und Zeichenorientierung

WordBasic.FormatTextFlow FormatTextFlow
Changes text flow
direction and
character
orientation

Format
Kontext (Tabellen)

Textrichtung...
Absatzrichtung... Context 782 564
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FormatAufzählungUndNumerierung Erstellt eine Aufzählung
oder eine nummerierte Liste Dialogs(wdDialogFormatBulletsAndNumbering).Show FormatBulletsAndNumbering

Creates a
numbered or
bulleted list

Format
Kontext

Nummerierung und
Aufzählungszeichen...

Formatting
Context 783 824

ExtrasDokumentSchützen
Bestimmt den
Dokumentschutz für das
aktive Dokument.

Dialogs(wdDialogToolsProtectDocument).Show ToolsProtectDocument Extras Dokument schützen... Tools 785 503

FormatFormatvorlagenGruppe Weist Formatvorlagen aus
einer Dokumentvorlage zu Dialogs(wdDialogFormatStyleGallery).Show FormatStyleGallery Apply styles from

templates Formatvorlagenkatalog... 787 505

FormatGrafikPosRahmen Ändert die Optionen für
Frameformatierung FormatFrameOrFramePicture

Changes the
options for frame
formatting

Kontext
(Positionsrahmen) Positionsrahmen formatieren... Rt-click on a

frame 788 346

ExtrasSprache
Ändert die
Spracheinstellungen für die
markierten Zeichen.

Dialogs(wdDialogToolsLanguage).Show
Selection.LanguageID = wdLanguageID
Selection.NoProofing = Boolean
Application.CheckLanguage = Boolean

ToolsLanguage

Changes the
language
formatting of the
selected
characters

Extras > Sprache Sprache bestimmen...
Sprache festlegen...

Tools > Language
> Set Language 790 188

ExtrasWörterZählen Zeigt die Wortanzahl des
aktiven Dokuments an Dialogs(wdDialogToolsWordCount).Show ToolsWordCount

Displays the word
count statistics of
the active
document

Extras Wörter zählen... Tools 792 228

ExtrasAutoKorrektur
Löscht AutoKorrektur-
Einträge oder fügt sie hinzu.
Löscht AutoKorrektur

Dialogs(wdDialogToolsAutoCorrect).Show ToolsAutoCorrect
Adds or deletes
AutoCorrect
entries

Extras AutoKorrektur...
AutoKorrektur-Optionen... Tools 793 378

ExtrasBriefumschlagUndEtiketten
Erstellt oder druckt einen
Umschlag, ein Etikett oder
einen Bogen mit Etiketten.

Dialogs(wdDialogToolsEnvelopesAndLabels).Show ToolsEnvelopesAndLabels
Creates or prints
an envelope, a
label, or a sheet of
labels

Extras Umschläge und Etiketten... Tools 794 607

ExtrasEtikettenErstellen
Erstellt oder druckt ein
Etikett oder einen Bogen mit
denselben Etiketten.

Dialogs(wdDialogToolsCreateLabels).Show ToolsCreateLabels
Creates or prints a
label or a sheet of
labels

Beschriftungen... 795 489

BriefEigenschaften Formatiert ein
Briefdokument Dialogs(wdDialogLetterWizard).Show LetterProperties Formats a Letter

Document Extras Brief-Assistent... 796 821

ExtrasAnpassen
Passt die Microsoft Word-
Benutzeroberfläche an
(Menüs, Tastatur und
Symbolleisten)

Dialogs(wdDialogToolsCustomize).Show ToolsCustomize

Customizes the
Word user
interface (menus,
keyboard and
toolbars)

Extras
Anpassen...
Rechts-Klick auf irgendeine
Menü- oder Symbolleiste

Tools Alt T, C 797 152

TabelleZellenVerbinden
Verbindet die markierten
Zellen zu einer einzigen
Zelle.

Selection.Cells.Merge TableMergeCells
Merges the
selected table
cells into a single
cell

Tabelle Zellen verbinden Table 798 136

TabelleZellenTeilen Teilt Zellen, die vorher
verbunden waren. Dialogs(wdDialogTableSplitCells).Show TableSplitCells Splits the selected

table cells
Tabelle
Tabellen und Rahmen Zellen teilen...

Table
Tables and
Borders

800 137

TabelleZeileMarkieren Markiert die aktuelle Zeile in
der Tabelle Selection.SelectRow TableSelectRow Selects the current

row in a table Tabelle > Markieren
Zeile
Zieie markieren
(links von Zeile klicken)

Table Click in left
margin 801 140

TabelleSpalteMarkieren Markiert die aktuelle Spalte
in der Tabelle Selection.SelectColumn TableSelectColumn Selects the current

column in a table Tabelle > Markieren
Spalte markieren
(Alt+Klick; Alt+Ziehen um
mehrere Spalten auszuwählen)

Table
Alt+click
(Alt+drag to
select several)

802 141

TabelleTabelleMarkieren Markiert die gesamte
Tabelle. Selection.Tables(1).Select TableSelectTable Selects an entire

table Tabelle > Markieren
Tabelle
Tabelle markieren
(Alt+Doppelklick oder Alt+Num-
5)

Table Alt+double-click 803 139

TabelleFormatZelle
Ändert die Höhe und Breite
der Zeilen und Spalten in
einer Tabelle

Dialogs(wdDialogTableFormatCell).Show TableFormatCell
Changes the
height and width of
the rows and
columns in a table

Word97-Tabellenmenü Tabelleneigenschaften... Table (Word97) 804 612

TabelleÜberschriften Schaltet die Überschrift-
Eigenschaften ein und aus. Selection.Rows.HeadingFormat = wdToggle TableHeadings

Toggles table
headings attribute
on and off

Tabelle Überschriftenzeilen
wiederholen Table Alt A, H 805 598

TextInTabelle Wandelt Text in eine
Tabelle um. Dialogs(wdDialogTextToTable).Show TextToTable Tabelle Text in Tabelle... 806 127

TabelleFormel Fügt ein Formelfeld in eine
Tabellenzelle ein. Dialogs(wdDialogTableFormula).Show TableFormula

Inserts a formula
field into a table
cell

Tabelle Formel... Table 807 348

TabelleTeilen
Fügt einen Absatz oberhalb
der aktuellen Tabellenzeile
ein.

Selection.SplitTable TableSplit
Inserts a
paragraph mark
above the current
row in the table

Tabelle Tabelle teilen Table 808 138

BearbeitenOfficeZwischenablage Zeigt den Inhalt der Office-
Zwischenablage an CommandBars("Clipboard").Visible = True EditOfficeClipboard

Displays the
contents of the
Office Clipboard

Zwischenablage einblenden
Office-Zwischenablage

Show Clipboard
task pane. 809 459

HilfeKurzübersicht Help wdHelpQuickPreview HelpQuickPreview Kurzübersicht 811 7
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HilfeBeispieleUndDemos Help wdHelpExamplesAndDemos HelpExamplesAndDemos Beispeile und Demos 812 8

HilfeWordPerfectHilfe
Zeigt die Entsprechung für
einen WordPerfect-Befehl
an.

Dialogs(wdDialogHelpWordPerfectHelp).Show HelpWordPerfectHelp
Shows the
equivalent for a
WordPerfect
command

WordPerfect-Hilfe... 813 10

HilfeTipsUndTricks Zeigt einen der Tipps und
Tricks an. WordBasic.HelpTipOfTheDay HelpTipOfTheDay Displays a Word

Tip of the Day Tipps und Tricks... 814 635

HilfeSoftwareService
Zeigt Informationen zur
Produktunterstützung von
Microsoft Word an.

Help wdHelpPSSHelp HelpPSSHelp

Displays
information about
the support
available for
Microsoft Word

Technischer Support 815 360

NumerierungÜberspringen
Überspringt die markierten
Absätze bei der
Nummerierung

WordBasic.SkipNumbering SkipNumbering
Makes the
selected
paragraphs skip
numbering

Nummerierung überspringen 816 438

ExtrasAnpassenTastatur Passt die Word-
Tastenbelegung an. Dialogs(wdDialogToolsCustomizeKeyboard).Show ToolsCustomizeKeyboard

Customizes the
Word key
assignments

Extras > Anpassen >
Tastatur Tastatur anpassen...

Tools >
Customize >
Keyboard button

818 432

EinblendenAlleÜberschriften
Zeigt alle
Überschriftenebenen und
den Textkörper an.

ActiveWindow.View.ShowAllHeadings ShowAllHeadings
Displays all of the
heading levels and
the body text

Gliederung
Dokumentstruktur

Alle
Alt+Umschalt+A

Outlining toolbar
Document Map Alt+Shift+A 826 260

BearbeitenAktualisierenIMEDic IME Wörterbuch aktivieren WordBasic.EditUpdateIMEDic EditUpdateIMEDic Update IME
dictionary IME-Verzeichnis aktualisieren... 827 638

IMESteuerung IME deaktivieren WordBasic.IMEControl IMEControl Disable IME IME deaktivieren 828 646
Schaltet zum Fenster mit
diesem Dokument um Fenster 1 830

Dateiliste Datei1 - Datei9 Öffnet dieses Dokument. File1 - File9 Datei 831

SchaltflächensymbolKopieren
Kopiert das
Schaltflächensymbol in die
Zwischenablage.

WordBasic.CopyButtonImage CopyButtonImage Schaltfläche kopieren 832 526

EinfügenSchaltflächenSymbol
Kopiert das
Schaltflächensymbol aus
der Zwischenablage auf die
markierte Schaltfläche.

WordBasic.PasteButtonImage PasteButtonImage Schaltfläche einfügen 833 527

VorgabeSchaltflächenSymbol
Setzt das
Schaltflächensymbol auf die
Vorgabe zurück .

WordBasic.ResetButtonImage ResetButtonImage Schaltfläche zurücksetzen 834 528

BearbeitenSchaltflächenSymbol Bearbeitet das markierte
Schaltflächensymbol. WordBasic.EditButtonImage EditButtonImage Schaltfläche bearbeiten... 835 614

SchaltflächenSymbolWählen
Verbindet ein Symbol oder
Text mit der markierten
Schaltfläche.

WordBasic.ChooseButtonImage ChooseButtonImage Schaltfläche auswählen... 836 627

AufgabeErstellen
Erstellt eine Outlook-
Aufgabe aus der aktuellen
Markierung

WordBasic.CreateTask CreateTask
Creates a
Microsoft Outlook
task from the
current selection

Überarbeiten Microsoft Outlook-Aufgabe
erstellen Reviewing 837 900

DokumentMinimieren Verkleinert das aktive
Fenster zu einem Symbol. ActiveWindow.WindowState = wdWindowStateMinimize DocMinimize

Minimizes the
active window to
an icon

Minimieren
(Alle Fenster minimieren:
Windows+D, Minimieren
rückgängig:
Umschalt+Windows+M; oder
Rechtsklick auf Windows-
Startleiste)

838 320

DokumentWiederherstellen
Ändert die
Dokumentfenstergröße zur
Normalgröße.

ActiveWindow.WindowState = wdWindowStateNormal DocRestore
Restores the
window to normal
size

Wiederherstellen
Strg+F5 Ctrl+F5 839 233

DokumentSchließen
Fordert zum Speichern auf
und schließt anschließend
das aktive Fenster.

WordBasic.DocClose DocClose
Prompts to save
the document and
then closes the
active window

Schließen
Strg+F4 oder Strg+W Ctrl+W, Ctrl+F4 840 234

DokumentVerschieben Ändert die Position des
aktiven Fensters. WordBasic.DocMove DocMove

Changes the
position of the
active window

Verschieben
Strg+F7 (oder mit Maus in
obere Fenserleiste klicken und
ziehen)

Ctrl+F7 841 231

DokumentGröße Ändert die Größe des
aktiven Fensters. WordBasic.DocSize DocSize

Changes the size
of the active
window

Größe
Strg+F8 (? einfach Cursor auf
Fensterrand plazieren ?)

Ctrl+F8 842 230

DokumentMaximieren Vergrößert das aktive
Fenster auf volle Größe ActiveWindow.WindowState = wdWindowStateMaximize DocMaximize

Enlarges the
active window to
full size

Maximieren
Strg+F10 Ctrl+F10 843 232
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NächstesFenster Schaltet zum nächsten
Dokumentfenster um. ActiveWindow.Next.Activate NextWindow

Switches to the
next document
window

Nächstes Fenster
Strg+F6 oder Alt+F6 Ctrl+F6 844 22

AnsichtStatusleiste Schaltet die Statusleiste ein
oder aus. Application.DisplayStatusBar = Not Application.DisplayStatusBar ViewStatusBar Shows or hides

the status bar Statusleiste 850 154

FormatierungLöschen Löscht Formatierungen aus
dem ausgewählten Text ClearFormatting

Clears formatting
and styles from
selected text

872 1354

AnsichtRahmenSymbolleiste

Blendet die Tabellen- und
Rahmensymbolleiste ein
oder aus
Zeigt die Tabellen- und
Rahmensymbolleiste an
[ein/aus].

WordBasic.ViewBorderToolbar ViewBorderToolbar
Shows or hides
the Borders/Table
toolbar

Tabelle
Standard > Tabellen
und Rahmen

Tabelle zeichnen
Tabellen und Rahmen-
Symbolleiste
(oder in irgendeine
Symbolleiste rechts-klicken)

Standard
(You can right-
click on any
toolbar to select
which toolbars
should be visible)

916 604

OK
Bestätigt die Position einer
zu kopierenden oder zu
verschiebenden
Markierung.

WordBasic.OK OK
Confirms a
location for
copying or moving
the selection

OK 920 71

AusschnittSchließen Schließt den aktiven
Fensterausschnitt. ActiveWindow.ActivePane.Close ClosePane Closes the active

window pane
Schließen
Alt+Umschalt+C

Close button on
the relevant
panes

Alt+Shift+C 921 243

DateiGrafikSchließen Schließt das aktive
Grafikdokument WordBasic.FileClosePicture FileClosePicture Grafik bearbeiten Grafik schließen Edit Picture 922 694

SeitenansichtSchließen Beendet die Seitenansicht. ActiveDocument.ClosePrintPreview ClosePreview Exits print preview Seitenansicht Schließen Print Preview 923 437

AnsichtKopfFußzeileSchließen Kehrt zum Dokument-Text
zurück.

ActiveWindow.ActivePane.View.SeekView =
wdSeekMainDocument CloseViewHeaderFooter Returns to

document text Kopf- und Fußzeile Schließen Header and
Footer 924 640

AnsichtZoom
Skaliert (vergrößert oder
verkleinert) die
Bearbeitungsansicht

Dialogs(wdDialogViewZoom).Show ViewZoom Scales the editing
view Ansicht Zoom... View 925 577

HilfeInfo
Zeigt
Programminformationen,
die Word-Versionsnummer
und Copyright-Hinweise an.

Dialogs(wdDialogHelpAbout).Show HelpAbout

Displays the
program
information, Word
version number
and the copyright

? Info Help 927 9

TabelleSortieren
Ordnet den markierten
Bereich entsprechend dem
Sortierschlüssel an.

Dialogs(wdDialogTableSort).Show TableSort
Rearranges the
selection into a
specified order

Tabelle Sortieren... Table 928 199

TabelleInText Wandelt eine Tabelle in
Text um. Dialogs(wdDialogTableToText).Show TableToText Tabelle > Umwandeln Text in Tabelle... 929 128

BearbeitenNeuenVerlegerErstellen Dialogs(wdDialogEditCreatePublisher).Show EditCreatePublisher Neuer Verleger... 933 732
BearbeitenAbonnieren Dialogs(wdDialogEditSubscribeTo).Show EditSubscribeTo Abonnieren... 934 733

HilfeAssistent
Sucht nach Hilfethemen,
basierend auf einer
eingegebenen Frage oder
Aufforderung

WordBasic.HelpAW HelpAW
Locates Help
topics based on an
entered question
or request

? Hilfe-Assistent...
Antwort-Assistent... 937 794

DateiAblegen
Legt das aktive Dokument
in einem Exchange-Ordner
ab

ActiveDocument.Post FilePost
Puts the active
document into an
Exchange folder

Datei Senden an > Exchange-
Ordner... 938 760

FensterListe
Wechselt zum Fenster mit
dem angegebenen
Dokument.

Dialogs(wdDialogWindowActivate).Show WindowList
Switches to the
window containing
the specified
document

Weitere Fenster... 959 220

BearbeitenObjekt Öffnet das markierte Objekt
zur Bearbeitung. Dialogs(wdDialogEditObject).Show EditObject

Opens the
selected object for
editing

Bearbeiten
Kontext Objekt Context 961 125

AutoTextErstellen
Fügt der aktiven
Dokumentvorlage AutoText-
Einträge hinzu

Dialogs(wdDialogCreateAutoText).Show CreateAutoText
Adds an AutoText
entry to the active
template

AutoText-Feld
Einfügen > AutoText
AutoText

AutoText erstellen...
Neu...
Alt+F3

Field AutoText
AutoText Alt+F3 963 872

Microsoft Network 982
HilfeIndex Zeigt den Hilfe-Index an. Help wdHelpIndex HelpIndex ? Inhalt und Index 983 6

Hilfe
Zeigt die Hilfe zu der
aktuellen Aufgabe oder dem
aktuellen Befehl an.

Help wdHelp Help
Help from the
Office Assistant for
the current task or
command

?
Standard
E-Mail-Symbolleisten

Microsoft Word-Hilfe
F1

Help
Standard
Mail toolbars

F1 984 1

HilfeAnzeigenAusblenden Office-Assistent ein-
/ausblenden WordBasic.HelpShowHide HelpShowHide Show/Hide the

Office Assistant ? Office-Assistenten anzeigen 1004 858

control on 401

Ändert die Farbe des
markierten Textes
Ändert die
Schattierungsfarbe des
markierten Textes

Format > Zeichen >
Schriftfarbe
Tabellen und Rahmen >
Schattierungsfarbe
Format > Schriftfarbe
Zeichnen > Schriftfarbe

Weitere Farben...
Format > Font
Formatting
Drawing

1005



Deutsch Beschreibung Makro-Beispiel English Description Type Symbolleiste Befehl/Kürzel Toolbar Shortcut Comm Dial

Öffnet das Dialogfeld
"Fülleffekte", in dem Sie
eine Grafik, graduelle
Füllung, Struktur und
Musterfüllung auswählen
können.

Zeichnen > Füllfarbe Fülleffekte... Drawing > Fill
Color 1006

WebÖffnenHyperlink An eine Stelle im Dokument
springen... WordBasic.WebOpenHyperlink WebOpenHyperlink Jump to a

location... Web > Wechseln zu... Öffnen...
Hyperlink öffnen... Web 1015 921

WebÖffnenStartSeite Startseite öffnen WordBasic.WebOpenStartPage WebOpenStartPage Open Start Page Web Startseite Web 1016 930

WebGeheZurück Hyperlink zurück WordBasic.WebGoBack WebGoBack Backward
hyperlink Web Zurück

Alt+Links Web Alt+left arrow 1017 931

WebGeheWeiter Hyperlink weiter WordBasic.WebGoForward WebGoForward Forward hyperlink Web Vorwärts
Alt+Rechts Web Alt+rt arrow 1018 933

WebStopLaden Diesen Sprung abbrechen WordBasic.WebStopLoading WebStopLoading Stop current jump Web Aktuellen Sprung anhalten
Anhalten Web 1019 934

WebAktualisieren Diese Seite aktualisieren ActiveDocument.Reload WebRefresh Refresh current
page Web Aktuelle Seite aktualisieren

Aktualisieren Web 1020 935

WebÖffnenFavoriten Favoriten-Ordner öffnen WordBasic.WebOpenFavorites WebOpenFavorites Open Favorites
folder Web > Favoriten Favoriten öffnen... Web 1021 928

WebHinzufügenFavoriten Zu Favoriten hinzufügen Selection.Range.Hyperlinks(1).AddToFavorites
(ActiveDocument.AddToFavorites?) WebAddToFavorites Add to Favorites

Web
Hyperlinkmenü
Kontext

Zu Favoriten hinzufügen... Web>Favourites 1022 924

WebAusblendenSymbolleisten Weitere Symbolleisten
ausblenden WordBasic.WebHideToolbars WebHideToolbars Hide other

toolbars Web Nur Websymbolleiste anzeigen Web 1023 929

DurchsuchenZurück Springt zum vorherigen
Suchobjekt Application.Browser.Previous BrowsePrev

Jump to the
previous browse
object

Zurück
Suche/gehe zu vorherigem
Strg+Bild-AUF-Taste
(oder doppelter nach-oben Pfeil
unter vertikaler Bildlaufleiste)

Double-up-arrow
below vertical
scrollbar

Ctrl+PgUp 1024 823

DurchsuchenWeiter Springt zum nächsten
Suchobjekt Application.Browser.Next BrowseNext Jump to the next

browse object

Weiter
Suche/gehe zu nächstem
Strg+Bild-AB-Taste
(oder doppelter nach-unten
Pfeil unter vertikaler
Bildlaufleiste)

Double-down-
arrow below
vertical scrollbar

Ctrl+PgDn 1025 834

DurchsuchenMarkierung Nächstes/vorheriges
Suchobjekt markieren BrowseSel

Select the
next/prev browse
object

Browseobjekt auswählen
Alt+Strg+Pos1 Alt+Ctrl+Home 1028 822

EinfügenWordArt

Erstellt Texteffekte durch
Einfügen eines Microsoft
Office-Zeichnungsobjekts.
Fügt ein Microsoft WordArt-
Objekt ein.

CommandBars("WordArt").Visible = True
ActiveDocument.Shapes.AddTextEffect(PresetTextEffect As
MsoPresetTextEffect,Text As String,FontName As String,FontSize
As Single,FontBold as MsoTriState,FontItalic As MsoTriState,Left A
Single,Top As Single,[Anchor]).Select
WordBasic.InsertWordArt

InsertWordArt Zeichnen
Einfügen > Grafik WordArt... Drawing 1031 682

ZeichnenEinfügenDiagramm Neues Diagramm einfügen ??? ??? Zeichnen Schematische Darstellung... Drawing 1032

ZeichnungBewegenNachOben

Verschiebt die markierten
Objekte in kleinen Schritten
nach oben.
Verschiebt die markierten
Zeichnungselemente nach
oben.

WordBasic.DrawNudgeUp
Selection.ShapeRange.IncrementTop ... DrawNudgeUp

Moves the
selected drawing
objects up

Zeichnen > Zeichnen >
Präzisionsausrichtung

Oben
Aufwärts Up arrow 1035 670

ZeichnungBewegenNachUnten

Verschiebt die markierten
Objekte in kleinen Schritten
nach unten.
Verschiebt die markierten
Zeichnungselemente nach
unten.

WordBasic.DrawNudgeDown
Selection.ShapeRange.IncrementTop -... DrawNudgeDown

Moves the
selected drawing
objects down

Zeichnen > Zeichnen >
Präzisionsausrichtung

Unten
Abwärts Down arrow 1036 671

ZeichnungBewegenNachLinks

Verschiebt die markierten
Objekte in kleinen Schritten
nach links.
Verschiebt die markierten
Zeichnungselemente nach
links.

WordBasic.DrawNudgeLeft
Selection.ShapeRange.IncrementLeft ... DrawNudgeLeft

Moves the
selected drawing
objects to the left

Zeichnen > Zeichnen >
Präzisionsausrichtung

Links
Links Left arrow 1037 672

ZeichnungBewegenNachRechts

Verschiebt die markierten
Objekte in kleinen Schritten
nach rechts.
Verschiebt die markierten
Zeichnungselemente nach
rechts.

WordBasic.DrawNudgeRight
Selection.ShapeRange.IncrementLeft -... DrawNudgeRight

Moves the
selected drawing
objects to the right

Zeichnen > Zeichnen >
Präzisionsausrichtung

Rechts
Rechts Right arrow 1038 673

ZeichnenAusrichtenRelativZurSeite
Richtet die markierten
Objekte relativ zu Seite aus
oder verteilt sie.

DrawAlignDistributeRelativeToPage Zeichnen > Ausrichten
oder Verteilen Relativ zur Seite Drawing > Align

or Distribute 1039



Deutsch Beschreibung Makro-Beispiel English Description Type Symbolleiste Befehl/Kürzel Toolbar Shortcut Comm Dial

Richtet die markierten
Objekte relativ zu Seite aus
oder verteilt sie.

??? Relativ zur Seite/Folie 1040

ZeichnenKurveEinfügen
Fügt eine Linie mit runden
Ecken durch die Punkte ein,
auf der Sie im aktiven
Fenster klicken.

??? ??? Zeichnen > AutoFormen
> Linien Kurve

Drawing >
AutoShapes >
Lines

1041

ZeichnenGeradeVerbindungEinfügen (?)

Zeichnet eine gerade
Verbindung zwischen den
blauen Verbindungsseiten,
die Sie auf zwei
AutoFormen auswählen.

??? ??? Gerade Verbindung 1042

ZeichnenGewinkelteVerbindungEInfügen (?)

Zeichnet eine 90 Grad
gewinkelte Verbindung
zwischen den blauen
Verbindungsseiten,die Sie
auf zwei AutoFormen
auswählen.

??? ??? Gewinkelte Verbindung 1043

ZeichnenGekrümmteVerbindungEinfügen (?)

Zeichnet eine gekrümmte
Verbindung zwischen den
blauen Verbindungsseiten,
die Sie auf zwei
AutoFormen auswählen.

??? ??? Gekrümmte Verbindung 1044

Legenden ButtonPopup Zeichnen > AutoFormen Legenden Drawing >
AutoShapes 1047

Flussdiagramm ButtonPopup Zeichnen > AutoFormen Flussdiagramm Drawing >
AutoShapes 1048

Blockpfeile ButtonPopup Zeichnen > AutoFormen Blockpfeile Drawing >
AutoShapes 1049

Sterne und Banner ButtonPopup Zeichnen > AutoFormen Sterne und Banner Drawing >
AutoShapes 1050

Öffnet das Dialogfeld
'Farben', in dem Sie eine
andere Farben auswählen
oder selber mischen
können.

Zeichnen > Füllfarbe Weitere Füllfarben... Drawing > Fill
Color 1051

Zeigt zusätzliche
Linienfarben an. Zeichnen > Linienfarbe Weitere Linienfarben... Drawing > Line

Color 1052

Zeigt Muster an, die Sie für
die Linie des markierten
Objekts übernehmen
können.

Zeichnen > Linienfarbe Linien-Füllmuster... Drawing > Line
Color 1053

Ändert die Eigenschaften
der markierten
Zeichnungsobjekte.

Grafik > Linienart Weitere Linien... Picture 1054

WordArt-Form ButtonPopup WordArt WordArt-Form WordArt 1058
WordArt-Ausrichtung ButtonPopup WordArt WordArt-Ausrichtung WordArt 1059
WordArt-Zeichenabstand ButtonPopup WordArt WordArt-Zeichenabstand WordArt 1060

Stapelt den Text innerhalb
des markierten WordArt-
Objektes vertikal - ein
Zeichen oberhalb des
anderen, um das Wort von
oben nach unten zu lesen.

WordArt WordArt als vertikaler Text WordArt 1061

Weist allen Buchstaben im
aktuellen WordArt-Objekt
dieselbe Höhe zu.

DrawWordArtSetCharactersToSameHe
ight WordArt WordArt-Buchstaben mit

gleicher Höhe WordArt 1063

Vergrößert die Sättigung,
oder Intensität der Farbe
der markierten Grafik.

DrawPictureMoreContrast Grafik Mehr Kontrast Picture 1064

Verringert die Sättigung,
oder Intensität der Farbe
der markierten Grafik.

DrawPictureLessContrast Grafik Weniger Kontrast Picture 1065

Fügt weiß hinzu, um die
Farben der markierten
Grafik aufzuhellen.

DrawPictureMoreBrightness Grafik Mehr Helligkeit Picture 1066

Fügt schwarz hinzu, um die
Farben der markierten
Grafik abzudunkeln.

DrawPictureLessBrightness Grafik Weniger Helligkeit Picture 1067
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ZeichnenSchattenAusrichten(???)
Verschiebt den Schatten
des markierten Objekts in
kleinen Schritten nach
oben.

DrawShadowNudgeUp Schatteneinstellungen Präzisionsausrichtung Schatten
oben Shadow Settings 1068

Verschiebt den Schatten
des markierten Objekts in
kleinen Schritten nach
unten.

DrawShadowNudgeDown Schatteneinstellungen Präzisionsausrichtung Schatten
unten Shadow Settings 1069

Verschiebt den Schatten
des markierten Objekts in
kleinen Schritten nach links.

DrawShadowNudgeLeft Schatteneinstellungen Präzisionsausrichtung Schatten
links Shadow Settings 1070

Verschiebt den Schatten
des markierten Objekts in
kleinen Schritten nach
rechts.

DrawShadowNudgeRight Schatteneinstellungen Präzisionsausrichtung Schatten
rechts Shadow Settings 1071

Zeigt zusätzliche Farben für
den Schatten des
markierten Objekts an

Schatteneinstellungen >
Schattenfarbe Weitere Schattenfarben... Shadow Settings 1072

Zeigt zusätzliche Farben für
die 3D-Effekte für das
markierte Objekt an.

3D-Einstellungen > 3D-
Farbe Weitere 3D-Farben... 3-D Settings 1073

Richtet den Text linksbündig
aus für das markierte
WordArt-Objekt.

DrawWordArtAlignLeft WordArt > WordArt-
Ausrichtung Linksbündig WordArt 1108

Zentriert den Text des
markierten WordArt-
Objektes.

DrawWordArtAlignCenter WordArt > WordArt-
Ausrichtung Zentriert WordArt 1109

Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertAccentBorderCallout4 Zeichnen > AutoFormen
> Legenden

Legende mit Linie (4) (Rahmen
und Markierungsleiste)

Drawing >
AutoShapes >
Callouts

1110

ZeichnenEinfügenRechteck
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertRectangle
Zeichnen
Zeichnen > AutoFormen
> Standardformen

Rechteck
Drawing
Drawing >
AutoShapes >
Basic Shapes

1111

ZeichnenEinfügenParallelogramm
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertParallelogram Zeichnen > AutoFormen
> Standardformen Parallelogramm

Drawing >
AutoShapes >
Basic Shapes

1112

ZeichnenEinfügenTrapezoid
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertTrapezoid Zeichnen > AutoFormen
> Standardformen

Trapez
Trapezoid

Drawing >
AutoShapes >
Basic Shapes

1113

ZeichnenEinfügenRaute
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertDiamond Zeichnen > AutoFormen
> Standardformen Raute

Drawing >
AutoShapes >
Basic Shapes

1114

ZeichnenEinfügenAbgerundetesRechteck (?)
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertRoundedRectangle Zeichnen > AutoFormen
> Standardformen Abgerundetes Rechteck

Drawing >
AutoShapes >
Basic Shapes

1115

ZeichnenEinfügenAchteck
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertOctagon Zeichnen > AutoFormen
> Standardformen Achteck

Drawing >
AutoShapes >
Basic Shapes

1116

ZeichnenEinfügenGleichschenkligesDreieck (?)
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertIsocelesTriangle Zeichnen > AutoFormen
> Standardformen Gleichschenkliges Dreieck

Drawing >
AutoShapes >
Basic Shapes

1117

ZeichnenEinfügenRechtwinkligesDreieck (?)
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertRightTriangle Zeichnen > AutoFormen
> Standardformen Rechtwinkliges Dreieck

Drawing >
AutoShapes >
Basic Shapes

1118

ZeichnenEinfügenOval
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertOval
Zeichnen
Zeichnen > AutoFormen
> Standardformen

Ellipse
Drawing
Drawing >
AutoShapes >
Basic Shapes

1119

ZeichnenEinfügenSechseck
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertHexagon Zeichnen > AutoFormen
> Standardformen Sechseck

Drawing >
AutoShapes >
Basic Shapes

1120
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ZeichnenEinfügenKreuz
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertPlus Zeichnen > AutoFormen
> Standardformen Kreuz

Drawing >
AutoShapes >
Basic Shapes

1121

ZeichnenEinfügenWürfel
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertCube Zeichnen > AutoFormen
> Standardformen Würfel

Drawing >
AutoShapes >
Basic Shapes

1122

Schmuckrahmen (?)
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertPlaque Zeichnen > AutoFormen
> Standardformen

Schmuckrahmen
Zierrahmen

Drawing >
AutoShapes >
Basic Shapes

1123

ZeichnenEinfügenRichtungspfeil (?!?)
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertPentagon Zeichnen > AutoFormen
> Standardformen Regelmäßiges Fünfeck

Drawing >
AutoShapes >
Basic Shapes

1124

Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertWave Zeichnen > AutoFormen
> Sterne & Banner Welle

Drawing >
AutoShapes >
Stars & Banners

1125

Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertCan Zeichnen > AutoFormen
> Standardformen Zylinder

Drawing >
AutoShapes >
Basic Shapes

1126

Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertVerticalScroll Zeichnen > AutoFormen
> Sterne & Banner

Vertikale Rolle
Vertikaler Bildlauf

Drawing >
AutoShapes >
Stars & Banners

1127

Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertHorizontalScroll Zeichnen > AutoFormen
> Sterne & Banner

Horizontale Rolle
Horizontaler Bildlauf

Drawing >
AutoShapes >
Stars & Banners

1128

ZeichnenEinfügenGefalteteEcke
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertFoldedCorner Zeichnen > AutoFormen
> Standardformen Gefaltete Ecke

Drawing >
AutoShapes >
Basic Shapes

1129

ZeichnenEinfügenRahmen
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertBevel Zeichnen > AutoFormen
> Standardformen Rahmen

Drawing >
AutoShapes >
Basic Shapes

1130

ZeichnenEinfügenSmiley
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertSmileyFace Zeichnen > AutoFormen
> Standardformen Smiley

Drawing >
AutoShapes >
Basic Shapes

1131

ZeichnenEinfügenRad
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertDonut Zeichnen > AutoFormen
> Standardformen Rad

Drawing >
AutoShapes >
Basic Shapes

1132

ZeichnenEinfügenRauchverbot (?!?)
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertNoSmoking Zeichnen > AutoFormen
> Standardformen "Nein"-Symbol

Drawing >
AutoShapes >
Basic Shapes

1133

ZeichnenEinfügenHalbbogen
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertBlockArc Zeichnen > AutoFormen
> Standardformen Halbbogen

Drawing >
AutoShapes >
Basic Shapes

1134

Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertLeftBracket Zeichnen > AutoFormen
> Standardformen

Klammer auf
Runde Klammer links

Drawing >
AutoShapes >
Basic Shapes

1135

Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertRightBracket Zeichnen > AutoFormen
> Standardformen

Klammer zu
Runde Klammer rechts

Drawing >
AutoShapes >
Basic Shapes

1136

Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertLeftBrace Zeichnen > AutoFormen
> Standardformen

Geschweifte Klammer auf
Geschweifte Klammer links

Drawing >
AutoShapes >
Basic Shapes

1137

Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertRightBrace Zeichnen > AutoFormen
> Standardformen

Geschweifte Klammer zu
Geschweifte Klammer rechts

Drawing >
AutoShapes >
Basic Shapes

1138

Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertArc Zeichnen > AutoFormen
> Standardformen Bogen

Drawing >
AutoShapes >
Basic Shapes

1139
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ZeichnenEinfügenGewitterblitz
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertLightningBolt Zeichnen > AutoFormen
> Standardformen Gewitterblitz

Drawing >
AutoShapes >
Basic Shapes

1140

ZeichnenEinfügenHerz
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertHeart Zeichnen > AutoFormen
> Standardformen Herz

Drawing >
AutoShapes >
Basic Shapes

1141

ZeichnenEinfügenPfeil
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertRightArrow Zeichnen > AutoFormen
> Blockpfeile Pfeil nach rechts

Drawing >
AutoShapes >
Block Arrows

1142

ZeichnenEinfügenPfeilNachLinks
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertLeftArrow Zeichnen > AutoFormen
> Blockpfeile Pfeil nach links

Drawing >
AutoShapes >
Block Arrows

1143

ZeichnenEinfügenPfeilNachRechts (!?!)
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

Zeichnen > AutoFormen
> Blockpfeile Pfeil nach oben

Drawing >
AutoShapes >
Block Arrows

1144

ZeichnenEinfügenPfeilNachUnten
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertDownArrow Zeichnen > AutoFormen
> Blockpfeile Pfeil nach unten

Drawing >
AutoShapes >
Block Arrows

1145

ZeichnenEinfügenPfeilNachLinksUndRechts (?)
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertLeftRightArrow Zeichnen > AutoFormen
> Blockpfeile Pfeil nach links und rechts

Drawing >
AutoShapes >
Block Arrows

1146

ZeichnenEinfügenPfeilNachObenUndUnten (?)
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertUpDownArrow Zeichnen > AutoFormen
> Blockpfeile Pfeil nach oben und unten

Drawing >
AutoShapes >
Block Arrows

1147

ZeicnhenEinfügenPfeilInVierRichtungen (?)
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertQuadArrow Zeichnen > AutoFormen
> Blockpfeile Pfeil in vier Richtungen

Drawing >
AutoShapes >
Block Arrows

1148

ZeichnenEinfügenPfeil (!?!)
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

Zeichnen > AutoFormen
> Blockpfeile

Pfeil nach links, rechts und
oben

Drawing >
AutoShapes >
Block Arrows

1149

ZeichnenEinfügenPfeilNachLinksUndOben (?)
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertLeftUpArrow Zeichnen > AutoFormen
> Blockpfeile Pfeil nach links und oben

Drawing >
AutoShapes >
Block Arrows

1150

ZeichnenEinfügenGewinkelterPfeilNachOben (?)
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertBentUpArrow Zeichnen > AutoFormen
> Blockpfeile Nach oben gebogener Pfeil

Drawing >
AutoShapes >
Block Arrows

1151

Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

Zeichnen > AutoFormen
> Blockpfeile Rechteckiger Pfeil

Drawing >
AutoShapes >
Block Arrows

1152

Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertUTurnArrow Zeichnen > AutoFormen
> Blockpfeile 180 Grad-Pfeil

Drawing >
AutoShapes >
Block Arrows

1153

Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertStripedRightArrow Zeichnen > AutoFormen
> Blockpfeile Gestreifter Pfeil nach rechts

Drawing >
AutoShapes >
Block Arrows

1154

Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertNotchedRightArrow Zeichnen > AutoFormen
> Blockpfeile Eingekerbter Pfeil nach rechts

Drawing >
AutoShapes >
Block Arrows

1155

ZeichnenEinfügenFünfeck (!?!)
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

Zeichnen > AutoFormen
> Blockpfeile Richtungspfeil

Drawing >
AutoShapes >
Block Arrows

1156

ZeichnenEinfügenEingekerbterRichtungspfeil (?)
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

Zeichnen > AutoFormen
> Blockpfeile Eingekerbter Richtungspfeil

Drawing >
AutoShapes >
Block Arrows

1157

Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

Zeichnen > AutoFormen
> Blockpfeile Gebogener Pfeil

Drawing >
AutoShapes >
Block Arrows

1158



Deutsch Beschreibung Makro-Beispiel English Description Type Symbolleiste Befehl/Kürzel Toolbar Shortcut Comm Dial

AutoForm AutoForm 1159
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertCurvedRightArrow Zeichnen > AutoFormen
> Blockpfeile Nach rechts gekrümmter Pfeil

Drawing >
AutoShapes >
Block Arrows

1160

Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertCurvedLeftArrow Zeichnen > AutoFormen
> Blockpfeile Nach links gekrümmter Pfeil

Drawing >
AutoShapes >
Block Arrows

1161

Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertCurvedUpArrow Zeichnen > AutoFormen
> Blockpfeile Nach oben gekrümmter Pfeil

Drawing >
AutoShapes >
Block Arrows

1162

Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertCurvedDownArrow Zeichnen > AutoFormen
> Blockpfeile Nach unten gekrümmter Pfeil

Drawing >
AutoShapes >
Block Arrows

1163

Legende mit Pfeil nach rechts
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertRightArrowCallout Zeichnen > AutoFormen
> Blockpfeile Legende mit Pfeil nach rechts

Drawing >
AutoShapes >
Block Arrows

1164

Legende mit Pfeil nach links
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertLeftArrowCallout Zeichnen > AutoFormen
> Blockpfeile Legende mit Pfeil nach links

Drawing >
AutoShapes >
Block Arrows

1165

Legende mit Pfeil nach oben
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertUpArrowCallout Zeichnen > AutoFormen
> Blockpfeile Legende mit Pfeil nach oben

Drawing >
AutoShapes >
Block Arrows

1166

Legende mit Pfeil nach unten
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertDownArrowCallout Zeichnen > AutoFormen
> Blockpfeile Legende mit Pfeil nach unten

Drawing >
AutoShapes >
Block Arrows

1167

Legende mit Pfeil nach links und rechts
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertLeftRightArrowCallout Zeichnen > AutoFormen
> Blockpfeile

Legende mit Pfeil nach links
und rechts

Drawing >
AutoShapes >
Block Arrows

1168

Legende mit Pfeil nach oben und unten
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertUpDownArrowCallout Zeichnen > AutoFormen
> Blockpfeile

Legende mit Pfeil nach oben
und unten

Drawing >
AutoShapes >
Block Arrows

1169

Legende mit Pfeil in vier Richtungen
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertQuadArrowCallout Zeichnen > AutoFormen
> Blockpfeile

Legende mit Pfeil in vier
Richtungen

Drawing >
AutoShapes >
Block Arrows

1170

Rechteckige Legende
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertRectangularCallout Zeichnen > AutoFormen
> Legenden Rechteckige Legende

Drawing >
AutoShapes >
Callouts

1172

Abgerundete rechteckige Legende
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertRoundedRectangularCallout Zeichnen > AutoFormen
> Legenden

Abgerundete rechteckige
Legende

Drawing >
AutoShapes >
Callouts

1173

Ovale Legende
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertBalloon Zeichnen > AutoFormen
> Legenden Ovale Legende

Drawing >
AutoShapes >
Callouts

1174

Wolkenförmige Legende
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertCloudCallout Zeichnen > AutoFormen
> Legenden Wolkenförmige Legende

Drawing >
AutoShapes >
Callouts

1175

Legende mit Linie (2)
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertBorderCallout2 Zeichnen > AutoFormen
> Legenden Legende mit Linie (2)

Drawing >
AutoShapes >
Callouts

1176

Legende mit Linie (3)
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertBorderCallout3 Zeichnen > AutoFormen
> Legenden Legende mit Linie (3)

Drawing >
AutoShapes >
Callouts

1177

Legende mit Linie (4)
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertBorderCallout4 Zeichnen > AutoFormen
> Legenden Legende mit Linie (4)

Drawing >
AutoShapes >
Callouts

1178
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ZeichnenEinfügenBand2
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertRibbon2 Zeichnen > AutoFormen
> Sterne und Banner Band nach unten

Drawing >
AutoShapes >
Stars & Banners

1179

ZeichnenEinfügenBand
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertRibbon Zeichnen > AutoFormen
> Sterne und Banner Band nach oben

Drawing >
AutoShapes >
Stars & Banners

1180

Nach unten gekrümmtes Band
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertCurvedDownRibbon Zeichnen > AutoFormen
> Sterne und Banner Nach unten gekrümmtes Band

Drawing >
AutoShapes >
Stars & Banners

1181

Nach oben gekrümmtes Band
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertCurvedUpRibbon Zeichnen > AutoFormen
> Sterne und Banner Nach oben gekrümmtes Band

Drawing >
AutoShapes >
Stars & Banners

1182

Stern mit 5 Zacken
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertStar Zeichnen > AutoFormen
> Sterne und Banner Stern mit 5 Zacken

Drawing >
AutoShapes >
Stars & Banners

1183

Stern mit 8 Zacken
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertSeal8 Zeichnen > AutoFormen
> Sterne und Banner Stern mit 8 Zacken

Drawing >
AutoShapes >
Stars & Banners

1184

Stern mit 16 Zacken
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertSeal16 Zeichnen > AutoFormen
> Sterne und Banner Stern mit 16 Zacken

Drawing >
AutoShapes >
Stars & Banners

1185

Stern mit 24 Zacken
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertSeal24 Zeichnen > AutoFormen
> Sterne und Banner Stern mit 24 Zacken

Drawing >
AutoShapes >
Stars & Banners

1186

Stern mit 32 Zacken
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertSeal32 Zeichnen > AutoFormen
> Sterne und Banner Stern mit 32 Zacken

Drawing >
AutoShapes >
Stars & Banners

1187

Explosion 1
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertExplosion1 Zeichnen > AutoFormen
> Sterne und Banner

Sterne und Banner > Explosion
1

Drawing >
AutoShapes >
Stars & Banners

1188

Explosion 2
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertExplosion2 Zeichnen > AutoFormen
> Sterne und Banner

Sterne und Banner > Explosion
2

Drawing >
AutoShapes >
Stars & Banners

1189

Flussdiagramm: Prozess
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertFlowchartProcess Zeichnen > AutoFormen
> Flussdiagramm Flussdiagramm: Prozess

Drawing >
AutoShapes >
Flowchart

1190

Flussdiagramm: Alternativer Prozess
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertFlowchartAlternateProcess Zeichnen > AutoFormen
> Flussdiagramm

Flussdiagramm: Alternativer
Prozess

Drawing >
AutoShapes >
Flowchart

1191

Flussdiagramm: Verzweigung
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertFlowchartDecision Zeichnen > AutoFormen
> Flussdiagramm Flussdiagramm: Verzweigung

Drawing >
AutoShapes >
Flowchart

1192

Flussdiagramm: Daten
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertFlowchartInputOutput Zeichnen > AutoFormen
> Flussdiagramm Flussdiagramm: Daten

Drawing >
AutoShapes >
Flowchart

1193

Flussdiagramm: Vordefinierter Prozess
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertFlowchartPredefinedProces
s

Zeichnen > AutoFormen
> Flussdiagramm

Flussdiagramm: Vordefinierter
Prozess

Drawing >
AutoShapes >
Flowchart

1194

Flussdiagramm: Zentralspeicher
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertFlowchartOnlineStorage Zeichnen > AutoFormen
> Flussdiagramm

Flussdiagramm:
Zentralspeicher

Drawing >
AutoShapes >
Flowchart

1195

Flussdiagramm: Dokument
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertFlowchartDocument Zeichnen > AutoFormen
> Flussdiagramm Flussdiagramm: Dokument

Drawing >
AutoShapes >
Flowchart

1196

Flussdiagramm: Mehrere Dokumente
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertFlowchartMultidocument Zeichnen > AutoFormen
> Flussdiagramm

Flussdiagramm: Mehrere
Dokumente

Drawing >
AutoShapes >
Flowchart

1197
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Flussdiagramm: Grenzstelle
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertFlowchartTerminator Zeichnen > AutoFormen
> Flussdiagramm Flussdiagramm: Grenzstelle

Drawing >
AutoShapes >
Flowchart

1198

Flussdiagramm: Vorbereitung
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertFlowchartPreparation Zeichnen > AutoFormen
> Flussdiagramm Flussdiagramm: Vorbereitung

Drawing >
AutoShapes >
Flowchart

1199

Flussdiagramm: Manuelle Eingabe
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertFlowchartManualInput Zeichnen > AutoFormen
> Flussdiagramm

Flussdiagramm: Manuelle
Eingabe

Drawing >
AutoShapes >
Flowchart

1200

Flussdiagramm: Manuelle Verarbeitung
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertFlowchartManualOperation Zeichnen > AutoFormen
> Flussdiagramm

Flussdiagramm: Manuelle
Verarbeitung

Drawing >
AutoShapes >
Flowchart

1201

Flussdiagramm: Verbindungsstelle
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertFlowchartConnector Zeichnen > AutoFormen
> Flussdiagramm

Flussdiagramm:
Verbindungsstelle

Drawing >
AutoShapes >
Flowchart

1202

Flussdiagramm: Verbindungsstelle zu einer
anderen Seite

Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertFlowchartOffpageConnector Zeichnen > AutoFormen
> Flussdiagramm

Flussdiagramm:
Verbindungsstelle zu einer
anderen Seite

Drawing >
AutoShapes >
Flowchart

1203

Flussdiagramm: Karte
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertFlowchartPunchedCard Zeichnen > AutoFormen
> Flussdiagramm Flussdiagramm: Karte

Drawing >
AutoShapes >
Flowchart

1204

Flussdiagramm: Lochstreifen
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertFlowchartPunchedTape Zeichnen > AutoFormen
> Flussdiagramm Flussdiagramm: Lochstreifen

Drawing >
AutoShapes >
Flowchart

1205

Flussdiagramm: Zusammenführung
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertFlowchartMerge Zeichnen > AutoFormen
> Flussdiagramm

Flussdiagramm:
Zusammenführung

Drawing >
AutoShapes >
Flowchart

1206

Flussdiagramm: Oder
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertFlowchartOr Zeichnen > AutoFormen
> Flussdiagramm Flussdiagramm: Oder

Drawing >
AutoShapes >
Flowchart

1207

Flussdiagramm: Zusammenstellen
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertFlowchartCollate Zeichnen > AutoFormen
> Flussdiagramm

Flussdiagramm:
Zusammenstellen

Drawing >
AutoShapes >
Flowchart

1208

Flussdiagramm: Sortieren
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertFlowchartSort Zeichnen > AutoFormen
> Flussdiagramm Flussdiagramm: Sortieren

Drawing >
AutoShapes >
Flowchart

1209

Flussdiagramm: Auszug
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertFlowchartExtract Zeichnen > AutoFormen
> Flussdiagramm Flussdiagramm: Auszug

Drawing >
AutoShapes >
Flowchart

1210

Flussdiagramm: Zusammenführen
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertFlowchartSummingJunction Zeichnen > AutoFormen
> Flussdiagramm

Flussdiagramm:
Zusammenführen

Drawing >
AutoShapes >
Flowchart

1211

Flussdiagramm: Gespeicherte Daten
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertFlowchartInternalStorage Zeichnen > AutoFormen
> Flussdiagramm

Flussdiagramm: Gespeicherte
Daten

Drawing >
AutoShapes >
Flowchart

1213

Flussdiagramm: Datenträger mit sequenziellem
Zugriff

Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertFlowchartMagneticTape Zeichnen > AutoFormen
> Flussdiagramm

Flussdiagramm: Datenträger
mit sequenziellem Zugriff

Drawing >
AutoShapes >
Flowchart

1214

Flussdiagramm: Magnetplattenspeicher
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertFlowchartMagneticDisk
DrawInsertFlowchartMagneticDrum

Zeichnen > AutoFormen
> Flussdiagramm

Flussdiagramm:
Magnetplattenspeicher

Drawing >
AutoShapes >
Flowchart

1215

Flussdiagramm: Datenträger mit direktem Zugriff
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertFlowchartOfflineStorage Zeichnen > AutoFormen
> Flussdiagramm

Flussdiagramm: Datenträger
mit direktem Zugriff

Drawing >
AutoShapes >
Flowchart

1216

Flussdiagramm: Anzeige
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertFlowchartDisplay Zeichnen > AutoFormen
> Flussdiagramm Flussdiagramm: Anzeige

Drawing >
AutoShapes >
Flowchart

1217
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Flussdiagramm: Verzögerung
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertFlowchartDelay Zeichnen > AutoFormen
> Flussdiagramm Flussdiagramm: Verzögerung

Drawing >
AutoShapes >
Flowchart

1218

Legende mit Linie (1)
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertBorderCallout1 Zeichnen > AutoFormen
> Legenden Legende mit Linie (1)

Drawing >
AutoShapes >
Callouts

1219

Legende mit Linie (1) (Markierungsleiste)
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertAccentCallout1 Zeichnen > AutoFormen
> Legenden

Legende mit Linie (1)
(Markierungsleiste)

Drawing >
AutoShapes >
Callouts

1220

Legende mit Linie (2) (Markierungsleiste)
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertAccentCallout2 Zeichnen > AutoFormen
> Legenden

Legende mit Linie (2)
(Markierungsleiste)

Drawing >
AutoShapes >
Callouts

1221

Legende mit Linie (3) (Markierungsleiste)
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertAccentCallout3 Zeichnen > AutoFormen
> Legenden

Legende mit Linie (3)
(Markierungsleiste)

Drawing >
AutoShapes >
Callouts

1222

Legende mit Linie (4) (Markierungsleiste)
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertAccentCallout4 Zeichnen > AutoFormen
> Legenden

Legende mit Linie (4)
(Markierungsleiste)

Drawing >
AutoShapes >
Callouts

1223

Legende mit Linie (1)
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertCallout1 Zeichnen > AutoFormen
> Legenden Legende mit Linie (1)

Drawing >
AutoShapes >
Callouts

1224

Legende mit Linie (2)
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertCallout2 Zeichnen > AutoFormen
> Legenden Legende mit Linie (2)

Drawing >
AutoShapes >
Callouts

1225

Legende mit Linie (3)
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertCallout3 Zeichnen > AutoFormen
> Legenden Legende mit Linie (3)

Drawing >
AutoShapes >
Callouts

1226

Legende mit Linie (4)
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertCallout4 Zeichnen > AutoFormen
> Legenden Legende mit Linie (4)

Drawing >
AutoShapes >
Callouts

1227

Legende mit Linie (1) (Rahmen und
Markierungsleiste)

Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertAccentBorderCallout1 Zeichnen > AutoFormen
> Legenden

Legende mit Linie (1) (Rahmen
und Markierungsleiste)

Drawing >
AutoShapes >
Callouts

1228

Legende mit Linie (2) (Rahmen und
Markierungsleiste)

Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertAccentBorderCallout2 Zeichnen > AutoFormen
> Legenden

Legende mit Linie (2) (Rahmen
und Markierungsleiste)

Drawing >
AutoShapes >
Callouts

1229

Legende mit Linie (3) (Rahmen und
Markierungsleiste)

Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertAccentBorderCallout3 Zeichnen > AutoFormen
> Legenden

Legende mit Linie (3) (Rahmen
und Markierungsleiste)

Drawing >
AutoShapes >
Callouts

1230

Form ändern zu Legende mit Linie (4) (Rahmen
und Markierungsleiste)

Form ändern zu Legende mit
Linie (4) (Rahmen und
Markierungsleiste)

1231

Form ändern zu Rechteck Form ändern zu Rechteck 1232
Form ändern zu Parallelogramm Form ändern zu

Parallelogramm 1233
Form ändern zu Trapez Form ändern zu Trapez 1234
Form ändern zu Raute Form ändern zu Raute 1235
Form ändern zu abgerundetem Rechteck Form ändern zu abgerundetem

Rechteck 1236
Form ändern zu Achteck Form ändern zu Achteck 1237
Form ändern zu gleichschenkligem Dreieck Form ändern zu

gleichschenkligem Dreieck 1238

Form ändern zu rechtwinkligem Dreieck Form ändern zu rechtwinkligem
Dreieck 1239

Form ändern zu Oval Form ändern zu Oval 1240
Form ändern zu Sechseck Form ändern zu Sechseck 1241
Form ändern zu Kreuz Form ändern zu Kreuz 1242
Form ändern zu Würfel Form ändern zu Würfel 1243
Form ändern zu Zierrahmen Form ändern zu Zierrahmen 1244
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Form ändern zu regelmäßigem
Fünfeck 1245

Form ändern zu Welle Form ändern zu Welle 1246
Form ändern zu Zylinder Form ändern zu Zylinder 1247
Form ändern zu vertikaler Rolle Form ändern zu vertikaler Rolle 1248
Form ändern zu horizontaler Rolle Form ändern zu horizontaler

Rolle 1249
Form ändern zu gefalteter Ecke Form ändern zu gefalteter Ecke 1250
Form ändern zu Rahmen Form ändern zu Rahmen 1251
Form ändern zu Smiley Form ändern zu Smiley 1252
Form ändern zu Rad Form ändern zu Rad 1253
Form ändern zu "Nein"-Symbol Form ändern zu "Nein"-Symbol 1254
Form ändern zu Halbbogen Form ändern zu Halbbogen 1255
Form ändern zu linker eckiger Klammer Form ändern zu linker eckiger

Klammer 1256

Form ändern zu rechter eckiger Klammer Form ändern zu rechter eckiger
Klammer 1257

Form ändern zu linker geschweifter Klammer Form ändern zu linker
geschweifter Klammer 1258

Form ändern zu rechter geschweifter Klammer Form ändern zu rechter
geschweifter Klammer 1259

Form ändern zu Bogen Form ändern zu Bogen 1260
Form ändern zu Gewitterblitz Form ändern zu Gewitterblitz 1261
Form ändern zu Herz Form ändern zu Herz 1262
Form ändern zu Pfeil nach rechts Form ändern zu Pfeil nach

rechts 1263
Form ändern zu Pfeil nach links Form ändern zu Pfeil nach links 1264
Form ändern zu Pfeil nach oben Form ändern zu Pfeil nach

oben 1265

Form ändern zu Pfeil nach unten Form ändern zu Pfeil nach
unten 1266

Form ändern zu Pfeil nach links und rechts Form ändern zu Pfeil nach links
und rechts 1267

Form ändern zu Pfeil nach oben und unten Form ändern zu Pfeil nach
oben und unten 1268

Form ändern zu Pfeil in vier Richtungen Form ändern zu Pfeil in vier
Richtungen 1269

Form ändern zu Pfeil nach links, rechts und oben Form ändern zu Pfeil nach
links, rechts und oben 1270

Form ändern zu Pfeil nach links und oben Form ändern zu Pfeil nach links
und oben 1271

Form ändern zu nach oben gebogenem Pfeil Form ändern zu nach oben
gebogenem Pfeil 1272

Form ändern zu rechteckigem Pfeil Form ändern zu rechteckigem
Pfeil 1273

Form ändern zu 180 Grad-Pfeil Form ändern zu 180 Grad-Pfeil 1274
Form ändern zu gestreiftem Pfeil nach rechts Form ändern zu gestreiftem

Pfeil nach rechts 1275

Form ändern zu eingekerbtem Pfeil nach rechts Form ändern zu eingekerbtem
Pfeil nach rechts 1276

Form ändern zu Richtungspfeil Form ändern zu Richtungspfeil 1277
Form ändern zu eingekerbtem Richtungspfeil Form ändern zu eingekerbtem

Richtungspfeil 1278

Form ändern zu gebogenem Pfeil Form ändern zu gebogenem
Pfeil 1279

Form ändern zu nach rechts gekrümmtem Pfeil Form ändern zu nach rechts
gekrümmtem Pfeil 1281

Form ändern zu nach links gekrümmtem Pfeil Form ändern zu nach links
gekrümmtem Pfeil 1282

Form ändern zu nach oben gekrümmtem Pfeil Form ändern zu nach oben
gekrümmtem Pfeil 1283

Form ändern zu nach unten gekrümmtem Pfeil Form ändern zu nach unten
gekrümmtem Pfeil 1284

Form ändern zu Legende mit Pfeil nach rechts Form ändern zu Legende mit
Pfeil nach rechts 1285

Form ändern zu Legende mit Pfeil nach links Form ändern zu Legende mit
Pfeil nach links 1286
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Form ändern zu Legende mit Pfeil nach oben Form ändern zu Legende mit
Pfeil nach oben 1287

Form ändern zu Legende mit Pfeil nach unten Form ändern zu Legende mit
Pfeil nach unten 1288

Form ändern zu Legende mit Pfeil nach links und
rechts

Form ändern zu Legende mit
Pfeil nach links und rechts 1289

Form ändern zu Legende mit Pfeil nach oben und
unten

Form ändern zu Legende mit
Pfeil nach oben und unten 1290

Form ändern zu Legende mit Pfeil in vier
Richtungen

Form ändern zu Legende mit
Pfeil in vier Richtungen 1291

Form ändern zu rechteckiger Legende Form ändern zu rechteckiger
Legende 1293

Form ändern zu abgerundeter rechteckiger
Legende

Form ändern zu abgerundeter
rechteckiger Legende 1294

Form ändern zu ovaler Legende Form ändern zu ovaler
Legende 1295

Form ändern zu wolkenförmiger Legende Form ändern zu wolkenförmiger
Legende 1296

Form ändern zu Legende mit Linie (2) Form ändern zu Legende mit
Linie (2) 1297

Form ändern zu Legende mit Linie (3) Form ändern zu Legende mit
Linie (3) 1298

Form ändern zu Legende mit Linie (4) Form ändern zu Legende mit
Linie (4) 1299

Form ändern zu Band nach unten Form ändern zu Band nach
unten 1300

Form ändern zu Band nach oben Form ändern zu Band nach
oben 1301

Form ändern zu nach unten gekrümmtem Band Form ändern zu nach unten
gekrümmtem Band 1302

Form ändern zu nach oben gekrümmtem Band Form ändern zu nach oben
gekrümmtem Band 1303

Form ändern zu Stern mit 5 Ecken Form ändern zu Stern mit 5
Ecken 1304

Form ändern zu Stern mit 8 Ecken Form ändern zu Stern mit 8
Ecken 1305

Form ändern zu Stern mit 16 Ecken Form ändern zu Stern mit 16
Ecken 1306

Form ändern zu Stern mit 24 Ecken Form ändern zu Stern mit 24
Ecken 1307

Form ändern zu Stern mit 32 Ecken Form ändern zu Stern mit 32
Ecken 1308

Form ändern zu Explosion 1 Form ändern zu Explosion 1 1309
Form ändern zu Explosion 2 Form ändern zu Explosion 2 1310
Form ändern zu Flussdiagramm: Prozess Form ändern zu

Flussdiagramm: Prozess 1311

Form ändern zu Flussdiagramm: Alternativer
Prozess

Form ändern zu
Flussdiagramm: Alternativer
Prozess

1312

Form ändern zu Flussdiagramm: Verzweigung Form ändern zu
Flussdiagramm: Verzweigung 1313

Form ändern zu Flussdiagramm: Daten Form ändern zu
Flussdiagramm: Daten 1314

Form ändern zu Flussdiagramm: Vordefinierter
Prozess

Form ändern zu
Flussdiagramm: Vordefinierter
Prozess

1315

Form ändern zu Flussdiagramm: Zentralspeicher
Form ändern zu
Flussdiagramm:
Zentralspeicher

1316

Form ändern zu Flussdiagramm: Dokument Form ändern zu
Flussdiagramm: Dokument 1317

Form ändern zu Flussdiagramm: Mehrere
Dokumente

Form ändern zu
Flussdiagramm: Mehrere
Dokumente

1318

Form ändern zu Flussdiagramm: Grenzstelle Form ändern zu
Flussdiagramm: Grenzstelle 1319

Form ändern zu Flussdiagramm: Vorbereitung Form ändern zu
Flussdiagramm: Vorbereitung 1320
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Form ändern zu Flussdiagramm: Manuelle
Eingabe

Form ändern zu
Flussdiagramm: Manuelle
Eingabe

1321

Form ändern zu Flussdiagramm: Manuelle
Verarbeitung

Form ändern zu
Flussdiagramm: Manuelle
Verarbeitung

1322

Form ändern zu Flussdiagramm:
Verbindungsstelle

Form ändern zu
Flussdiagramm:
Verbindungsstelle

1323

Form ändern zu Flussdiagramm:
Verbindungsstelle zu einer anderen Seite

Form ändern zu
Flussdiagramm:
Verbindungsstelle zu einer
anderen Seite

1324

Form ändern zu Flussdiagramm: Karte Form ändern zu
Flussdiagramm: Karte 1325

Form ändern zu Flussdiagramm: Lochstreifen Form ändern zu
Flussdiagramm: Lochstreifen 1326

Form ändern zu Flussdiagramm:
Zusammenführung

Form ändern zu
Flussdiagramm:
Zusammenführung

1327

Form ändern zu Flussdiagramm: Oder Form ändern zu
Flussdiagramm: Oder 1328

Form ändern zu Flussdiagramm:
Zusammenstellen

Form ändern zu
Flussdiagramm:
Zusammenstellen

1329

Form ändern zu Flussdiagramm: Sortieren Form ändern zu
Flussdiagramm: Sortieren 1330

Form ändern zu Flussdiagramm: Auszug Form ändern zu
Flussdiagramm: Auszug 1331

Form ändern zu Flussdiagramm: Verschmelzen Form ändern zu
Flussdiagramm: Verschmelzen 1333

Form ändern zu Flussdiagramm: Gespeicherte
Daten

Form ändern zu
Flussdiagramm: Gespeicherte
Daten

1334

Form ändern zu Flussdiagramm: Datenträger mit
sequenziellem Zugriff

Form ändern zu
Flussdiagramm: Datenträger
mit sequenziellem Zugriff

1335

Form ändern zu Flussdiagramm:
Magnetplattenspeicher

Form ändern zu
Flussdiagramm:
Magnetplattenspeicher

1336

Form ändern zu Flussdiagramm: Datenträger mit
direktem Zugriff

Form ändern zu
Flussdiagramm: Datenträger
mit direktem Zugriff

1337

Form ändern zu Flussdiagramm: Anzeige Form ändern zu
Flussdiagramm: Anzeige 1338

Form ändern zu Flussdiagramm: Verzögerung Form ändern zu
Flussdiagramm: Verzögerung 1339

Form ändern zu Legende mit Linie (1) Form ändern zu Legende mit
Linie (1) 1340

Form ändern zu Legende mit Linie (1)
(Markierungsleiste)

Form ändern zu Legende mit
Linie (1) (Markierungsleiste) 1341

Form ändern zu Legende mit Linie (2)
(Markierungsleiste)

Form ändern zu Legende mit
Linie (2) (Markierungsleiste) 1342

Form ändern zu Legende mit Linie (3)
(Markierungsleiste)

Form ändern zu Legende mit
Linie (3) (Markierungsleiste) 1343

Form ändern zu Legende mit Linie (4)
(Markierungsleiste)

Form ändern zu Legende mit
Linie (4) (Markierungsleiste) 1344

Form ändern zu Legende mit Linie (1) (ohne
Rahmen)

Form ändern zu Legende mit
Linie (1) (ohne Rahmen) 1345

Form ändern zu Legende mit Linie (2) (ohne
Rahmen)

Form ändern zu Legende mit
Linie (2) (ohne Rahmen) 1346

Form ändern zu Legende mit Linie (3) (ohne
Rahmen)

Form ändern zu Legende mit
Linie (3) (ohne Rahmen) 1347

Form ändern zu Legende mit Linie (4) (ohne
Rahmen)

Form ändern zu Legende mit
Linie (4) (ohne Rahmen) 1348

Form ändern zu Legende mit Linie (1) (Rahmen
und Markierungsleiste)

Form ändern zu Legende mit
Linie (1) (Rahmen und
Markierungsleiste)

1349

Form ändern zu Legende mit Linie (2) (Rahmen
und Markierungsleiste)

Form ändern zu Legende mit
Linie (2) (Rahmen und
Markierungsleiste)

1350
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Form ändern zu Legende mit Linie (3) (Rahmen
und Markierungsleiste)

Form ändern zu Legende mit
Linie (3) (Rahmen und
Markierungsleiste)

1351

Richtet den markierten Text
rechtsbündig aus mit linkem
Flatterrand.

DrawWordArtAlignRight WordArt>Ausrichtung Rechtsbündig WordArt>Alignm
ent 1352

Richtet aus oder erstellt
einen Blocksatz für den
markierten Texteffekt durch
verteilen des Leerraums
zwichen einzelnen Zeichen
und Wörtern.

DrawWordArtAlignLetterJustify WordArt > WordArt-
Ausrichtung Zeichen ausrichten WordArt 1353

Richtet aus oder erstellt
einen Blocksatz durch
Verteilen des Leerraums
zwischen jedem Wort aber
nicht zwischen einzelnen
Zeichen innerhalb eines
Wortes.

DrawWordArtAlignWordJustify WordArt > WordArt-
Ausrichtung Wortausrichtung WordArt 1354

Richtet aus oder erstellt
einen Blocksatz für den
markierten Texteffekt durch
Vergrößern/Verkleinern des
Texts horizontal. Es wird
kein Leerraum zwischen
einzelnen Zeichen oder
Wörter hinzugefügt.

DrawWordArtAlignStretchJustify WordArt > WordArt-
Ausrichtung Streckung ausrichten WordArt 1355

Verschiebt die Zeichen in
Ihrem Texteffekt sehr nahe
zusammen.

DrawWordArtSpacingVeryTight WordArt > WordArt-
Zeichenabstand Sehr eng WordArt 1356

Verschiebt die Zeichen in
Ihrem Texteffekt näher
zusammen.

DrawWordArtSpacingTight WordArt > WordArt-
Zeichenabstand Eng WordArt 1357

Übernimmt den Standard-
Zeichenabstand für Ihren
Texteffekt.

DrawWordArtSpacingNormal WordArt > WordArt-
Zeichenabstand Normal WordArt 1358

Fügt zusätzlichen
Zwischenraum zwischen die
Zeichen in Ihrem Texteffekt
ein.

DrawWordArtSpacingLoose WordArt > WordArt-
Zeichenabstand Weit WordArt 1359

Fügt den maximalen
Zwischenraum zwischen die
Zeichen in Ihrem Texteffekt
ein.

DrawWordArtSpacingVeryLoose WordArt > WordArt-
Zeichenabstand Sehr weit WordArt 1360

Passt automatisch die
Unterschneidung an, oder
die Menge des Leerraums
zwischen bestimmten
Zeichenkombinationen,
sodass der Zeichenabstand
im gesamten Wort
gleichmäßiger aussieht.

DrawWordArtStretchToFill WordArt > WordArt-
Zeichenabstand Zeichenpaare unterschneiden WordArt 1361

ZeichnungGrafikZurücksetzen

Entfernt die Zuschneidung
der markierten Grafik und
stellt die Farbe, Helligkeit
und Kontrast zurück zu den
Orginaleinstellungen.

DrawPictureReset Grafik Grafik zurücksetzen Picture 1362

Fügt die markierte Grafik in
den Text des aktuellen
Absatzes ein, wo es sich
wie normaler Text verhält.

DrawPictureInline Eingebettete Grafik 1363

Konvetiert die markierte
Grafik zurück zu den
ursprünglichen Farben und
Kontrast.

DrawPictureAutomatic Grafik > Grafik
zurücksetzen Automatisch Picture 1365

Konvertiert die markierte
Grafik zu einem
Graustufenbild.

DrawPictureGrayscale Grafik > Grafik
zurücksetzen Graustufe Picture 1366

Konvertiert die markierte
Grafik zu einem
Schwarzweißbild, auch
bekannt als Liniengrafik.

DrawPictureBlackAndWhite Grafik > Grafik
zurücksetzen Schwarzweiß Picture 1367

Konvertiert die Grafik zu
einem hellen, niedrigen
Kontrastbild.

DrawPictureWatermark Grafik > Grafik
zurücksetzen Wasserzeichen Picture 1368
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FormatZeichenObjektUmbruchRechteck
Setzt die markierten
Zeichnungsobjekte auf
"Umbruch Rechteck"

FormatDrawingObjectWrapSquare
Changes the
selected drawing
objects to square
wrapping

Zeichnen
WordArt
Textfluss
Kontext

Quadrat
Drawing
WordArt
Text Wrapping
Context

1369 4088

FormatZeichenObjektUmbruchGenau
Ändert den Umbruch der
markierten
Zeichnungsobjekte auf
"passend"

FormatDrawingObjectWrapTight
Changes the
selected drawing
objects to tight
wrapping

Zeichnen
WordArt
Textfluss
Kontext

Passend
Drawing
WordArt
Text Wrapping
Context

1370 4089

FormatZeichenObjektUmbruchOhne
Setzt die markierten
Zeichnungsobjekte auf
"Kein Umbruch"

FormatDrawingObjectWrapNone
Changes the
selected drawing
objects to no
wrapping

Ohne 1371 4091

BearbeitenUmbruchGrenze
Umbruchsgrenze für eine
Grafik oder ein
Zeichnungselement
bearbeiten

WordBasic.EditWrapBoundary EditWrapBoundary
Edit the wrapping
boundary for a
picture or drawing
object

Zeichnen
WordArt
Textfluss
Kontext

Rahmenpunkte bearbeiten
Drawing
WordArt
Text Wrapping
Context

1372 995

Schaltet die 3D-
Formatierung für das
markierte Objekt ein und
verwendet die Standard 3D-
Einstellungen oder schaltet
die 3D-Formatierung aus.

Draw3DToggle 3D-Einstellungen 3D ein/aus 3-D Settings 1374

Dreht den 3D-Effekt um 6
Grad um eine horizontale
Achse.

Draw3DTiltDown 3D-Einstellungen Nach unten kippen 3-D Settings 1375

Dreht den 3D-Effekt um 6
Grad um eine horizontale
Achse.

Draw3DTiltUp 3D-Einstellungen Nach oben kippen 3-D Settings 1376

Dreht den 3D-Effekt um 6
Grad nach links um eine
vertikale Achse.

Draw3DTiltLeft 3D-Einstellungen Nach links kippen 3-D Settings 1377

Dreht den 3D-Effekt um 6
Grad nach rechts um eine
vertikale Achse.

Draw3DTiltRight 3D-Einstellungen Nach rechts kippen 3-D Settings 1378

Tiefe ButtonPopup 3D-Einstellungen Tiefe 3-D Settings 1379
Richtung ButtonPopup 3D-Einstellungen Richtung 3-D Settings 1380
Beleuchtung ButtonPopup 3D-Einstellungen Beleuchtung 3-D Settings 1382
Oberfläche ButtonPopup 3D-Einstellungen Oberfläche 3-D Settings 1383

Setzt die Tiefe des 3D-
Effekts auf dem markierten
Objekt auf null.

Draw3DDepth0 3D-Einstellungen >
Tiefe 0 pt. 3-D Settings 1384

Setzt die Tiefe des 3D-
Effekts auf dem markierten
Objekt auf 36 Punkte (oder
0,5 Zoll).

Draw3DDepth1 3D-Einstellungen >
Tiefe 36 pt. 3-D Settings 1385

Setzt die Tiefe des 3D-
Effekts auf dem markierten
Objekt auf 72 Punkte (oder
1 Zoll).

Draw3DDepth2 3D-Einstellungen >
Tiefe 72 pt. 3-D Settings 1386

Setzt die Tiefe des 3D-
Effekts auf dem markierten
Objekt auf 144 Punkte (oder
2 Zoll).

Draw3DDepth3 3D-Einstellungen >
Tiefe 144 pt. 3-D Settings 1387

Setzt die Tiefe des 3D-
Effekts auf dem markierten
Objekt auf 288 Punkte (oder
4 Zoll).

Draw3DDepth4 3D-Einstellungen >
Tiefe 288 pt. 3-D Settings 1388

Setzt die Tiefe des 3D-
Effekts auf unendlich. Draw3DDepthInfinite 3D-Einstellungen >

Tiefe Unendlich 3-D Settings 1389

Erweitert den 3D-Effekt in
die Richtung eines
einzelnen Punktes.

Draw3DPerspective 3D-Einstellungen >
Richtung Perspektive 3-D Settings 1390

Erweitert alle Seiten des
3D-Effekts parallel
zueinander.

Draw3DParallel 3D-Einstellungen >
Richtung Parallel 3-D Settings 1391

Helle Belichtung fügt am
meisten Weiß zur Farbe
oder Schatten des 3D-
Effekts auf dem markierten
Objekt hinzu.

3D-Einstellungen >
Beleuchtung Hell 3-D Settings 1392
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Normale Belichtung fügt
durchschnittlich viel Weiß
zur Farbe oder Schatten
des 3D-Effekts auf dem
markierten Objekt hinzu.

Draw3DLightingNormal 3D-Einstellungen >
Beleuchtung Normal 3-D Settings 1393

Abgeschwächte Belichtung
fügt am wenigsten Weiß zur
Farbe oder Schatten des
3D-Effekts auf dem
markierten Objekt hinzu.

3D-Einstellungen >
Beleuchtung Abblenden 3-D Settings 1394

Lässt die Oberfläche des
markierten Objekts matt
erscheinen.

Draw3DSurfaceMatte 3D-Einstellungen >
Oberfläche Matt 3-D Settings 1395

Lässt die Oberfläche des
markierten Objekts wie
Plastik erscheinen.

Draw3DSurfacePlastic 3D-Einstellungen >
Oberfläche Plastik 3-D Settings 1396

Lässt die Oberfläche des
markierten Objekts poliert
erscheinen.

Draw3DSurfaceMetal 3D-Einstellungen >
Oberfläche Metall 3-D Settings 1398

Entfernt alle Oberlächen
vom markierten Objekt und
zeigt nur die darunter
liegende Struktur an.

Draw3DWireFrame 3D-Einstellungen >
Oberfläche Drahtrahmen 1399

Wechselt zum
Textbearbeitungsmodus,
um Text der markierten
AutoForm hinzuzufügen.

Kontext
(Zeichnen.Formen) Text bearbeiten 1401

Bildsteuerung ButtonPopup Grafik Bildsteuerung
Farbe Picture 1403

Textfluss ButtonPopup
Zeichnen > Zeichnen
WordArt
Grafik

Textfluss
Drawing
WordArt
Picture

1404

Standardformen ButtonPopup Zeichnen > Zeichnen >
AutoForm ändern Standardformen 1405

Legende ButtonPopup Zeichnen > Zeichnen >
AutoForm ändern

Legende
Legenden 1406

Flussdiagramm ButtonPopup Zeichnen > Zeichnen >
AutoForm ändern Flussdiagramm 1407

Blockpfeile ButtonPopup Zeichnen > Zeichnen >
AutoForm ändern Blockpfeile 1408

Sterne und Banner ButtonPopup Zeichnen > Zeichnen >
AutoForm ändern Sterne und Banner 1409

Schalten dei WordArt-
Symbolleiste ein und aus. Kontext (WordArt) WordArt-Symbolleiste anzeigen 1410

Schaltet den Frei-Drehen-
Modus aus.

Kontext
(Zeichnen.Drehungsmod
us)

Rotationsmodus beenden 1412

Schaltet die Symbolleiste
für Grafik ein und aus. DrawTogglePictureToolbar

Kontext (Unverankerte
Grafik, Eingebettete
Grafik, OLE-Objekt)

Grafiksymbolleiste anzeigen
Context (Floating
Picture, Inline
Picture, OLE
Object)

1413

Punkt hinzufügen
Fügt einen neuen
Scheitelpunkt einer
gekrümmten Linie hinzu.
Klicken Sie mit der rechten
Maustaste auf einen Punkt
auf der Linie.

DrawPointAdd
Zeichnen.Kurvenpunkt,
Zeichnen.Kurvenabschni
tt

Punkt hinzufügen Curve Node,
Curve Segment 1415

Punkt löschen
Entfernt den markierten
Scheitelpunkt vond er
gekrümmten Linie und
verbindet die Linie zwischen
den zwei benachbarten
Scheitelpunkten.

DrawPointDelete Zeichnen.Kurvenpunkt Punkt löschen Curve Node 1416

Geglätteter Abschnitt
Ändert den markierten
gekrümmten Abschnitt zu
einem glatten Abschnitt.

DrawSegmentStraight Zeichnen.Kurvenabschni
tt Geglätteter Abschnitt Curve Segment 1417
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Gekrümmter Abschnitt
Ändert den markierten
geraden Abschnitt in einen
gekrümmten Abschnitt.

DrawSegmentCurved Zeichnen.Kurvenabschni
tt Gekrümmter Abschnitt Curve Segment 1418

Vervollständigt eine offene
Kurve durch Hinzufügen
eine Abschnitts, das den
ersten und letzten Punkt
verbindet.

Zeichnen.Kurve,
Zeichnen.Kurvenpunkt,
Zeichnen.Kurvenabschni
tt

Kurve schließen
Curve, Curve
Node, Curve
Segment

1420

AutoPunkt
Tangentenlinien werden
automatisch berechnet und
Tangentenpunkte oder -
linien sind nicht sichtbar.

DrawPointAuto Zeichnen.Kurvenpunkt AutoPunkt Curve Node 1421

Übergangspunkt
Beide Tangentenpunkte
haben immer denselben
Abstand vom Originalpunkt
und sind immer 180 Grad
voneinander entfernt.

DrawPointStraight Zeichnen.Kurvenpunkt Übergangspunkt Curve Node 1422

Punkt glätten
Tangenten behalten ihren
180 Gradwinkel bei, aber
die Länge jeder Tangente
kann unabhängig
voneinander geändert
werden.

DrawPointSmooth Zeichnen.Kurvenpunkt Punkt glätten Curve Node 1423

Eckpunkt
Die Länge und der Winkel
zwischen zwei Tangenten
sind unabhängig.

DrawPointCorner Zeichnen.Kurvenpunkt Eckpunkt Curve Node 1424

Schalted den Punkt- und
Eigenschaten-
Bearbeitungsmodus für
Kurven aus.

Zeichnen.Kurvenpunkt,
Zeichnen.Kurvenabschni
tt

Punktbearbeitung beenden Curve Node,
Curve Segment 1425

ZeichnungEbenenUmstellen
Wechselt zwischen der
Positionierung des Objekts
im Vorder- oder Hintergrund

??? DrawToggleLayer

Switches whether
the drawing object
appears in the
front of or behind
the text

Hinter den Text bringen 1427 556,
468?

ExtrasDokumentschutzAufheben
Hebt den Dokumentschutz
für das aktive Dokument
auf.

Dialogs(wdDialogToolsUnprotectDocument).Show ToolsUnprotectDocument Dokumentschutz aufheben 1439 521

FormatGrafik
Ändert die
Grafikinformationen für
Skalierung, Größe und
Zuschnitt.

Dialogs(wdDialogFormatPicture).Show FormatPicture
Changes the
picture scaling,
size, and cropping
information

Grafik formatieren... 1440 187

WordArt-Form.Textumschläge WordArt > WordArt-
Form Textumschläge WordArt 1447

Strichart.Stricharten Zeichnen > Strichart Stricharten Drawing 1448
Pfeilart.Pfeilarten Zeichnen > Pfeilart Pfeilarten Drawing 1449

Füllfarbe.Keine Farbe Zeichnen > Füllfarbe Keine Farbe Drawing > Fill
Color 1453

Füllfarbe.Standardfarben Zeichnen > Füllfarbe Standardfarben Drawing > Fill
Color 1456

Füllfarbe.Zuletzt genutzte Farben Zeichnen > Füllfarbe Zuletzt genutzte Farben Drawing > Fill
Color 1457

Linienfarbe.Keine Farbe Zeichnen > Linienfarbe Keine Farbe Drawing > Line
Color 1458

Linienfarbe.Standardfarben Zeichnen > Linienfarbe Standardfarben Drawing > Line
Color 1461

Linienfarbe.Zuletzt genutzte Farben Zeichnen > Linienfarbe Zuletzt genutzte Farben Drawing > Line
Color 1462

Schatten.Keine Farbe Zeichnen > Schatten Keine Farbe Drawing 1463

Schattenfarbe.Standardfarben Schatteneinstellungen >
Schattenfarbe Standardfarben Shadow Settings 1466

Schattenfarbe.Zuletzt genutzte Farben Schatteneinstellungen >
Schattenfarbe Zuletzt genutzte Farben Shadow Settings 1467

3D.Keine Farbe Zeichnen > 3D Keine Farbe Drawing 1468
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Automatische Farbe 3D-Einstellungen > 3D-
Farbe Automatische Farbe 3-D Settings 1469

Standardfarben 3D-Einstellungen > 3D-
Farbe Standardfarben 3-D Settings 1471

Zuletzt genutzte Farben 3D-Einstellungen > 3D-
Farbe Zuletzt genutzte Farben 3-D Settings 1472

3D-Einstellungen >
Beleuchtung Beleuchtungsrichtung 3-D Settings 1473

3D-Einstellungen >
Richtung Extrusionsrichtung 3-D Settings 1521

Aktiviert die markierte Grafik
zum Bearbeiten. DrawEditPicture Unverankerte Grafik Grafik bearbeiten Floating Picture 1540

EinfügenFeldSeite Fügt ein Feld für die
Seitenzahl ein. Selection.Fields.Add Range:=Selection.Range, Type:=wdFieldPage InsertPageField Inserts a page

number field Kopf- und Fußzeile Seitenzahlen
Alt+Umschalt+P

Header and
Footer Alt+Shift+P 1554 239

AnsichtCode Code für markiertes
Steuerelement anzeigen ActiveDocument.ViewCode ViewCode View Code for

Selected Control
Steuerelement-Toolbox
Kontext Code anzeigen Control Toolbox

Context 1561 878

Linienart.Linienstärke Zeichnen > Linienart
Grafik > Linienart Linienstärke Drawing

Picture 1563

EinfügenOfficeZeichnung Fügt ein Microsoft Draw 8.0-
Objekt ein WordBasic.InsertOfficeDrawing InsertOfficeDrawing Inserts a Microsoft

Draw 8.0 object Einfügen > Grafik Neue Zeichnung 1571 815

Anpassen: Tiefe Anpassen: 3D-Einstellungen >
Tiefe Anpassen: 3-D Settings 1572

WebÖffnenInNeuemFenster In neuem Fenster öffnen WordBasic.WebOpenInNewWindow WebOpenInNewWindow Open in New
Window Kontext In neuem Fenster öffnen Context 1574 922

WebKopierenHyperlink Shortcut kopieren Selection.Range.Hyperlinks(1).Range.Fields(1).Result.Select
Selection.Copy WebCopyHyperlink Copy Shortcut Kontext Hyperlink kopieren Context 1575 923

EinfügenHyperlink Hyperlink einfügen Dialogs(wdDialogInsertHyperlink).Show InsertHyperlink Insert Hyperlink
Einfügen
Standard
E-Mail senden

Hyperlink…
Strg+K

Insert
Standard
Send Mail

Ctrl+K 1576 925

BearbeitenHyperlink Hyperlink bearbeiten Selection.ShapeRange.Hyperlink.Delete EditHyperlink Edit Hyperlink Kontext Hyperlink bearbeiten... Context 1577 926
WebMarkierenHyperlink Text bearbeiten Selection.Range.Hyperlinks(1).Range.Fields(1).Result.Select WebSelectHyperlink Edit Text Kontext Hyperlink uswählen Context 1578 927

EinfügenAnmerkung Kommentar einfügen Selection.Comments.Add Range:=Selection.Range InsertAnnotation Insert comment Einfügen
Überarbeiten

Kommentar
Alt+Strg+M

Insert
Reviewing

Alt+Ctrl+M (or Alt
I, M) 1589 161

GeheZuVorherigemKommentar
Springt zum vorherigen
Kommentar im aktiven
Dokument

Selection.GoToPrevious wdGoToComment GoToPreviousComment
Jumps to the
previous comment
in the active
document

Überarbeiten Vorheriger Kommentar Reviewing 1590 413

GeheZuNächstemKommentar
Springt zum nächsten
Kommentar im aktiven
Dokument

Selection.GoToNext wdGoToComment GoToNextComment
Jumps to the next
comment in the
active document

Überarbeiten Nächster Kommentar Reviewing 1591 412

LöschenAnmerkung Kommentar löschen Selection.Comments(1).Delete DeleteAnnotation Delete comment Kommentar
Überarbeiten Kommentar löschen Comment

Reviewing 1592 973

AnsichtAnmerkungen

Öffnet die
Markiersprechblase für
Kommentare (ein/aus)
Öffnet den
Anmerkungsausschnitt zum
Lesen der Anmerkungen
(ein/aus).

ActiveWindow.View.SplitSpecial = wdPaneComments ViewAnnotations
Show or hide
comment markup
balloons

Ansicht Kommentare View (Comments) Hover over
comment 1594 157

UmschaltenFormularDesign Aktiviert Formular Design ActiveDocument.ToggleFormsDesign ToggleFormsDesign Enables Form
Design

Steuerelement-Toolbox
Visual Basic Entwurfsmodus Control Toolbox

Visual Basic 1605 873

Öffnet das Dialogfeld
'WordArt Gallery', in dem
Sie einen anderen WordArt-
Stil für das markierte
WordArt-Objekt auswählen
können.

WordArt WordArt-Katalog WordArt 1606

FormularFeldOptionen Ändert die Optionen für ein
Formularfeld. Dialogs(wdDialogFormFieldOptions).Show FormFieldOptions

Changes the
options for a form
field

Formular
Kontext Eigenschaften Forms

Context 1607 353

DateiSeitenansichtGanzerBildschirm
Blendet die Menü-,
Bearbeitungs- und
Statusleisten ein und aus.

ActiveWindow.View.FullScreen = Not
ActiveWindow.View.FullScreen FilePrintPreviewFullScreen Toggles full screen Seitenansicht Ganzer Bildschirm Print Preview 1612 516

Anpassen: WordArt > WordArt-
Zeichenabstand Anpassen: WordArt 1621

AutoBildlauf Startet den Bildlauf im
aktiven Dokument WordBasic.AutoScroll AutoScroll Starts scrolling the

active document
AutoBildlauf
(Mausrad einmal drücken) 1626 994
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UmschaltenZentralFilialdokumente
Schaltet zwischen
Hyperlinks und
Filialdokumenten hin und
her

ActiveDocument.Subdocuments.Expanded = Not
ActiveDocument.Subdocuments. _
Expanded

ToggleMasterSubdocs
Switches between
hyperlinks and
subdocuments

Gliederung
Filialdokumente reduzieren
Unterdokumente reduzieren
Filialdokumente erweitern
Alt+Strg+\

Outlining toolbar 1633 884

ZeichnenDoppelpfeilEinfügen
Zeichnet einen Doppelpfeil
an der Stelle, auf der Sie im
aktiven Fenster klicken oder
ziehen.

DrawInsertDoubleArrow Zeichnen > AutoFormen
> Linien Doppelpfeil

Drawing
Drawing >
AutoShapes >
Lines

1639

Füllfarbe Zeichnen Füllfarbe Drawing 1691
FormatLinieFarbe WordBasic.FormatLineColor FormatLineColor Zeichnen Linienfarbe Drawing 1692 5725
Schattenfarbe Schatteneinstellungen Schattenfarbe Shadow Settings 1693
3D-Farbe 3D-Einstellungen 3D-Farbe 3-D Settings 1694

AnsichtVBCode Zeigt die VB-
Bearbeitungsplattform an ShowVisualBasicEditor = True ViewVBCode

Shows the VB
editing
environment

Extras > Makro
Visual Basic

Visual Basic-Editor
Alt+F11

Visual Basic
Tools Alt+F11 1695 948

BearbeitenHerausgebenOptionen Dialogs(wdDialogEditPublishOptions).Show EditPublishOptions Verlegeroptionen... 1697 735
BearbeitenAbonnierenOptionen Dialogs(wdDialogEditSubscribeOptions).Show EditSubscribeOptions Abonnentoptionen... 1698 736

RahmenAlle Ändert alle Rahmen der
markierten Tabellenzellen WordBasic.BorderAll BorderAll

Changes all the
borders of the
selected table
cells

Format > Rahmen
Tabellen und Rahmen >
Rahmen
Rahmen

Alle Rahmenlinien
Formatting
Tables and
Borders
Borders

1704 977

MenüFormatHintergrund Format Hintergrund-
Untermenü ButtonPopup MenuFormatBackground Format > Hintergrund Hintergrund 1706 5762

SendenAnFax Dokument an Fax senden Application.SendFax SendToFax Send this
document to fax

Datei-Menü > Senden
an Faxempfänger... File 1707 940

ExtrasAutoZusammenfassen
Erstellt automatisch eine
Zusammenfassung des
aktuellen Dokuments

ActiveDocument.AutoSummarize ToolsAutoSummarize
Automatically
generates a
summary of the
active document

Extras AutoZusammenfassen... Tools 1709 905

DateiSpeichernVersion Speichert eine Kopie des
Dokuments Dialogs(wdDialogFileSaveVersion).Show FileSaveVersion

Saves a new
version of a
document

Überarbeiten Version speichern... Reviewing 1713 1007

AnsichtDokumentStruktur
Schaltet zwischen
Einstellungen des Titel
Explorers hin und her

ViewDocumentMap
Toggles state of
the Heading
Explorer

Ansicht
Standard
Nachricht lesen
Outlook-E-Mail lesen
E-Mail senden

Dokumentstruktur View and
Standard 1714 944

ExtrasÜberarbeitungsmarkierungenAnnehmen Nimmt die Änderung in der
aktuellen Markierung an. Selection.Range.Revisions.AcceptAll ToolsRevisionMarksAccept Accepts change in

current selection.
Überarbeiten
Änderungen
nachverfolgen

Änderungen annehmen Reviewing
Track Changes 1715 942

ExtrasÜberarbeitungsmarkierungenAblehnen Änderung in der aktuellen
Markierung ablehnen. Selection.Range.Revisions.RejectAll ToolsRevisionMarksReject Rejects change in

current selection.
Überarbeiten
Änderungen
nachverfolgen

Änderungen ablehnen Reviewing
Track Changes 1716 943

ExtrasLexiRomNachschlagenVerweis
Schlägt einen Verweis für
das ausgewählte Wort in
Microsoft Bookshelf oder
LexiRom nach

ToolsBookshelfLookupReference

Looks up a
reference for the
selected word in
Microsoft
Bookshelf

Extras Referenz nachschlagen... 1720 957

ExtrasLexiRomDefinierenVerweis
Schlägt eine Definition für
das markierte Wort in
Microsoft Bookshelf oder
LexiRom nach

ToolsBookshelfDefineReference

Looks up a
definition for the
selected word in
Microsoft
Bookshelf

Kontext Definieren 1721 958

DateiMacBenutzerSeiteEinrichtenGX Dialogs(wdDialogFileMacCustomPageSetupGX).Show FileMacCustomPageSetupGX Seite einrichten... 1722
DateiDruckenEineKopie Dialogs(wdDialogFilePrintOneCopy).Show FilePrintOneCopy 1723

RahmenlinienArt
Ändert die Rahmenart der
markierten Absätze,
Tabellenzellen und
Grafiken.

BorderLineStyle

Changes border
line s of the
selected
paragraphs, table
cells, and pictures

Tabellen und Rahmen Linienart Tables and
Borders 1724 451

AutoZusammenfassenSchließen
Schaltet Ansicht
"AutoZusammenfassung"
aus

ActiveDocument.ShowSummary = False AutoSummarizeClose
Turns
AutoSummarize
view off

AutoZusammenfassen Schließen AutoSummarize 1726 906

DateiMacSeiteEinrichten Dialogs(wdDialogFileMacPageSetup).Show FileMacPageSetup Seite einrichten... 1727 685
Schriftart Ändert die Schriftart des

markierten Textteils. WordBasic.Font Font Changes the font
of the selection Format Schriftart:

Strg+Umschalt+A Formatting Ctrl+Shift+F 1728 42

EinblendenDetails Zeigt die Details der
markierten Adresse an WordBasic.DisplayDetails DisplayDetails

Displays the
Details of the
selected address

Kontext Wer ist... Context 1729 901
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SeriendruckGeheZuDatensatz
Zeigt den angegebenen
Datensatz in der aktuellen
Seriendruck-Datenquelle.

MailMergeGoToRecord
Displays the
specified record in
the active mail
merge data source

Seriendruck Aufzeichnen: Mail Merge 1730 482

SchriftgradAuswahl Ändert den Schriftgrad des
markierten Textteils. WordBasic.FontSizeSelect FontSizeSelect

Changes the font
size of the
selection

Format Schriftgrad:
Strg+Umschalt+P Formatting Ctrl+Shift+P 1731 43

Formatvorlage

Weist eine bestehende
Formatvorlage zu, oder
zeichnet eine
Formatvorlage
entsprechend dem Beispiel
auf.

WordBasic.Style Style
Applies an existing
style or records a
style by example

Format Formatvorlage:
Strg+Umschalt+S Formatting Strl+Shift+S 1732 151

(Zoom-Dropdown)
Skaliert die
Bearbeitungsansicht
Vergrößert oder verkleinert
die Bearbeitungsansicht.

??? ??? Zoom: 1733

SchattierungsMuster

Ändert das
Schattierungsmuster
markierter Absätze,
Tabellenzellen oder
Grafiken.

ShadingPattern

Changes shading
pattern of the
selected
paragraphs, table
cells, and pictures

Schattierung: 1738 452

(Hyperlink-Dropdown) Hyperlink-Adresse Web Adresse: Web 1740

MailNachrichtenkopfEinAusblenden
Zeigt den Kopf einer
Nachricht bei der
Verwendung von Word als
E-Mail Editor an (ein/aus)

WordBasic.MailHideMessageHeader MailHideMessageHeader
Shows/hides the
mail message
header for Word
as Email editor

E-Mail senden
Nachricht lesen Kopfzeilen erweitern/reduzieren Send Mail

Read Mail 1751 763

EinfügenImagerScan Fügt ein Microsoft Photo
Editor-Objekt ein WordBasic.InsertPhotoEditorScan InsertPhotoEditorScan

Inserts a Microsoft
Photo Editor
object

Einfügen > Grafik Von Scanner oder Kamera... 1764

RahmenHoriz
Ändert die horizontalen
Rahmenlinien der
markierten Tabellenzellen

With Selection.Borders(wdBorderHorizontal)
.LineStyle = Options.DefaultBorderLineStyle
.LineWidth = Options.DefaultBorderLineWidth
.Color = Options.DefaultBorderColor

End With

BorderHoriz
Changes the
horizontal borders
of the selected
table cells

Format > Rahmen
Tabellen und Rahmen >
Rahmen
Rahmen

Innere horizontale Rahmenlinie
Formatting
Tables and
Borders
Borders

1840 962

RahmenVert
Ändert die vertikalen
Rahmenlinien der
markierten Tabellenzellen

With Selection.Borders(wdBorderVertical)
.LineStyle = Options.DefaultBorderLineStyle
.LineWidth = Options.DefaultBorderLineWidth
.Color = Options.DefaultBorderColor

End With

BorderVert
Changes the
vertical borders of
the selected table
cells

Format > Rahmen
Tabellen und Rahmen >
Rahmen
Rahmen

Innere vertikale Rahmenlinie
Formatting
Tables and
Borders
Borders

1841 963

RahmenOLNachUR
Ändert die markierten
Tabellenzellen diagonal von
links oben nach rechts
unten

With Selection.Borders(wdBorderDiagonalDown)
.LineStyle = Options.DefaultBorderLineStyle
.LineWidth = Options.DefaultBorderLineWidth
.Color = Options.DefaultBorderColor

End With

BorderTLtoBR

Changes the top
left to bottom right
diagonal of the
selected table
cells

Format > Rahmen
Tabellen und Rahmen >
Rahmen
Rahmen

Rahmenlinien diagonal nach
unten

Formatting
Tables and
Borders
Borders

1842 788

RahmenORNachUL
Ändert die markierten
Tabellenzellen diagonal von
rechts oben nach links
unten

With Selection.Borders(wdBorderDiagonalUp)
.LineStyle = Options.DefaultBorderLineStyle
.LineWidth = Options.DefaultBorderLineWidth
.Color = Options.DefaultBorderColor

End With

BorderTRtoBL

Changes the top
right to bottom left
diagonal of the
selected table
cells

Format > Rahmen
Tabellen und Rahmen >
Rahmen
Rahmen

Rahmenlinien diagonal nach
oben

Formatting
Tables and
Borders
Borders

1843 789

LnrAbsatz Schaltet Absatzausrichtung
auf LNR Selection.LtrPara LtrPara Set paragraph

orientation to LTR Format Von links nach rechts Formatting 1846 1054

RnlAbsatz Schaltet Absatzausrichtung
auf RNL Selection.RtlPara RtlPara Set paragraph

orientation to RTL Format Von rechts nach links Formatting 1847 1055

EinfügenOCXSteuerelement Fügt ein Kontrollkästchen-
Steuerelement ein WordBasic.InsertOCXCheckbox InsertOCXCheckbox Inserts a

Checkbox Control Steuerelement-Toolbox Kontrollkästchen Control Toolbox 1848 7077

EinfügenOCXTextfeld Fügt ein Textfeld-
Steuerelement ein WordBasic.InsertOCXTextBox InsertOCXTextBox Inserts a Text Box

Control Steuerelement-Toolbox Textfeld Control Toolbox 1850 7081

EinfügenOCXSchaltfläche Fügt ein Schaltflächen-
Steuerelement ein WordBasic.InsertOCXButton InsertOCXButton Inserts a Button

Control Steuerelement-Toolbox Befehlsschaltfläche Control Toolbox 1851 7082

EinfügenOCXOptionenSchaltfläche Fügt ein Optionsfeld-
Steuerelement ein WordBasic.InsertOCXOptionButton InsertOCXOptionButton

Inserts a
RadioButton
Control

Steuerelement-Toolbox Optionsfeld Control Toolbox 1852 7083

EinfügenOCXListenfeld Fügt ein Listenfeld-
Steuerelement ein WordBasic.InsertOCXListBox InsertOCXListBox Inserts a Listbox

Control Steuerelement-Toolbox Listenfeld Control Toolbox 1853 7084

EinfügenOCXDropdownKombinationsfeld Fügt ein Kombinationsfeld-
Steuerelement ein WordBasic.InsertOCXDropdownCombo InsertOCXDropdownCombo Inserts a

Combobox Control Steuerelement-Toolbox Kombinationsfeld Control Toolbox 1854 7085

EinfügenOCXUmschaltSchaltfläche Fügt ein E/A-Schaltflächen-
Steuerelement ein WordBasic.InsertOCXToggleButton InsertOCXToggleButton Inserts a Toggle

Button Control Steuerelement-Toolbox Umschaltfläche Control Toolbox 1855 7086

EinfügenOCXDrehelement Fügt ein Drehfeld-
Steuerelement ein WordBasic.InsertOCXSpin InsertOCXSpin Inserts a Spin

Control Steuerelement-Toolbox Drehfeld Control Toolbox 1856 7078

EinfügenOCXBildlaufleiste Fügt ein Bildlaufleisten-
Steuerelement ein WordBasic.InsertOCXScrollbar InsertOCXScrollbar Inserts a Scrollbar

Control Steuerelement-Toolbox Bildlaufleiste Control Toolbox 1857 7079
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EinfügenOCXKategorie Fügt ein Kategorie-
Steuerelement ein WordBasic.InsertOCXLabel InsertOCXLabel Inserts a Label

Control Steuerelement-Toolbox Bezeichnung Control Toolbox 1858 7080
Schaltet den
halbtransparenten Schatten
ein und aus.

DrawShadowSemiTransparentToggle Schatteneinstellungen >
Schattenfarbe Halbtransparenter Schatten Shadow Settings 1859

WebÖffnenSuchenSeite Suchseite öffnen WordBasic.WebOpenSearchPage WebOpenSearchPage Open Search
Page Web Im Web suchen Web 1922 968

control on 401 Ändert die Farbe des
markierten Textes

Format > Zeichen
Format
Zeichnen

Schriftfarbe > Automatische
Farbe

Format > Font
Formatting
Drawing

1926

control on 401 Ändert die Farbe des
markierten Textes

Format > Zeichen
Format
Zeichnen

Schriftfarbe > Farbe
Format > Font
Formatting
Drawing

1928

ObjektUmwandeln Konvertiert oder aktiviert ein
Objekt als neuen Objekttyp Dialogs(wdDialogConvertObject).Show ConvertObject

Converts or
activates an object
as another type

Umwandeln...
Konvertieren... 1967 392

ExtrasÜberarbeitungsmarkierungenUmschalten
Schaltet Überarbeitungen
für das aktive Dokument ein
oder aus

ActiveDocument.TrackRevisions = Not
ActiveDocument.TrackRevisions ToolsRevisionMarksToggle

Toggles track
changes for the
active document

Überarbeiten
Änderungen
nachverfolgen
Überarbeitungsanzeige

Änderungen verfolgen
Änderungen nachverfolgen
Überarbeiten
Strg+Umschalt+E

Reviewing
Track Changes
Track Changes
Indicator

Ctr.l+Shift+E 2041 956

ExtrasÜberarbeiten Ändert die
Überarbeitungsoptionen. Dialogs(wdDialogToolsHighlightChanges).Show ToolsRevisions

Sets track
changes for the
active document

Extras > Änderungen
verfolgen
Überarbeitungsanzeige

Änderungen hervorheben...
Tools
Track Changes
Indicator

2042 197

AnmerkungBearbeiten

Öffnet den
Anmerkungsausschnitt zum
Lesen der Anmerkungen
(ein/aus).
Kommentar bearbeiten

AnnotationEdit Edit comment
Ansicht
Überarbeiten
Kommentar

Kommentare
Kommentar bearbeiten
Kommentar anzeigen

Reviewing
Comment 2056 1333

(Web) Web > Wechseln zu... Startseite bestimmen... Web 2057
(Web) Web > Wechseln zu... Suchseite bestimmen... Web 2058

TabelleErstellen Fügt eine Tabelle ein. WordBasic.CreateTable CreateTable Inserts a table
Tabelle
Tabellen und Rahmen
Formular
Kontext (Tabelle)

Tabelle zeichnen
Tables and
Borders
Forms
Context (Table)

2059 796

ZellenTeilungEntfernen Entfernt Zellpartitionen WordBasic.RemoveCellPartition RemoveCellPartition Removes cell
partitions Tabellen und Rahmen Radiergummi Tables and

Borders 2060 888

ObenAusrichten Richtet Zelleninhalt am
oberen Zellenrand aus. Selection.Cells.VerticalAlignment = wdCellAlignVerticalTop TopAlign Aligns cell content

to the top of cell (Word97) Oben ausrichten
Word 97 Context
and Word 97
Tables and
Borders

2061 799

MitteAusrichten Richtet Zelleninhalt zentriert
in der Zelle aus Selection.Cells.VerticalAlignment = wdCellAlignVerticalCenter CenterAlign

Aligns cell content
to the center of
cell

(Word97) Vertikal zentrieren
Word 97 Context
and Word 97
Tables and
Borders

2062 800

UntenAusrichten Richtet Zelleninhalt am
unteren Zellenrand aus Selection.Cells.VerticalAlignment = wdCellAlignVerticalBottom BottomAlign

Aligns cell content
to the bottom of
cell

(Word97) Unten ausrichten
Word 97 Context
and Word 97
Tables and
Borders

2063 801

AnordnenSpalte Markierte Spalten
gleichmäßig anordnen Selection.Cells.DistributeWidth DistributeColumn Evenly distributes

selected columns
Tabelle > AutoAnpassen
Kontext Spalten gleichmäßig verteilen Context 2067 807

AnordnenZeile Markierte Zeilen
gleichmäßig anordnen Selection.Cells.DistributeHeight DistributeRow Evenly distributes

selected rows
Tabelle > AutoAnpassen
Kontext Zeilen gleichmäßig verteilen Context 2068 893

EinfügenOCXRahmen Fügt ein Frame-
Steuerelement ein WordBasic.InsertOCXFrame InsertOCXFrame Inserts a Frame

Control Rahmen 2088 7089

EinfügenOCXBild Fügt ein Grafik-
Steuerelement ein WordBasic.InsertOCXImage InsertOCXImage Inserts an Image

Control Steuerelement-Toolbox Bild Control Toolbox 2089 7090
Öffnet das Dialogfeld
'WordArt bearbeiten', in
dem Sie den Text des
markierten WordArt-
Objektes bearbeiten
können.

DrawEditWordArt WordArt
WordArt-Kontextmenü Text bearbeiten...

WordArt
WordArt Context
Menu

2094

Organisieren
Verwaltet AutoText-
Einträge, Formatvorlagen,
Makros und Symbolleisten.

Dialogs(wdDialogOrganizer).Show Organizer
Manages AutoText
entries, styles,
macros, and
toolbars

Organisieren 2171 222
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Schaltet die
Schattenformatierung für
das markierte Objekt unter
Verwendung der
Standardschatten-
Einstellungen ein oder aus.

DrawShadowToggle Schatteneinstellungen Schatten ein/aus Shadow Settings 2175

BestimmenZeichnenStandardeinstellungen
Ändert die Standard-
Zeichnungsobjekteigenscha
ften

Selection.ShapeRange.SetShapesDefaultProperties SetDrawingDefaults
Changes the
default drawing
object properties

Zeichnen > Zeichnen
Kontext

Als Standard für AutoForm
festlegen Drawing toolbar 2179 993

ExtrasThesaurus Findet Synonyme für das
markierte Wort. Dialogs(wdDialogToolsThesaurus).Show ToolsThesaurus

Finds a synonym
for the selected
word

Extras > Sprache
Kontext

Thesaurus...
Umschalt+F7

Tools > Language
Context Shift+F7 2185 194

ExtrasMakroAufzeichnenEnde Schaltet den Makrorekorder
ein oder aus ToolsRecordMacroStop Turns macro

recording on or off Aufzeichnung beenden Aufzeichnung anhalten Stop Recording 2186 667

MakroBeenden Schaltet den Makrorekorder
ein und aus. StopMacro Aufzeichnung beenden Anhalten Stop Recording 2187 668

DateiSenden
Sendet das aktuelle
Dokument mit Hilfe der
Elektronischen Post.

ActiveDocument.SendMail FileSendMail
Sends the active
document through
electronic mail

Datei
Überarbeiten
Outlook-E-Mail senden
E-Mail senden

Senden an > Mailempfänger
(als Anlage)...

File
Reviewing
Outlook Send
Mail
Send Mail

2188 613

AutoZusammenfassenUmschaltenAnsicht

Wechselt die Anzeige für
die Zusammenfassung:
Hervorhebung von
zusammengefasstem Text
oder Ausblenden aller
Textelemente außer der
Zusammenfassung.

If ActiveDocument.SummaryViewMode =
wdSummaryModeHighlight Then
ActiveDocument.SummaryViewMode =

wdSummaryModeHideAllButSummary
Else

If ActiveDocument.SummaryViewMode =
wdSummaryModeHideAllButSummary _

Then
ActiveDocument.SummaryViewMode =

wdSummaryModeHighlight
End If

End If

AutoSummarizeToggleView

Switches how
Word displays a
summary:
highlighting
summary text, or
hiding everything
but the summary.

AutoZusammenfassen Markieren/Anzeigen: Nur
Zusammenfassung AutoSummarize 2189 910

AnsichtZentraldokument
Schaltet zur
Zentraldokument-Ansicht
um.

ActiveWindow.ActivePane.View.Type = wdMasterView ViewMasterDocument
Switches to
master document
view

Zentraldokument
Masterdokument 2190 490

HilfeVerwenden Zeigt Informationen zur
Verwendung der Hilfe an. Help wdHelpUsingHelp HelpUsingHelp

Displays the
instructions for
how to use Help

Hilfe zur Arbeit mit der Hilfe 2193 3

MicrosoftSysteminfo Führt die Anwendung
Microsoft Systeminfo aus. System.MSInfo MicrosoftSystemInfo

Execute the
Microsoft System
Info application

? > Info Microsoft Systeminfo
Alt+Strg+F1 Alt+Ctrl+F1 2195 711

HilfeWordPerfectHilfeOptionen Passt WordPerfect-Hilfe an Dialogs(wdDialogHelpWordPerfectHelpOptions).Show HelpWordPerfectHelpOptions Customizes
WordPerfect Help WordPerfect-Hilfeoptionen... 2196 511

Überschreiben
Schaltet den
Überschreibmodus ein und
aus.

Overtype = Not Overtype Overtype
Toggles the typing
mode between
replacing and
inserting

Überschreiben
Einfügen Ins 2197 13

MarkierungErweitern

Schaltet den Modus zur
Erweiterung der Markierung
ein und erweitert die
Markierung mit den
Richtungstasten

Selection.Extend ExtendSelection

Turns on extend
selection mode
and then expands
the selection with
the direction keys

Markierung erweitern
F8 oder Doppelklick in
Statusleiste: ÜB
(Abbruch mit Esc)

Status bar
(double-click)

F8 (press Esc to
turn off) 2198 14

Sammlung
Löscht die Markierung und
fügt sie einem speziellen
AutoText-Eintrag hinzu.

NormalTemplate.AutoTextEntries.AppendToSpike
Range:=Selection.Range Spike

Deletes the
selection and adds
it to the special
AutoText entry

Der Sammlung hinzufügen
Sammlung
Strg+F3

Ctrl+F3 2199 15

EinfügenSammlung
Leert den AutoText-Eintrag
"Sammlung" und fügt alle
Einträge in das Dokument
ein.

With NormalTemplate.AutoTextEntries("Sammlung")
.Insert Where:=Selection.Range, RichText:=True
.Delete

End With
InsertSpike

Empties the spike
AutoText entry
and inserts all of
its contents into
the document

Sammlung einfügen
Strg+Umschalt+F3 Ctrl+Shift+F3 2200 16

GroßKleinschreibungÄndern
Ändert die Groß-
/Kleinschreibung im
markierten Textteil.

Selection.Range.Case = wdNextCase ChangeCase
Changes the case
of the letters in the
selection

Format Groß-/Kleinschreibung...
Umschalt+F3 Shift+F3 2201 17

TextVerschieben
Verschiebt einen markierten
Textteil an eine bestimmte
Stelle.

WordBasic.MoveText MoveText
Moves the
selection to a
specified location

Auswahl verschieben
Text verschieben
F2

F2 2202 18

TextKopieren
Kopiert einen markierten
Textteil an eine bestimmte
Stelle.

WordBasic.CopyText CopyText
Makes a copy of
the selection at a
specified location

Text kopieren
Umschalt+F2 (nicht
verwechseln mit Strg+C!)

Shift+F2 2203 19

EinfügenAutoText
Ersetzt den Namen des
AutoText-Eintrags durch
dessen Inhalt.

Selection.Range.InsertAutoText InsertAutoText
Replaces the
name of the
AutoText entry
with its contents

AutoText einfügen
F3 oder Alt+Strg+V F3 2204 20
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Fügt den AutoText-Eintrag
in das Dokument ein. AutoText-Namen übernehmen 2205

AndererAusschnitt Schaltet zum anderen
Fensterausschnitt um. ActiveWindow.ActivePane.Next.Activate OtherPane Switches to the

other window pane
Anderer Ausschnitt
F6 oder Umschalt+F6 F6 2206 21

VorherigesFenster Schaltet zum vorherigen
Dokumentfenster um. ActiveWindow.Previous.Activate PrevWindow

Switches back to
the previous
document window

Vorheriges Fenster
Strg+Umschalt+F6 oder
Alt+Umschalt+F6

Ctrl+Shift+F6 2208 23

NächstesFeld Springt zum nächsten Feld. Selection.NextField.Select NextField Moves to the next
field

Nächstes Feld
F11 oder Alt+F1 F11 2209 25

VorherigesFeld Springt zum vorherigen
Feld. Selection.PreviousField.Select PrevField Moves to the

previous field
Vorheriges Feld
Umschalt+F11 oder
Alt+Umschalt+F1

Shift+F11 2210 26

SpalteMarkieren Markiert einen
spaltenförmigen Textblock. Selection.ExtendMode = True ColumnSelect

Selects a
columnar block of
text

Spalten markieren
Spaltenauswahl
Strg+Umschalt+F8 (oder
Alt+Ziehen)

Alt+Drag (or
press
Ctrl+Shift+F8 and
drag, but
Alt+Drag is far
easier!)

2211 27

EinfügenFeldzeichen Fügt ein Feld mit
Feldzeichen ein.

Selection.Fields.Add Range:=Selection.Range,
Type:=wdFieldEmpty, _
PreserveFormatting:=False

InsertFieldChars
Inserts a field with
the enclosing field
characters

Feldzeichen einfügen
Strg+F9 Ctrl+F9 2212 31

EinfügenListenNrFeld Fügt ein ListenNr-Feld ein
Selection.Fields.Add Range:=Selection.Range,
Type:=wdFieldListNum, _
PreserveFormatting:=False

InsertListNumField Inserts a ListNum
Field

ListenNum-Feld einfügen
Alt+Strg+Umschalt+L Alt+Ctrl+L 2213 966

VerknüpfungLösenFelder
Ersetzt die Feldfunktionen
endgültig mit deren
Ergebnissen.

Selection.Fields.Unlink UnlinkFields
Permanently
replaces the field
codes with the
results

Feldverknüpfungen aufheben
Strg+6 oder Strg+Umschalt+F9 Ctrl+Shift+F9 2214 33

FeldSperren Schließt markierte Felder
von der Aktualisierung aus. Selection.Fields.Locked = True LockFields

Locks the selected
fields to prevent
updating

Felder schützen
Felder sperren
Strg+3 oder Strg+F11

Ctrl+F11 2215 35

FeldFreigabe Gibt die markierten Felder
zur Aktualisierung frei. Selection.Fields.Locked = False UnlockFields

Unlocks the
selected fields for
updating

Felder freigeben
Feldsperre aufheben
Strg+4 oder
Strg+Umschalt+F11

Ctrl+Shift+F11 2216 36

QuelleAktualisieren
Kopiert geänderten Text
einer verknüpften Datei
zurück in die Quelldatei.

Selection.Fields.UpdateSource UpdateSource
Copies the
modified text of a
linked file back to
its source

Quelle aktualisieren
Strg+Umschalt+F7 Ctrl+Shift+F7 2217 37

HängenderEinzug Vergrößert den hängenden
Einzug. Selection.ParagraphFormat.TabHangingIndent 1 HangingIndent Increases the

hanging indent

Hängenden Einzug vergrößern
Hängender Einzug
Strg+T (oder im Lineal mit
Maus verschieben)

Ctrl+T (or drag
the ruler) 2218 40

RückEinzugSeitenrand Verkleinert den hängenden
Einzug. Selection.ParagraphFormat.TabHangingIndent -1 UnHang Decreases the

hanging indent

Hängenden Einzug reduzieren
Einzug rückgängig
Strg+Umschalt+T (oder in
Lineal ziehen)

Ctrl+Shift+T (or
drag the ruler) 2219 41

Schmal
Setzt die Laufweite des
markierten Textteils auf
schmal.

x = .Parameter of Control
0,1 = 0,1 pt
…
3 = 3 pt
…
12,7 = 12,7 pt
Selection.Font.Spacing = -0.5

Condensed (z. B. 3 pt) Schmal 2220 531

X pt Gesperrt
Setzt die Laufweite des
markierten Textteils auf
gesperrt.

.Parameter of Command = X X pt Expanded (z. B. 3 pt) Gesperrt 2221 532

Tiefergestellt Erweitert die Markierung bis
unter die Grundlinie.

x= .Parameter of Control
1 = 1 pt
…
127 = 127 pt

Lowered (z. B. 3 pt) Tiefergestellt 2222 534

x pt Höhergestellt Erweitert die Markierung bis
über die Grundlinie. x = .Parameter of Control x pt Raised (z. B. 3 pt) Höhergestellt 2223 535

Schriftgrad Ändert den Schriftgrad des
markierten Textteils.

x = .Parameter of Control
8 = 8 pt
..
72 = 72 pt

FontSize (z. B. 10 pt) Schriftart 2224 533

Ausgeblendet
Formatiert einen markierten
Textteil ausgeblendet
[ein/aus].

Selection.Font.Hidden = wdToggle Hidden
Makes the
selection hidden
text (toggle)

Ausgeblendet
Strg+Umschalt+H Ctrl+Shift+H 2225 50

StandardZeichenLaufweite
Entfernt gesperrte oder
schmale
Zeichenformatierung.

WordBasic.NormalFontSpacing NormalFontSpacing
Removes the
expanded or
condensed font
attribute

Standardzeichenabstand 2226 571
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StandardZeichenPosition
Entfernt hoch- oder
tiefgestellte
Zeichenformatierung.

WordBasic.NormalFontPosition NormalFontPosition
Removes the
raised or lowered
font attribute

Standardzeichenposition 2227 572

Farbe: Ändert die Farbe des
markierten Textes. Selection.Font.Color = wdColorXXX Color: ??? Automatisch Color ((bzw.

gewählte Farbe)) 2228 548

Absatzkontrolle

Verhindert einen
Seitenumbruch, durch den
eine einzelne Zeile eines
Absatzes auf einer Seite
verbleiben würde.

Selection.ParagraphFormat.WidowControl = wdToggle ParaWidowOrphanControl

Prevents a page
break from leaving
a single line of a
paragraph on one
page

Absatz Absätze nicht trennen 2229 628

AbsatzZeilenNichtTrennen
Verhindert, dass ein Absatz
vor dem Seitenumbruch
getrennt wird.

Selection.ParagraphFormat.KeepTogether = wdToggle ParaKeepLinesTogether
Prevents a
paragraph from
splitting across
page boundaries

Absatz Zeilen nicht trennen 2230 621

AbsätzeNichtTrennen Trennt einen Absatz nicht
von dem folgenden Absatz. Selection.ParagraphFormat.KeepWithNext = wdToggle ParaKeepWithNext

Keeps a
paragraph and the
following
paragraph on the
same page

Absatz Absatzkontrolle 2231 622

AbsatzSeitenwOberhalb
Verschiebt den Beginn des
aktuellen Absatzes auf eine
neue Seite.

Selection.ParagraphFormat.PageBreakBefore = wdToggle ParaPageBreakBefore
Makes the current
paragraph start on
a new page

Absatz Seitenwechsel oberhalb
Absatz Seitenumbruch
oberhalb

2232 623

AbsatzAbstandSchließen
Entfernt den zusätzlichen
Leerraum über dem
markierten Absatz

Selection.ParagraphFormat.CloseUp CloseUpPara
Removes extra
spacing above the
selected
paragraph

Kein Abstand vor 2233 65

AbsatzAbstandVor
Legt den zusätzlichen
Leerraum über dem
markierten Absatz fest

Selection.ParagraphFormat.OpenUp OpenUpPara
Sets extra spacing
above the selected
paragraph

Abstand vor 2234 66

AbsatzAbstandVorHinzufügenOderLöschen
Bestimmt oder entfernt
Abstände vor dem
markierten Absatz.

OpenOrCloseUpPara
Sets or removes
extra spacing
above the selected
paragraph

Abstand vor
Strg+0 Ctrl+0 2235 698

VorgabeAbsatz

Ordnet den Absätzen in der
Markierung die
Absatzformatierung der
Formatvorlage als Standard
zu.

Selection.ParagraphFormat.Reset ResetPara

Makes the
selection the
default paragraph
format of the
applied style

Absatzformat zurücksetzen
Absatz zurücksetzen
Strg+Q

Ctrl+Q 2236 67

ZurückEinfügemarke
Geht zur vorherigen
Position der Einfügemarke
zurück.

Application.GoBack GoBack
Returns to the
previous insertion
point

Vorherige Bearbeitung
Umschalt+F5 oder Alt+Strg+Z Shift+F5 2237 69

NächsteEinfügemarke Kehrt zur letzten
Einfügemarke zurück Application.GoForward NextInsert Returns to the

next insertion point Nächste Bearbeitung 2238 836

DokVorlageSpeichern
Speichert die
Dokumentvorlage des
aktiven Dokuments.

ActiveDocument.AttachedTemplate.Document.Save SaveTemplate
Saves the
document
template of the
active document

Vorlage speichern 2239 70

VorherigeSeite Springt zur vorherigen
Seite. ActiveWindow.ActivePane.PageScroll Up:=1 PrevPage Moves to the

previous page Vorherige Seite 2241 74

NächsteSeite Springt zur nächsten Seite. ActiveWindow.ActivePane.PageScroll Down:=1 NextPage Moves to the next
page Nächste Seite 2242 75

NächstesObjekt Springt zum nächsten
Objekt auf der Seite. Selection.MoveRight Unit:=wdItem NextObject Moves to the next

object on the page
Nächstes Objekt
Alt+Abwärts Alt+down arrow 2243 76

VorherigesObjekt Springt zum vorherigen
Objekt auf der Seite. Selection.MoveLeft Unit:=wdItem PrevObject

Moves to the
previous object on
the page

Vorheriges Objekt
Alt+Aufwärts Alt+up arrow 2244 77

DateiUmwandlungenBestätigen
Fordert den Benutzer auf,
die Dateikonvertierung zu
bestätigen (ein/aus)

Options.ConfirmConversions = Not Options.ConfirmConversions FileConfirmConversions
Toggles asking the
user to confirm the
conversion when
opening a file.

Dateiumwandlung bestätigen 2245 687

SeriendruckÖffnenDatenquelle
Öffnet eine Datenquelle für
den Seriendruck oder für
die Option "Einfügen
Datenbank".

Dialogs(wdDialogMailMergeOpenDataSource).Show MailMergeOpenDataSource
Opens a data
source for mail
merge or insert
database

Seriendruck Datenquelle öffnen 2246 81

SeriendruckÖffnenSteuersatzquelle
Öffnet eine
Steuersatzquelle für den
Seriendruck.

Dialogs(wdDialogMailMergeOpenHeaderSource).Show MailMergeOpenHeaderSource
Opens a header
source for mail
merge

Seriendruck Kopfzeilenquelle
öffnen 2247 82

SeriendruckAdreßbuchVerwenden
Öffnet ein Adressbuch als
Datenquelle für den
Seriendruck

Dialogs(wdDialogMailMergeUseAddressBook).Show MailMergeUseAddressBook
Opens an address
book as a data
source for mail
merge

Seriendruck Adressbuch
verwenden 2248 779

SeriendruckAbfrageOptionen
Bestimmt die
Abfrageoptionen für den
Seriendruck.

Dialogs(wdDialogMailMergeQueryOptions).Show MailMergeQueryOptions
Sets the query
options for a mail
merge

Seriendruck Abfrageoptionen 2251 681



Deutsch Beschreibung Makro-Beispiel English Description Type Symbolleiste Befehl/Kürzel Toolbar Shortcut Comm Dial

SeriendruckEinfügenWenn Fügt ein Bedingungsfeld vor
der Einfügemarke ein Dialogs(wdDialogMailMergeInsertIf).Show MailMergeInsertIf

Inserts a Word
field at the
insertion point

Seriendruck >
Bedingungsfeld
einfügen

> Wenn... Dann... Sonst...
Seriendruck Wenn einfügen Auch Dialog 568? 2252 4049

SeriendruckEinfügenDatensatz Fügt ein Datensatz-Feld an
der Einfügemarke ein.

ActiveDocument.MailMerge.Fields.AddMergeRec
Range:=Selection.Range MailMergeInsertMergeRec

Inserts a Word
record field at the
insertion point

Seriendruck >
Bedingungsfeld
einfügen

> Datensatz verbinden
Seriendruck Datensätze
zusammenführen einfügen

Mail Merge 2253 4050

SeriendruckEinfügenSeq Fügt ein SEQ-Feld an der
Einfügemarke ein.

ActiveDocument.MailMerge.Fields.AddMergeSeq
Range:=Selection.Range MailMergeInsertMergeSeq

Inserts a Word
sequence field at
the insertion point

Seriendruck >
Bedingungsfeld
einfügen

> Sequenz verbinden
Seriendruck Sequenz
zusammenführen einfügen

Mail Merge 2254 4051

SeriendruckEinfügenNächster Fügt ein Nächster-Feld an
der Einfügemarke ein.

ActiveDocument.MailMerge.Fields.AddNext
Range:=Selection.Range MailMergeInsertNext

Inserts a Word
next field at the
insertion point

Seriendruck >
Bedingungsfeld
einfügen

> Nächster Datensatz
Seriendruck Nächster einfügen Mail Merge 2255 4052

SeriendruckEinfügenNächsterWenn Fügt ein NWenn-Feld an
der Einfügemarke ein. Dialogs(wdDialogMailMergeInsertNextIf).Show MailMergeInsertNextIf

Inserts a Word
next if field at the
insertion point

Seriendruck >
Bedingungsfeld
einfügen

> Nächster Datensatz Wenn...
Seriendruck Nächster Wenn
einfügen

Mail Merge 2256 4053

SeriendruckEinfügenÜberspringen Fügt ein Überspringen-Feld
an der Einfügemarke ein. Dialogs(wdDialogMailMergeInsertSkipIf).Show MailMergeInsertSkipIf

Inserts a Word
skip if field at the
insertion point

Seriendruck >
Bedingungsfeld
einfügen

> Datensatz überspringen...
Seriendruck Überspringen
Wenn einfügen

Mail Merge 2257 4055

SeriendruckEinfügenEingeben Fügt ein Eingeben-Feld an
der Einfügemarke ein. Dialogs(wdDialogMailMergeInsertFillIn).Show MailMergeInsertFillIn

Inserts a Word
fillin field at the
insertion point

Seriendruck >
Bedingungsfeld
einfügen

> Eingeben...
Seriendruck Einfüllen einfügen Mail Merge 2258 4048

SeriendruckEinfügenFrage Fügt ein Frage-Feld an der
Einfügemarke ein. Dialogs(wdDialogMailMergeInsertAsk).Show MailMergeInsertAsk

Inserts a Word ask
field at the
insertion point

Seriendruck >
Bedingungsfeld
einfügen

> Frage...
Seriendruck Frage einfügen Mail Merge 2259 4047

SeriendruckEinfügenBestimmen Fügt ein Bestimmen-Feld an
der Einfügemarke ein. Dialogs(wdDialogMailMergeInsertSet).Show MailMergeInsertSet

Inserts a Word set
field at the
insertion point

Seriendruck >
Bedingungsfeld
einfügen

> Textmarke bestimmen...
Seriendruck Bestimmen
einfügen

Mail Merge 2260 4054

SeriendruckLösen
Setzt ein Seriendruck-
Hauptdokument in ein
normales Dokument zurück

ActiveDocument.MailMerge.MainDocumentType =
wdNotAMergeDocument MailMergeReset

Resets a mail
merge main
document to a
normal document

Seriendruck zurücksetzen 2261 96

SeriendruckDatenquelleErstellen Erstellt eine neue
Seriendruck-Datenquelle. Dialogs(wdDialogMailMergeCreateDataSource).Show MailMergeCreateDataSource

Creates a new
mail merge data
source

Seriendruck Datenquelle
erstellen

Mail merge
toolbar 2262 642

SeriendruckSteuersatzquelleErstellen
Erstellt eine neue
Seriendruck-
Steuersatzquelle.

Dialogs(wdDialogMailMergeCreateHeaderSource).Show MailMergeCreateHeaderSource
Creates a new
mail merge header
source

Seriendruck Kopfzeilenquelle
erstellen 2263 643

GeheZuVorherigemAbschnitt
Springt im aktiven
Dokument zum vorherigen
Abschnitt.

Selection.GoToPrevious wdGoToSection GoToPreviousSection
Jumps to the
previous section in
the active
document

Gehe zu vorherigem Abschnitt 2264 407

GeheZuNächstemAbschnitt
Springt im aktiven
Dokument zum nächsten
Abschnitt.

Selection.GoToNext wdGoToSection GoToNextSection
Jumps to the next
section in the
active document

Gehe zu nächstem Abschnitt 2265 406

GeheZuVorherigerSeite
Springt im aktiven
Dokument zur vorherigen
Seite.

Selection.GoToPrevious wdGoToPage GoToPreviousPage
Jumps to the
previous page in
the active
document

Gehe zu vorheriger Seite 2266 405

GeheZuNächsterSeite
Springt im aktiven
Dokument zur nächsten
Seite.

Selection.GoToNext wdGoToPage GoToNextPage
Jumps to the next
page in the active
document

Gehe zu nächster Seite 2267 404

GeheZuVorherigerFußnote
Springt im aktiven
Dokument zur vorherigen
Fußnote.

Selection.GoToPrevious wdGoToFootnote GoToPreviousFootnote
Jumps to the
previous footnote
in the active
document

Gehe zu vorheriger Fußnote 2268 409

GeheZuNächsterFußnote
Springt im aktiven
Dokument zur nächsten
Fußnote.

Selection.GoToNext wdGoToFootnote GoToNextFootnote
Jumps to the next
footnote in the
active document

Gehe zu nächster Fußnote 2269 408

GeheZuVorherigerEndnote
Springt im aktiven
Dokument zur vorherigen
Endnote.

Selection.GoToPrevious wdGoToEndnote GoToPreviousEndnote
Jumps to the
previous endnote
in the active
document

Gehe zu vorheriger Endnote 2270 411

GeheZuNächsterEndnote
Springt im aktiven
Dokument zur nächsten
Endnote.

Selection.GoToNext wdGoToEndnote GoToNextEndnote
Jumps to the next
endnote in the
active document

Gehe zu nächster Endnote 2271 410

ObjektAktivieren Aktiviert ein Objekt. Selection.InlineShapes(1).OLEFormat.Activate ActivateObject Activates an object Objekt aktivieren 2272 126
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TabelleAktualisierenAutoFormat

Aktualisiert die
Formatierung der Tabelle
mit dem zuvor
zugewiesenen Satz von
Formatierungen.

Selection.Tables(1).UpdateAutoFormat TableUpdateAutoFormat
Updates the table
formatting to
match the applied
formatting set

Tabelle AutoFormat
aktualisieren
Alt+Strg+U

Alt+Ctrl+U 2275 626

AnsichtKonzept
Zeigt das Dokument zur
schnellen Bearbeitung ohne
Formatierung und Grafik an
(ein/aus).

ActiveWindow.ActivePane.View.Draft = Not
ActiveWindow.ActivePane.View. _
Draft

ViewDraft

Displays the
document without
formatting and
pictures for faster
editing (toggle)

Ansicht Entwurf 2277 149

NeueSymbolleiste Erstellt eine neue
Symbolleiste. Dialogs(wdDialogNewToolbar).Show NewToolbar Creates a new

toolbar Neue Symbolleiste 2279 586

AnsichtNormalKopfzeileBereich
Zeigt eine Liste von Kopf-
und Fußzeilen zum
Bearbeiten an

WordBasic.NormalViewHeaderArea NormalViewHeaderArea
Shows a list of
headers and
footers for editing

Ansicht Kopf-/Fußzeile
Normalansicht -
Kopfzeilenbereich

2283 155

EinfügenAbschnittsWechsel Beendet einen Abschnitt vor
der Einfügemarke. Selection.InsertBreak Type:=wdSectionBreakContinuous InsertSectionBreak Ends a section at

the insertion point Abschnittswechsel einfügen 2284 707

EndnoteJetztEinfügen Fügt ein Endnotenzeichen
an der Einfügemarke ein. ActiveDocument.Endnotes.Add(Range As Range, Reference, text) InsertEndnoteNow

Inserts an endnote
reference at the
insertion point

Endnote jetzt einfügen
Alt+Strg+D Alt+Ctrl+D 2285 369

FußnotenUmwZuEndnoten Wandelt alle Fußnoten in
Endnoten um. ActiveDocument.Footnotes.Convert EditConvertAllFootnotes

Converts all
footnotes into
endnotes

Bearbeiten Alle Fußnoten
umwandeln 2286 439

EndnotenUmwZuFußnoten Wandelt alle Endnoten in
Fußnoten um. ActiveDocument.Endnotes.Convert EditConvertAllEndnotes

Converts all
endnotes into
footnotes

Bearbeiten Alle Endnoten
umwandeln 2287 440

UmwAlleFußnotenEndnoten
Ändert alle Fußnoten auf
Endnoten um und
umgekehrt.

ActiveDocument.Footnotes.SwapWithEndnotes EditSwapAllNotes

Changes all
footnotes to
endnotes and all
endnotes to
footnotes

Bearbeiten Fußnoten und
Endnoten vertauschen 2288 441

Sonderzeichen Fügt ein Sonderzeichen ein Selection.InsertSymbol Font:="...", CharacterNumber:=...,
Unicode:= True Symbol 2290 555

EinfügenEnAbstand Fügt einen En-Abstand ein.
Selection.InsertSymbol CharacterNumber:=8194, Font:="(normaler
Text)", _
Unicode:=True

InsertEnSpace Inserts an EN
space En-Abstand einfügen 2291 618

EinfügenEmAbstand Fügt einen EM-Abstand ein.
Selection.InsertSymbol CharacterNumber:=8195, Font:="(normaler
Text)", _
Unicode:=True

InsertEmSpace Inserts an EM
space Em-Abstand einfügen 2292 619

IndexEintragFestlegen
Kennzeichnet den Text, der
in den Index aufgenommen
werden soll.

Dialogs(wdDialogMarkIndexEntry).Show MarkIndexEntry
Marks the text you
want to include in
the index

Indexeintrag festlegen
Alt+Umschalt+X Alt+Shift+X 2293 169

AutoFestlegenIndexEintrag
Fügt Indexeinträge mit Hilfe
einer AutoFestlegungsdatei
ein.

WordBasic.AutoMarkIndexEntries AutoMarkIndexEntries
Inserts index
entries using an
automark file

Automatisch Indexeinträge
festlegen 2294 616

ZitatFestlegen

Markiert den Text, der in
das
Rechtsgrundlagenverzeichn
is aufgenommen werden
soll

Dialogs(wdDialogMarkCitation).Show MarkCitation
Marks the text you
want to include in
the table of
authorities

Zitat festlegen Alt+Shift+I 2295 463

BearbeitenRGVKategorie
Ändert die Kategorienamen
für das
Rechtsgrundlagenverzeichn
is

Dialogs(wdDialogEditTOACategory).Show EditTOACategory
Modifies the
category names
for the table of
authorities

Kategorie bearbeiten 2296 625

EinfügenIndex Fügt alle Indexeinträge zu
einem Index zusammen. Dialogs(wdDialogInsertIndex).Show InsertIndex

Collects the index
entries into an
index

Index einfügen 2298 170

EinfügenInhaltsverzeichnis
Erstellt ein
Inhaltsverzeichnis aus
INHALT-Feldern oder
Überschriften.

Dialogs(wdDialogInsertTableOfContents).Show InsertTableOfContents

Collects the
headings or the
table of contents
entries into a table
of contents

Inhaltsverzeichnis einfügen 2299 171

InhaltsverzeichnisEintragAuswählen
Kennzeichnet den Text, der
in das Inhaltsverzeichnis
aufgenommen werden soll.

Dialogs(wdDialogMarkTableOfContentsEntry).Show MarkTableOfContentsEntry
Marks the text you
want to include in
the table of
contents

Eintrag für Inhaltsverzeichnis
festlegen
Alt+Umschalt+O

Alt+Shift+O 2300 442

EinfügenAbbildungsVerzeichnis
Erstellt ein
Abbildungsverzeichnis aus
Beschriftungen.

Dialogs(wdDialogInsertTableOfFigures).Show InsertTableOfFigures
Collects captions
into a table of
figures

Abbildungsverzeichnis einfügen 2301 472

EinfügenRechtsgrundlagenverzeichnis
Stellt die Einträge im
Rechtsgrundlagenverzeichn
is zusammen

Dialogs(wdDialogInsertTableOfAuthorities).Show InsertTableOfAuthorities
Collects the table
of authorities
entries into a table
of authorities

Rechtsgrundlagenverzeichnis
einfügen 2302 471

ZeichnungMarkierungAufheben Hebt die Gruppierung von
Zeichnungselementen auf. Selection.Collapse DrawUnselect Unselects a drawn

object Zeichnen Markierung aufheben 2305 708
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ZeichnungMarkierenNächste Markiert das nächste
Zeichnungselement. WordBasic.DrawSelectNext DrawSelectNext Selects the next

drawn object Zeichnen Nächsten markieren 2306 709

ZeichnungMarkierenVorherige Markiert das vorherige
Zeichnungselement. WordBasic.DrawSelectPrevious DrawSelectPrevious

Selects the
previous drawn
object

Zeichnen Vorherigen markieren 2307 710

TextfeldVerknüpfen
Erstellt eine Vorwärts-
Verknüpfung zu einem
anderen Textfeld

TextBoxLinking
Creates a forward
link to another text
box

Textfeld
Kontext (Textfeld) Textfeld verknüpfen

Text Box
Context (text
box)

2308 840

TextfeldVerknüpfungAufheben
Hebt die Vorwärts-
Verknüpfung zu einem
anderen Textfeld auf

Selection.ShapeRange.TextFrame.BreakForwardLink TextBoxUnlinking
Breaks the forward
link to another text
box

Textfeld
Kontext (Textfeld) Textfeldverknüpfung aufheben

Text box toolbar
Context (text
box)

2309 841

GeheZuNächstemVerknüpftemTextfeld Markiert das nächste
verknüpfte Textfeld Selection.ShapeRange.TextFrame.Next.Parent.Select GotoNextLinkedTextBox Selects the next

linked text box Textfeld Nächstes Textfeld Text Box &
Context 2310 842

GeheZuVorherigemVerknüpftemTextfeld Markiert das vorherige
verknüpfteTextfeld Selection.ShapeRange.TextFrame.Previous.Parent.Select GotoPrevLinkedTextBox

Selects the
previous linked
text box

Textfeld Vorheriges Textfeld Text Box &
Context 2311 843

Schattierung
Ändert die Schattierung von
Absätzen und
Tabellenzellen.

x = .Parameter of Control
0 = Transparent
1 = Einfarbig (100%)
2 = 5%
3 = 10%
…
25 = Hell Karo

Shading (z. B.: 10%) Schattierung 2313 546

Rahmenlinien
Ändert die Rahmenlinien
von Absätzen,
Tabellenzellen und
Grafiken.

x = .Parameter of Control
0 = (ohne)
1 = Oben
2 = Unten
3 = Links
4 = Rechts
5 = Innen
6 = Kasten
7 = Gitternetz

Borders z. B.: (Kasten) Rahmen 2314 547

FormatAbschnitt Ändert das Seitenformat
des markierten Abschnitts. Dialogs(wdDialogFormatSectionLayout).Show FormatSectionLayout

Changes the page
format of the
selected sections

Format Abschnittslayout 2315 176

Spalten
Ändert die Anzahl der
Spalten im markierten
Textteil.

x = .Parameter of Control
1 = 1 Spalte
…
45 = 45 Spalten

Columns X Spalten 2316 530

FormatvorlageNeuDefinieren
Definiert die aktuelle
Formatvorlage neu,
basierend auf dem
markierten Text

WordBasic.RedefineStyle RedefineStyle
Redefines the
current style
based on the
selected text

Formatvorlage neu definieren 2319 816

Weist die angegebene
Formatvorlage dem
markierten Text zu.

Formatvorlagennamen
übernehmen 2321

ZuweisenÜberschrift1
Weist dem markierten Text
die Formatvorlage
"Überschrift 1" zu.

Selection.Style = ActiveDocument.Styles(wdStyleHeading1) ApplyHeading1
Applies Heading 1
style to the
selected text

Überschrift 1 übernehmen
Alt+1 Alt+Ctrl+1 2322 593

ZuweisenÜberschrift2
Weist dem markierten Text
die Formatvorlage
"Überschrift 2" zu.

Selection.Style = ActiveDocument.Styles(wdStyleHeading2) ApplyHeading2
Applies Heading 2
style to the
selected text

Überschrift 2 übernehmen
Alt+2 2323 594

ZuweisenÜberschrift3
Weist dem markierten Text
die Formatvorlage
"Überschrift 3" zu.

Selection.Style = ActiveDocument.Styles(wdStyleHeading3) ApplyHeading3
Applies Heading 3
style to the
selected text

Überschrift 3 übernehmen
Alt+3 Alt+Ctrl+3 2324 595

ZuweisenAufzählung
Weist dem markierten Text
die Formatvorlage
"Aufzählungszeichen" zu.

ApplyListBullet
Applies List Bullet
style to the
selected text

Aufzählungszeichen
übernehmen
Strg+Umschalt+L

Ctrl+Shift+L 2325 596

KonvertierenTextfeldZuRahmen
Konvertiert ein einzelnes
markiertes Textfeld zu
einem Rahmen

Selection.ShapeRange(1).ConvertToFrame ConvertTextBoxToFrame
Converts a single
selected textbox
into a frame

Textfeld in Positionsrahmen
umwandeln Rt-click 2326 916

Objekt...
Format
Horizontale Linie
Eingebettete Grafik
Grafik

Objekt...
AutoForm/Grafik formatieren 2327

HöherstufenListe Stuft die Markierung um
eine Ebene höher. WordBasic.PromoteList PromoteList Promotes the

selection one level Liste höher stufen 2330 591

TieferstufenListe Stuft den markierten Text
eine Ebene tiefer. WordBasic.DemoteList DemoteList Demotes the

selection one level Liste tieferstufen 2331 592

ExtrasRechtschreibAuswahl
Dokumentprüfung
Überprüft die
Rechtschreibung im
markierten Textteil.

WordBasic.ToolsSpellSelection ToolsSpellSelection
Checks the
spelling of the
selected text

Extras Rechtschreibungsauswahl Tools 2333 192
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NächsterRechtschreibfehler Sucht den nächsten
Rechtschreibfehler

If Options.CheckSpellingAsYouType = True Then
If Options.CheckGrammarAsYouType = True Then
Selection.GoToNext(wdGoToProofreadingError).Select

Else
Selection.GoToNext(wdGoToSpellingError).Select

End If
Else

If Options.CheckGrammarAsYouType = True Then
Selection.GoToNext(wdGoToGrammaticalError).Select

End If
End If

NextMisspelling Find next spelling
error

Nächster Rechtschreibfehler
Nächster Rechtschreib- oder
Grammatikfehler
Alt+F7

Alt+F7 2334 759

ExtrasSilbentrennungManuell
Führt die Silbentrennung
innerhalb der Markierung
oder im gesamten
Dokument durch.

ActiveDocument.ManualHyphenation ToolsHyphenationManual
Hyphenates the
selection or the
entire document

Extras manuelle Silbentrennung 2336 704

ExtrasNumerierungAufzählungen
Ändert mit Nummerierungs-
und Aufzählungszeichen
versehene Absätze

Dialogs(wdDialogToolsBulletsNumbers).Show ToolsBulletsNumbers
Changes the
numbered and
bulleted
paragraphs

Extras
Aufzählungszeichen/Nummerier
ung

2337 196

ExtrasÜberarbeitungVerbinden
Führt Änderungen aus dem
aktuellen Dokument mit
einer älteren Version
zusammen

Dialogs(wdDialogToolsMergeDocuments).Show ToolsMergeRevisions
Merges changes
from the active
document to an
earlier version

Extras > Änderungen
verfolgen

Dokumente zusammenführen...
Dokumente vergleichen und
zusammenführen...

2338 435

ExtrasBerechnen Berechnet Ausdrücke im
markierten Bereich. Selection.Calculate ToolsCalculate

Calculates
expressions in the
selection

Extras Berechnen
(Formel markieren, Ergebnis in
Statusleiste)

2339 200

ExtrasAnpassenTastaturShortcut Shortcutmethode zum
Anpassen der Tastatur. ToolsCustomizeKeyboardShortcut

Shortcut method
for customizing
keyboard settings

Extras Anpassen
Tastenkombination
Alt + Strg + (Num+)
("+" in numerischem
Tastenfeld)

2340 557

ExtrasAnpassenMenüShortcutHinzu Shortcutmethode zum
Anpassen von Menüs. ToolsCustomizeAddMenuShortcut

Shortcut method
for customizing
menus

Extras Anpassen Menü-
Tastenkombination hinzufügen
Alt+Strg+6

Alt+Ctrl+=
(The equals sign
on the main
keyboard, not the
one on the
numeric keypad)

2341 558

ExtrasAnpassenMenüShortcutEntf Shortcutmethode zum
Anpassen von Menüs. ToolsCustomizeRemoveMenuShortcut

Shortcut method
for customizing
menus

Extras Anpassen Menü-
Tastenkombination entfernen
Alt+Strg+-

Alt+Ctrl +-
(The hyphen on
the main
keyboard, not the
one on the
numeric keypad)

2342 601

BefehleAuflisten
Erstellt eine Tabelle mit
allen Word-Befehlen,
Tastenbelegungen und
Menübefehlen.

Dialogs(wdDialogListCommands).Show ListCommands
Create a table of
Word commands,
with key and menu
assignments

Befehle auflisten 2343 723

ExtrasOptionenAllgemein Ändert allgemeine
Optionen. Dialogs(wdDialogToolsOptionsGeneral).Show ToolsOptionsGeneral Changes the

general options Extras > Optionen Allgemein Tools > Options 2344 203

ExtrasOptionenKompatibilität
Kompatibilitäts-Optionen
Ändert die Optionen der
Dokumentkompatibilität.

Dialogs(wdDialogToolsOptionsCompatibility).Show ToolsOptionsCompatibility
Changes the
document
compatibility
options

Extras > Optionen Kompatibilität 2345 525

ExtrasOptionenDrucken Ändert die Druckoptionen. Dialogs(wdDialogToolsOptionsPrint).Show ToolsOptionsPrint Changes the
printing options Extras > Optionen Drucken Tools > Options 2346 208

ExtrasOptionenSpeichern Ändert die
Speicheroptionen. Dialogs(wdDialogToolsOptionsSave).Show ToolsOptionsSave Changes the save

settings Extras > Optionen Speichern Tools > Options 2347 209

ExtrasRechtschreibungErneutPrüfen
Setzt die Ergebnisse der
Rechtschreibprüfung für
dieses Dokument zurück

Application.ResetIgnoreAll
ActiveDocument.SpellingChecked = False
ActiveDocument.GrammarChecked = False

ToolsSpellingRecheckDocument
Resets spelling
results for current
document

Extras Rechtschreibung Dokument
erneut prüfen Tools 2349 777

ExtrasOptionenBenutzerInfo Ändert die Optionen für die
Benutzer-Info. Dialogs(wdDialogToolsOptionsUserInfo).Show ToolsOptionsUserInfo

Changes the user
information
options

Extras > Optionen Benutzer-Info Tools > Options 2350 213

WW7_ExtrasOptionenAutoFormat Ändert die AutoFormat-
Optionen. WordBasic.WW7_ToolsOptionsAutoFormat WW7_ToolsOptionsAutoFormat AutoFormat W7 2351 365

ExtrasOptionenAutoFormat Ändert die AutoFormat-
Optionen. Dialogs(wdDialogToolsOptionsAutoFormat).Show ToolsOptionsAutoFormat

Changes the
AutoFormat
options

Extras > Optionen AutoFormat Tools > Options 2352 959

ExtrasOptionenAutoFormatBeiEingabe
Ändert die Optionen für
"AutoFormat während der
Eingabe"

Dialogs(wdDialogToolsOptionsAutoFormatAsYouType).Show ToolsOptionsAutoFormatAsYouType
Changes the
AutoFormat As
You Type options

Extras > Optionen AutoFormat beim Schreiben 2353 778

ExtrasOptionenÜberarbeitung
Überarbeitungsmarkierungs
-Optionen
Ändert die Optionen für
Änderungen verfolgen

Dialogs(wdDialogToolsOptionsTrackChanges).Show ToolsOptionsRevisions Changes track
changes options Überarbeitungsanzeige Optionen... Track Changes

Indicator 2354 386
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ExtrasOptionenBearbeiten Ändert die
Bearbeitungsoptionen. Dialogs(wdDialogToolsOptionsEdit).Show ToolsOptionsEdit Changes the

editing options Extras > Optionen Bearbeiten 2355 224

SeriendruckChevronsUmwandeln
Wandelt Seriendruck-
Chevrons aus Word für
Macintosh um [ein/aus].

If FileConverters.ConvertMacWordChevrons = wdNeverConvert
Then
FileConverters.ConvertMacWordChevrons = wdAlwaysConvert

Else
If FileConverters.ConvertMacWordChevrons = wdAlwaysConvert

Then
FileConverters.ConvertMacWordChevrons = wdNeverConvert

Else
If FileConverters.ConvertMacWordChevrons =

wdAskToNotConvert _
Then
FileConverters.ConvertMacWordChevrons = wdAskToConvert

Else
If FileConverters.ConvertMacWordChevrons =

wdAskToConvert _
Then
FileConverters.ConvertMacWordChevrons = _

wdAskToNotConvert
End If

End If
End If

End If

MailMergeConvertChevrons

Toggles
converting Word
for the Macintosh
mail merge
chevrons

Seriendruck Chevrons
konvertieren 2356 512

SeriendruckAnfrageChevronsUmwandeln

Fordert den Benutzer auf,
die Umwandlung der
Seriendruck-Chevrons aus
Word für Macintosh zu
bestätigen [ein/aus].

If FileConverters.ConvertMacWordChevrons = wdNeverConvert
Then
FileConverters.ConvertMacWordChevrons = wdAskToNotConvert

Else
If FileConverters.ConvertMacWordChevrons =

wdAskToNotConvert Then
FileConverters.ConvertMacWordChevrons = wdNeverConvert

Else
If FileConverters.ConvertMacWordChevrons = wdAlwaysConvert

Then
FileConverters.ConvertMacWordChevrons = wdAskToConvert

Else
If FileConverters.ConvertMacWordChevrons =

wdAskToConvert _
Then
FileConverters.ConvertMacWordChevrons = _

wdAlwaysConvert
End If

End If
End If

End If

MailMergeAskToConvertChevrons

Toggles asking the
user about
converting Word
for the Macintosh
mail merge
chevrons

Seriendruck Anfragen für
Klammerumwandlung 2357 609

SteuerungAusführen
Zeigt die Systemsteuerung
oder die Zwischenablage
an.

Dialogs(wdDialogControlRun).Show ControlRun
Displays the
Control Panel or
the Clipboard

Steuerelement ausführen 2360 235

AusführenDruckManager Zeigt den Druck-Manager
an. WordBasic.RunPrintManager RunPrintManager Displays the Print

Manager Druck-Manager ausführen 2361 684

MarkierungVerkleinern Verkleinert die Markierung
zur nächstkleineren Einheit. Selection.Shrink ShrinkSelection

Shrinks the
selection to the
next smaller unit

Markierung verkleinern
Umschalt+F8 2362 236

StandardFV Weist die
Standardformatvorlage zu. Selection.Range.Style = ActiveDocument.Styles(wdStyleNormal) NormalStyle Applies the

Normal style

Formatvorlage Standard
zuweisen
Formatvorlage Standard
Strg+Umschalt+N oder
Alt+Umschalt+Num-5

Ctrl+Shift+N 2363 248

NächsteZelle Springt zur nächsten
Tabellenzelle. Selection.MoveRight Unit:=wdCell NextCell Moves to the next

table cell
Nächste Zelle
Tab Tab 2364 270

VorherigeZelle Springt zur vorherigen
Tabellenzelle. Selection.MoveLeft Unit:=wdCell PrevCell Moves to the

previous table cell
Vorherige Zelle
Umschalt+Tab Shift+Tab 2365 271

BeginnTabellenzeile Springt zur ersten Zelle in
der aktuellen Tabellenzeile.

WordBasic.StartOfRow
Selection.HomeKey Unit:=wdRow StartOfRow

Moves to the first
cell in the current
row

Zeilenanfang
Alt+Pos1
(Markieren: +Umschalt)

Alt+Home 2366 272

EndeTabellenzeile Springt zur letzten Zelle in
der aktuellen Tabellenzeile.

WordBasic.EndOfRow
Selection.EndKey Unit:=wdRow EndOfRow

Moves to the last
cell in the current
row

Zeilenende
Alt+End
(Markieren: +Umschalt)

Alt+End 2367 273

BeginnSpalte
Springt zur ersten Zelle in
der aktuellen
Tabellenspalte.

WordBasic.StartOfColumn StartOfColumn
Moves to the first
cell in the current
column

Spaltenanfang
Alt+Bild-AUF-Taste
(Markieren: +Umschalt)

Alt+PgUp 2368 274

EndeSpalte
Springt zur letzten Zelle in
der aktuellen
Tabellenspalte.

WordBasic.EndOfColumn EndOfColumn
Moves to the last
cell in the current
column

Ende der Spalte
Alt+Bild-AB-Taste
(Markieren: +Umschalt)

Alt+PgDn (to
select to end of
column, use
Alt+Shift+PgDn)

2369 275

WW7_EinfügenSpaltenWechsel Fügt vor der Einfügemarke
einen Spaltenwechsel ein. Selection.InsertBreak Type:=wdColumnBreak WW7_InsertColumnBreak Spaltenwechsel W7 einfügen 2370 278
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EinfügenSpaltenwechsel Fügt vor der Einfügemarke
einen Spaltenumbruch ein Selection.InsertBreak Type:=wdColumnBreak InsertColumnBreak

Inserts a column
break at the
insertion point

Spaltenwechsel einfügen
Strg+Umschalt+Return Ctrl+Shift+Return 2371 831

AnwMinimieren
Verkleinert das
Anwendungsfenster zum
Symbol.

WordBasic.AppMinimize AppMinimize
Minimizes the
application window
to an icon

Alle Minimieren 2372 279

AnwVollbild
Vergrößert das
Anwendungsfenster auf
Vollbild.

WordBasic.AppMaximize AppMaximize
Enlarges the
application window
to full size

Alle maximieren
Alt+F10 Alt+F10 2373 280

AnwWiederherstellen
Stellt die Normalgröße des
Anwendungsfensters wieder
her.

WordBasic.AppRestore AppRestore
Restores the
application window
to normal size

Alle wiederherstellen
Alt+F5 Alt+F5 2374 281

FeldaktionAusführen
Führt die mit dem
Schaltflächen-Feld
verbundene Aktion aus.

Selection.Fields(1).DoClick DoFieldClick
Executes the
action associated
with the button
fields

Feldklick ausführen
Alt+Umschalt+F9 Alt+Shift+F9 2375 282

MarkierungAktuellSchriftart
Markiert alle Zeichen mit
derselben Schriftart und
demselben Schriftgrad.

Selection.SelectCurrentFont SelectCurFont
Selects all
characters with the
same font name
and point size

Aktuelle Schriftart übernehmen 2376 286

MarkierungAktuellAusrichtung Markiert alle Absätze mit
derselben Ausrichtung. Selection.SelectCurrentAlignment SelectCurAlignment

Selects all
paragraphs with
the same
alignment

Aktuelle Ausrichtung
übernehmen 2377 287

MarkierungAktuellAbstand Markiert alle Absätze mit
demselben Zeilenabstand. Selection.SelectCurrentSpacing SelectCurSpacing

Selects all
paragraphs with
the same line
spacing

Aktuellen Abstand übernehmen 2378 288

MarkierungAktuellEinzug Markiert alle Absätze mit
demselben Einzug. Selection.SelectCurrentIndent SelectCurIndent

Selects all
paragraphs with
the same
indentation

Aktuellen Einzug übernehmen 2379 289

MarkierungAktuellTab Markiert alle Absätze mit
denselben Tabstopps. Selection.SelectCurrentSpacing SelectCurTabs

Selects all
paragraphs with
the same tabs

Aktuelle Tabstopps
übernehmen 2380 290

MarkierungAktuellFarbe Markiert alle Zeichen mit
derselben Farbe. Selection.SelectCurrentColor SelectCurColor

Selects all
characters with the
same color

Aktuelle Farbe übernehmen 2381 291

EntfernenPosRahmen Entfernt Frameformatierung
von der Markierung WordBasic.RemoveFrames RemoveFrames

Removes frame
formatting from the
selection

Positionsrahmen entfernen 2382 292

MenüModus Aktiviert die Menüleiste. WordBasic.MenuMode MenuMode Makes the menu
bar active

Menümodus
Alt oder F10 Alt or F10 2383 293

FormatSeitenzahl
Ändert das
Erscheinungsbild der
Seitenzahlen.

Dialogs(wdDialogFormatPageNumber).Show FormatPageNumber
Changes the
appearance of
page numbers

Kopf- und Fußzeile Format Seitenzahlen Header and
Footer 2384 298

AnsichtZoom200
Ändert die Größe der
Bearbeitungsansicht auf
200% in der Normalansicht.

ActiveWindow.ActivePane.View.Zoom.Percentage = 200 ViewZoom200
Scales the editing
view to 200% in
normal view

Ansicht Zoom200 2385 573

AnsichtZoom75
Ändert die Größe der
Bearbeitungsansicht auf
75% in der Normalansicht.

ActiveWindow.ActivePane.View.Zoom.Percentage = 75 ViewZoom75
Scales the editing
view to 75% in
normal view

Ansicht Zoom75 2386 574

EmpfängerAdreßSchriftart
Formatiert die Schriftart der
Empfängeradresse für
Briefumschläge.

Dialogs(wdDialogFormatAddrFonts).Show FormatAddrFonts
Formats the
delivery address
font for envelopes

Format Adressschriftart 2387 103

FormatAbsenderSchriftart
Formatiert die Schriftart der
Absenderadresse für
Briefumschläge.

Dialogs(wdDialogFormatRetAddrFonts).Show FormatRetAddrFonts
Formats the return
address font for
envelopes

Format Absender-Schriftart 2388 221

ExtrasOptionenDateiablage
Ändert die
Standardeinstellungen, die
Word zum Auffinden von
Dateien verwendet.

Dialogs(wdDialogToolsOptionsFileLocations).Show ToolsOptionsFileLocations
Changes the
default locations
Word uses to find
files

Extras > Optionen Dateiablage 2389 225

ExtrasVerzeichnisErstellen Erstellt ein neues
Verzeichnis Dialogs(wdDialogToolsCreateDirectory).Show ToolsCreateDirectory Creates a new

directory Extras Verzeichnis erstellen 2390 833

VerzeichnisAktualisieren

Wählen Sie die Methode,
nach der das
Inhaltsverzeichnis oder
Abbildungsverzeichnis
aktualisiert werden soll.

Dialogs(wdDialogUpdateTOC).Show UpdateToc
Select method of
updating a table of
contents or figures

Inhaltsverzeichnis aktualisieren 2391 331

AnsichtFußnotenTrennlinie
Öffnet ein Fenster zum
Kontrollieren und
Bearbeiten der
Fußnotentrennlinie.

ActiveWindow.View.SplitSpecial = wdPaneFootnoteSeparator ViewFootnoteSeparator
Opens a pane for
viewing and
editing the
footnote separator

Ansicht > Fußnoten >
Fußnotentrennlinie (Normal-
Ansicht)

Footnote pane (in
Normal View) 2399 493
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AnsichtFußnotenFortsetzungsTrennlinie
Öffnet ein Fenster zum
Kontrollieren und
Bearbeiten der Fußnoten-
Fortsetzungstrennlinie.

ActiveWindow.View.SplitSpecial =
wdPaneFootnoteContinuationSeparator ViewFootnoteContSeparator

Opens a pane for
viewing and
editing the
footnote
continuation
separator

Ansicht > Fußnoten >
Fußnoten-
Fortsetzungstrennlinie (Normal-
Ansicht)

Footnote pane (in
Normal View) 2400 494

AnsichtFußnotenFortsetzungsHinweis
Öffnet ein Fenster zum
Kontrollieren und
Bearbeiten des Fußnoten-
Fortsetzungshinweises.

ActiveWindow.View.SplitSpecial =
wdPaneFootnoteContinuationNotice ViewFootnoteContNotice

Opens a pane for
viewing and
editing the
footnote
continuation notice

Ansicht > Fußnoten >
Fußnoten-Fortsetzungshinweis
(Normal-Ansicht)

Footnote pane (in
Normal View) 2401 495

AnsichtEndnotenTrennlinie
Öffnet ein Fenster zum
Kontrollieren und
Bearbeiten der
Endnotentrennlinie.

ActiveWindow.View.SplitSpecial = wdPaneEndnoteSeparator ViewEndnoteSeparator
Opens a pane for
viewing and
editing the
endnote separator

Ansicht > Fußnoten >
Endnotentrennlinie (Normal-
Ansicht)

Endnote pane (in
Normal View) 2402 496

AnsichtEndnotenFortsetzungsTrennlinie
Öffnet ein Fenster zum
Kontrollieren und
Bearbeiten der Endnoten-
Fortsetzungstrennlinie.

ActiveWindow.View.SplitSpecial =
wdPaneEndnoteContinuationSeparator ViewEndnoteContSeparator

Opens a pane for
viewing and
editing the
endnote
continuation
separator

Ansicht > Fußnoten >
Endnoten-
Fortsetzungstrennlinie (Normal-
Ansicht)

Endnote pane (in
Normal View) 2403 497

AnsichtEndnotenFortsetzungsHinweis
Öffnet ein Fenster zum
Kontrollieren und
Bearbeiten des Endnoten-
Fortsetzungshinweises.

ActiveWindow.View.SplitSpecial =
wdPaneEndnoteContinuationNotice ViewEndnoteContNotice

Opens a pane for
viewing and
editing the
endnote
continuation notice

Ansicht > Fußnoten >
Endnoten-Fortsetzungshinweis
(Normal-Ansicht)

Endnote pane (in
Normal View) 2404 498

EinfügenAutoBeschriftung
Bestimmt Objekte, die beim
Einfügen mit einer
Beschriftung versehen
werden.

Dialogs(wdDialogInsertAutoCaption).Show InsertAutoCaption
Defines which
objects are
inserted with a
caption

AutoBeschriftung einfügen 2412 359

EinfügenBeschriftungHinzu
Fügt eine neue
Beschriftungskategorie
hinzu.

Dialogs(wdDialogInsertAddCaption).Show InsertAddCaption Adds a new
caption type Beschriftung hinzufügen 2413 402

EinfügenBeschriftungNumerierung
Bestimmt die Nummer für
eine
Beschriftungskategorie.

Dialogs(wdDialogInsertCaptionNumbering).Show InsertCaptionNumbering Sets the number
for a caption type

Beschriftungsnummerierung
einfügen 2414 358

ExtrasAutoKorrekturTextErsetzen
Markiert das AutoKorrektur-
Kontrollkästchen "Während
der Eingabe ersetzen" oder
löscht die Markierung.

AutoCorrect.ReplaceText = Not AutoCorrect.ReplaceText ToolsAutoCorrectReplaceText
Selects or clears
the AutoCorrect
ReplaceText
check box

Extras >
AutoKorrektur...

Während der Eingabe ersetzen
Text ersetzen

Tools >
AutoCorrect 2415 380

ExtrasAutoKorrekturAnfangsbuchstabenGroß

Markiert das AutoKorrektur-
Kontrollkästchen "Zwei
Großbuchstaben am
Wortanfang korrigieren"
oder löscht die Markierung.

AutoCorrect.CorrectInitialCaps = Not
AutoCorrect.CorrectInitialCaps ToolsAutoCorrectInitialCaps

Selects or clears
the AutoCorrect
InitialCaps check
box

Extras >
AutoKorrektur...

Zwei GRoßbuchstaben am
Wortanfang korrigieren

Tools >
AutoCorrect 2416 381

ExtrasAutoKorrekturSatzanfangGroß

Markiert das AutoKorrektur-
Kontrollkästchen "Jeden
Satz mit einem
Großbuchstaben beginnen"
oder löscht die Markierung.

AutoCorrect.CorrectSentenceCaps = Not
AutoCorrect.CorrectSentenceCaps ToolsAutoCorrectSentenceCaps

Selects or clears
the AutoCorrect
SentenceCaps
check box

Extras >
AutoKorrektur...

Jeden Satz mit einem
Großbuchstaben beginnen
Satzanfang groß

Tools >
AutoCorrect 2417 383

ExtrasAutoKorrekturTage
Aktiviert oder deaktiviert das
Kontrollkästchen
AutoKorrekturtage

AutoCorrect.CorrectDays = Not AutoCorrect.CorrectDays ToolsAutoCorrectDays
Selects or clears
the AutoCorrect
Days check box

Extras >
AutoKorrektur...

Wochentage immer groß
schreiben
Tage korrigieren

Tools >
AutoCorrect 2418 384

ExtrasAutoKorrekturAnfZeichenTypogr

Markiert AutoKorrektur-
Kontrollkästchen "Gerade
Anführungszeichen durch
typographische ersetzen"
oder löscht die Markierung.

WordBasic.ToolsAutoCorrectSmartQuotes ToolsAutoCorrectSmartQuotes
Selects or clears
the AutoCorrect
SmartQuotes
check box

Extras >
AutoKorrektur...

AutoFormat während der
Eingabe > Gerade
Anführungszeichen durch
typographische ersetzen
Typographische
Anführungszeichen

Tools >
AutoCorrect 2419 227

ExtrasAutokorrekturFeststelltasteAus

Schaltet das
Kontrollkästchen
"Unbeabsichtigtes
Verwenden der
fESTSTELLTASTE" ein
oder aus

AutoCorrect.CorrectCapsLock = Not AutoCorrect.CorrectCapsLock ToolsAutoCorrectCapsLockOff
Selects or clears
the AutoCorrect
Caps Lock Off
check box

Extras >
AutoKorrektur...

Unbeabsichtigtes Verwenden
der fESTSTELLTASTE
korrigieren
Feststelltaste aus

Tools >
AutoCorrect 2420 767

ExtrasAutoKorrekturAusnahmen

Fügt der Liste, welche die
AutoKorrektur-Ausnahmen
für die Großschreibung
enthält, Einträge hinzu oder
löscht sie aus der Liste

Dialogs(wdDialogToolsAutoCorrectExceptions).Show ToolsAutoCorrectExceptions
Adds or deletes
AutoCorrect
Capitalization
exceptions

Extras
AutoKorrekturausnahmen 2421 762

AutoZusammenfassenProzentVomOriginal
Ändert die Größe der
automatischen
Zusammenfassung

AutoSummarizePercentOfOriginal
Changes the size
of the automatic
summary

AutoZusammenfassen Prozent vom Original AutoSummarize 2422 909

AnwGrößeÄndern Ändert die Größe des
Anwendungsfensters. WordBasic.AppSize AppSize

Changes the size
of the application
window

Alle vergrößern 2427 419
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AnwVerschieben Ändert die Position des
Anwendungsfensters. WordBasic.AppMove AppMove

Changes the
position of the
application window

Alle Verschieben 2428 418

Verbinden Stellt eine Verbindung zu
einem Netzlaufwerk her. Dialogs(wdDialogConnect).Show Connect Connects to a

network drive Verbinden 2429 420

ExtrasOptionenAnsicht
Bestimmt spezielle
Optionen für den
Ansichtmodus.

Dialogs(wdDialogToolsOptionsView).Show ToolsOptionsView Set specific view
mode options Extras > Optionen Ansicht Tools > Options 2430 204

GeheZuKommentarBereich
Hebt den Text hervor, der
mit einem
Kommentarverweiszeichen
gekennzeichnet ist

Selection.Comments(1).Range.Select GotoCommentScope
Highlights the text
associated with an
comment
reference mark

Gehe zu Kommentarbereich 2436 597

SchriftartenErsetzung Ersetzt nicht verfügbare
Schriftarten im Dokument. Dialogs(wdDialogFontSubstitution).Show FontSubstitution

Changes the
document's font
mapping

Schriftartenersetzung 2437 581

AnzeigeAktualisierung Aktualisiert die Anzeige. Application.ScreenRefresh ScreenRefresh Refreshes the
display Bildschirmaktualisierung 2438 665

ZeichenLinks Bewegt die Einfügemarke
um ein Zeichen nach links. Selection.MoveLeft Unit:=wdCharacter, Count:=1 CharLeft

Moves the
insertion point to
the left one
character

Zeichen links
Links Left arrow 2439 4000

ZeichenRechts Bewegt die Einfügemarke
um ein Zeichen nach rechts. Selection.MoveRight Unit:=wdCharacter, Count:=1 CharRight

Moves the
insertion point to
the right one
character

Zeichen rechts
Rechts Right arrow 2440 4001

WortLinks Bewegt die Einfügemarke
um ein Wort nach links. Selection.MoveLeft Unit:=wdWord, Count:=1 WordLeft

Moves the
insertion point to
the left one word

Wort nach links
Strg+Links Ctrl+left arrow 2441 4002

WortRechts Bewegt die Einfügemarke
um ein Wort nach rechts. Selection.MoveRight Unit:=wdWord, Count:=1 WordRight

Moves the
insertion point to
the right one word

Wort nach rechts
Strg+Rechts Ctrl+rt arrow 2442 4003

SatzLinks
Bewegt die Einfügemarke
zum Anfang des vorherigen
Satzes.

Selection.MoveLeft Unit:=wdSentence, Count:=1 SentLeft

Moves the
insertion point to
the beginning of
the previous
sentence

Satz nach links 2443 4004

SatzRechts
Bewegt die Einfügemarke
zum Anfang des nächsten
Satzes.

Selection.MoveRight Unit:=wdSentence, Count:=1 SentRight
Moves the
insertion point to
beginning of the
next sentence

Satz nach rechts 2444 4005

AbsatzOben
Bewegt die Einfügemarke
zum Anfang des vorherigen
Absatzes.

Selection.MoveUp Unit:=wdParagraph, Count:=1 ParaUp

Moves the
insertion point to
the beginning of
the previous
paragraph

Absatz nach oben
Strg+Aufwärts Ctrl+up arrow 2445 4006

AbsatzUnten
Bewegt die Einfügemarke
zum Anfang des nächsten
Absatzes.

Selection.MoveDown Unit:=wdParagraph, Count:=1 ParaDown
Moves the
insertion point to
the beginning of
the next paragraph

Absatz nach unten
Strg+Abwärts Ctrl+down arrow 2446 4007

ZeileOben Bewegt die Einfügemarke
um eine Zeile nach oben. Selection.MoveUp Unit:=wdLine, Count:=1 LineUp

Moves the
insertion point up
one line

Zeile nach oben
Aufwärts Up arrow 2447 4008

ZeileUnten Bewegt die Einfügemarke
um eine Zeile nach unten. Selection.MoveDown Unit:=wdLine, Count:=1 LineDown

Moves the
insertion point
down one line

Zeile nach unten
Abwärts Down arrow 2448 4009

ZeichenLinksErweitern Erweitert die Markierung
nach links um ein Zeichen.

Selection.MoveLeft Unit:=wdCharacter, Count:=1,
Extend:=wdExtend CharLeftExtend

Extends the
selection to the left
one character

Zeichen links erweitern
Umschalt+Links Shift+Left arrow 2449 4018

ZeichenRechtsErweitern Erweitert die Markierung
nach rechts um ein Zeichen.

Selection.MoveRight Unit:=wdCharacter, Count:=1,
Extend:=wdExtend CharRightExtend

Extends the
selection to the
right one character

Zeichen rechts erweitern
Umschalt+Rechts Shift+Right arrow 2450 4019

WortLinksErweitern Erweitert die Markierung
nach links um ein Wort. Selection.MoveLeft Unit:=wdWord, Count:=1, Extend:=wdExtend WordLeftExtend

Extends the
selection to the left
one word

Wort nach links erweitern
Strg+Umschalt+Links

Shift+Ctrl+left
arrow 2451 4020

WortRechtsErweitern Erweitert die Markierung
nach rechts um ein Wort. Selection.MoveRight Unit:=wdWord, Count:=1, Extend:=wdExtend WordRightExtend

Extends the
selection to the
right one word

Wort nach rechts erweitern
Strg+Umschalt+Rechts

Shift+Ctrl+rt
arrow 2452 4021

SatzLinksErweitern
Erweitert die Markierung
nach links bis zum Anfang
des vorherigen Satzes.

Selection.MoveLeft Unit:=wdSentence, Count:=1,
Extend:=wdExtend SentLeftExtend

Extends the
selection to the
beginning of the
previous sentence

Satz nach links erweitern 2453 4022

SatzRechtsErweitern
Erweitert die Markierung.
nach rechts bis zum Anfang
des nächsten Satzes.

Selection.MoveRight Unit:=wdSentence, Count:=1,
Extend:=wdExtend SentRightExtend

Extends the
selection to
beginning of the
next sentence

Satz nach rechts erweitern 2454 4023
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AbsatzObenErweitern
Erweitert die Markierung
nach oben bis zum Anfang
des vorherigen Absatzes.

Selection.MoveUp Unit:=wdParagraph, Count:=1,
Extend:=wdExtend ParaUpExtend

Extends the
selection to the
beginning of the
previous
paragraph

Absatz nach oben erweitern
Strg+Umschalt+Aufwärts

Shift+Ctrl+up
arrow 2455 4024

AbsatzUntenErweitern
Erweitert die Markierung
nach unten bis zum Anfang
des nächsten Absatzes.

Selection.MoveDown Unit:=wdParagraph, Count:=1,
Extend:=wdExtend ParaDownExtend

Extends the
selection to the
beginning of the
next paragraph

Absatz nach unten erweitern
Strg+Umschalt+Abwärts

Shift+Ctrl+down
arrow 2456 4025

ZeileObenErweitern Erweitert die Markierung
nach oben um eine Zeile. Selection.MoveUp Unit:=wdLine, Count:=1, Extend:=wdExtend LineUpExtend

Extends the
selection up one
line

Zeile nach oben erweitern
Umschalt+Aufwärts Shift+up arrow 2457 4026

ZeileUntenErweitern Erweitert die Markierung
nach unten um eine Zeile. Selection.MoveDown Unit:=wdLine, Count:=1, Extend:=wdExtend LineDownExtend

Extends the
selection down
one line

Zeile nach unten erweitern
Umschalt+Abwärts Shift+down arrow 2458 4027

BildAufErweitern
Erweitert die Markierung um
eine Bildschirmseite nach
oben.

Selection.MoveUp Unit:=wdScreen, Count:=1, Extend:=wdExtend PageUpExtend

Extends the
selection and
changes the
document display
to the previous
screen of text

Seite nach oben erweitern
Umschalt+Bild-AUF-Taste Shift+PgUp 2459 4028

BildAbErweitern
Erweitert die Markierung um
eine Bildschirmseite nach
unten.

Selection.MoveDown Unit:=wdScreen, Count:=1,
Extend:=wdExtend PageDownExtend

Extends the
selection and
changes the
document display
to the next screen
of text

Seite nach unten erweitern
Umschalt+Bild-AB-Taste Shift+PgDn 2460 4029

BeginnZeileErweitern
Erweitert die Markierung
nach links bis zum Anfang
der aktuellen Zeile.

Selection.HomeKey Unit:=wdLine, Extend:=wdExtend StartOfLineExtend
Extends the
selection to the
beginning of the
current line

Zeilenanfang erweitern
Umschalt+Pos1 Shift+Home 2461 4030

EndeZeileErweitern
Erweitert die Markierung bis
zum Ende der aktuellen
Zeile.

Selection.EndKey Unit:=wdLine, Extend:=wdExtend EndOfLineExtend
Extends the
selection to the
end of the current
line

Erweitern zum Ende der Zeile
Umschalt+End Shift+End 2462 4031

BeginnFensterErweitern
Erweitert die Markierung bis
zur ersten sichtbaren Zeile
auf dem Bildschirm.

Selection.HomeKey Unit:=wdWindow, Extend:=wdExtend StartOfWindowExtend

Extends the
selection to the
beginning of the
first visible line on
the screen

Fensteranfang erweitern
Alt+Strg+Umschalt+Bild-AUF-
Taste

Shift+Alt+Ctrl+Pg
Up 2463 4032

EndeFensterErweitern
Erweitert die Markierung bis
zur letzten sichtbaren Zeile
auf dem Bildschirm.

Selection.EndKey Unit:=wdWindow, Extend:=wdExtend EndOfWindowExtend

Extends the
selection to the
end of the last
visible line on the
screen

Erweitern zum Fensterende
Alt+Strg+Umschalt+Bild-AB-
Taste

Shift+Alt+Ctrl+Pg
Dn 2464 4033

BeginnDokumentErweitern
Erweitert die Markierung
nach oben bis zum Anfang
der ersten Zeile des
Dokumentes.

Selection.HomeKey Unit:=wdStory, Extend:=wdExtend StartOfDocExtend

Extends the
selection to the
beginning of the
first line of the
document

Dokumentanfang erweitern
Strg+Umschalt+Pos1 Ctrl+Shift+Home 2465 4034

EndeDokumentErweitern
Erweitert die Markierung bis
zum Ende der letzten Zeile
des Dokuments.

Selection.EndKey Unit:=wdStory, Extend:=wdExtend EndOfDocExtend
Extends the
selection to the
end of the last line
of the document

Erweitern zum Ende des
Dokuments
Strg+Umschalt+End

Ctrl+Shift+End 2466 4035

SymbolSchriftart Weist der Markierung die
Schriftart "Symbol" zu Selection.Font.Name = "Symbol" SymbolFont

Applies the
Symbol font to the
selection

Symbolschriftart
Strg+Umschalt+B Ctrl+Shift+Q 2467 651

ExtrasGrammatikEinstellungen Grammatik-Einstellungen
anpassen WordBasic.ToolsGramSettings ToolsGramSettings Customize

Grammar Settings Extras Grammatikeinstellungen 2469 885

DateiNeuStandard
Erstellt ein neues, auf der
Vorlage NORMAL.DOT
basierendes Dokument.

FileNewDefault
Creates a new
document based
on the NORMAL
template

Standard
Word für Windows 2.0

Neues leeres Dokument
Strg+N

Standard
Word for
Windows 2.0

Ctrl+N 2520 301

DateiDruckenStandard
Druckt das aktive Dokument
mit den aktuellen
Standardeinstellungen.

ActiveDocument.PrintOut FilePrintDefault
Prints the active
document using
the current
defaults

Standard
Seitenansicht
Nachricht lesen
E-Mail senden
Outlook-E-Mail lesen
Outlook-E-Mail senden

Drucken...
Strg+P oder
Strg+Umschalt+F12

Standard
Print Preview
Read Mail
Send Mail
Outlook Read
Mail
Outlook Send
Mail

2521 302

DateiVersionen Verwaltet die Versionen
eines Dokuments Dialogs(wdDialogFileVersions).Show FileVersions

Manages the
versions of a
document

Datei Version...
Versionen... File 2522 945
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ExtrasÜberprüfung Überprüft die Korrekturen
im aktuellen Dokument Dialogs(wdDialogToolsSpellingAndGrammar).Show ToolsProofing

Checks the
proofing in the
active document

Extras
Standard
E-Mail senden

Rechtschreibung und
Grammatik...
F7

Tools
Standard
Send Mail

F7 2566 828

ExtrasÜberarbeitungsMarkierungVorher Vorherige Änderung suchen Selection.PreviousRevision (True) ToolsRevisionMarksPrev Find previous
change Überarbeiten Vorherige Änderung Reviewing 2604 970

ExtrasÜberarbeitungsMarkierungNächste Nächste Änderung suchen Selection.NextRevision (True) ToolsRevisionMarksNext Find next change Überarbeiten Nächste Änderung Reviewing 2605 971

MailNachrichtEigenschaften Definiert die Eigenschaften
der Nachricht MailMessageProperties

Sets the properties
of the mail
message

E-Mail senden Eigenschaften Send Mail 2618 764

EinfügenGrafik Fügt eine Grafik ein. Dialogs(wdDialogInsertPicture).Show InsertPicture
Inserts a picture
from a graphics
file

Einfügen > Grafik
Kontext

Aus Datei...
Grafik...

Insert
Context 2619 163

RahmenLinieStärke
Ändert die
Rahmenlinienstärke der
markierten Absätze,
Tabellenzellen und Grafiken

BorderLineWeight

Changes border
line weights of the
selected
paragraphs, table
cells, and pictures

Tabellen und Rahmen Linienstärke Tables and
Borders 2622 961

RahmenLinieFarbe

Rahmenfarbe ButtonPopup
Ändert die
Rahmenlinienfarbe der
markierten Absätze,
Tabellenzellen und Grafiken

BorderLineColor

Changes border
line color of the
selected
paragraphs, table
cells, and pictures

Tabellen und Rahmen Rahmenfarbe Tables and
Borders 2628 964

(AutoFormen-Auswahldialog) Einfügen > Grafik AutoFormen 2630

(Linien ButtonPopup) Zeichnen > AutoFormen Linien Drawing >
AutoShapes 2631

(Standardformen ButtonPopup) Zeichnen > AutoFormen Standardformen Drawing >
AutoShapes 2632

(Verbindungen ButtonPopup) ??? Verbindungen 2633

ZeichnenEinfügenSonne
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertSun Zeichnen > AutoFormen
> Standardformen Sonne

Drawing >
AutoShapes >
Basic Shapes

2634

ZeichnenEinfügenMond
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertMoon Zeichnen > AutoFormen
> Standardformen Mond

Drawing >
AutoShapes >
Basic Shapes

2635

Eckige Klammer links/rechts
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertBracketPair Zeichnen > AutoFormen
> Standardformen Eckige Klammer links/rechts

Drawing >
AutoShapes >
Basic Shapes

2636

Geschweifte Klammer links/rechts
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertBracePair Zeichnen > AutoFormen
> Standardformen

Geschweifte Klammer
links/rechts

Drawing >
AutoShapes >
Basic Shapes

2637

Stern mit 4 Ecken
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertSeal4 Zeichnen > AutoFormen
> Sterne und Banner Stern mit 4 Ecken

Drawing >
AutoShapes >
Stars & Banners

2638

Doppelte Welle
Zeichnet eine AutoForm im
aktiven Fenster an der
Stelle, an der Sie klicken
oder ziehen.

DrawInsertDoubleWave Zeichnen > AutoFormen
> Sterne und Banner Doppelte Welle

Drawing >
AutoShapes >
Stars & Banners

2639

ZeichnenGeradeVerbindungMitPfeilEinfügen (?)

Zeichnet eine gerade
Verbindung mit Pfeil
zwischen den blauen
Verbindungsseiten, die Sie
auf zwei AutoFormen
auswählen.

??? ??? Gerade Verbindung mit Pfeil 2640

ZeichnenGeradeVerbindungMitDopelpfeilEinfüge
n (?)

Zeichnet eine gerade
Verbindung mit Doppelpfeil
zwischen den blauen
Verbindungsseiten, die Sie
auf zwei AutoFormen
auswählen.

??? ??? Gerade Verbindung mit
Doppelpfeil 2641

ZeichnenGewinkelteVerbindungMitPfeilEinfügen
(?)

Zeichnet eine 90 Grad
gewinkelte Verbindung mit
Pfeil zwischen den blauen
Verbindungsseiten, die Sie
auf zwei AutoFormen
auswählen.

??? ??? Gewinkelte Verbindung mit Pfeil 2642
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ZeichnenGewinkelteVerbindungMitDoppelpfeilEin
fügen (?)

Zeichnet eine 90 Grad
gewinkelte Verbindung mit
Doppelpfeil zwischen den
blauen Verbindungsseiten,
die Sie auf zwei
AutoFormen auswählen.

??? ??? Gewinkelte Verbindung mit
Doppelpfeil 2643

ZeichnenGekrümmteVerbindungMitPfeilEinfügen
(?)

Fügt eine Linie mit einer
Pfeilspitze an der Stelle ein,
auf der Sie im aktiven
Fenster klicken.

??? ??? Gekrümmte Verbindung mit
Pfeil 2644

ZeichnenGekrümmteVerbindungMitDoppelpfeilEi
nfügen (?)

Zeichnet eine gekrümmte
Verbindung mit Doppelpfeil
zwischen den blauen
Verbindungsseiten, die Sie
auf zwei AutoFormen
auswählen.

??? ??? Gekrümmte Verbindung mit
Doppelpfeil 2645

HyperlinkÖffnen Öffnen Selection.Range.Hyperlinks(1).Follow AddHistory:=True HyperlinkOpen Open Kontext Öffnen Context Click on it 2664 920
Form ändern zu Sonne Form ändern zu Sonne 2677
Form ändern zu Mond Form ändern zu Mond 2678
Form ändern zu eckige
Klammer links/rechts

Form ändern zu eckige
Klammer links/rechts 2679

Form ändern zu
geschweifte Klammer
links/rechts

Form ändern zu geschweifte
Klammer links/rechts 2680

Form ändern zu Stern mit 4
Ecken

Form ändern zu Stern mit 4
Ecken 2681

Form ändern zu doppelte
Welle Form ändern zu doppelte Welle 2682

Löscht den markierten
Abschnitt.

Zeichnen.Kurvenabschni
tt Abschnitt löschen Curve Segment 2692

Fügt einen kleinen
Zwischenraum zwischen
den Anfang und dem Ende
einer geschlossenen
Kurvenlinie ein.

Zeichnen.Kurve
Zeichnen.Kurvenpunkt
Zeichnen.Kurvenabschni
tt

Kurve öffnen
Curve
Curve Node
Curve Segment

2693

Film aus Clip Gallery
einfügen
Führt Microsoft Clip Gallery
aus und sucht nach Filmen

Film aus Gallery... 2705

Sound aus Gallery einfügen
Führt Microsoft Clip Gallery
aus und sucht nach Sounds

Sound aus Gallery... 2707

FormatZeichenObjektUmbruchObenUnten
Setzt die markierten
Zeichnungsobjekte auf
"Umbruch oben/unten"

FormatDrawingObjectWrapTopBottom

Changes the
selected drawing
objects to
top/bottom
wrapping

Zeichnen
WordArt
Textfluss
Kontext

> Oben und unten
Drawing
WordArt
Text Wrapping
Context

2766 4092

FormatZeichenObjektUmbruchDurch
Ändert den Umbruch der
markierten
Zeichnungsobjekte auf
"genau durchgehend"

FormatDrawingObjectWrapThrough
Changes the
selected drawing
objects to tight
through wrapping

Zeichnen
WordArt
Textfluss
Kontext

> Transparent
Drawing
WordArt
Text Wrapping
Context

2767 4090

ExtrasMakroAufzeichnenUmschalten Schaltet den Makrorekorder
ein oder aus Dialogs(wdDialogToolsMacroRecord).Show ToolsRecordMacroToggle Turns macro

recording on or off Extras > Makro Aufzeichnen... Visual Basic
toolbar 2780 214

ExtrasAutoManager
Ändert verschiedene
Kategorien der Auto-
Optionen von Word

Dialogs(wdDialogToolsAutoManager).Show ToolsAutoManager
Changes various
categories of Word
Auto options

AutoManager... Tools 2781 915

EndnotenFußnotenVertauschen
Wandelt markierte
Fußnoten in Endnoten oder
markierte Endnoten in
Fußnoten um.

If Selection.StoryType = wdFootnotesStory Then
Selection.Footnotes.Convert

Else
Selection.Endnotes.Convert

End If

EditConvertNotes

Converts selected
footnotes into
endnotes, or
converts selected
endnotes into
footnotes

Fußnoten
Endnoten In Endnoten umwandeln Footnotes

Endnotes 2783 462

VorgabeFußnotenTrennlinieOderHinweis
Setzt die Tennlinie, die
Fortsetzungstrennlinie oder
den Fortsetzungshinweis
zur Vorgabe zurück.

ActiveDocument.Footnotes.ResetSeparator
ActiveDocument.Footnotes.ResetContinuationSeparator
ActiveDocument.Footnotes.ResetContinuationNotice

ResetNoteSepOrNotice

Resets a
separator,
continuation
separator, or
continuation notice
to the Word
default

Zurücksetzen 2786 388

BearbeitenEinfügenAlsHyperlink
Fügt den Inhalt der
Zwischenablage als
Hyperlinkobjekt ein

Selection.PasteSpecial Link:=True, DataType:=wdPasteHyperlink EditPasteAsHyperlink
Inserts the
Clipboard contents
as a hyperlink
object

Bearbeiten Als Hyperlink einfügen 2787 976



Deutsch Beschreibung Makro-Beispiel English Description Type Symbolleiste Befehl/Kürzel Toolbar Shortcut Comm Dial

ExtrasOptionenRechtschreibung
Ändert die
Überprüfungsoptionen
Ändert die Optionen für die
Rechtschreibung.

Dialogs(wdDialogToolsOptionsSpellingAndGrammar).Show ToolsOptionsSpelling
Changes the
proofreader
options

Statusleiste für
Rechtschreibprüfung im
Hintergrund

Optionen...
Background
Proofing Status
Bar

2788 211

ExtrasOptionenGrammatik
Grammatikoptionen
Ändert die
Überprüfungsoptionen

WordBasic.ToolsOptionsGrammar ToolsOptionsGrammar
Changes the
proofreader
options

Grammatikoptionen 2789 212

EinzugErstesZeichen
Erweitert den hängenden
Einzug um eine
Zeichenbreite

Selection.ParagraphFormat.IndentFirstLineCharWidth 1 IndentFirstChar
Increases the
hanging indent by
width of a
character

Einzug für erstes Zeichen 2790 721

EinzugRückErstesZeichen
Reduziert den hängenden
Einzug um eine
Zeichenbreite

Selection.ParagraphFormat.IndentFirstLineCharWidth -1 UnIndentFirstChar
Decreases the
hanging indent by
width of a
character

Einzug für erstes Zeichen
rückgängig machen 2791 722

AnordnenAbsatz Verteilter Absatz. Selection.ParagraphFormat.Alignment =
wdAlignParagraphDistribute DistributePara Distributed

Paragraph Verteilter Absatz 2792 740

ÄndernByte
Wechselt zwischen breiten
und schmalen
Buchstabenarten in der
Markierung.

WordBasic.ChangeByte ChangeByte

Changes between
wide and narrow
versions of the
letters in the
selection

Bytes ändern 2793 730

ÄndernKana
Wechselt die Zeichen in der
Markierung zwischen
Katakana und Hiragana

WordBasic.ChangeKana ChangeKana

Changes the
characters in the
selection between
Katakana and
Hiragana

Kana wechseln 2794 731

KorrigierenÄnderung
Ersetzt das markierte Wort
durch den ausgewählten
Vorschlag

FixSpellingChange (Rechtschreibvorschläge) 2799 744

ExtrasSilbentrennung
Ändert die Einstellungen für
die Silbentrennung im
aktiven Dokument.

Dialogs(wdDialogToolsHyphenation).Show ToolsHyphenation
Changes the
hyphenation
settings for the
active document

Extras > Sprache (!) Silbentrennung... Tools >
Language (!) 2800 195

AnordnenAllgemein
Ordnet markierte
Zeilen/Spalten in einer
Tabelle gleichmäßig an.

DistributeGeneral
Evenly distributes
selected
rows/columns in a
table

Zeilen/Spalten verteilen 2801 866

VerbindenTeilenAllgemein Verbindet oder trennt die
markierten Tabellenzellen MergeSplitGeneral

Merges or splits
the selected table
cell(s)

Kontext Zellverbindung/-teilung Context 2802 867

PunktAkzent Formatiert die Markierung
mit Punktakzenten (ein/aus)

If Selection.Font.EmphasisMark = wdEmphasisMarkNone Then
Selection.Font.EmphasisMark = wdEmphasisMarkOverSolidCircle

Else
Selection.Font.EmphasisMark = wdEmphasisMarkNone

End If

DotAccent
Formats the
selection with dot
accents (toggle)

Erweiterte Formatierung Punktakzent Extended
Formatting 2805 765

KommaAkzent
Formatiert die Markierung
mit Kommaakzenten
(ein/aus)

If Selection.Font.EmphasisMark = wdEmphasisMarkNone Then
Selection.Font.EmphasisMark =

wdEmphasisMarkOverWhiteCircle
Else
Selection.Font.EmphasisMark = wdEmphasisMarkNone

End If

CommaAccent
Formats the
selection with
comma accents
(toggle)

Kommaakzent 2806 766

ExtrasOptionenFuzzy Ändert die Optionen für
Fuzzyausdrücke Dialogs(wdDialogToolsOptionsFuzzy).Show ToolsOptionsFuzzy

Changes the fuzzy
expressions
options

2807 790

ExtrasOptionenTypographie Ändert Typographie-
Optionen Dialogs(wdDialogToolsOptionsTypography).Show ToolsOptionsTypography

Changes the
Typography
options

Typografische Optionen 2808 739

ExtrasOptionenHHC Ändert HHC Optionen WordBasic.ToolsOptionsHHC ToolsOptionsHHC Changes the HHC
options Extras > Optionen HHC Tools > Options 2809 786

AnsichtFormatExSymbolleiste
Blendet die Erweiterte
Formatierungssymbolleiste
ein oder aus

Dialogs(wdDialogEditGoToOld).Show ViewFormatExToolbar
Shows or hides
the Extended
Formatting toolbar

Erweiterte Formatsymbolleiste 2810 811

WW7_FormatAufzählungUndNumerierung Erstellt eine Aufzählung
oder eine nummerierte Liste WordBasic.WW7_FormatBulletsAndNumbering WW7_FormatBulletsAndNumbering

Creates a
numbered or
bulleted list

2812 397

HilfeIchitaroHilfe Zeigt Konkurrenzhilfe (J
Ichitaro, Koreanisch WP) Help 13 HelpIchitaroHelp

Shows Competitor
(J Ichitaro, Korean
WP) Help

Ichitaro-Hilfe 2814 728

ExtrasKonsistenz
Japanischer
Konsistenzüberprüfung
Überprüft die Konsistenz im
aktiven Dokument

ActiveDocument.CheckConsistency ToolsConsistency
Checks the
consistency in the
active document

Extras > Sprache Japanischer
Konsistenzüberprüfung Tools > Language 2815 992
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TabelleGitternetzlinien
Schaltet die Anzeige der
Gitternetzlinien in der
Tabelle ein und aus.

ActiveWindow.View.TableGridlines = Not
ActiveWindow.View.TableGridlines TableGridlines

Toggles table
gridlines on and
off

Tabelle Gitternetzlinien ausblenden Table 2816 144

ExtrasAutoZusammenfassenStart
Erstellt automatisch eine
Zusammenfassung des
aktuellen Dokuments

Dialogs(wdDialogToolsAutoSummarize).Show ToolsAutoSummarizeBegin
Automatically
generates a
summary of the
active document

AutoZusammenfassen
Erneut zusammenfassen 2817 874

AutoZusammenfassenDateiEigenschaftenAktuali
sieren

Aktualisiert
Datei/Eigenschaften-
Information mit der aktuelle
Zusammenfassung

ActiveDocument.UpdateSummaryProperties AutoSummarizeUpdateFileProperties

Updates
File/Properties
information with
the current
summary

Eigenschaften aktualisieren 2818 908

WortLöschen
Löscht das folgende Wort,
ohne es in die
Zwischenablage zu
übertragen.

Selection.Delete Unit:=wdWord, Count:=1 DeleteWord
Deletes the next
word without
putting it on the
Clipboard

Nächstes Wort löschen
Strg+Entf Ctrl+Del 2820 28

LetztesWortLöschen
Löscht das vorherige Wort,
ohne es in die
Zwischenablage zu
übertragen.

Selection.Delete Unit:=wdWord, Count:=-1 DeleteBackWord
Deletes the
previous word
without putting it
on the Clipboard

Vorheriges Wort löschen
Strg+RÜCK Ctrl+Backspace 2821 29

ZeichenVorgabe
Ordnet der Formatvorlage
die Zeichenformatierung der
Markierung als Standard zu.

Selection.Font.Reset ResetChar

Makes the
selection the
default character
format of the
applied style

Zeichenformat zurücksetzen
Strg+Leertaste oder
Strg+Umschalt+Z

Ctrl+Spacebar 2822 56

Weist die angegebene
Schriftart dem markierten
Text zu.

Schriftartenname 2823

AnsichtFußzeile Zeigt Fußzeilen in der
Layout-Ansicht an

If ActiveWindow.View.SplitSpecial wdPaneNone Then
ActiveWindow.Panes(2).Close

End If
If ActiveWindow.ActivePane.View.Type = wdNormalView Or
ActiveWindow. _
ActivePane.View.Type = wdOutlineView Then
ActiveWindow.ActivePane.View.Type = wdPrintView

End If
ActiveWindow.ActivePane.View.SeekView =
wdSeekCurrentPageFooter

ViewFooter Displays footer in
page layout view Fußzeile anzeigen 2825 654

FormatÜberschriftenNumerierung
Ändert die
Nummerierungsoptionen
der Überschriften-
Formatvorlagen.

WordBasic.FormatHeadingNumbering FormatHeadingNumbering
Changes
numbering options
for heading level
styles

Überschriftnummerierung 2826 603

ZeichnenTransparenteFarbeBestimmen

Legt die transparente Farbe
für das markierte Bitmap
fest. Klicken Sie auf die
Farbe die transparent sein
soll. Dieses Tool funktioniert
nur mit Bitmap-Grafiken.

DrawSetTransparentColor Grafik Transparente Farbe bestimmen Picture 2827

FormatHintergrundMehrFarben
Stellt mehr Farboptionen für
die Hintergrundfarbe zur
Verfügung

WordBasic.FormatBackgroundMoreColors FormatBackgroundMoreColors
Provides more
color choices for
the background
color

Format > Hintergrund Weitere Farben... 2857 1005

FormatHintergrundFülleffekt
Stellt Fülleffekte für die
Hintergrundfarbe zur
Verfügung

WordBasic.FormatBackgroundFillEffect FormatBackgroundFillEffect
Provides fill effects
for the background
color

Format > Hintergrund Fülleffekte... Format 2858 1006

RahmenlinieOben
Ändert die obere
Rahmenlinie der markierten
Absätze, Tabellenzellen
oder Grafiken.

With Selection.Borders(wdBorderTop)
.LineStyle = Options.DefaultBorderLineStyle
.LineWidth = Options.DefaultBorderLineWidth
.Color = Options.DefaultBorderColor

End With

BorderTop

Changes the top
borders of the
selected
paragraphs, table
cells, and pictures

Format > Rahmen
Tabellen und Rahmen >
Rahmen
Rahmen

Rahmenlinie oben
Formatting
Tables and
Borders
Borders

2867 4062

RahmenlinieUnten
Ändert die untere
Rahmenlinie der markierten
Absätze, Tabellenzellen
oder Grafiken.

With Selection.Borders(wdBorderBottom)
.LineStyle = Options.DefaultBorderLineStyle
.LineWidth = Options.DefaultBorderLineWidth
.Color = Options.DefaultBorderColor

End With

BorderBottom

Changes the
bottom border of
the selected
paragraphs, table
cells, and pictures

Format > Rahmen
Tabellen und Rahmen >
Rahmen
Rahmen

Rahmenlinie unten
Formatting
Tables and
Borders
Borders

2868 4064

RahmenlinieLinks
Ändert die linke
Rahmenlinie der markierten
Absätze, Tabellenzellen und
Grafiken.

With Selection.Borders(wdBorderLeft)
.LineStyle = Options.DefaultBorderLineStyle
.LineWidth = Options.DefaultBorderLineWidth
.Color = Options.DefaultBorderColor

End With

BorderLeft

Changes the left
border of the
selected
paragraphs, table
cells, and pictures

Format > Rahmen
Tabellen und Rahmen >
Rahmen
Rahmen

Rahmenlinie links
Formatting
Tables and
Borders
Borders

2869 4063

RahmenlinieRechts
Ändert die rechte
Rahmenlinie der markierten
Absätze, Tabellenzellen und
Grafiken.

With Selection.Borders(wdBorderRight)
.LineStyle = Options.DefaultBorderLineStyle
.LineWidth = Options.DefaultBorderLineWidth
.Color = Options.DefaultBorderColor

End With

BorderRight

Changes the right
border of the
selected
paragraphs, table
cells, and pictures

Format > Rahmen
Tabellen und Rahmen >
Rahmen
Rahmen

Rahmenlinie rechts
Formatting
Tables and
Borders
Borders

2870 4065
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UmschaltenTextFluß Ändert die Textflussrichtung
und Zeichenorientierung WordBasic.ToggleTextFlow ToggleTextFlow

Changes text flow
direction and
character
orientation

Tabellen und Rahmen
Textfeld Textrichtung ändern

Tables and
Borders
Text Box

2872 1009

FormatLinienart FormatLineStyle Grafik Linienart Picture 2917 5727

WebSymbolleiste Websymbolleiste ein- oder
ausschalten WordBasic.WebToolbar WebToolbar Toggle Web

toolbar Websymbolleiste 2934 1008

SchattierungsFarbe
Ändert die
Schattierungsfarbe des
markierten Textes

ShadingColor
Changes the
shading color of
the selected text

Tabellen und Rahmen Schattierungsfarbe Tables and
Borders 2947 865

MicrosoftImWeb1 Microsoft Im Web 1 WordBasic.MicrosoftOnTheWeb1 MicrosoftOnTheWeb1 Microsoft On the
Web 1 Kostenloses Zubehör Word Help 3021 4094

MicrosoftImWeb2 Microsoft Im Web 2 WordBasic.MicrosoftOnTheWeb2 MicrosoftOnTheWeb2 Microsoft On the
Web 2 Produktneuigkeiten 3022 4095

MicrosoftImWeb3 Microsoft Im Web 3 WordBasic.MicrosoftOnTheWeb3 MicrosoftOnTheWeb3 Microsoft On the
Web 3 Häufig gestellte Fragen 3023 4096

MicrosoftImWeb4 Microsoft Im Web 4 WordBasic.MicrosoftOnTheWeb4 MicrosoftOnTheWeb4 Microsoft On the
Web 4 Onlinesupport 3024 4097

MicrosoftImWeb5 Microsoft Im Web 5 WordBasic.MicrosoftOnTheWeb5 MicrosoftOnTheWeb5 Microsoft On the
Web 5 Webhilfe 5 3025 4098

MicrosoftImWeb6 Microsoft Im Web 6 WordBasic.MicrosoftOnTheWeb6 MicrosoftOnTheWeb6 Microsoft On the
Web 6 Webhilfe 6 3026 4099

MicrosoftImWeb7 Microsoft Im Web 7 WordBasic.MicrosoftOnTheWeb7 MicrosoftOnTheWeb7 Microsoft On the
Web 7 Webhilfe 7 3027 4100

MicrosoftImWeb8 Microsoft Im Web 8 WordBasic.MicrosoftOnTheWeb8 MicrosoftOnTheWeb8 Microsoft On the
Web 8 Webhilfe 8 3028 4101

MicrosoftImWeb9 Microsoft Im Web 9 WordBasic.MicrosoftOnTheWeb9 MicrosoftOnTheWeb9 Microsoft On the
Web 9 Microsoft Office-Homepage 3029 4102

MicrosoftImWeb10 Microsoft Im Web 10 WordBasic.MicrosoftOnTheWeb10 MicrosoftOnTheWeb10 Microsoft On the
Web 10 Feedback senden... 3030 4103

MicrosoftImWeb11 Microsoft Im Web 11 WordBasic.MicrosoftOnTheWeb11 MicrosoftOnTheWeb11 Microsoft On the
Web 11 Interessantes im Web 3031 4104

MicrosoftImWeb12 Microsoft Im Web 12 WordBasic.MicrosoftOnTheWeb12 MicrosoftOnTheWeb12 Microsoft On the
Web 12 Im Web suchen... 3032 4105

MicrosoftImWeb13 Microsoft Im Web 13 WordBasic.MicrosoftOnTheWeb13 MicrosoftOnTheWeb13 Microsoft On the
Web 13 Weblernprogramm 3033 4106

MicrosoftImWeb14 Microsoft Im Web 14 WordBasic.MicrosoftOnTheWeb14 MicrosoftOnTheWeb14 Microsoft On the
Web 14 Webhilfe 14 3034 4107

MicrosoftImWeb15 Microsoft Im Web 15 WordBasic.MicrosoftOnTheWeb15 MicrosoftOnTheWeb15 Microsoft On the
Web 15 Webhilfe 15 3035 4108

MicrosoftImWeb16 Microsoft Im Web 16 WordBasic.MicrosoftOnTheWeb16 MicrosoftOnTheWeb16 Microsoft On the
Web 16 Webhilfe 16 3036 4109

MicrosoftImWeb17 Microsoft Im Web 17 WordBasic.MicrosoftOnTheWeb17 MicrosoftOnTheWeb17 Microsoft On the
Web 17 Microsoft-Homepage 3091 4110

ExtrasFeldManager
Löscht ein Feld aus einer
Datenbank oder fügt es
hinzu.

Dialogs(wdDialogToolsManageFields).Show ToolsManageFields
Adds or deletes a
field from a
database

Datenbank Felder organisieren Database 3124 631

DateiSpeichernHtml Datei als HTML-Dokument
speichern WordBasic.FileSaveHtml FileSaveHtml Save file as HTML

document Als HTML speichern... Word 97 File 3147 1012

TabelleSortierenANachZ
Sortiert Datensätze in
aufsteigender Reihenfolge
(A bis Z).

Selection.SortAscending TableSortAToZ
Sorts records in
ascending order
(A to Z)

Tabellen und Rahmen
Datenbank Aufsteigend

Tables and
Borders
Database

3157 393

TabelleSortierenZNachA
Sortiert Datensätze in
absteigender Reihenfolge
(Z bis A).

Selection.SortDescending TableSortZToA
Sorts records in
descending order
(Z to A)

Tabellen und Rahmen
Datenbank Absteigend

Tables and
Borders
Database

3158 394

EinfügenPosRahmen
Fügt einen leeren Frame ein
oder stellt das markierte
Element in einen Frame

ActiveDocument.Frames.Add Range:=Selection.Range InsertFrame
Inserts an empty
frame or encloses
the selected item
in a frame

Formular
Word für Windows 2.0 Positionsrahmen

Forms
Word for
Windows 2.0

3174 158

ZeichnungBewegenNachObenPixel
Verschiebt die markierten
Zeichnungselemente um ein
Pixel nach oben.

WordBasic.DrawNudgeUpPixel
Selection.ShapeRange.IncrementTop ... DrawNudgeUpPixel

Präzisionsausrichtung nach
oben um 1 Pixel
Strg+Aufwärts

3177 700

ZeichnungBewegenNachUntenPixel
Verschiebt die markierten
Zeichnungselemente um ein
Pixel nach unten.

WordBasic.DrawNudgeDownPixel
Selection.ShapeRange.IncrementTop -... DrawNudgeDownPixel

Präzisionsausrichtung nach
unten um 1 Pixel
Strg+Abwärts

3178 701

ZeichnungBewegenNachLinksPixel
Verschiebt die markierten
Zeichnungselemente um ein
Pixel nach links.

WordBasic.DrawNudgeLeftPixel
Selection.ShapeRange.IncrementLeft ... DrawNudgeLeftPixel

Präzisionsausrichtung nach
links um 1 Pixel
Strg+Links

3179 702
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ZeichnungBewegenNachRechtsPixel
Verschiebt die markierten
Zeichnungselemente um ein
Pixel nach rechts.

WordBasic.DrawNudgeRightPixel
Selection.ShapeRange.IncrementLeft -... DrawNudgeRightPixel

Präzisionsausrichtung nach
rechts um 1 Pixel
Strg+Rechts

3180 703

Fügt den AutoText-Eintrag
an der aktuellen
Einfügemarke ein

(Eintrag) 3210

FeldAnzeigeUmschalten
Zeigt die Feldfunktionen/-
ergebnisse im markierten
Bereich an [ein/aus].

Selection.Fields.ToggleShowCodes ToggleFieldDisplay
Shows the field
codes or the
results for the
selection (toggle)

Kontext Feldfunktionen ein/aus
Umschalt+F9 Context

Shift+F9 (Alt+F9
toggles all field
codes on or off)

3214 34

AnsichtFußnotenBereich
Öffnet ein Fenster zur
Ansicht und Bearbeitung
von Fußnoten [ein/aus].

If ActiveWindow.ActivePane.View.Type = wdPrintView Or
ActiveWindow. _
ActivePane.View.Type = wdWebView Or

ActiveWindow.ActivePane.View.Type = _
wdPrintPreview Then
ActiveWindow.View.SeekView = wdSeekMainDocument

Else
ActiveWindow.Panes(2).Close

End If

ViewFootnoteArea
Opens a pane for
viewing and
editing the
footnotes (toggle)

Kontext Fußnoten
Gehe zu Fußnote
Doppelklick auf Fußnoten-
Referenz

Context
Dbl-click the
footnote
reference

3215 156

AnsichtEndnotenBereich
Öffnet ein Fenster zur
Ansicht und Bearbeitung
von Endnoten [ein/aus].

If ActiveWindow.ActivePane.View.Type = wdPrintView Or _
ActiveWindow.ActivePane.View.Type = wdWebView Or _
ActiveWindow.ActivePane.View.Type = wdPrintPreview Then
ActiveWindow.View.SeekView = wdSeekMainDocument

Else
ActiveWindow.Panes(2).Close

End If

ViewEndnoteArea
Opens a pane for
viewing and
editing the
endnotes (toggle)

Kontext Endnoten
Gehe zu Endnote
Doppelklick auf Endnoten-
Referenz

Context
Dbl-click the
endnote
reference

3216 338

ExtrasRechtschreibungAusblenden Rechtschreibmarkierungen
im Hintergrund ausblenden ActiveDocument.ShowSpellingErrors = True ToolsSpellingHide Hide background

spelling errors Rechtschreibfehler ausblenden 3217 978

ExtrasGrammatikAusblenden
Anzeige der
Grammatikfehler im
Hintergrund ausblenden

ActiveDocument.ShowGrammaticalErrors = True ToolsGrammarHide Hide background
grammar errors Grammatikfehler ausblenden 3218 979

ExtrasWörterbuch Übersetzt das markierte
Wort WordBasic.ToolsDictionary ToolsDictionary Translates the

selected word
Wörterbuch...
Alt+Umschalt+F7 3219 989

BearbeitenHerausgeberOderAbonnentOptionen Veröffentlichen/Abonnieren
Optionen EditPubOrSubOptions Veröffentlichen/Abonnieren

Optionen 3220 734

DateiDateiInfo Zeigt die Dateiinformationen
des aktiven Dokuments an. Dialogs(wdDialogFileSummaryInfo).Show FileSummaryInfo

Shows the
summary
information about
the active
document

3221 86

FußEndnotenOptionen Ändert die Optionen für
Fußnoten und Endnoten. Dialogs(wdDialogNoteOptions).Show NoteOptions

Changes the
options for
footnotes or
endnotes

Fußnoten/Endnoten-Optionen 3222 373

FormatHintergrundOhne Entfernt den Hintergrund
vom Dokument WordBasic.FormatBackgroundNone FormatBackgroundNone Format > Hintergrund Keine Farbe 3223 1004

Format > Hintergrund Standardfarben 3224

PunktiertUnterstreichen
Unterstreicht den
markierten Textteil punktiert
[ein/aus].

If Selection.Font.Underline = wdUnderlineDotted Then
Selection.Font.Underline = wdUnderlineNone

Else
Selection.Font.Underline = wdUnderlineDotted

End If

DottedUnderline
Underlines the
selection with dots
(toggle)

Punktiert unterstrichen 3225 620

AufzählungNumerierungEntfernen
Entfernt Nummerierung und
Aufzählungszeichen aus der
Markierung

WordBasic.RemoveBulletsNumbers RemoveBulletsNumbers
Removes numbers
and bullets from
the selection

Nummerierung entfernen 3228 522

ExtrasAnpassenSymbolleiste Passt die Word-
Symbolleisten an. ToolsCustomizeToolbar Customizes the

Word toolbars Symbolleisten anpassen 3229 716

ExtrasAnpassenMenü Passt die Word-
Menüzuweisungen an Dialogs(wdDialogToolsCustomizeMenus).Show ToolsCustomizeMenus

Customizes the
Word menu
assignments

Menüs anpassen 3230 433

BearbeitenGrafik
Verwendet das definierte
Zeichnungsprogramm, um
die markierte Grafik zu
bearbeiten.

Selection.InlineShapes(1).Activate EditPicture Grafik 3231 296

BeginnFenster
Bewegt die Einfügemarke
zum Anfang der ersten, auf
dem Bildschirm sichtbaren
Zeile.

Selection.HomeKey Unit:=wdWindow StartOfWindow

Moves the
insertion point to
the beginning of
the first visible line
on the screen

Anfang des Fensters
Alt+Strg+Bild-AUF-Taste Alt+Ctrl+PgUp 3232 4014

EndeFenster
Bewegt die Einfügemarke
ans Ende der letzten Zeile
auf dem Bildschirm.

Selection.EndKey Unit:=wdWindow EndOfWindow

Moves the
insertion point to
the end of the last
visible line on the
screen

Ende des Fensters
Alt+Strg+Bild-AB-Taste Alt+Ctrl+PgDn 3233 4015
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(control on 2947 ...)
Ändert die
Schattierungsfarbe des
markierten Textes

Tabellen und Rahmen Schattierungsfarbe > Keine
Farbe

Tables and
Borders 3237

(control on 2947 ...)
Ändert die
Schattierungsfarbe des
markierten Textes

Tabellen und Rahmen Schattierungsfarbe >
Standardfarben

Tables and
Borders 3238

(control on 340 ...) Hebt den markierten Text
farbig hervor Hervorheben > Keine Farbe 3239 742

(control on 340 ...) Hebt den markierten Text
farbig hervor Hervorheben > Standardfarben 3240 742

(control on 401 ...)
Ändert die
Rahmenlinienfarbe der
markierten Absätze,
Tabellenzellen und Grafiken

Tabellen und Rahmen >
Rahmenfarbe Keine Farbe Tables and

Borders 3241

(control on 401 ...)
Ändert die
Rahmenlinienfarbe der
markierten Absätze,
Tabellenzellen und Grafiken

Tabellen und Rahmen >
Rahmenfarbe Standardfarben Tables and

Borders 3242

ExtrasAutoKorrekturHEKorrigieren Hangul und alphabetische
Korrektur

AutoCorrect.CorrectKeyboardSetting = Not AutoCorrect. _
CorrectKeyboardSetting ToolsAutoCorrectHECorrect

Hangul and
alphabet
correction

HEKorrigieren 3247 1001

FormatZeichnungsElement
Ändert die Eigenschaften
der markierten
Zeichnungsobjekte.

Dialogs(wdDialogFormatDrawingObject).Show FormatDrawingObject
Changes the
properties of the
selected drawing
objects

Kontext
WordArt

Objekt...
Objekt formatieren...

Context
WordArt 3249 960

FormatObjektKern
Ändert die Eigenschaften
der markierten
Zeichnungsobjekte.

FormatObjectCore
Changes the
properties of the
selected drawing
objects

3249 ? 918

WW7_ExtrasOptionen
Passt eine Vielzahl von
Word für Windows-
Einstellungen an.

WordBasic.WW7_ToolsOptions WW7_ToolsOptions
Changes various
categories of Word
for Windows
options

Optionen... 3250 202

Präsentieren
Erstellt aus dem aktuellen
Dokument eine Microsoft
PowerPoint-Präsentation

ActiveDocument.PresentIt PresentIt

Create a Microsoft
PowerPoint
presentation from
the current
document

Datei-Menü
Senden an > Microsoft
PowerPoint
In Microsoft PowerPoint
bearbeiten

3251 969

EinblendenAbsatzmarken
Blendet alle nicht
druckbaren Absatzmarken
ein oder aus

ActiveWindow.ActivePane.View.ShowParagraphs = Not
ActiveWindow.ActivePane. _
View.ShowParagraphs

ShowPara
Shows/hides all
nonprinting
paragraph marks

Absatzmarken anzeigen 3252 890

EinfügenVertikalenRahmen
Fügt einen leeren vertikalen
Frame ein oder stellt das
markierte Element in einen
vertikalen Frame

ActiveDocument.Frames.Add Range:=Selection.Range
Selection.Orientation = wdTextOrientationVerticalFarEast InsertVerticalFrame

Inserts an empty
vertical frame or
encloses the
selected item in a
vertical frame

Vertikaler Positionsrahmen 3253 787

BearbeitenObjekt Öffnet das markierte Objekt
zur Bearbeitung. Dialogs(wdDialogEditObject).Show EditObject

Opens the
selected object for
editing

Bearbeiten
Kontext Objekt Context 3257 125

MenüAutoTextListe (Aufzählung der AutoText-
Einträge) MenuAutoTextList Einfügen > AutoText 3260 5773

WW7_FormatZeichenobjekt
Ändert die Attribute für
Füllung, Linie, Format und
Position der markierten
Zeichnungsobjekte

WordBasic.WW7_FormatDrawingObject WW7_FormatDrawingObject

Changes the fill,
line, size, and
position attributes
of the selected
drawing objects

Objekt...
Objekt formatieren... 3262 565

FormatAutoFormatAnfang
Führt eine automatische
Formatierung des
Dokuments durch.

FormatAutoFormatBegin
Automatically
formats a
document

AutoFormat... 3271 321

SeriendruckDatenMaske Bearbeitet eine Liste oder
Tabelle in einem Formular. ActiveDocument.DataForm MailMergeDataForm Edits a list or table

in a form Datenbank Datenformular Database 3272 340
Verschiebt die markierten
Objekte um ein Pixel nach
oben.

DrawNudgeUpOnePixel
Präzisionsausrichtung nach
oben um 1 Pixel
Strg+Aufwärts

3274

Verschiebt die markierten
Objekte um ein Pixel nach
unten.

DrawNudgeDownOnePixel
Präzisionsausrichtung nach
unten um 1 Pixel
Strg+Abwärts

3275

Verschiebt die markierten
Objekte um ein Pixel nach
links.

DrawNudgeLeftOnePixel AusrichtenLinksEinPixel
Strg+Links 3276

Verschiebt die markierten
Objekte um ein Pixel nach
rechts.

DrawNudgeRightOnePixel
Präzisionsausrichtung nach
rechts um 1 Pixel
Strg+Rechts

3277

HilfeInhalt Zeigt den Inhalt der Hilfe an. Help wdHelpContents HelpContents Inhalt und Index 3278 688
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DateiDateiÖffnen Öffnet dieses Dokument. .Parameter of Command = full file name FileOpenFile Öffnen: ((Dateiname)) 3280 536

ExtrasAufzählungStandard
Erstellt eine Aufzählung
basierend auf den aktuellen
Standardeinstellungen

WordBasic.ToolsBulletListDefault ToolsBulletListDefault
Creates a bulleted
list based on the
current defaults

Extras
Aufzählungszeichenvorgabe 3359 307

ExtrasNumerierungStandard
Erstellt eine nummerierte
Liste basierend auf den
aktuellen
Standardeinstellungen

WordBasic.ToolsNumberListDefault ToolsNumberListDefault
Creates a
numbered list
based on the
current defaults

Extras Aufzählungsvorgabe 3360 309

FormatMultilevelStandard
Erstellt eine nummerierte
Liste basierend auf den
aktuellen
Standardeinstellungen

WordBasic.FormatMultilevelDefault FormatMultilevelDefault
Creates a
numbered list
based on the
current defaults

Nummerierung 3361 951

FormatEinfachNumerierungStandard
Erstellt eine nummerierte
Liste basierend auf den
aktuellen
Standardeinstellungen

WordBasic.FormatSimpleNumberDefault FormatSimpleNumberDefault
Creates a
numbered list
based on the
current defaults

Nummerierung 3362 398

BriefAssistent Assistent zur Erstellung
eines Briefdokumentes WordBasic.LetterWizard LetterWizard Wizard to create a

Letter Document Brief-Assistent... 3363 919

AktualisierenInhaltsverzeichnisVollständig
Inhalts- oder
Abbildungsverzeichnis neu
erstellen.

WordBasic.UpdateTocFull UpdateTocFull Rebuild a table of
contents or figures Inhaltsverzeichnis neu erstellen 3364 941

EinfügenFußnote
Fügt ein Fuß- oder
Endnotenzeichen an der
Einfügemarke ein.

Dialogs(wdDialogInsertFootnote).Show InsertFootnote
Inserts a footnote
or endnote
reference at the
insertion point

Einfügen Fußnote... Insert Alt I, N 3365 370

HilfeTastatur
Tastaturhilfe
Listet die Tastenschlüssel
und ihre Funktionen auf.

Help wdHelpKeyboard HelpKeyboard Hilfe Tastatur 3366 5

Hilfe im aktiven Fenster
Zeigt Informationen über
den aktiven
Fensterausschnitt oder über
die Dokumentansicht an.

Help wdHelpActiveWindow HelpActiveWindow Hilfe Aktuelles Fenster 3367

AktualisierenFelderVBA
Aktualisiert die markierten
Felder und zeigt die
Ergebnisse an.

WordBasic.UpdateFieldsVBA UpdateFieldsVBA
Updates and
displays the
results of the
selected fields

Felder aktualisieren
F9 oder Alt+Umschalt+U 3368 880

VerknüpfungAuflösenFelderVBA
Ersetzt die Feldfunktionen
endgültig mit deren
Ergebnissen.

WordBasic.UnlinkFieldsVBA UnlinkFieldsVBA Feldverknüpfungen aufheben
Strg+6 3369 883

ZeichenFarbe Ändert die Farbe des
markierten Textes. WordBasic.CharColor X (where X = .Parameter of the Control) CharColor (Farbe; z. B.:) Dunkelrot 3370 57

DokumentStatistik Zeigt statistische Daten für
das aktive Dokument an. Dialogs(wdDialogDocumentStatistics).Show DocumentStatistics Dokumentstatistik 3371 78

BearbeitenSuchenZeichen Bearbeiten Suchen
Schriftart WordBasic.EditFindFont EditFindFont 3372 113

BearbeitenSuchenAbsatz Absatz suchen WordBasic.EditFindPara EditFindPara 3373 114
BearbeitenSuchenTabstops Bearbeiten Suchen

Tabstopp EditFindTabs 3374 446
BearbeitenSuchenRahmen Bearbeiten Suchen Rahmen WordBasic.EditFindBorder EditFindBorder 3375 447
BearbeitenSuchenSprache Sprache suchen WordBasic.EditFindLang EditFindLang 3376 428
BearbeitenSuchenPostionsrahmen Bearbeiten Suchen

Positionsrahmen WordBasic.EditFindFrame EditFindFrame 3377 448

BearbeitenSuchenFV Bearbeiten Suchen
Formatvorlage WordBasic.EditFindStyle EditFindStyle 3378 115

BearbeitenSuchenHervorgehoben Bearbeiten Suchen
Hervorhebung Selection.Find.Highlight = True EditFindHighlight 3379 780

BearbeitenSuchenNichtHervorgehoben Bearbeiten Suchen Ohne
Hervorhebung Selection.Find.Highlight = False EditFindNotHighlight 3380 782

BearbeitenSuchenLöschenFormatierung Bearbeiten Suchen
Formatierung löschen Selection.Find.ClearFormatting EditFindClearFormatting 3381 116

BearbeitenErsetzenZeichen Bearbeiten Ersetzen
Schriftart WordBasic.EditReplaceFont EditReplaceFont 3382 118

BearbeitenErsetzenAbsatz Absatz ersetzen WordBasic.EditReplacePara EditReplacePara 3383 119
BearbeitenErsetzenTabstops Bearbeiten Ersetzen

Tabstopp EditReplaceTabs 3384 456

BearbeitenErsetzenRahmen Bearbeiten Ersetzen
Rahmen WordBasic.EditReplaceBorder EditReplaceBorder 3385 457

BearbeitenErsetzenSprache Sprache ersetzen WordBasic.EditReplaceLang EditReplaceLang 3386 429
BearbeitenErsetzenPositionsrahmen Bearbeiten Ersetzen

Positionsrahmen WordBasic.EditReplaceFrame EditReplaceFrame 3387 458
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BearbeitenErsetzenFV Bearbeiten Ersetzen
Formatvorlage WordBasic.EditReplaceStyle EditReplaceStyle 3388 120

BearbeitenErsetzenHervorgehoben Bearbeiten Ersetzen
Hervorhebung Selection.Find.Replacement.Highlight = True EditReplaceHighlight 3389 781

BearbeitenErsetzenNichtHervorgehoben Bearbeiten Ersetzen Ohne
Hervorhebung Selection.Find.Replacement.Highlight = False EditReplaceNotHighlight 3390 783

BearbeitenErsetzenLöschenFormatierung Bearbeiten Ersetzen
Formatierung löschen Selection.Find.Replacement.ClearFormatting EditReplaceClearFormatting 3391 121

TabelleTabelleEinfügen Fügt eine Tabelle ein. Dialogs(wdDialogTableInsertTable).Show TableInsertTable

Tabelle > Zellen
einfügen
Tabellen und Rahmen
Kontext Tabellenzellen,
Tabellenüberschriften,
Tabellenlisten,
Tabellengrafiken,
Tabellentext

Tabelle
Tabelle einfügen... 3392 129

ExtrasAbschnittSchützen
Bestimmt den
Dokumentschutz für
Abschnitte im aktiven
Dokument.

Dialogs(wdDialogToolsProtectSection).Show ToolsProtectSection Extras Abschnitt schützen Tools 3393 578

FormatFVDefZeichen
Format
Schriftartformatvorlage
definieren

Dialogs(wdDialogFormatDefineStyleFont).Show FormatDefineStyleFont 3394 181

FormatFVDefAbsatz
Format
Absatzformatvorlage
definieren

Dialogs(wdDialogFormatDefineStylePara).Show FormatDefineStylePara 3395 182

FormatFVDefTab
Format
Tabstoppformatvorlage
definieren

Dialogs(wdDialogFormatDefineStyleTabs).Show FormatDefineStyleTabs 3396 183

FormatFVDefPosRahmen
Format
Positionsrahmenformatvorla
ge definieren

Dialogs(wdDialogFormatDefineStyleFrame).Show FormatDefineStyleFrame 3397 184

FormatFVDefRahmen
Format
Rahmenformatvorlage
definieren

Dialogs(wdDialogFormatDefineStyleBorders).Show FormatDefineStyleBorders 3398 185

FormatFVDefSprache
Format
Spracheformatvorlage
definieren

Dialogs(wdDialogFormatDefineStyleLang).Show FormatDefineStyleLang 3399 186

FormatFVDefNum
Format
Zahlenformatvorlage
definieren

FormatDefineStyleNumbers 3400 602

FormatAufzählung Erstellt eine Liste mit
Aufzählungszeichen. WordBasic.FormatBullet FormatBullet Format Aufzählungszeichen 3401 389

FormatNumerierung Erstellt eine Liste mit
Nummerierungen WordBasic.FormatNumber FormatNumber Zahlenformat 3402 390

FormatGegliederteListe Erstellt eine Liste mit
mehreren Ebenen WordBasic.FormatMultilevel FormatMultilevel Format Mehrere Ebenen 3403 391

FormatÜberschriftenNummer
Verändert Formatvorlagen
für
Überschriftennummerierung

WordBasic.FormatHeadingNumber FormatHeadingNumber Format Überschritnummer 3404 606

ExtrasAnpassenMenüleiste Extras Anpassen
Menüleiste Dialogs(wdDialogToolsCustomizeMenuBar).Show ToolsCustomizeMenuBar Extras Anpassen Menüleiste 3406? 615

ExtrasWeitereEinstellungen
Ändert weitere Optionen in
den Initialisierungsdateien
(WINWORD6.INI und
WIN.INI).

Dialogs(wdDialogToolsAdvancedSettings).Show ToolsAdvancedSettings Extras Weitere Einstellungen 3407 206

Benutzerdialog Benutzerdialog 3409
DateiKopieren Dialogs(wdDialogCopyFile).Show CopyFile 3410 300
FormularFeldLeeren Löscht das ausgewählte

Formularfeld WordBasic.ClearFormField ClearFormField Deletes the
selected form field Formularfeld löschen 3411 706

WW2_LinealModus Aktiviert das Lineal. WordBasic.WW2_RulerMode WW2_RulerMode Makes the ruler
active

Linealmodus
Strg+Umschalt+F10 3412 44

WW2_DateiDokVorlagen
Ändert die aktuelle
Dokumentvorlage und die
Dokumentvorlagen-
Optionen.

WW2_FileTemplates
Changes the
active template
and the template
options

Datei Vorlagen 3413 6054

WW2_SeriendruckAnDrucker Seriendruck An Drucker WordBasic.WW2_PrintMergeToPrinter WW2_PrintMergeToPrinter Seriendruck An Drucker 3414 93
WW2_SeriendruckInDateiUmleiten Seriendruck In Dokument WordBasic.WW2_PrintMergeToDoc WW2_PrintMergeToDoc Seriendruck In Dokument 3415 92
WW2_SeriendruckPrüfen Seriendruck überprüfen WordBasic.WW2_PrintMergeCheck WW2_PrintMergeCheck Seriendruck überprüfen 3416 91
WW2_Seriendruck Seriendruck WordBasic.WW2_PrintMerge WW2_PrintMerge Seriendruck 3417 90
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WW2_SeriendruckMarkierung Seriendruck Auswahl WordBasic.WW2_PrintMergeSelection WW2_PrintMergeSelection Seriendruck Auswahl 3418 94
WW2_SeriendruckManager Seriendruck Hilfe WordBasic.WW2_PrintMergeHelper WW2_PrintMergeHelper Seriendruck Hilfe 3419 95
WW2_SeriendruckDatenQuelleErstellen Seriendruck Datenquelle

erstellen WordBasic.WW2_PrintMergeCreateDataSource WW2_PrintMergeCreateDataSource Seriendruck Datenquelle
erstellen 3420 105

WW2_SeriendruckSteuerQuelleErstellen Seriendruck
Steuersatzquelle erstellen WordBasic.WW2_PrintMergeCreateHeaderSource WW2_PrintMergeCreateHeaderSource Seriendruck Steuersatzquelle

erstellen 3421 106
WW2_BearbeitenSuchen Bearbeiten Suchen WordBasic.WW2_EditFind WW2_EditFind Bearbeiten Suchen 3422 421
WW2_BearbeitenSuchenZeichen Bearbeiten Suchen Zeichen WordBasic.WW2_EditFindChar WW2_EditFindChar Bearbeiten Suchen Zeichen 3423 415
WW2_BearbeitenErsetzen Bearbeiten Ersetzen WordBasic.WW2_EditReplace WW2_EditReplace Bearbeiten Ersetzen 3424 422
WW2_BearbeitenErsetzenZeichen Bearbeiten Ersetzen

Zeichen WordBasic.WW2_EditReplaceChar WW2_EditReplaceChar Bearbeiten Ersetzen Zeichen 3425 416

WW2_TabellenZeilenHöhe Ändert die Zeilenhöhe in
einer Tabelle. WordBasic.WW2_TableRowHeight WW2_TableRowHeight

Changes the
height of the rows
in a table

Tabelle Zeilenhöhe 3426 326

WW2_TabelleSpaltenBreite Ändert die Spaltenbreite in
einer Tabelle WordBasic.WW2_TableColumnWidth WW2_TableColumnWidth

Changes the width
of the columns in a
table

Tabelle Spaltenbreite 3427 223

WW2_AnsichtZoom Vergrößert oder verkleinert
die Bearbeitungsansicht WordBasic.WW2_ViewZoom WW2_ViewZoom Scales the editing

view Ansicht Zoom 3428 148

WW2_EinfügenFußnote
Fügt einen
Fußnotenverweis an der
Einfügemarke ein.

WordBasic.WW2_InsertFootnote WW2_InsertFootnote
Inserts a footnote
reference at the
insertion point

Einfügen Fussnote 3429 160

WW2_EinfügenSonderzeichen Fügt ein Sonderzeichen ein WordBasic.WW2_InsertSymbol WW2_InsertSymbol Inserts a special
character Einfügen Symbol 3430 693

WW2_EinfügenIndex Fügt alle Indexeinträge zu
einem Index zusammen WordBasic.WW2_InsertIndex WW2_InsertIndex

Collects the index
entries into an
index

Index einfügen 3431 695

WW2_EinfügenInhaltsverzeichnis
Erstellt ein
Inhaltsverzeichnis aus
INHALT-Feldern oder
Überschriften

WordBasic.WW2_InsertTableOfContents WW2_InsertTableOfContents

Collects the
headings or the
table of contents
entries into a table
of contents

Inhaltsverzeichnis einfügen 3432 344

WW2_FormatZeichen Verändert das Format der
markierten Zeichen WordBasic.WW2_FormatCharacter WW2_FormatCharacter

Changes the
appearance of the
selected
characters

Format Zeichen 3433 374

WW2_FormatDefFVZeichen
Format
Zeichenformatvorlage
definieren

WordBasic.WW2_FormatDefineStyleChar WW2_FormatDefineStyleChar 3434 414

WW2_ExtrasSilbentrennung Extras Silbentrennung WordBasic.WW2_ToolsHyphenation WW2_ToolsHyphenation Extras > Sprache Silbentrennung Tools > Language 3435 345
WW2_ExtrasÜberarbeiten Extras Überarbeiten WW2_ToolsRevisionsMark Extras Überarbeiten Tools 3436 464
WW2_ExtrasEinstellungenAllgemein Extras Optionen Allgemein WordBasic.WW2_ToolsOptionsGeneral WW2_ToolsOptionsGeneral Extras > Optionen Allgemein Tools > Options 3437 387
WW2_ExtrasEinstellungenAnsicht Extras Optionen Ansicht WordBasic.WW2_ToolsOptionsView WW2_ToolsOptionsView Extras > Optionen Ansicht Tools > Options 3438 499
WW2_ExtrasEinstellungenMenüs Extras Optionen Menüs WordBasic.WW2_ToolsOptionsMenus WW2_ToolsOptionsMenus Extras > Optionen Menüs Tools > Options 3439 487
WW2_ExtrasEinstellungenTastatur Extras Optionen Tastatur WordBasic.WW2_ToolsOptionsKeyboard WW2_ToolsOptionsKeyboard Extras > Optionen Tastatur Tools > Options 3440 434
WW2_ExtrasEinstellungenDrucken Extras Optionen Drucken WordBasic.WW2_ToolsOptionsPrint WW2_ToolsOptionsPrint Extras > Optionen Drucken Tools > Options 3441 347

Changes the
buttons on the
toolbar

3442

WW2_LinealModusÄndern
Ändert die Darstellung des
Lineals (Absatz-, Tabellen-
und Dokumentmodus).

WordBasic.WW2_ChangeRulerMode WW2_ChangeRulerMode Liniealmodus ändern 3443 295

WW2_FußnotenOptionen Verändert die Optionen für
Fußnoten. WordBasic.WW2_FootnoteOptions WW2_FootnoteOptions Fußnotenoptionen 3444 299

WW2_FormatRahmenUndSchattierung
Verändert Rahmen und
Schattierung der markierten
Absätze, Tabellenzellen und
Grafiken.

WordBasic.WW2_FormatBordersAndShading WW2_FormatBordersAndShading Format Rahmen und
Schattierung 3445 697

WW7_ExtrasGrammatik Überprüft die Korrekturen
im aktiven Dokument WordBasic.WW7_ToolsGrammar WW7_ToolsGrammar Grammatik 3446 1000

ExtrasRechtschreibungBereich
Überprüft die
Rechtschreibung für den
Bereich

WordBasic.ToolsSpellingRange ToolsSpellingRange Extras Rechtschreibungsbereich Tools 3447 846

ExtrasGrammatikBereich
Überprüft Rechtschreibung
und Grammatik für den
Bereich

WordBasic.ToolsGrammarRange ToolsGrammarRange Extras Grammatikbereich 3448 847

ZeichnungBogen
Fügt ein
Zeichnungselement
"Bogen" ein.

WordBasic.DrawArc
ActiveDocument.Shapes.AddShape(msoShapeArc, Left, Top,
Width, Height, [Anchor]).Select

DrawArc Bogen 3453 455
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EinfügenSeitenwechsel Fügt vor der Einfügemarke
einen Seitenumbruch ein. Selection.InsertBreak Type:=wdPageBreak InsertPageBreak

Inserts a page
break at the
insertion point

Seitenumbruch und
Absatzmarke
Strg+Return

Ctrl+Return 3462 830

MakroAusführungUmschalten ToggleMacroRun Makro ausführen ein/aus 3463 669

MakroAusführen
Ermöglicht das Ausführen,
Erstellen, Löschen oder
Bearbeiten eines Makros

StartMacro Makro... 3464 554

RechtschreibungUndAutoKorrektur
Fügt den markierten
Vorschlag als
AutoKorrektur-Ersetzung für
dieses Wort hinzu

SpellingAndAutoCorrect 3465 903

FormatRahmenSchattierung
Ändert Rahmen und
Schattierung von markierten
Absätzen, Tabellenzellen
und Grafiken.

Dialogs(wdDialogFormatBordersAndShading).Show FormatBordersAndShading

Changes the
borders and
shading of the
selected
paragraphs, table
cells, and pictures

Format
Kontext Rahmen und Schattierung... Formatting

Context Alt O, B 3466 189

WW7_ZeichnenTextFeld Fügt ein Zeichnungsobjekt
"Textfeld" ein WordBasic.WW7_DrawTextBox WW7_DrawTextBox Inserts a text box

drawing object Textfeld 3467 363

WW7_ZeichnenVertikalesTextfeld Fügt ein Zeichnungsobjekt
"vertikales Textfeld" ein WordBasic.WW7_DrawVerticalTextBox WW7_DrawVerticalTextBox

Inserts a vertical
text box drawing
object

Vertikales Textfeld 3468 738

WW7_BearbeitenGeheZu
Springt zu einer bestimmten
Position im aktiven
Dokument

WordBasic.WW7_EditGoTo WW7_EditGoTo 3469 122

WW7_EinzugErweitern
Vergrößert den Einzug oder
stuft die Markierung um
eine Ebene tiefer

WW7_IncreaseIndent
Increases indent
or demotes the
selection one level

Einzug vergrößern 3470 649

WW7_EinzugReduzieren
Reduziert den Einzug oder
stuft die Markierung um
eine Ebene höher

WW7_DecreaseIndent
Decreases indent
or promotes the
selection one level

Einzug verkleinern 3471 650

EinzugVergrößern
Vergrößert den Einzug oder
stuft die Markierung um
eine Ebene tiefer.

WordBasic.IncreaseIndent IncreaseIndent
Increases indent
or demotes the
selection one level

Format Einzug vergrößern
Strg+M Formatting 3472 1010

EinzugVerringern

Reduziert den Einzug oder
stuft die Markierung um
eine Ebene höher.
Verringert den Einzug oder
stuft die Markierung um
eine Ebene höher.

WordBasic.DecreaseIndent DecreaseIndent
Decreases indent
or promotes the
selection one level

Format
Kontext

Einzug verkleinern
Strg+Umschalt+M

Formatting
Context 3473 1011

EinzugZeichen Erweitert den Einzug um
eine Zeichenbreite Selection.ParagraphFormat.IndentCharWidth 1 IndentChar

Increases the
indent by width of
a character

Einzug vergrößern 3474 719

Einzug Reduziert den Einzug um
eine Zeichenbreite Selection.ParagraphFormat.IndentCharWidth -1 UnIndentChar

Decreases the
indent by width of
a character

Einzug verkleinern 3475 720

AnsichtGliederungTeilenSymbolleiste
Blendet die Tabellen- und
Rahmensymbolleiste ein
oder aus.

WordBasic.ViewOutlineSplitToolbar ViewOutlineSplitToolbar
Shows or hides
the Borders/Table
toolbar

Rahmen 3476 804

MarkierungZeichnungsElement

Zeichnungselemente
markieren
Wird benutzt, um
Zeichnungselemente zu
markieren -- Ziehen Sie mit
der Maus ein Rechteck um
die Elemente.
Ändert den Zeiger zum
Auswahlpfeil, um Objekt im
aktiven Fenster
auszuwählen.

WordBasic.SelectDrawingObjects SelectDrawingObjects

Use to select
drawing objects --
drag to create a
rectangle
enclosing the
objects

Zeichnen Objekte markieren Drawing 3477 545

ZeichnungLegende
Fügt ein
Zeichnungselement
"Legende" ein.

WordBasic.DrawCallout DrawCallout Inserts a callout
drawing object Legende 3478 611

WW7_BearbeitenAutoText
Fügt einen AutoText-Eintrag
ein oder definiert einen
Eintrag neu.

WordBasic.WW7_EditAutoText WW7_EditAutoText Inserts or defines
AutoText entries AutoText... 3479 123

EinfügenWordArt

Erstellt Texteffekte durch
Einfügen eines Microsoft
Office-Zeichnungsobjekts.
Fügt ein Microsoft WordArt-
Objekt ein.

CommandBars("WordArt").Visible = True
ActiveDocument.Shapes.AddTextEffect(PresetTextEffect As
MsoPresetTextEffect,Text As String,FontName As String,FontSize
As Single,FontBold as MsoTriState,FontItalic As MsoTriState,Left A
Single,Top As Single,[Anchor]).Select
WordBasic.InsertWordArt

InsertWordArt Inserts a Microsoft
WordArt object

Zeichnen
Einfügen > Grafik WordArt... Drawing 3481 682
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ZeichnungEinfügenLinie

Fügt ein
Zeichnungselement "Linie"
ein.
Zeichnet eine gerade Linie
an der Stelle, an der Sie
klicken und ziehen im
aktiven Fenster.

WordBasic.DrawLine
ActiveDocument.Shapes.AddLine(BeginX, BeginY, EndX, EndY,
[Anchor]).Select

DrawLine Inserts a line
drawing object

Zeichnen
Zeichnen > AutoFormen
> Linien

Linie
Drawing
Drawing >
AutoShapes >
Lines

3482 376

ZeichnungFreihandVieleck
Fügt ein
Zeichnungselement
"Freihandfigur" ein.

WordBasic.DrawFreeformPolygon DrawFreeformPolygon Inserts a freeform
drawing object Freihandform 3483 538

MakroListe Makros auflisten ListMacros
This command is
not available on
this platform.

Makros auflisten (Aktives
Makro) 3484 664

AutoText
AutoText-Eintrag wird je
nach Markierung erstellt
oder eingefügt.

WordBasic.AutoText AutoText
Creates or inserts
an AutoText entry
depending on the
selection

AutoText 3485 653

DateiMacSeiteEinrichtenGX Dialogs(wdDialogFileMacPageSetupGX).Show FileMacPageSetupGX Seite einrichten... 3486

WebHinzufügenHyperlinkZuFav Zu Favoriten hinzufügen WordBasic.WebAddHyperlnkToFavorites WebAddHyperlnkToFavorites Add to Favorites
Web
Hyperlinkmenü
Kontext

Dokument zu Favoriten
hinzufügen...

Hyperlink Menu
Context 3488 1002

FormatHintergrund WordBasic.FormatBackground FormatBackground
This command is
not available on
this platform.

Hintergrund... 3489 914

FormatKopfFußzeileVerknüpfen
Verknüpft diese Fuß-
/Kopfzeile mit dem
vorherigen Abschnitt.

Selection.HeaderFooter.LinkToPrevious = False FormatHeaderFooterLink
Links this
header/footer to
the previous
section

Mit vorheriger verknüpfen
(kein Shortcut in deutscher
Version)

Alt+Shift+R 3491 242

ExtrasHHC Sucht ein Hangul/Hanja
Wort für das markierte Wort Selection.Range.ConvertHangulAndHanja ToolsHHC

Finds a
Hangul/Hanja
word for the
selected word

Extras > Sprache Hangul Hanja-Konvertierung... 3492 784

EinzugRückgängigZeile Reduziert den Einzug um 2
Zeichenbreiten Selection.ParagraphFormat.IndentCharWidth -2 UnIndentLine

Decreases the
indent by width of
2 characters

Einzug verkleinern 3493 757

EinzugRückgängigErsteZeile Reduziert den hängenden
Einzug um 2 Zeichenbreiten Selection.ParagraphFormat.IndentFirstLineCharWidth -2 UnIndentFirstLine

Decreases the
hanging indent by
width of 2
characters

Erstzeileneinzug verkleinern 3494 755

EinzugZeile Erweitert den Einzug um 2
Zeichenbreiten Selection.ParagraphFormat.IndentCharWidth 2 IndentLine

Increases the
indent by width of
2 characters

Einzug vergrößern 3495 756

EinzugErsteZeile Erweitert den hängenden
Einzug um 2 Zeichenbreiten Selection.ParagraphFormat.IndentFirstLineCharWidth 2 IndentFirstLine

Increases the
hanging indent by
width of 2
characters

Erstzeileneinzug vergrößern 3496 754

SeriendruckSteuersatzquelleBearbeiten
Öffnet eine
Steuersatzquelle für den
Seriendruck.

ActiveDocument.MailMerge.EditHeaderSource MailMergeEditHeaderSource
Opens a mail
merge header
source

Kopfzeilenquelle bearbeiten 3497 675

Datei1 (control button Id 831) Öffnet dieses Dokument. WordBasic.File1 File1 Opens this
document Datei 1 (Dateiname) 3498 4037

Datei2 (control button Id 831) Öffnet dieses Dokument. WordBasic.File2 File2 Opens this
document Datei 2 (Dateiname) 3499 4038

Datei3 (control button Id 831) Öffnet dieses Dokument. WordBasic.File3 File3 Opens this
document Datei 3 (Dateiname) 3500 4039

Datei4 (control button Id 831) Öffnet dieses Dokument. WordBasic.File4 File4 Opens this
document Datei 4 (Dateiname) 3501 4040

Datei5 (control button Id 831) Öffnet dieses Dokument. WordBasic.File5 File5 Opens this
document Datei 5 (Dateiname) 3502 4041

Datei6 (control button Id 831) Öffnet dieses Dokument. WordBasic.File6 File6 Opens this
document Datei 6 (Dateiname) 3503 4042

Datei7 (control button Id 831) Öffnet dieses Dokument. WordBasic.File7 File7 Opens this
document Datei 7 (Dateiname) 3504 4043

Datei8 (control button Id 831) Öffnet dieses Dokument. WordBasic.File8 File8 Opens this
document Datei 8 (Dateiname) 3505 4044

Datei9 (control button Id 831) Öffnet dieses Dokument. WordBasic.File9 File9 Opens this
document Datei 9 (Dateiname) 3506 4045

ListeEinzug Stuft den markierten Text
eine Ebene tiefer. Selection.Range.ListFormat.ListIndent ListIndent Demotes the

selection one level Einzug vergrößern 3507 826

ListeNegativerEinzug Stuft die Markierung um
eine Ebene höher. Selection.Range.ListFormat.ListOutdent ListOutdent Promotes the

selection one level Einzug verkleinern 3508 825



Deutsch Beschreibung Makro-Beispiel English Description Type Symbolleiste Befehl/Kürzel Toolbar Shortcut Comm Dial

FormatÄnderungFallOstasien
Ändert die Groß-
/Kleinschreibung im
markierten Text

WordBasic.FormatChangeCaseFareast FormatChangeCaseFareast
Changes the case
of the letters in the
selection

Formatting 3509 980

FormatAnpassenText Weist Eigenschaft:
AnpassenText zu. Dialogs(wdDialogFitText).Show FormatFitText Apply Fit Text

Property Text anpassen... 3510 983

FormatPhonetischesLeitzeichen
Fügt ein phonetisches
Leitzeichen in das aktuelle
Dokument ein

Dialogs(wdDialogPhoneticGuide).Show FormatPhoneticGuide
Inserts a Phonetic
Guide field in the
active document

Erweiterte Formatierung Phonetische Leitzeichen... Extended
Formatting 3511 986

FormatKombinierteZeichen Kombinierte Zeichen (Dialog fügt eq-Felder ein) FormatCombineCharacters Combine
Characters Erweiterte Formatierung Zeichen kombinieren... Extended

Formatting 3512 987

PostkartenAssistent Postkarten-Assistent PostcardWizard Postcard Wizard Extras Postkarten-Assistent...
((funktioiert nicht?)) 3513 988

ZeichnenGeschweifteKlammer
Fügt ein
Zeichnungselement
"geschweifte Klammer" ein

WordBasic.DrawBrace DrawBrace Inserts a brace
drawing object Klammer 3515 791

ZeichnenEckigeKlammer
Fügt ein
Zeichnungselement "eckige
Klammer" ein

WordBasic.DrawBracket DrawBracket Inserts a bracket
drawing object

Geschwungene Klammer
(Eckige Klammer??) 3516 792

StandardZeichenRahmen Standard Zeichengrenze

With Selection.Font.Borders(1)
If .LineStyle = wdLineStyleNone Then
.LineStyle = Options.DefaultBorderLineStyle
.LineWidth = Options.DefaultBorderLineWidth
.Color = Options.DefaultBorderColor

Else
.LineStyle = wdLineStyleNone

End If
End With

DefaultCharBorder Default Character
Border Zeichenumriss 3517 997

StandardZeichenSchattierung Standard
Zeichenschattierung

With Selection.Font.Shading
If .Texture = wdTextureNone Then
.Texture = wdTexture15Percent
.ForegroundPatternColor = wdColorBlack
.BackgroundPatternColor = wdColorWhite

Else
.Texture = wdTextureNone

End If
End With

DefaultCharShading Default Character
Shading Zeichenschattierung 3518 1015

AnsichtWeb Browser-ähnliche
Dokumentdarstellung ActiveWindow.View.Type = wdWebView ViewWeb

Displays the
document similar
to how a browser
would

Ansicht Weblayout Word 2000 View 3621 848

FormatDesign Webdesign Dialogs(wdDialogFormatTheme).Show FormatTheme Web Theme Format Design... Formatting 3623 855

BearbeitenEinfügen2
Fügt den Inhalt der
Zwischenablage an der
Einfügemarke ein

WordBasic.EditPaste2 EditPaste2
Inserts the
Clipboard contents
at the insertion
point

Einfügen 3624 1180

BearbeitenEinfügenVerschachtelteTabelle
Fügt den Inhalt der
Zwischenablage vor der
Einfügemarke ein

Selection.PasteAsNestedTable EditPasteAsNestedTable
Inserts the
Clipboard contents
at the insertion
point

3625 904

LöschenHyperlink Hyperlink entfernen Selection.ShapeRange.Hyperlink.Delete DeleteHyperlink Remove Hyperlink Kontext > Hyperlink Hyperlink entfernen Context 3626 897

ExtrasSchutzoptionen Schutz, Sicherheit... WordBasic.ViewSecurity ViewSecurity Security... Extras > Makro
Visual Basic Sicherheit...

Visual Basic
Word 2000 Tools
(under Macro)

3627 1049

ExtrasSkriptEinfügen Skript einfügen
ActiveDocument.Scripts.Add ScriptText:="<!--" & vbCrLf & vbCrLf &
"-->"
ActiveDocument.HTMLProject.Open

ToolsInsertScript Insert Script Skriptanchormenü Skript einfügen Script Anchor
Popup 3628 1050

AlleSkripteEntfernen Alle Skripte entfernen ActiveDocument.Scripts.Delete RemoveAllScripts Remove All
Scripts Alle Skripts entfernen 3630 1051

MicrosoftScriptEditor Microsoft Script Editor ActiveDocument.HTMLProject.Open MicrosoftScriptEditor Microsoft Script
Editor

Extras
Visual Basic
Webtools

Microsoft Skript-Editor
Alt+Umschalt+F11

Visual Basic
Web Tools Alt+Shift+F11 3631 1052

WordBasic.ShowClipboard ShowClipboard

Zwischenablage >
Elemente
(beim Verweilen mit der
Maus über einem
Element wird der Inhalt
angezeigt)

Clipboard 3632

Zwischenablage Alle einfügen Clipboard 3633
Zwischenablage Zwischenablage löschen Clipboard 3634
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EinfügenHorizontalLinie Fügt eine horizontale Linie
ein Selection.InlineShapes.AddHorizontalLineStandard InsertHorizontalLine Inserts a

horizontal line
Format
Tabellen und Rahmen Horizontale Linie...

Formatting
Tables and
Borders

3653 1066

WebSeiteVorschau Zeigt vollständige Seiten in
einem Webbrowser an ActiveDocument.WebPagePreview WebPagePreview Displays full pages

in a Web browser Datei-Menü Webseitenvorschau 3655 1093

HilfeInhaltArabisch
Zeigt den Inhalt des
arabischen Hilfeprogramms
an

WordBasic.HelpContentsArabic HelpContentsArabic Displays Arabic
Help contents BiDi-Features 3657 1063

LaufUmschalten
Schaltet die Einfügemarke
zwischen RNL- und LNR-
Läufen um

RunToggle
Toggles the
insertion point
between RTL and
LTR runs

Format Tastatursprache
(z. B. Deutsch Deutschland) Formatting 3659 1053

control on 3659
Schaltet die Einfügemarke
zwischen RNL- und LNR-
Läufen um

3660

RnlLauf Definiert den aktuellen Lauf
als RNL WordBasic.RtlRun RtlRun Makes the current

run RTL Rtl Run 3661 1058

LnrLauf Definiert den aktuellen Lauf
als LNR WordBasic.LtrRun LtrRun Makes the current

run LTR Ltr Run 3662 1059

RNLMakroDialoge Aktiviert die Anzeige von
RNL in Makrodialogen WordBasic.RTLMacroDialogs RTLMacroDialogs

Makes macro
dialogs display
RTL

RTL-Makrodialogfelder 3663 1064

LNRMakroDialoge Aktiviert die Anzeige von
LNR in Makrodialogen WordBasic.LTRMacroDialogs LTRMacroDialogs

Makes macro
dialogs display
LTR

LNR-Makrodialogfelder 3664 1065

FettLauf
Formatiert den aktuellen
Lauf in der Markierung fett
(ein/aus)

WordBasic.BoldRun BoldRun
Makes the current
run in the selection
bold (toggle)

Fett ausführen 3669 1060

KursivLauf
Formatiert den aktuellen
Lauf in der Markierung
kursiv (ein/aus)

Selection.ItalicRun ItalicRun
Makes the current
run in the selection
italic (toggle)

Kursiv ausführen 3670 1061

ExtrasOptionenBidi Ändert bidirektionale
Optionen Dialogs(wdDialogToolsOptionsBidi).Show ToolsOptionsBidi

Changes the
Bidirectional
options

Extras > Optionen Bidi 3671 1029

TabelleMarkierenZelle Markiert die aktuelle Zelle in
der Tabelle Selection.SelectCell TableSelectCell Selects the current

cell in a table Tabelle > Markieren Zelle
Zelle auswählen

Table
(Word2000) 3678 1075

TabelleLöschenTabelle Entfernt die markierte
Tabelle Selection.Tables(1).Delete TableDeleteTable Deletes the

selected table Tabelle > Löschen Tabelle
Tabelle löschen 3679 1078

TabelleEinfügenZeileOberhalb Fügt eine oder mehrere
Zeilen in die Tabelle ein TableInsertRowAbove

Inserts one or
more rows into the
table

Tabelle > Zellen
einfügen
Tabellen und Rahmen

Zeilen oberhalb
Zeilen oberhalb einfügen

Table
(Word2000) 3681 1096

TabelleEinfügenZeileUnterhalb
Fügt eine oder mehrere
Zeilen unterhalb der
aktuellen Zeile in die
Tabelle ein

TableInsertRowBelow
Inserts one or
more rows into the
table below the
current row

Tabelle > Zellen
einfügen
Tabellen und Rahmen

Zeilen unterhalb
Zeilen unterhalb einfügen 3683 1076

TabelleSpalteEinfügen Fügt eine oder mehrere
Spalten in die Tabelle ein. Selection.InsertColumns TableInsertColumn

Inserts one or
more columns into
the table

Tabelle
Tabellen und Rahmen

Spalten nach links
Spalten links einfügen

Table
Tables and
Borders

3685 132

TabelleEinfügenSpalteRechts
Fügt eine oder mehrere
Spalten rechts von der
aktuellen Spalte in die
Tabelle ein

Selection.InsertColumnsRight TableInsertColumnRight

Inserts one or
more columns into
the table to the
right of the current
column

Tabelle > Zellen
einfügen
Tabellen und Rahmen

Spalten nach rechts
Spalten rechts einfügen

Table
Tables and
Borders

3687 1077

AnzeigenSkriptAnker Alle Skripte anzeigen WordBasic.ShowScriptAnchor ShowScriptAnchor Show All Scripts Alle Skripts anzeigen 3689 1110

KontextHilfe
Kontextsensitive Hilfe mit
der F1 Taste ein- und
ausschalten

WordBasic.ContextHelp ContextHelp
Turn on and off
context sensitive
help through F1
key

Kontexthilfe ein/aus 3692 813

(Tabellen-Dropdown) Tabellen und Rahmen Tabelle einfügen Tables and
Borders 3693

TabelleEigenschaften
Ändert die Höhe und Breite
der Zeilen und Spalten in
einer Tabelle

TableProperties
Changes the
height and width of
the rows and
columns in a table

Tabelle Tabelleneigenschaften… 3704 861

TabelleOptionen
Tabellenoptionen
Ändert die Höhe und Breite
der Zeilen und Spalten in
einer Tabelle

TableOptions
Changes the
height and width of
the rows and
columns in a table

Tabelle >
Tabelleneigenschaften…

Optionen…
Tabellenoptionen...
(Standardzellenbegrenzungen,
Standard-Zellenabstand)

3705 1080

ZelleOptionen
Tabellenzellenoptionen
Ändert die Höhe und Breite
der Zeilen und Spalten in
einer Tabelle

WordBasic.CellOptions CellOptions
Changes the
height and width of
the rows and
columns in a table

Tabelle >
Tabelleneigenschaften >
Zelle

Optionen…
Zelloptionen... 3706 1081
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EmailSenden Führt den Befehl Senden für
E-mailumschläge aus WordBasic.EmailSend EmailSend

Executes the e-
mail envelope's
Send command

Jetzt senden 3708 1082

EmailNamenWählen Blendet das E-
mailadressbuch ein WordBasic.EmailSelectNames EmailSelectNames Displays the e-

mail address book Namen auswählen 3709 1083

EmailNamenÜberprüfen
Überprüft den
Empfängernamen im E-
Mail-Umschlag

WordBasic.EmailCheckNames EmailCheckNames
Verifies the
recipient names in
the e-mail
envelope

Namen überprüfen 3710 1084

EmailWählenAnNamen
Blendet das E-Mail-
Adressbuch ein, um
Empfänger zum Feld: "An"
hinzuzufügen

WordBasic.EmailSelectToNames EmailSelectToNames
Displays the e-
mail address book
to add recipients
to the To field

To: Focus 3711 1085

EmailWählenCcNamen
Blendet das E-Mail-
Adressbuch ein, um
Empfänger zum Feld: "Cc"
hinzuzufügen

WordBasic.EmailSelectCcNames EmailSelectCcNames
Displays the e-
mail address book
to add recipients
to the Cc field

CC: Focus 3712 1086

EmailWählenBccNamen
Blendet das E-Mail-
Adressbuch ein, um
Empfänger zum Feld: "Bcc"
hinzuzufügen

WordBasic.EmailSelectBccNames EmailSelectBccNames
Displays the e-
mail address book
to add recipients
to the Bcc field

Bcc: Focus 3713 1087

EmailFokusBetreff
Ändert den Fokus auf das
E-Mail-Umschlagfeld:
Betreff

WordBasic.EmailFocusSubject EmailFocusSubject
Switches focus to
the e-mail
envelope's subject
field

Subject Focus 3714 1088

EmailNachrichtOptionen Blendet den Optionendialog
für E-Mail-Umschläge ein WordBasic.EmailMessageOptions EmailMessageOptions

Displays the e-
mail envelope's
options dialog

Mailoptionen 3715 1089

EmailKennzeichnung
Blendet den
Nachrichtkennzeichendialog
für Umschläge ein

WordBasic.EmailFlag EmailFlag
Displays the
envelope's
message flag
dialog

E-Mail-Kennzeichnung 3716 1090

EmailAnhangSpeichern
Speichert die Anhänge
einer E-Mail-
Umschlagnachricht

WordBasic.EmailSaveAttachment EmailSaveAttachment
Saves the
attachments of a
e-mail envelope
message

Mailanlagen speichern 3717 1091

DateiSchließenOderBeenden FileCloseOrExit Schließen oder beenden
Alt+F4 Alt+F4 (<9>) 3719 932

BearbeitenIMERekonvertierung Rekonvertieren mit IME WordBasic.EditIMEReconversion EditIMEReconversion Reconvert using
IME Erneut umwandeln 3720 857

OnlineBesprechung Startet ein oder schaltet um
zu einem Onlinemeeting WordBasic.OnlineMeeting OnlineMeeting

Starts or switches
to an Online
Meeting

Extras >
Onlinezusammenarbeit Besprechung beginnen 3727 1136

AnOnlineBesprechungsTeilnehmerSenden Sendet das Dokument an
Onlinemeeting-Teilnehmer. WordBasic.SendToOnlineMeetingParticipants SendToOnlineMeetingParticipants

Send this
document to
Online Meeting
participant

Datei-Menü > Senden
an Onlinebesprechungsteilnehmer 3728 975

Teilnehmerliste 3729
Teilnehmer anrufen 3732
Anderen das Bearbeiten
ermöglichen 3733
Teilnehmer entfernen 3734
Chatfenster anzeigen 3735
Whiteboard anzeigen 3736
Besprechung beenden 3737

EmailUmschlag Blendet den E-Mail-
Umschlag ein

ActiveWindow.EnvelopeVisible = Not
ActiveWindow.EnvelopeVisible EmailEnvelope Displays the e-

mail envelope
Datei
Standard

Senden an > Mailempfänger
E-Mail-Empfänger Standard 3738 875

ExtrasBusu Extras Sprache Busu für
Korea ToolsBusu Tools Language

Busu for Korea Extras > Sprache Hanja Radikal-Eingabe... 3741 939

HtmlGrößeAnker
Bearbeitet Hyperlink-
Makroschaltflächen, die mit
dem Internet Assistant
erstellt wurden

WordBasic.HtmlResAnchor HtmlResAnchor
Handles old
Internet Assistant-
style hyperlink
macro buttons

HTML Res Anchor 3742 967

FramesetInhaltsverzeichnis Ändert ein Frameset-
Inhaltsverzeichnis ActiveWindow.ActivePane.TOCInFrameset FramesetTOC Create a frameset

table of content
Format
Frames Inhaltsverzeichnis im Frame (Web) Frames 3743 1111

KorrigierenRechtschreibSprache Ändert die Sprache für
dieses Wort FixSpellingLang Changes language

of this word Sprache festlegen... 3744 899

(Sprachen-Dropdown)
Ändert die
Spracheinstellungen für die
markierten Zeichen.

Changes the
language
formatting of the
selected
characters

Sprache 3745
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Umschlag 3746
TabelleUmbruch Ändert den Umbruch in

einer Tabelle WordBasic.TableWrapping TableWrapping Changes the
wrapping in a table Tabellenumbruch 3751 854

EmailOptionen
Ändert verschiedene
Kategorien der Word-E-
Mail-Optionen

Dialogs(wdDialogEmailOptions).Show EmailOptions
Changes various
categories of
Word's E-Mail
options

E-Mail-Optionen... 3753 863

AnzeigenAddInsXDialog Zeigt den erweiterten Office
AddIn Manager Dialog ShowAddInsXDialog

Displays the Office
AddIn Manager
dialog

COM-Add-Ins... 3754 936

EmailSignaturOptionen Erstellt oder ändert
AutoSignatur-Einträge WordBasic.EMailSignatureOptions EmailSignatureOptions

Create or changes
AutoSignature
entries

AutoSignaturmenü E-Mail-Unterschrift...
E-Mail-Signatur...

AutoSignature
Popup 3766 862

FrameEigenschaften Ändert die
Frameeigenschaften WordBasic.FrameProperties FrameProperties

Changes the
Properties of the
Frame

Frames
Kontext Frameeigenschaften... (Web) Frames

Context 3768 1074

Korrigieren Office verifizieren WordBasic.FixMe FixMe Verify Office ? Erkennen und Reparieren... Help 3774 705
OfficeImWeb Office im Web... WordBasic.OfficeOnTheWeb OfficeOnTheWeb Office on the

Web... ? Office im Web Help 3775 579

PrivFunktionstaste1 Hilfe PrivFunctionkey1 Function key Funktionstastenanzeige Hilfe F1 Function Key
Display 3777 1097

PrivFunktionstaste2 Text verschieben PrivFunctionkey2 Function key Funktionstastenanzeige Text verschieben F2 Function Key
Display 3778 1098

PrivFunktionstaste3 AutoText einfügen PrivFunctionkey3 Function key Funktionstastenanzeige AutoText einfügen F3 Function Key
Display 3779 1099

PrivFunktionstaste4 Wiederholen PrivFunctionkey4 Function key Funktionstastenanzeige Wiederholen F4 Function Key
Display 3780 1100

PrivFunktionstaste5 Gehe zu... PrivFunctionkey5 Function key Funktionstastenanzeige Gehe zu... F5 Function Key
Display 3781 1101

PrivFunktionstaste6 Anderer Ausschnitt PrivFunctionkey6 Function key Funktionstastenanzeige Anderer Ausschnitt F6 Function Key
Display 3782 1102

PrivFunktionstaste7 Rechtschreibung und
Grammatik... PrivFunctionkey7 Function key Funktionstastenanzeige Rechtschreibung und

Grammatik... F7
Function Key
Display 3783 1103

PrivFunktionstaste8 Funktionstaste 8 PrivFunctionkey8 Function key Funktionstastenanzeige Funktionstaste 8 F8 Function Key
Display 3784 1104

PrivFunktionstaste9 Felder aktualisieren PrivFunctionkey9 Function key Funktionstastenanzeige Felder aktualisieren F9 Function Key
Display 3785 1105

PrivFunktionstaste10 Menümodus PrivFunctionkey10 Function key Funktionstastenanzeige Menümodus F10 Function Key
Display 3786 1106

PrivFunktionstaste11 Nächstes Feld PrivFunctionkey11 Function key Funktionstastenanzeige Nächstes Feld F11 oder Alt+F1 Function Key
Display 3787 1107

PrivFunktionstaste12 Speichern unter... PrivFunctionkey12 Function key Funktionstastenanzeige Speichern unter... F12 Function Key
Display 3788 1108

DateiNeuKontext
Erzeugt ein neues
Dokument basierend auf
der Standardvorlage

FileNewContext
Creates a new
document based
on the NORMAL
template

Neu 3792 1265

EinfügenGrafikAufzählungszeichen Fügt eine Grafik als
Aufzählungszeichen ein InsertPictureBullet Inserts a picture

as a bullet Bildaufzählungszeichen... 3793 860

DateiNeuWeb
Erstellt ein neues, auf der
Vorlage NORMAL.DOT
basierendes Dokument.

WordBasic.FileNewWeb FileNewWeb
Creates a new
document based
on the NORMAL
template

DateiNeu Neue Webseite FileNew 3794 1113

DateiNeueEmailNachricht Erstellt eine neue E-Mail-
Nachricht Documents.Add DocumentType:=wdNewEmailMessage FileNewEmail Creates a new

mail message DateiNeu Neue E-Mailnachricht
Neue E-Mail-Nachricht FileNew 3795 1092

EinfügenHTMLHGAudio Fügt ein Hintergrund-
Soundobjekt ein WordBasic.InsertHTMLBGSound InsertHTMLBGSound Inserts a

background sound Webtools Sound Web Tools 3798 1134

EinfügenHTMLMovie Fügt ein Film-
Steuerelement ein WordBasic.InsertHTMLMovie InsertHTMLMovie Inserts a movie

control Webtools Film Web Tools 3799 1133

EinfügenHTMLMarquee Fügt ein Marquee-
Steuerelement ein WordBasic.InsertHTMLMarquee InsertHTMLMarquee Inserts a marquee

control Webtools Lauftext Web Tools 3800 1135

DateiNeuDrucken
Erstellt ein neues, auf der
Vorlage NORMAL.DOT
basierendes Dokument.

WordBasic.FileNewPrint FileNewPrint
Creates a new
document based
on the NORMAL
template

DateiNeu Neues leeres Dokument FileNew 3813 1115
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DateiNeuDialog
Erstellt ein neues, auf der
Vorlage NORMAL.DOT
basierendes Dokument.

WordBasic.FileNewDialog FileNewDialog
Creates a new
document based
on the NORMAL
template

DateiNeu Andere... FileNew 3814 1116

HTMLQuelleAktualisieren Aktualisieren ActiveDocument.HTMLProject.RefreshDocument HTMLSourceRefresh Refresh Aktualisieren Aktualisieren Refresh 3817 1118
HTMLQuelleNichtAktualisieren Nicht aktualisieren ActiveDocument.HTMLProject.RefreshDocument False HTMLSourceDoNotRefresh Do Not Refresh Aktualisieren Nicht aktualisieren Refresh 3819 1120

DateiSpeichernAlsWebSeite
Speichert eine Kopie des
Dokuments in eine andere
Datei

WordBasic.FileSaveAsWebPage FileSaveAsWebPage
Saves a copy of
the document in a
separate file

Datei Als Webseite speichern... File 3823 1164

EinfügenGraphischeHorizontaleLinie Fügt eine graphische
horizontale Linie ein InsertGraphicalHorizontalLine Inserts a picture

horizontal line Horizontale Linie... 3824 1067

WebOptionen Öffnet den
Weboptionendialog Dialogs(wdDialogWebOptions).Show WebOptions Opens the Web

Options Dialog Weboptionen... 3831 898

FramesetAssistent Macht aus dem aktuellen
Fenster ein Frameset ActiveWindow.ActivePane.NewFrameset FramesetWizard

Turns the current
window into a
frameset

Format Neue Framesseite Formatting 3833 1068

FrameTeilenOberhalb
Teilt den aktiven Frame und
fügt den neuen oberhalb
des aktuellen Frames ein

ActiveWindow.ActivePane.Frameset.AddNewFrame
(wdFramesetNewFrameAbove) FrameSplitAbove

Splits the active
frame adding the
new frame above
the current

Frames Neuer Frame Oben (Web) Frames 3834 1069

FrameTeilenUnterhalb
Teilt den aktiven Frame und
fügt den neuen unterhalb
des aktuellen Frames ein

ActiveWindow.ActivePane.Frameset.AddNewFrame
(wdFramesetNewFrameBelow) FrameSplitBelow

Splits the active
frame adding the
new frame below
the current

Frames Neuer Frame Unten (Web) Frames 3835 1070

FrameTeilenLinks
Teilt den aktiven Frame und
fügt den neuen links vom
aktuellen Frame ein

ActiveWindow.ActivePane.Frameset.AddNewFrame
(wdFramesetNewFrameLeft) FrameSplitLeft

Splits the active
frame adding new
frame left of the
current

Frames Neuer Frame Links (Web) Frames 3836 1071

FrameTeilenRechts
Teilt den aktiven Frame und
fügt den neuen rechts vom
aktuellen Frame ein

ActiveWindow.ActivePane.Frameset.AddNewFrame
(wdFramesetNewFrameRight) FrameSplitRight

Splits the active
frame adding new
frame right of the
current

Frames Neuer Frame Rechts (Web) Frames 3837 1072

FrameEntfernenTeilen Entfernt den aktuellen
Frame ActiveWindow.ActivePane.Frameset.Delete FrameRemoveSplit Removes the

current frame Frames Frame löschen (Web) Frames 3838 1073
Führt Microsoft Clip Gallery
aus und sucht nach
AutoFormen

Zeichnen > AutoFormen Weitere AutoFormen... Drawing >
AutoShapes 3889

AnsichtHTMLQuelle HTML-Quelle ActiveDocument.HTMLProject.Open
msoHTMLProjectOpenTextView ViewHTMLSource HTML Source Ansicht HTML-Quelle 3902 1154

AutoAnpassenInhalt Tabelle automatisch dem
Inhalt anpassen Selection.Tables(1).AutoFitBehavior (wdAutoFitContent) AutoFitContent Auto-Fit Table to

the contents

Tabelle > AutoAnpassen
Tabellen und Rahmen >
AutoAnpassen
Kontext >
AutoAnpassen

AutoAnpassen Inhalt
Tables and
Borders
Context

3907 1141

AutoAnpassenFenster Tabelle automatisch dem
Fenster anpassen Selection.Tables(1).AutoFitBehavior (wdAutoFitWindow) AutoFitWindow Auto-Fit Table to

the window

Tabelle > AutoAnpassen
Tabellen und Rahmen >
AutoAnpassen
Kontext >
AutoAnpassen

AutoAnpassen Fenster
Größe an Fenster anpassen

Tables and
Borders
Context

3908 1142

AutoAnpassenKorrigiert Tabellengröße auf feste
Breite definieren Selection.Tables(1).AutoFitBehavior (wdAutoFitFixed) AutoFitFixed Set table size to a

fixed width

Tabelle > AutoAnpassen
Tabellen und Rahmen >
AutoAnpassen
Kontext >
AutoAnpassen

Feste Spaltenbreite
Tables and
Borders
Context

3909 1144

UnterstreichenFarbe

Unterstreichungsfarbe
ButtonPopup
Ändert die
Unterstreichungsfarbe des
markierten Textes

WordBasic.UnderlineColor UnderlineColor
Changes the
underline color of
the selected text

Unterstreichungsfarbe 3911 785

ObenLinksAusrichten Richtet den Zelleninhalt
oben links aus WordBasic.TopLeftAlign TopLeftAlign

Aligns cell content
to the top-left of
cell

Tabellen und Rahmen
Zellausrichtung
Kontext

> Oben Links ausrichten
Tables and
Borders
Cell Alignment
Context

3914 1147

ObenZentriertAusrichten Richtet den Zelleninhalt
oben zentriert aus WordBasic.TopCenterAlign TopCenterAlign

Aligns cell content
to the top-center of
cell

Tabellen und Rahmen
Zellausrichtung
Kontext

> Oben Mitte ausrichten
Tables and
Borders
Cell Alignment
Context

3915 1146
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ObenRechtsAusrichten
Richtet den Zelleninhalt
rechts oben von der Zelle
aus

WordBasic.TopRightAlign TopRightAlign
Aligns cell content
to the top-right of
cell

Tabellen und Rahmen
Zellausrichtung
Kontext

> Oben Rechts ausrichten
Tables and
Borders
Cell Alignment
Context

3916 1145

MitteLinksAusrichten Richtet den Zelleninhalt in
der Mitte links aus WordBasic.MiddleLeftAlign MiddleLeftAlign

Aligns cell content
to the middle-left
of cell

Tabellen und Rahmen
Zellausrichtung
Kontext

Mitte Links ausrichten
Tables and
Borders
Cell Alignment
Context

3917 1150

MitteZentriertAusrichten Richtet den Zelleninhalt in
der Mitte zentriert aus WordBasic.MiddleCenterAlign MiddleCenterAlign

Aligns cell content
to the middle-
center of cell

Tabellen und Rahmen
Zellausrichtung
Kontext

> Mitte ausrichten
Tables and
Borders
Cell Alignment
Context

3918 1149

MitteRechtsAusrichten Richtet den Zelleninhalt in
der Mitte rechts aus WordBasic.MiddleRightAlign MiddleRightAlign

Aligns cell content
to the middle-right
of cell

Tabellen und Rahmen
Zellausrichtung
Kontext

> Mitte rechts ausrichten
Tables and
Borders
Cell Alignment
Context

3919 1148

UntenLinksAusrichten Richtet den Zelleninhalt
unten links aus WordBasic.BottomLeftAlign BottomLeftAlign

Aligns cell content
to the bottom-left
of cell

Kontext Unten links ausrichten Context 3920 1153

UntenZentriertAusrichten Richtet den Zelleninhalt
unten zentriert aus WordBasic.BottomCenterAlign BottomCenterAlign

Aligns cell content
to the bottom-
center of cell

Tabellen und Rahmen >
Zellausrichtung Unten Mitte ausrichten

Tables and
Borders
Cell Alignment
Context

3921 1152

UntenRechtsAusrichten Richtet den Zelleninhalt
unten rechts aus WordBasic.BottomRightAlign BottomRightAlign

Aligns cell content
to the bottom-right
of cell

Tabellen und Rahmen >
Zellausrichtung
Kontext

Unten rechts ausrichten
Tables and
Borders
Cell Alignment
Context

3922 1151

EinfügenHTMLSteuerelement Fügt ein Kontrollkästchen
ein WordBasic.InsertHTMLCheckBox InsertHTMLCheckBox Inserts a Check

Box Webtools Kontrollkästchen Web Tools 3939 1122

EinfügenHTMLOptionsSchaltfläche Fügt eine
Optionsschaltfläche ein WordBasic.InsertHTMLOptionButton InsertHTMLOptionButton Inserts an Option

Button Webtools Optionsfeld Web Tools 3940 1123

EinfügenHTMLDropdownFeld Fügt ein Dropdown-
Listenfeld ein WordBasic.InsertHTMLDropdownBox InsertHTMLDropdownBox Inserts a

Dropdown listbox Webtools Dropdownfeld Web Tools 3941 1124

EinfügenHTMLListenFeld Fügt ein Listenfeld ein WordBasic.InsertHTMLListBox InsertHTMLListBox Inserts a Listbox Webtools Listenfeld Web Tools 3942 1125
EinfügenHTMLTextFeld Fügt ein Textfeld ein InsertHTMLTextBox Inserts a Textbox Webtools Textfeld Web Tools 3943 1126
EinfügenHTMLTextBereich Fügt einen Textbereich ein WordBasic.InsertHTMLTextArea InsertHTMLTextArea Inserts a Textarea Webtools Textbereich Web Tools 3944 1127

EinfügenHTMLVorschlagen Fügt eine Absenden-
Schaltfläche ein WordBasic.InsertHTMLSubmit InsertHTMLSubmit Inserts a Submit

button Webtools Übermitteln Web Tools 3945 1128

EinfügenHTMLBildVorschlagen Fügt eine Absenden-
Schaltfläche mit Bild ein WordBasic.InsertHTMLImageSubmit InsertHTMLImageSubmit Inserts a Submit

button with image Webtools Mit Bild übermitteln Web Tools 3946 1129

EinfügenHTMLVorgabe Fügt eine Zurücksetzen-
Schaltfläche ein WordBasic.InsertHTMLReset InsertHTMLReset Inserts a reset

button Webtools Zurücksetzen Web Tools 3947 1130

EinfügenHTMLAusgeblendet Fügt ein ausgeblendetes
Steuerelement ein WordBasic.InsertHTMLHidden InsertHTMLHidden Inserts a hidden

control Webtools Ausgeblendet Web Tools 3948 1131

EinfügenHTMLKennwort Fügt ein Kennwort-
Steuerelement ein WordBasic.InsertHTMLPassword InsertHTMLPassword Inserts a password

control Webtools Kennwort Web Tools 3949 1132

ExtrasTCVCÜbersetzung Übersetzt chinesische
Zeichenfolge. Dialogs(wdDialogTCSCTranslator).Show ToolsTCSCTranslation Translates chinese

string.
Chinesische
Schriftumwandlung... 3958 1156

HanjaWörterbuch Hanja-Wörterbuch HanjaDictionary Hanja Dictionary Extras > Sprache Hanja-Wörterbuch ... 3959 1158
Tabellen-Assistent
(Table Wizard not
implemented?)

Table Wizard Tabelle Multidiagonale Zelle einfügen...
(Befehl nicht implementiert?) 3961

UnterstreichenArt
Fomatiert die Markierung
mit einer durchgezogenen
Unterstreichung

WordBasic.UnderlineStyle UnderlineStyle
Formats the
selection with a
continuous
underline

Unterstreichen 3962 1163

FormatHorizontalInVertikal Eigenschaft: Horizontal in
Vertikal anwenden Dialogs(wdDialogHorizontalInVertical).Show FormatHorizontalInVertical Apply Horizontal in

Vertical property Horizontal nach Vertikal... 3963 1160

FormatZweiZeilenInEiner Eigenschaft: "Zwei Zeilen in
einer" zuweisen Dialogs(wdDialogTwoLinesInOne).Show FormatTwoLinesInOne Apply Two Lines in

One property Zwei Zeilen in einer... 3964 1161

FormatEingeschlossenesZeichen Fügt ein eingeschlossenes
Zeichen ein Dialogs(wdDialogFormatEncloseCharacters).Show FormatEncloseCharacters Inserts a enclosed

character Erweiterte Formatierung Eingeschlossene Zeichen... Extended
Formatting 3969 1162

UmschlagAssistent Chinesischer
Briefumschlag-Assistent... EnvelopeWizard Envelope Wizard Extras Chinesischer Briefumschlag-

Assistent... 3972 1175
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ZeichnenMehrereObjekteMarkieren

Ändert den Zeiger zu einem
Kreuz, damit Sie ein
Markierungsrechteck um
mehrere Objekte ziehen
können, um diese zu
markieren.

??? ??? Mehrere Objekte auswählen 3990

ExtrasVCTCÜbertragen Übersetzt chinesische
Zeichenfolge.

Selection.Range.TCSCConverter WdTCSCConverterDirection:= _
wdTCSCConverterDirectionSCTC ToolsSCTCTranslate Translates chinese

string.
Chinesische
Schriftumwandlung

In vereinfachte chinesische
Schrift umwandeln

Chinese
Translation 3997 1170

FormatZeichenObjektTextflussHinter
Ändert die markierten
Zeichnungsobjekte auf
"Keinen Umbruch nach
Text"

FormatDrawingObjectWrapBehind

Changes the
selected drawing
objects to no
wrapping behind
text

Zeichnen
WordArt
Textfluss
Kontext

> Hinter den Text
Drawing
WordArt
Text Wrapping
Context

4000 4112

FormatZeichenObjektTextflussSchrift
Ändert die markierten
Zeichnungsobjekte auf
"Keinen Umbruch vor Text"

FormatDrawingObjectWrapFront

Changes the
selected drawing
objects to no
wrapping in front
of text

Zeichnen
WordArt
Textfluss
Kontext

> Vor den Text
Drawing
WordArt
Text Wrapping
Context

4001 4111

FormatHintergrundWasserzeichen Hintergrund für
Wasserzeichen FormatBackgroundWatermark Watermark

Background Format > Hintergrund Wasserzeichen...
Gedrucktes Wasserzeichen... 4003 946

DateiSpeichernFrameAls
Speichert eine Kopie des
aktuellen Framedokuments
in einer anderen Datei

WordBasic.FileSaveFrameAs FileSaveFrameAs
Saves a copy of
the current frame
document in a
separate file

Aktuellen Frame speichern
als... 4004 1109

AnsichtWebToolbox Blendet die Webtoolbox ein
oder aus

WordBasic.ViewWebToolbox
((Kein Code)) ViewWebToolbox Shows or hides

the Web Toolbox Webtoolbox 4020 7108

Zeichenraster Tunnel zum Dialog: Auf
Rasterbreite anpassen WordBasic.DrawingGrid DrawingGrid Tunnel to

SnapToGrid dialog Gitternetz... 4024 1168

ExtrasTCVCÜbertragen Übersetzt chinesische
Zeichenfolge.

Selection.Range.TCSCConverter WdTCSCConverterDirection:= _
wdTCSCConverterDirectionTCSC ToolsTCSCTranslate Translates chinese

string.
Chinesische
Schriftumwandlung

In traditionelle chinesische
Schrift umwandeln

Chinese
Translation 4025 1169

ExtrasÜbertragenChinesisch Übersetzt chinesische
Zeichenfolge.

Selection.Range.TCSCConverter WdTCSCConverterDirection:= _
wdTCSCConverterDirectionAuto ToolsTranslateChinese Translates chinese

string.
Chinesische
Schriftumwandlung... 4026 1171

AnzeigenKonsistenz Zeigt einen Bezug zum
Konsistenzfehler an WordBasic.ShowConsistency ShowConsistency

Show one
relationship for
consistency error

Ähnliche Begriffe anzeigen 4031 1121

AnzeigenAlleKonsistenz Zeigt alle Bezüge zum
Konsistenzfehler an WordBasic.ShowAllConsistency ShowAllConsistency

Show all
relationship for
consistency error

Ähnliche Begriffe anzeigen 4032 1172

UmschaltenWebDesign Aktiviert Webdesign WordBasic.ToggleWebDesign ToggleWebDesign Enables Web
Design Webtools Entwurfsmodus Web Tools 4034 1119

ExtrasSynonymKorrigieren Synonym... WordBasic.ToolsFixSynonym ToolsFixSynonym Synonym... Synonyme 4077 1018

DiakritischFarbe
Diakritische Farbe
ButtonPopup
Ändert die Farbe der
diakritischen Zeichen

WordBasic.DiacriticColor DiacriticColor Changes the color
of the Diacritics Diakritische Farbe 4144 1112

WebDiskussionen Startet
Webserverdiskussionen WordBasic.WebDiscussions WebDiscussions Extras >

Onlinezusammenarbeit Webdiskussionen 4177 1179

BesprechungPlanen Erstellt den Termin für eine
Onlinebesprechung WordBasic.ScheduleMeeting ScheduleMeeting Schedules an

Online Meeting
Extras >
Onlinezusammenarbeit Meeting ansetzen... 4179 1178

AnsichtGliederungZentral Zeigt das Dokument in der
Gliederungsansicht an. ActiveWindow.ActivePane.View.Type = wdMasterView ViewOutlineMaster Displays a

document's outline Ansicht Gliederung 4387 1177
Webdesign Web Theme Webdesignname 5414

AnsichtUmschaltenSeiteBegrenzungen

Schaltet zwischen dem
Anzeigen/Ausblenden
vertikaler Seitenränder
innerhalb der
Drucklayoutansicht um

ViewTogglePageBoundaries
Switches between
showing/hiding
vertical margins in
Print Layout View

Leerraum zwischen Seiten 5730 871

FormatierenFeld Einfügen eines Feldes in
das aktive Dokument FormatField

Inserts a field in
the active
document

Feld bearbeiten... 5731 1340

ErsetzenEMailSignatur
Ersetzt die aktuelle
AutoSignatur mit einer
Anderen

ReplaceEmailSignature
Replaces the
current
AutoSignature with
a different one

E-Mail-Signatur ersetzen 5732 1341

ZeilenAbstand Zeilenabstand übernehmen
für die Auswahl LineSpacing

Applies line
spacing to the
selection

Format Zeilenabstand Formatting 5734 1263

ExtrasWörterZählenErneut
Aktualisiert die
Wörterzählstatistik des
aktiven Dokumentes

ToolsWordCountRecount
Updates the word
count statistics of
the active
document

Neu zählen 5739 1345
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ExtrasWörterZählenListe Zeigt die Wortanzahl des
aktiven Dokuments an ToolsWordCountList

Displays the word
count statistics of
the active
document

Statistik für Wörter zählen 5740 1346

FormatVorlageÄndern Modifiziert ausgewählte
Formatvorlage FormatStyleModify Modifies selected

style Formatvorlage bearbeiten 5741 1347

FormatVorlageNachBeispiel Creates a style out of the
currently selected text FormatStyleByExample

Creates a style out
of the currently
selected text

5742 1348

CssVerknüpfungen Verwaltet externe CSS-
Links CssLinks Manages external

CSS links CSS-Hyperlinks bearbeiten 5743 1261

AnzeigenAufgabenbereich Aufgabenbereich ein-
/ausblenden

CommandBars("Task Pane").Visible = Not (CommandBars("Task
Pane").Visible) ViewTaskPane Shows or hides

the Task Pane Aufgabenbereich 5746 1313

AnzeigenSignaturen Anzeigen digitaler
Signaturen ShowSignatures Show Digital

Signatures Signatur 5756 1267

FormatierFenster
Zuweisen, Erstellen oder
Modifizieren von
Formatvorlagen und
Formatierungen

FormattingPane
Applies, creates,
or modifies styles
and formatting

Format Formatvorlagen und
Formatierung... Formatting 5757 1364

VorlageLöschen Löscht die aktive
Formatvorlage DeleteStyle Deletes the

current style Formatvorlage löschen 5758 1365

VorlageUmbenennen Benennt die aktive
Formatvorlage um RenameStyle Renames the

current style Formatvorlage umbenennen 5759 1366

NachrichtAlsNurText
Konvertiert die aktuelle
Nachricht zu unformatierten
Text

MailAsPlainText
Converts the
current message
to plain text

Senden als Nur-Text 5760 1259

NachrichtAlsRTF Konvertiert die aktuelle
Nachricht zu HTML (?!?) MailAsRTF

Converts the
current message
to HTML (?!?)

Senden als RTF 5761 1264

NachrichtAlsHTML Konvertiert die aktuelle
Nachricht zu HTML MailAsHTML

Converts the
current message
to HTML

Senden als HTML 5762 1260

Schaltet Spracherkennung
Ein und Aus ToolsSpeech

Turns Speech
Recognition on or
off

Sprachein- und -ausgabe 5764 1258

NummerAuswählen Auswählen der
Abschnittsnummer SelectNumber Selects the

paragraph number Zahl wählen 5809 1349

NummerierungZurücksetzen Neuanlegen der
Abschnittsnummerierung RestartNumbering

Restarts
paragraph
numbering

Neu nummerieren 5810 1350

FesteUIMÄnderung
Ersetzt das markierte Wort
durch den ausgewählten
Vorschlag

FixUIMChange
Replaces this
word by the
selected
suggestion

(Rechtschreibvorschläge) 5816 1351

UIMKorrekturUI
Startet TIP's
Korrekturbenutzeroberfläch
e

UIMCorrectionUI Brings up TIP's
correction UI Weitere... 5817 1352

FesteUIMWortLöschen Entfernt das Wort FixUIMDeleteWord Removes the word Löschen 5818 1353
ExtrasOptionenBearbeitenKopierenEinfügen Ändert die

Bearbeitungsoptionen ToolsOptionsEditCopyPaste Changes the
editing options

Einstellungen kopieren und
einfügen... 5840 1356

BearbeitenEinfügenTabelleHinzufügen
Fügt den Inhalt der
Zwischenablage an der
Einfügemarke ein

EditPasteAppendTable
Inserts the
Clipboard contents
at the insertion
point

Kontext Tabelle einfügen Context 5842 1358

MailFormatÄndern Ändert das aktuelle
Nachrichtenformat ChangeMailFormat

Changes the
current message
format

Mailformat ändern 5846 7113

Assistent 5849
Kollegin 5855
Untergebene 5856

Konvertiert Diagramm zu
Radial Löschen 5858
Passt Zeichnungsbereich
an Inhalt an Anpassen 5866
Schaltet die
Zeichnungsbereich-
Symbolleiste ein oder aus

Symbolleiste für
Zeichnungsbereich einblenden 5868

DateiSuchen Öffnet das Durchsuchen
Fenster FileSearch

Brings up the
Search UI
workpane

Suchen... 5905 1363
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EtikettOptionen Etikettoptionendialog LabelOptions Label Options
Dialog Etikettenoptionen... 5906 1367

UmschlagOptionen Briefumschlagoptionendialo
g EnvelopeSetup Envelopes Option

Dialog Umschlag-Setup... 5907 1368

SerienDruckZuEmail Sendet das Ergebnis des
Seriendrucks an E-Mail MailMergeToEMail

Sends the results
of the mail merge
to E-Mail

Seriendruckergebnis in E-Mail
ausgeben 5908 1369

SerienDruckZuFax Sendet das Ergebnis des
Seriendrucks an Fax MailMergeToFax

Sends the results
of the mail merge
to Fax

Seriendruckergebnis in Fax
ausgeben 5909 1370

SerienDruckSymbolleiste Anzeigen/Ausblenden der
Seriendrucksymbolleiste. MailMergeToolbar

Displays / Hides
the Mail Merge
Toolbar.

Seriendruck-Symbolleiste
einblenden 5911 1371

SerienDruckListeErstellen Erstellt eine Office-
Adressenliste... MailMergeCreateList Create an Office

Address List... Seriendruckliste erstellen 5912 1372

SerienDruckListeBearbeiten Bearbeiten einer Office-
Adressenliste... MailMergeEditList Edit an Office

Address List... Seriendruckliste bearbeiten 5913 1373
Erweitert
Zeichnungsbereich Erweitern 5916

LizenzVerifikation LicenseVerification Produkt aktivieren... 5933 1377

FormatZeichenObjektTextflussInline
Ändert das ausgewählte
Zeichenobjekt zu
Inlineumbruch

FormatDrawingObjectWrapInline
Changes the
selected drawing
object to inline
wrapping

Mit Text in Zeile 5934 4113

FormatKonsistenzÜberprüfung Überprüfen der
Formatierungskonsistenz FormatConsistencyCheck

Check for
formatting
consistency

Konsistenzüberprüfung... 5945 1378

AuswählenÄhnlichesFormat Alle ähnliche
Formatierungen auswählen SelectSimilarFormatting Select all similar

formatting
Text mit ähnlicher Formatierung
wählen 5946 1244

AusPassportAbmelden Meldet von Microsoft
Passport ab SignOutOfPassport Signs out of

Microsoft Passport Abmelden 5950 1380

GesendetFürÜberprüfung Dokument zur Überprüfung
senden SendForReview

Send this
document for
review

Zum Bearbeiten versenden... 5958 1379

EinfügenWebkomponente Fügt eine FrontPage
Webkomponente ein InsertWebComponent

Inserts a
FrontPage web
component

Webkomponente... 5965 1324

Anordnen oder Verteilen der
markierten Objekte relativ
zum Zeichnungsbereich

Relativ zu Zeichnungsbereich 5976

Markierte Form nach oben
verschieben Form nach hinten verschieben 6010
Markierte Form nach unten
verschieben Form nach vorne verschieben 6011

ZeichenKodeUmschalten Schaltet um zwischen
Zeichen und Zeichenkode ToggleCharacterCode

Toggles a
character code
and a character

Zeichencode ein/ausschalten 6032 1393

ExtrasOptionenSmarttag Ändert die Optionen für
Smarttags ToolsOptionsSmartTag Changes the

Smart Tag options Extras Optionen Smarttag 6042 1395

EmailFokusEinführung
Wechselt den Fokus zu E-
Mail-
Umschlagseinführungsfeld

EmailFocusIntroduction
Switches focus to
the e-mail
envelope's
introduction field

Eingangsfokus 6057 1396

FormatVorlageSichtbar Ändert das Aussehen der
Dokumentvorlagen (!?!) FormatStyleVisibility

Changes the
visibility state of
the document's
styles

Formatvorlagenansicht 6058 1248

Diagrammtyp anwenden AutoFormat 6068
SerienDruckSchattenFelder Schatten ein/aus für

vermischte Felder. (!?!) MailMergeShadeFields Toggles shading
of merge fields. Seriendruckfelder hervorheben 6069 1245

SerienDruckAssistent Seriendruck-Assistent MailMergeWizard Mail Merge Wizard Seriendruck-Assistent (displays Mail
Merge task pane) 6070 1246

GrußSatz Japanischer Gruß-Assistent GreetingSentence Japanese
Greeting Wizard Grußformel... 6090 1176

JapanischGrußEröffnungsSatz
Eröffnungssatz des
japanischen Gruß-
Assistenten

JapaneseGreetingOpeningSentence
Japanese
Greeting Wizard
Opening Sentence

Beginn... 6091 1249

JapanischGrußSchlussSatz
Schlusssatz des
japanischen Gruß-
Assistenten

JapaneseGreetingClosingSentence
Japanese
Greeting Wizard
Closing Sentence

Schluss... 6092 1250
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JapanischGrußVorherigerGruß
Vorhergehender Gruß des
japanischen Gruß-
Assistenten

JapaneseGreetingPreviousGreeting
Japanese
Greeting Wizard
Previous Greeting

Vorherige Grußformel einfügen 6093 1251

FormatEigenschaften Formatierungseigenschafte
n anzeigen/ausblenden FormattingProperties

Shows or hides
Formatting
Properties

Formatierung anzeigen 6094 1062

Diagrammrichtung
umkehren Diagramm umkehren 6099

BearbeitenEinfügenVonExcel
Fügt den Inhalt der
Zwischenablage an der
Einfügemarke ein

EditPasteFromExcel
Inserts the
Clipboard contents
at the insertion
point

Einfügen 6103 1397

TxbxAutoGröße
Passt das markierte
Zeichenobjekt mittels
"Automatische Größe" an

TxbxAutosize
Changes the
selected drawing
object to autosize

Textfeld automatisch anpassen 6104 1357

ÜbersetzungsFenster Übersetzen TranslatePane Translate Übersetzen... 6111 1254

GeheZuInhaltsverzeichnis Die erste Inhaltsangabe der
Dokumentes auswählen GotoTableOfContents

Selects the first
table of contents in
the document

Gehe zu Inhaltsverzeichnis 6114 1389

InhaltsverzeichnisAktualisieren Die erste Inhaltsangabe der
Dokumentes aktualisieren UpdateTableOfContents

Updates the first
table of contents in
the document

Inhaltsverzeichnis aktualisieren 6115 1390

GliederungsEbene Setzt den ausgewählten
Absatz zur Kopfebene (!?!) OutlineLevel

Sets the selected
paragraphs to the
heading level

Gliederungsebene 6116 1391

EbeneAnzeigen Zeigt nur die Kopfebenen
an (!?!) ShowLevel

Displays the
selected level
headings only

Ebene anzeigen 6117 1392

WeiterNummerieren Fortsetzen der
Absatznummerierung ContinueNumbering

Continues
paragraph
numbering

Nummerierung fortsetzen 6125 1255

DateiAuschecken Dokument auschecken FileCheckout Check out a
Document Auschecken 6127 1277

DateiEinchecken Dokument einchecken. FileCheckin Check in a
Document. Einchecken 6128 1278

VerkleinernMehrfachAuswahl
Eine Mehrfachauswahl auf
das letzte Element
reduzieren

ShrinkMultiSel
Shrinks a multiple
selection to the
lastest piece

Nicht verbundenen Bereich
reduzieren 6130 1275

RückgabeÜberprüfung Dieses Dokument unter
Überprüfung senden ReturnReview

Send this
document under
review

Bearbeitung zurücksenden... 6139 1268

EndeÜberprüfung Überprüfung für dieses
Dokument beenden EndReview End the review for

this document Bearbeitung beenden... 6141 1270

NormalisierenText Text konsistent zum Rest NormalizeText
Make text
consistence with
the rest

Text normalisieren 6164 1272

IgnorierenKonsistenzFehler Konsistenzfehler ignorieren IgnoreConsistenceError Ignore consistence
error Ignorieren 6165 1273

IgnorierenAlleKonsistenzFehler Konsistenzfehler ignorieren IgnoreAllConsistenceError Ignore consistence
error Nie ändern 6166 1274

EinfügenFormatvorlagenTrennzeichen
Führt zwei Absätze
zusammen und erstellt
führende Hervorhebungen

InsertStyleSeparator
Joins two
paragraphs
together creating
leading emphasis

Formatvorlagentrennzeichen 6174 1398

ErlernenWorte
Wörter aus dem Dokument
zur Spracherkennung
erlernen

LearnWords
Learn words from
document for
speech recognition

Lernen von Dokument... 6187 1279

BearbeitenBildBearbeiten
Konvertiert das
ausgewählte Bild in einen
Zeichnungsbereich

EditPictureEdit
Converts the
selected picture
into a Drawing
Canvas

Bild bearbeiten 6208 1280

GliederungErhöhenÜberschrift1
Stuft den ausgewählten
Text als "Überschrift 1"
Format ein

OutlinePromoteHeading1
Promotes the
selected text to
Heading 1 style

Höher stufen zu Überschrift 1 6214 1360

FormatDefinierenFormatvorlageTabelle FormatDefineStyleTable Format Tabellenstil definieren 6221 1282
FormatDefinierenFormatvorlageStreifen FormatDefineStyleStripes Format definieren: Format

Streifen 6222 1283
Auf Kommentar antworten Auf Kommentar antworten 6228

AnzeigenÄnderungenUndKommentare Markiersprechblasen ein-
oder ausblenden ShowChangesAndComments Show or hide

markup balloons Markup anzeigen 6230 1288

AnzeigenKommentare Kommentarsprechblasen
ein- oder ausblenden ShowComments Show or hide

comment balloons Kommentare 6231 1289
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AnzeigenFormatierung Markiersprechblasen ein-
oder ausblenden ShowFormatting Show or hide

markup balloons Format 6233 1291

AnzeigenEndgültigesDokument
Einfügungen inline und
Streichungen in der
Sprechblase anzeigen

DisplayFinalDoc
Show insertions
inline and
deletions in
bubbles

Vorschau: Alle Änderungen
annehmen 6234 1285

AnzeigenOriginalDokument
Streichungen inline und
Einfügungen in der
Sprechblase anzeigen

DisplayOriginalDoc
Show deletions
inline and
insertions in
bubbles

Vorschau: Alle Änderungen
ablehnen 6235 1286

VorherigeÄnderungOderKommentar
Gehe zur vorigen
Einfügung, Streichung oder
Kommentar

PreviousChangeOrComment
Go to the previous
insertion, deletion,
or comment

Zurück 6237 1293

NächsteÄnderungOderKommentar
Gehe zur nächsten
Einfügung, Streichung oder
Kommentar

NextChangeOrComment
Go to the next
insertion, deletion,
or comment

Weiter 6238 1294

ÜberarbeitenLeiste

Öffnet ein
Zusammenfassungsfenster
zur Ansicht und Bearbeitung
der Dokumentenrevision
(toggle)

ReviewingPane

Opens a summary
pane for viewing
and editing
document
revisions (toggle)

Zusammenfassungsinformation
en... 6239 1359

AnnehmenÄnderungenAusgewählt Änderungen in der aktuellen
Auswahl annehmen. AcceptChangesSelected Accepts change in

current selection. Änderungen annnehmen 6240 1295

AnnehmenAlleÄnderungenAngezeigt

Alle Änderungen, die unter
den aktuellen
Filtereinstellungen
angezeigt werden,
annehmen.

AcceptAllChangesShown

Accepts all
changes that are
highlighted in the
current filter
settings.

►6240 Alle angezeigten Änderungen
annehmen 6241 1296

AnnehmenAlleÄnderungenImDokument
Alle Änderungen,
ungeachtet der
Filtereinstellungen,
annehmen.

AcceptAllChangesInDoc

Accepts all
changes in
document,
ignoring filter
settings.

►6240 Alle Änderungen im Dokument
annehmen 6242 1297

AblehnenÄnderungenAusgewählt
In der aktuellen Auswahl
Änderungen ablehnen und
Kommentare löschen.

RejectChangesSelected
Rejects changes
and deletes
comments in
current selection.

Änderung ablehnen/Kommentar
löschen 6243 1298

AblehnenAlleÄnderungenAngezeigt

Alle Änderungen, die unter
den aktuellen
Filtereinstellungen
angezeigt werden,
ablehnen.

RejectAllChangesShown

Rejects all
changes that are
highlighted in the
current filter
settings.

►6243 Alle angezeigten Änderungen
ablehnen 6244 1299

AblehnenAlleÄnderungenImDokument
Alle Änderungen,
ungeachtet der
Filtereinstellungen,
ablehnen.

RejectAllChangesInDoc

Rejects all
changes in
document,
ignoring filter
settings.

►6243 Alle Änderungen im Dokument
ablehnen 6245 1300

LöschenAlleKommentareAngezeigt
Alle Kommentare, die unter
den aktuellen
Filtereinstellungen
angezeigt werden, löschen.

DeleteAllCommentsShown

Deletes all
comments that are
highlighted in the
current filter
settings.

►6243 Alle angezeigten Kommentare
löschen 6246 1301

LöschenAlleKommentareImDokument
Alle Kommentare,
ungeachtet der
Filtereinstellungen, löschen.

DeleteAllCommentsInDoc

Deletes all
comments in
document,
ignoring filter
settings.

►6243 Alle Kommentare im Dokument
löschen 6247 1302

BriefassistentJSymbolleiste
Symbolleiste "Japanische
Grußformeln" anzeigen /
ausblenden.

LettersWizardJToolbar
Displays / Hides
the Japanese
Greeting Wizard
Toolbar.

Japanische Grußsymbolleiste
anzeigen 6250 1323

AnzeigenReparaturen

Zeigt alle während der
Wiederherstellung des
Dokuments
vorgenommenen
Reparaturen an

ShowRepairs
Shows all repairs
made to the
document during
Crash Recovery

Reparaturen anzeigen 6265 1381

SeriendruckFeldzuordnung Seriendruck Feldzuordnung. MailMergeFieldMapping Mail Merge field
mapping.

Übereinstimmende Felder
festlegen 6345 1304

SeriendruckAdressblockierung Seriendruck
Adressenblockierung. (!?!) MailMergeAddressBlock Mail Merge

Address Block. Adressblock einfügen 6346 1305

SeriendruckGrußzeile Seriendruck Grußzeile. MailMergeGreetingLine Mail Merge
Greeting Line. Grußzeile einfügen 6347 1306

SeriendruckFeldEinfügen Seriendruck Feld einfügen. MailMergeInsertFields Mail Merge Insert
Fields. Seriendruckfelder einfügen 6348 1307
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SeriendruckEmpfänger Seriendruck Empfänger. MailMergeRecipients Mail Merge
Recipients. Seriendruckempfänger 6349 1308

SBEmailOptionen Seriendruck an E-Mail
Optionsdialog MMEmailOptions Mail Merge Email

Options Dialog Seriendruck: E-Mail-Optionen 6350 1309

SBDruckOptionen Seriendruck an Drucker
Optionsdialog MMPrintOptions

Mail Merge Print
Merge Options
Dialog

Seriendruck: Druckoptionen 6351 1311

SBFaxOptionen Seriendruck an Fax
Optionsdialog MMFaxOptions Mail Merge Fax

Options Dialog Seriendruck:Faxoptionen 6352 1312

SBNeuesDokumentOptionen Seriendruck in Neues
Dokument Optionsdialog MMNewDocOptions

Mail Merge New
Document Merge
Options Dialog

Optionen für: Seriendruck in
neues Dokument 6353 1310

ZeichnenBildeKomprimieren (?!?) Bilder komprimieren ??? ??? Grafik Bilder komprimieren Picture 6382

ExtrasOptionenSicherheit Ändert die
Sicherheitsoptionen ToolsOptionsSecurity Changes security

options Sicherheit 6385 1361

TabelleAutoFormatvorlage Weist einer Tabelle eine
Tabellenformatforlage zu TableAutoFormatStyle Applies a table

style to a table AutoFormat für Tabellen... 6400 1375

SerienbriefBearbeitenAdressenBlock Adressenblock bearbeiten... MailMergeEditAddressBlock Edit Address
Block... Adressblock bearbeiten... 6468 1315

SerienbriefBearbeitenGrußzeile Grußzeile bearbeiten... MailMergeEditGreetingLine Edit Greeting
Line... Grußzeile bearbeiten... 6469 1316

SeriendruckSuchenEintrag
Findet einen bestimmten
Eintrag in einer
Seriendruck-Datenquelle

MailMergeFindEntry
Finds a specified
entry in a mail
merge data source

Eintrag suchen 6539 1326

AnsichtÄnderungen Markiersprechblasen ein-
oder ausblenden ViewChanges Show or hide

markup balloons Markup 6547 1284

ZurücksetzenFormularFeld
Setzt das ausgewählte
Formularfeld auf seinen
Standardwert zurück

ResetFormField
Resets the
selected form field
to its default value

Formularfelder zurücksetzen 6678 1329

SeriendruckWeitergabeEtikett Etiketten vervielfachen MailMergePropagateLabel Propagate Labels Etiketten übertragen 6693 1325

BearbeitenEinfügenOptionen

Fügt den Inhalt der
Zwischenablage mittels
spezifischer
Wiederherstellungsoption
an der Einfügemarke ein

EditPasteOption

Inserts the
Clipboard contents
at the insertion
point using
specific recovery
option

Einfügen 6921 1247

MenüOrganigrammEinfügen Zusätzliches Feld in das
Organigramm einfügen MenuOrgChartInsert

Inserts an
additional box to
the organization
chart

Form einfügen 6925 5814

SeriendruckSatzDokumentTyp
Löscht oder legt den
Serienbrief-Dokumenttyp
fest.

MailMergeSetDocumentType
Sets or clears the
Mail Merge
document type.

Hauptdokument-Setup 6926 1339

AnzeigenZumÜberarbeiten
Anzeigemodus für
Überarbeitungen und
Kommentare auswählen

DisplayForReview
Selects viewing
mode for revisions
and comments

Anzeige für Überarbeitung 6968 1332

EinfügenNeuKommentar Kommentar einfügen
(einschließlich Menü) InsertNewComment Insert comment

(includes menu) Neuer Kommentar 6969 1303
Übersetzen Übersetzen Translate Translate Übersetzen 7021 1338

BearbeitenLöschen
Löscht die Markierung ohne
Übertragung in die
Zwischenablage.

Selection.Delete Unit:=wdCharacter, Count:=1 EditClear

Performs a
forward delete or
removes the
selection without
putting it on the
Clipboard

Bearbeiten
Markierung löschen
Inhalt
Entf

Edit Del 7024 30

ExtrasEServices Öffnet den Dialog eServices ToolsEServices Opens the
eServices dialog Tools im Web... 7032 1383

ZeichnenUmschaltenZeichnung Skaliert Zeichnungsbereich
und Inhalt Zeichnungsbereich Zeichnung skalieren Drawing Canvas 7067
Richtet die markierten
Objekte relativ zum
Organigramm aus

Relativ zu Organigramm 7070

Richtet die markierten
Objekte relativ zum
Diagramma aus

Relativ zu Diagramm 7071

ReparierenFehlerhaftenText Fehlerhaften Text
reparieren FixBrokenText Fix Broken Text Beschädigten Text reparieren... 7089 1399

FileVersionsServer 7800
FileVesionsLocal 1269
ApplyFormattingOfSurrounding 1321
ApplyFormattingOfOriginal 1322
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MenüDatei Datei-Menü MenuFile File Menu Datei 30002 5700
MenüBearbeiten Bearbeiten-Menü MenuEdit Edit Menu Bearbeiten 30003 5701
MenüAnsicht Menü Ansicht MenuView View Menu Ansicht 30004 5702
MenüEinfügen Einfügen-Menü MenuInsert Insert Menu Einfügen 30005 5703
MenüFormat Format-Menü MenuFormat Format Menu Format 30006 5704
MenüExtras Menü Extras MenuTools Tools Menu Extras 30007 5705
MenüTabelle Menü Tabelle MenuTable Table Menu Tabelle 30008 5706
MenüFenster Menü Fenster MenuWindow Window Menu Fenster 30009 5707
MenüHilfe Hilfe-Menü MenuHelp Help Menu ? 30010 5708
Zeichnen-Menü Zeichnen Zeichnen Drawing 30013
MenüMakro Makrountermenü MenuMacro Macro Submenu Extras Makro 30017 5766
Untermenü löschen Clear Submenu Bearbeiten Löschen Edit 30021
Drehen oder kippen Zeichnen > Zeichnen Drehen oder kippen Drawing 30036

AnsichtSymbolleisten Blendet Word-
Symbolleisten ein oder aus. WordBasic.ViewToolbars ViewToolbars Shows or hides

the Word toolbars Ansicht Symbolleisten 30045 323

EinfügenSeriendruckFeld Fügt vor der Einfügemarke
ein Seriendruckfeld ein Dialogs(wdDialogInsertMergeField).Show InsertMergeField

Inserts a mail
merge field at the
insertion point

Seriendruck Seriendruckfeld einfügen
Alt+Umschalt+F Mail Merge Alt+Shift+F 30076 167

SeriendruckListeBedingungsfelder Fügt ein Bedingungsfeld vor
der Einfügemarke ein MailMergeListWordFields

Inserts a Word
field at the
insertion point

Seriendruck
Fügt ein Bedingungsfeld an der
Einfügemarke ein.
Bedingungsfeld einfügen

Mail Merge 30077

Reihenfolge

Zeichnen > Zeichnen
ActiveX-Steuerelemente,
Zeichnen.Kurve,
Unverankerte Grafik,
OLE-Objekt,
Zeichnen.Formen,
WordArt-Kontextmenü

Reihenfolge

Drawing
ActiveX Control,
Curve, Floating
Picture, OLE
Object, Shapes,
WordArt Context
Menu

30078

AutoForm ändern Zeichnen > Zeichnen AutoForm ändern Drawing 30080
Präzisionsausrichtung Zeichnen > Zeichnen Präzisionsausrichtung Drawing 30082

MenüFußEndnotenTextfluß Unverankertes End-
/Fußnoten-Menü MenuNotesFlow Notes Flow Menu Aktion 30083 879

Hyperlink Hyperlink

ActiveX-Steuerelemente,
Kommentar,
Zeichnen.Kurve,
Zeichnen.Kurvenpunkt,
Zeichnen.Kurvenabschni
tt, Endnoten,
Unverankerte Grafik,
Fußnoten,
Formularfelder,
Kopfzeilen, Hyperlink-
Kontextmenü, Inline-
ActiveX-Steuerelement,
Eingebettete Grafik,
Verknüpfte
Überschriften, Listen,
OLE-Objekt,
Zeichnen.Drehungsmod
us, Zeichnen.Formen,
Änderungen
nachverfolgen,
WordArt-Kontextmenü

fyperlink

ActiveX Control,
Comment, Curve,
Curve Node,
Curve Segment,
Endnotes,
Floating Picture,
Footnotes, Form
Fields, Headings,
Hyperlink Context
Menu, Inline
ActiveX Control,
Inline Picture,
Linked Headings,
Lists, OLE Object,
Rotate Mode,
Shapes, Track
Changes,
WordArt Context
Menu

30094

MenüSendenAn Dieses Dokument senden
an… MenuSendTo Send this

document to... Datei > Senden an... Senden an 30095 5771
AutoKorrektur... AutoCorrect... AutoKorrektur 30096

MenüZeichen Zeichen-Menü MenuFont Font Menu Schrift 30099 5710
MenüInArbeit Arbeitsmenü MenuWork Work Menu Arbeit 30100 5709
MenüBearbeitenObjekt Dieses Objekt bearbeiten... MenuEditObject Edit this Object... Objekt 30112 5770

MenüÜberarbeitungen Überarbeitungen-
Untermenü MenuRevisions Revisions

Submenu
Extras > Änderungen
verfolgen Änderungen nachverfolgen 30138 5761

Einfügen Frame Untermenü Insert Frame
Submenu Positionsrahmen 30164

Ausrichten oder verteilen Zeichnen > Zeichnen Ausrichten oder verteilen Drawing 30174
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Gruppierung

ActiveX-Steuerelemente,
Zeichnen.Kurve,
Unverankerte Grafik,
OLE-Objekt,
Zeichnen.Formen,
WordArt-Kontextmenü

Gruppierung

ActiveX Control,
Curve, Floating
Picture, OLE
Object, Shapes,
WordArt Context
Menu

30175

MenüWebFavoriten Favoriten... MenuWebFavorites Favorites... Web Favoriten Web 30176 937
AutoFormen-Menü Zeichnen AutoFormen Drawing 30177

Grafik-Untermenü einfügen Insert Picture
Submenu Einfügen Grafik 30180

MenüAutoText AutoText-Untermenü
einfügen MenuAutoText Insert AutoText

Submenu Einfügen AutoText 30181 5765

MenüSprache Sprachen-Untermenü MenuLanguage Language
Submenu Extras Sprache 30182 5712

MenüPowerTalk PowerTalk Untermenü MenuPowerTalk PowerTalk
Submenu E-Mail 30183 5767

MenüMicrosoftImWeb Microsoft Im Web-Menü MenuMicrosoftOnTheWeb Microsoft On the
Web Menu Microsoft im Web 30222 5713

Optionen... Options... Web Wechseln zu Web 30328

MenüZelleVertikalAusrichten Untermenü zur vertikalen
Zellenausrichtung MenuCellVerticalAlign

Cell Vertical
Alignment
Submenu

Ausrichtung 30411 5769

AutoText
Kopf- und Fußzeile

AutoText einfügen
Alle Einträge

AutoText
Header and
Footer

30423

Sprache... Language... Sprache 30443

MenüTabelleEinfügen Makrountermenü MenuTableInsert Macro Submenu Tabelle Zellen einfügen
Einfügen 30444 5755

MenüTabelleLöschen Makrountermenü MenuTableDelete Macro Submenu Tabelle Löschen 30445 5756
MenüTabelleMarkieren Makrountermenü MenuTableSelect Macro Submenu Tabelle Markieren 30446 5782
MenüTabelleKonvertieren Makrountermenü MenuTableConvert Macro Submenu Tabelle Umwandeln 30447 5783
MenüFrameset Format Frameset

Untermenü MenuFrameset Format Frameset
Submenu Format Frames 30452 5758

MenüTabelleAutoAnpassenKurz Makrountermenü MenuTableAutoFitShort Macro Submenu Tabellentext AutoAnpassen Table Text 30459 5786
MenüTabelleAutoAnpassenLang Makrountermenü MenuTableAutoFitLong Macro Submenu Tabelle AutoAnpassen 30460 5787

MenüZellenAusrichtung Zellausrichtung MenuCellAlignment
Tabellen und Rahmen
Tabellenzellen,
Tabellentext, Tabellen,
Ganze Tabelle

Zellausrichtung

Tables and
Borders
Table Cells, Table
Text, Tables,
Whole Table

30461 5788

MenüTabelleEinfügenLang Makrountermenü MenuTableInsertLong Macro Submenu Tabelle einfügen 30462 5789
MenüAsiatischesLayout Untermenü: Asiatisches

Layout MenuAsianLayout Asian Layout
Submenu Asiatisches Layout 30463 5791

Zusammenarbeit-
Untermenü Extras Onlinezusammenarbeit 30468

KorrigierenSynonymMenü Synonym... FixSynonymMenu Synonym... Text Synonyme Text 30475 5792
Zwischenablage Zwischenablage Elemente Clipboard 31121

ExtrasReparierenHHC Hangul/Hanja... ToolsFixHHC, FixHHCMenu Hangul/Hanja... Extras > Sprache Hangul/Hanja-Konvertierung Tools > Language 31154 1262,
5785

Layout Layout 31158
MenüBriefePost Extras Briefe- und

Sendungenuntermenü MenuLettersMail Briefe und Sendungen 31171 5807
Bezugsuntermenü einfügen Referenz 31174

MenüOrganiGrammLayout Diagrammlayout MenuOrgChartLayout Layout 31179 5803
MenüDiagrammKonvertierenZu Konvertieren zu MenuDiagramConvertTo Convert To Ändern zu 31180 5815

MenüOrganigrammAuswahl MenuOrgChartSelect Select
Organigramm
Organization Chart
Popup

Markieren
Organization
Chart
Organization
Chart Popup

31181 5754

MenüAnzeigenLeser Feinabstimmung zur
Anzeige der Sprechblasen MenuShowReviewers Fine tune which

bubbles are shown Format Bearbeiter Format 31184 5812

MenüAnzeigenÄnderungen Feinabstimmung zur
Anzeige der Sprechblasen MenuShowChanges Fine tune which

bubbles are shown Anzeigen 31234 5811
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AuflösenMenü
Änderungen
annehmen/ablehnen und
Kommentare löschen

ResolveMenu Lösen 31235 5813

Draw3DColor
Draw3DCustomize
DrawAttachText
DrawCloseFreeform
DrawDeleteFreeformSegment
DrawFillToggle
DrawInsertWordArt
DrawLineToggle
DrawMarqueeObjects

MenüZeichnen3D DrawMenu3D 5730

MenüZeichnen3DFarbe
Übernimmt die zuletzt
verwendete 3-D-Farbe in
die AutoForm

WordBasic.DrawMenu3DColor DrawMenu3DColor

Applies the most
recently used 3-D
color to the
selected
AutoShape

5751

MenüZeichnen3DTiefe DrawMenu3DDepth 5749
MenüZeichnen3DRichtung DrawMenu3DDirection 5750
MenüZeichnen3DHelligkeit DrawMenu3DLighting 5752
MenüZeichnen3DOberfläche DrawMenu3DSurface 5753
MenüZeichnenAusrichtenAnordnen DrawMenuAlignDistribute 5721
MenüZeichnenPfeile DrawMenuArrows 5729
MenüZeichnenAutoFormen DrawMenuAutoShapes 5739
MenüZeichnenFormÄndern DrawMenuChangeShape 5733
MenüZeichnenFormÄndern0 DrawMenuChangeShape0 5734
MenüZeichnenFormÄndern1 DrawMenuChangeShape1 5735
MenüZeichnenFormÄndern2 DrawMenuChangeShape2 5736
MenüZeichnenFormÄndern3 DrawMenuChangeShape3 5737
MenüZeichnenFormÄndern4 DrawMenuChangeShape4 5738
MenüZeichnenGruppieren DrawMenuGrouping 5720
MenüZeichnenBildSteuerelement DrawMenuImageControl 5732
MenüZeichnenLinieGestrichelt DrawMenuLineDash 5728
MenüZeichnenWeitereFormen1 DrawMenuMoreShapes1 5740
MenüZeichnenWeitereFormen2 DrawMenuMoreShapes2 5741
MenüZeichnenWeitereFormen3 DrawMenuMoreShapes3 5742
MenüZeichnenWeitereFormen4 DrawMenuMoreShapes4 5743
MenüZeichnenWeitereFormen5 DrawMenuMoreShapes5 5744
MenüZeichnenWeitereFormen6 DrawMenuMoreShapes6 5745
ZeichenMenüWeitereFormen7 DrawMenuMoreShapes7 5804
MenüZeichnenBewegen DrawMenuNudge 5723
MenüZeichnenReihenfolge DrawMenuOrder 5719
MenüZeichnenDrehenKippen DrawMenuRotateFlip 5722

MenüZeichnenSchattierungFarbe
Übernimmt die zuletzt
verwendete Schattenfarbe
in die AutoForm

WordBasic.DrawMenuShadowColor DrawMenuShadowColor

Applies the most
recently used
shadow color to
the selected
AutoShape

5731

MenüZeichnenSchattierungen DrawMenuShadows 5726
MenüZeichnenTextAusrichtung DrawMenuTextAlignment 5747
MenüZeichnenTextForm DrawMenuTextShape 5746
MenüZeichnenTextProtokollieren DrawMenuTextTracking 5748
MenüZeichnenTextumbruch DrawMenuTextWrapping 5718

DrawOpenFreeform
DrawRegroup
DrawSetArrowStyle
DrawSetFillColor
DrawSetFillEffect
DrawSetLineColor
DrawSetLinePattern
DrawShadowColor
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DrawShadowCustomize
DrawShowAutoShapesAndDrawingToo
lbars
DrawToggleCropMode
DrawToggleEditPointsMode
DrawToggleSelectObjectMode
DrawToggleWordArtToolbar
DrawWordArtAutoFormat
DrawWordArtKern
DrawWordArtRotateCharacters

DateiVorschau FilePreview 5759
FormatHintergrundMuster Ändert den Hintergrund des

Dokuments WordBasic.FormatBackgroundSwatch FormatBackgroundSwatch 1003

HilfeMSN
Dieser Befehl ist nicht
verfügbar auf dieser
Plattform.

WordBasic.HelpMSN HelpMSN
This command is
not available on
this platform.

795

EinfügenImagerScan InsertImagerScan 981
MenüRahmen MenuBorder 5714
MenüLöschen MenuClear 5808
MenüDiagrammLayout MenuDiagramLayout 5809
MenüZeichnen MenuDraw 5717
MenüBehebenRechtschreibAutoKorrekt MenuFixSpellingAC 5763
MenüKorrigierenRechtschreibSprache MenuFixSpellingLang 5760
MenüHyperlinkSub MenuHyperlinkSub 5768
MenüEinfügenRahmen MenuInsertFrame 5716
MenüGrafik MenuPicture 5764
MenüVerweis MenuReference 5806
MenüTabelleEinfügenPalette MenuTableInsertPalette 5784
MenüWebGehe MenuWebGo 998
OfficeZeichnenBefehl OfficeDrawingCommand 917
AntwortenAufAnmerkung ReplyToAnnotation 1344
MakroAblaufBeenden StopMacroRunning Strg+Pause 645
TabellenAssistent Tabellen-Assistent Tabellen-Assistent TableWizard Table Wizard 1157
BenutzerDialog WordBasic.UserDialog UserDialog 297
WebAdresse Hyperlinkadresse ActiveDocument.FollowHyperlink NewWindow:=False,

AddHistory:=True WebAddress Hyperlink Address 938

WW2_ExtrasEinstellungenFunktionsleiste Ändert die Schaltflächen auf
der Symbolleiste. WordBasic.WW2_ToolsOptionsToolbar WW2_ToolsOptionsToolbar 210

DrawInsertBentArrow
DrawInsertChevron
DrawInsertCircularArrow
DrawInsertCurve
DrawInsertFilledFreeform
DrawInsertFilledPolygon
DrawInsertFreeform
DrawInsertHomePlate
DrawInsertLine
DrawInsertNotchedCircularArrow
DrawInsertPolygon

FormatDesignName Webdesign WordBasic.FormatThemeName FormatThemeName 1114
AutoSignaturListe AutoSignatureList 5757

Sprache
Ändert die
Spracheinstellungen für die
markierten Zeichen.

Language

Changes the
language
formatting of the
selected
characters

856

AnzeigenEinfügungenUndLöschungen Markiersprechblasen ein-
oder ausblenden ShowInsertionsAndDeletions Show or hide

markup balloons Einfügungen und Löschen 1290
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